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New In this release

Features

Features

The following sections detail what's new in IP Phones Fundamentals
(NN43001-368) for Nortel Communication Server 1000 (CS 1000).

This document contains a Screen Saver Slideshow feature for the IP
Phone 2007. This feature allows you to download images onto the

phone for sequential display after the screen saver activates. For more
information about the Screen Saver Slideshow feature, see “Screen Saver
Slideshow IP Phone 2007” (page 370).

Navigation

Features

“Virtual Private Network” (page 551)

“Licensing” (page 565)

“Design for Operability” (page 559)

“Datagram Transport Layer Security” (page 549)
“Secure IP Call Recording” (page 357)

Communication Server Release 6.0 includes the following additions:

Two-line mode for IP Phones 1110 and 1210

Dynamic IP Line localization with support of 25 languages. Dynamic
localization means that prompt translations can be easily updated
and new translations can be added. New translations are regionally
controlled.

New telephony features: Caller ID display order and Normal Mode
Indication (with configurable Normal Mode Display)

Support of the Datagram Transport Layer Security (DTLS) protocol to
encrypt UNIStim signaling
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20 New in this release

* Record on Demand feature

®* Screen Saver Slideshow feature with the IP Phone 2007. This feature
allows you to download images onto the phone for sequential display
after the screen saver activates.

Nortel IP Softphone 2050 license information is a new section added to
support IP Softphone 2050 Release 3.3. For more information, see “Nortel
IP Softphone 2050 license information” (page 689).

Revision history

December 2009

November 2009

October 2009

July 2009

May 2009

May 2009

November 2009

February 2009

February 2009

January 2009

Standard 06.03. This document is up-issued to support
CS 1000 Release 6.0. Because of the similarity between
Communication Server 1000 Release 6.0 for UNIStim 4.0
features and Release 5.5 features, UNIStim 4.0 Release
6.0 documentation is also used for Release 5.5.

Standard 06.02. This document is up-issued to support
CS 1000 Release 6.0. Because of the similarity between
Communication Server 1000 Release 6.0 for UNIStim 4.0
features and Release 5.5 features, UNIStim 4.0 Release
6.0 documentation is also used for Release 5.5.

Standard 06.01. This document is up-issued to support
CS 1000 Release 6.0. Because of the similarity between
Communication Server 1000 Release 6.0 for UNIStim 4.0
features and Release 5.5 features, UNIStim 4.0 Release
6.0 documentation is also used for Release 5.5.

Standard 05.03. This document is up-issued to support IP
Softphone 2050 Release 3.3 for CS 1000 Release 6.0.

Standard 05.02. This document is up-issued to support
CS 1000 Release 6.0.

Standard 05.01. This document is up-issued to support
CS 1000 Release 6.0.

Standard 04.08. This document is up-issued to support the
Nortel 1165E IP Phone and UNIStim 3.x for both CS 1000
Release 5.x and CS 1000 Release 6.0.

Standard 04.07. This document is up-issued to change
CATS5 to CAT5e cable in the chapters Nortel IP Audio
Conference Phone 2033, Nortel IP Phone 1210, Nortel IP
Phone 1220, and Nortel IP Phone 1230.

Standard 04.06. This document is up-issued to change
CATS5 to CAT5e cable, which is currently shipped with IP
Phones.

Standard 04.05. This document is up-issued to reflect
changes in the IP Phone 2001 and 2004 component list.
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October 2008

August 2008

August 2008

July 2008

May 2008

April 2008

April 2008

March 2008

February 2008

December 2007

December 2007

December 2007

Standard 04.04. This document is up-issued to support
CS 1000 Release 5.5. This document contains an

update on functionality of IP port numbers used in IP
Softphone 2050 application and the steps involved in
session establishment between IP Softphone 2050 client,
Call Server, Signalling Server, Media cards, Licensing
server, Duplicate Media Stream, Application Gateway and
Signaling Encryption.

Standard 04.03. This document is up-issued to support
UNIStim Release 3.0 for CS 1000 Release 5.5.

Standard 04.02. This document is up-issued to support an
update to technical content for the IP Softphone 2050.

Standard 04.01. This document is up-issued to support IP
Softphone 2050 Release 3.1 for Communication Server
1000 Release 5.5. This document also contains updates to
technical content for UNIStim 3.0.

Standard 03.07. This document is up-issued to support
Communication Server 1000 Release 5.5. This document
contains an update to technical content within the IP
Phone 1200 Series sections.

Standard 03.06. This document is up-issued to support
Communication Server 1000 Release 5.5. This document
contains support for UNIStim 3.0.

Standard 03.05. This document is up-issued to support
Communication Server 1000 Release 5.5. This document
contains an update to technical content.

Standard 03.04. This document is up-issued to support
Communication Server 1000 Release 5.5. This document
contains an update to technical content for IP Softphone
2050 Release 3 and an update to technical content for
TFTP server firmware download.

Standard 03.03. This document is up-issued to support
Communication Server 1000 Release 5.5. This document
contains updates to technical content.

Standard 03.02. This document is up-issued to support
Communication Server 1000 Release 5.5. This document
contains updates to technical content.

Standard 03.01. This document is up-issued to support
Communication Server 1000 Release 5.5.

Standard 02.01. This document is up-issued to support
Communication Server 1000 Release 5.0. This document
contains support for IP Softphone 2050 Release 3.
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June 2007

May 2007

March 2007

March 2007

January 2007
November 2006

October 2006

October 2006

August 2006

July 2006

June 2006

April 2006

April 2006
March 2006

Standard 01.02. This document is up-issued to support
Communication Server 1000 Release 5.0.

Standard 01.01. This document is up-issued to support
Communication Server 1000 Release 5.0. This document
is renamed IP Phones Fundamentals (NN43001-368) and
contains information previously contained in the following
legacy document, now retired: (553-3001-368).

Standard 23.00. This document is up-issued to support
Communication Server 1000 Release 4.5. This document
is up-issued to include updated information for Mobile
Voice Client (MVC) 2050.

Standard 22.00. This document is up-issued to support
Communication Server 1000 Release 4.5. This document
is up-issued to support the addition of the IP Phone 1110.

Standard 21.00. Not issued.

Standard 20.00. This document is up-issued to support CS
1000 Release 4.5. This document is up-issued to support
the addition of the Expansion Module for IP Phone 1100
Series.

Standard 19.00. This document is up-issued to support
Communication Server 1000 Release 4.5.

Standard 18.00. This document is up-issued to support CS
1000 Release 4.5. This document is up-issued to support
the addition of the IP Phone 1150E.

Standard 17.00. This document is up-issued to support CS
1000 Release 4.5.

Standard 16.00. This document is up-issued to support CS
1000 Release 4.5.

Standard 15.00. This document is up-issued to include
UNIStim firmware up-version.

Standard 14.00. This document is up-issued to support CS
1000 Release 4.5. This document is up-issued to include
content for the IP Audio Conference Phone 2033 Release
2.

Standard 13.00. Not issued.

Standard 12.00. This document is up-issued to support CS
1000 Release 4.5. This document is up-issued to include
updated content for the IP Softphone 2050 V2.
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January 2006

January 2006

January 2006
November 2005
August 2005
April 2005

April 2005
February 2005
September 2004
June 2004

October 2003

Subject

Standard 11.00. This document is up-issued to support CS
1000 Release 4.5. This document is up-issued to include
updated content for the IP Phone 1120E and IP Phone
1140E.

Standard 10.00. This document is up-issued to support CS
1000 Release 4.5. This document is up-issued to include
updated content for the IP Phone 1140E.

Standard 9.00. This document is up-issued to support CS
1000 Release 4.5.

Standard 8.00. This document is up-issued to support the
addition of IP Phone 1140E.

Standard 7.00. This document is up-issued to support CS
1000 Release 4.5.

Standard 6.00. This document is up-issued to support the
addition of the IP Phone 2007.

Standard 5.00. This document is up-issued to support the
addition of the IP Audio Conference Phone 2033.

Standard 4.00. This document is up-issued to support the
8.x Firmware Upgrade for IP Phones.

Standard 3.00. This document is up-issued to support
Communication Server 1000 Release 4.0.

Standard 2.00. This document is up-issued to include the
Nortel Networks Mobile Voice Client 2050.

Standard 1.00. This document is a new NTP for
Succession 3.0 Software. It was created to support

a restructuring of the Documentation Library. This
document contains information previously contained in the
following legacy document, now retired: Internet Terminals
Description (553-3001-217).

This document contains description, installation, and administration
information for the following:

Nortel IP Audio Conference Phone 2033

Nortel IP Phone 2001, IP Phone 2002, IP Phone 2004, and IP Phone
2007

Nortel IP Phone Key Expansion Module (KEM)
Nortel IP Softphone 2050
Nortel Mobile Voice Client 2050 for Personal Digital Assistants (PDA)
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24 New in this release

Nortel IP Phone 1110

Nortel IP Phone 1120E

Nortel IP Phone 1140E

Nortel IP Phone 1150E

Nortel IP Phone 1165E

Expansion Module for IP Phone 1100 Series

Nortel IP Phone 1210

Nortel IP Phone 1220

Nortel IP Phone 1230

Nortel IP Phone 1200 Series Expansion Module (EM)

Note on legacy products and releases
This NTP contains information about systems, components, and features
that are compatible with Nortel Communication Server 1000 Release 6.0
software. For more information about legacy products and releases, click
the Technical Documentation link under Support on the Nortel home

page:

www.nortel.com

NTPs, User Guides, and other document references
This document references the following:

Features and Services Fundamentals (NN43001-106)

Signaling Server IP Line Applications Fundamentals (NN43001-125)
Converging the Data Network with VolP Fundamentals (NN43001-260)
IP Peer Networking Installation and Commissioning (NN43001-313)
Secure Multimedia Controller Implementation Guide (NN43001-325)
Automatic Call Distribution Fundamentals (NN43001-551)

Security Management Fundamentals (NN43001-604)

Software Input Output Reference - Administration (NN43001-611)
Emergency Service Access Fundamentals (NN43001-613)

Element Manager System Reference - Administration (NN43001-632)
Software Input Output Reference - Maintenance (NN43001-711)
Central Answering Position Implementation Guide (NN43011-501)

IP Phone 1110 User Guide (NN43110-101)

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.


http:\\www.nortel.com

Subject 25

* |P Phone 1110 Getting Started Card (NN43110-300)

* [P Phone 1120E Getting Started Card (NN43112-100)

* [P Phone 1120E User Guide (NN43112-103)

* |P Phone 1140E Getting Started Card (NN43113-103)

* |P Phone 1140E User Guide (NN43113-106)

* [P Phone 1150E Getting Started Card (NN43114-103)

* |P Phone 1150E User Guide (NN43114-100)

* |P Phone 2001 User Guide (NN43115-102)

* [P Phone 2002 User Guide (NN43116-104)

* [P Phone 2004 User Guide (NN43117-102)

* |P Phone 2007 User Guide (NN43118-100)

® [P Phone Audio Conference Phone 2033 User Guide (NN43111-100)
* [P Softphone 2050 User Guide (NN43119-101)

* |P Phone Key Expansion Module User Guide (NN43119-102)
* Mobile Voice Client 2050 User Guide (NN43119-103)

* Expansion Module for IP Phones 1100 Series User Guide
(NN43130-101)

* |P Phone 1210 User Guide (NN43140-101)

* [P Phone 1220 User Guide (NN43141-101)

* [P Phone 1230 User Guide (NN43142-101)

* Nortel Application Gateway 1000/2000 Administration Guide
(NN42360-600)

For information about WLAN Handset 2210, WLAN Handset 2211, WLAN
Handset 2212, WLAN Handset 6120, and WLAN Handset 6140, see
WLAN IP Telephony Installation and Commissioning (NN43001-504).

Online
To access Nortel documentation online, click the Technical
Documentation link under Support on the Nortel home page:

www.nortel.com

CD-ROM
To obtain Nortel documentation on CD-ROM, contact your Nortel customer
representative.
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How to get Help

This chapter explains how to get help for Nortel products and services.

Getting help from the Nortel Web site
The best way to get technical support for Nortel products is from the Nortel
Technical Support Web site:

www.nortel.com/support

This site provides quick access to software, documentation, bulletins, and
tools to address issues with Nortel products. From this site, you can:

* download software, documentation, and product bulletins

® search the Technical Support Web site and the Nortel Knowledge Base
for answers to technical issues

* sign up for automatic notification of new software and documentation
for Nortel equipment

* open and manage technical support cases

Getting help over the phone from a Nortel Solutions Center
If you do not find the information you require on the Nortel Technical
Support Web site, and you have a Nortel support contract, you can also
get help over the telephone from a Nortel Solutions Center.

In North America, call 1-800-4NORTEL (1-800-466-7835).

Outside North America, go to the following Web site to obtain the
telephone number for your region:

www.nortel.com/callus
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28 How to get Help

Getting help from a specialist by using an Express Routing Code
To access some Nortel Technical Solutions Centers, you can use an
Express Routing Code (ERC) to quickly route your call to a specialist in
your Nortel product or service. To locate the ERC for your product or
service, go to:

www.nortel.com/erc

Getting help through a Nortel distributor or reseller
If you purchased a service contract for your Nortel product from a
distributor or authorized reseller, contact the technical support staff for that
distributor or reseller.

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.


http://www.nortel.com/erc

29

Nortel IP Phone 2001

Contents

This section contains the following topics:

Introduction

“Introduction” (page 29)

“Description” (page 30)

“Components and functions” (page 30)
“Features” (page 32)

“Display characteristics” (page 33)
“Package components” (page 34)
“Installation and configuration” (page 36)
“Redeploying an IP Phone 2001” (page 40)
“Replacing an IP Phone 2001” (page 41)

“Removing an IP Phone 2001 from service” (page 41)

This section explains how to install and maintain the IP Phone 2001. For
information about using the IP Phone 2001, see the IP Phone 2001 User
Guide (NN43115-102).

This section contains the following procedures:

Procedure 1 “Configuring the IP Phone 2001” (page 37)
Procedure 2 “Connecting the components” (page 38)

Procedure 3 “Changing the TN of an existing IP Phone 2001” (page
40)

Procedure 4 “Replacing an IP Phone 2001” (page 41)

Procedure 5 “Removing an IP Phone 2001 from service” (page 41)
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If power to the phone is interrupted after you install and configure an IP
phone, you are not required to reenter the IP Parameters, Node Numbers,
or Terminal Number (TN). There is also no need to again acquire the
firmware.

Description
The IP Phone 2001 is a multi-line professional-level deskset with a
high-resolution, fully-backlit, QVGA color LCD display. The enhanced
configuration menus and USB peripheral support provide a superior
navigation experience. The integrated Bluetooth® Audio gateway offers
greater freedom and mobility. The set includes an integrated phone switch
with Gigabit Ethernet LAN and PC ports. When the phone is idle users
fully experience the personalized background images and capabilities, as
well as the Digital Picture Frame mode.

Figure 1 "IP Phone 2001" (page 30) shows the IP Phone 2001.

Figure 1
IP Phone 2001

Message wailing indicalod!
Incoming call indicator

Display screen

Soft kays (self.labeled)

Speakar =
Navigation keys

Services key

Disipad Message key

Goodbye key
Hold ey
Line key

Violume contral bar

Components and functions
This section describes the following components and functions of the IP
Phone 2001:

* *“Keys and functions” (page 31)

* “Services menu” (page 31)
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Keys and functions
Table 1 "IP Phone 2001 keys and functions" (page 31) describes the IP
Phone 2001 keys and functions.

Table 1

IP Phone 2001 keys and functions
Key Function
Speaker Press the Line key to activate the speaker for on-hook dialing and

listening.

Message waiting/ The Message waiting lamp turns on to indicate that a message is left
Incoming call indicator for the user. This lamp also flashes when the IP Phone ringer is on.
Volume control bar Use the volume control bar to adjust the volume of the Handset,

Ringer, and On-hook Dialing/Listen tones.

Press the right side of the rocker bar to increase volume; press the
left side to decrease volume.

Navigation keys Use the navigation keys to scroll through menus and lists in the
display area.
Line key Use the Line key to access the single line and activate on-hook

dialing. No status icon or light emitting diode (LED) is provided.

Hold key Press the Hold key to put an active call on hold. Press the Dial/Line
key to return to the caller on hold.

Context-sensitive soft keys  Context-sensitive soft keys (self-labeled) are located below the

(self-labeled) display area. The LCD label above the key changes, based on the
active feature. A triangle before a key label indicates that the key is
active.

Message key Press the Message key to access your voice mailbox.

Goodbye key Press the Goodbye key to terminate an active call.

Services menu
Table 2 "Services menu" (page 31) shows the Services menu.

Table 2
Services menu

Services key Press the Services key to access the following items:

® Telephone Options
— Volume adjustment
— Contrast adjustment
— Language

— Date/Time

— Local DialPad Tone
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— Set Info
— Diagnostics
— Ring type
— Call Timer
— Live Dialpad
— Normal Mode indication
— Caller ID display order
® Password Admin
— Station Control Password
® Virtual Office Login and Virtual Office Logout (if Virtual Office is configured)

® Test Local Mode and Resume Local Mode (if Branch Office is configured)

Press the Services key to exit from any menu or menu item.

You can customize the IP Phone features to meet user requirements. For
more information, see the IP Phone 2001 User Guide (NN43115-102).

Double-press the Services key to access Network diagnostic utilities. For
more information about Network diagnostic utilities, see “IP Phone diagnostic
utilities” (page 569).

If an incoming call is presented while you configure information in the Services menu, the phone
rings. However, the display does not update with the caller ID, and the programming text is not

disturbed.

While you are in the Services menu you cannot dial digits but you can use the programmable line
keys, such as Redial (double-press a line key) and Auto dial key to make a call. However, the
display does not update with the dialed digits or Caller ID.

Features

The IP Phone 2001 supports the following telephony features:

four context-sensitive soft keys
Functions for the context-sensitive soft keys are configured in LD 11.

For more information about context-sensitive soft keys, see Features
and Services Fundamentals (NN43001-106).

volume control bar to adjust ringer, speaker, handset volume
two specialized feature keys

— Message/Inbox

— Services

two call-processing keys
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— Goodbye
— Hold

Display characteristics
An IP Phone 2001 has two display areas:

* ‘“Information line display” (page 33)
* “Soft key label display” (page 34)

Figure 2 "IP Phone 2001 display areas" (page 33) shows these two display
areas.

Figure 2
IP Phone 2001 display areas

Upper display area
-information display \[

Lower display area

Sy - e -

NEORTEL

Cleaning the IP Phone display screen
Gently wipe the IP Phone display screen with a soft, dry cloth.

CAUTION

Do not use any liquids or powders on the IP Phone 2001. Using
anything other than a soft, dry cloth can contaminate IP Phone
components and cause premature failure.

Information line display
An IP Phone 2001 has a one-line information display area with the
following information:

e caller number
* caller name
e feature prompt strings

* user-entered digits
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* date and time information (if the IP Phone is in an idle state) or Call
Timer (if provisioned in the Telephone options menu)

* set information

The information area changes according to the call-processing state and
active features.

Soft key label display
The soft key label has a maximum six characters. Each soft key includes
the soft key label and an icon. When a soft key is in use, a triangle icon
appears at the beginning of the soft key label, and the label shifts one
character to the right. (If the label is six characters in length, the last or
rightmost character is truncated.) If a feature is enabled, the icon state
turns to On. The icon remains in the on state until the feature key is
pressed again. This cancels the enabled feature and turns the icon off,
and returns the soft key label to its original state.

Use the More soft key to navigate the layers of functions. If only four
functions are assigned to the soft keys, the More key does not appear,
and all four functions are displayed.

Package components
The following information applies to IP Phone 2001, IP Phone 2002, and
IP Phone 2004. Product codes for IP Phone 2001, IP Phone 2002, and IP
Phone 2004 are different from previous IP Phones.

See the product code on the back of the phone to confirm whether it is an
IP Phone 2001, IP Phone 2002, and IP Phone 2004. The product code for
IP Phone 2001, IP Phone 2002, and IP Phone 2004 appears as IP Phone
200x. The product code for previous versions of the IP Phones appears
with an i in front of the model number (for example, i200x).

You must order the global power supply separately if local power using the
global power supply is required, because IP Phone 2001, IP Phone 2002,

and IP Phone 2004 include integrated support for a number of power over
LAN options, including support for IEEE 802.3af standard power.

Table 3 "Package components" (page 35) lists the IP Phone 2001 package
components.
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Table 3
Package components

* |P Phone 2001

® handset

® handset cord

® 2.1 m (7-ft) e Ethernet cable
® (Getting Started Card

®* number plate and lens

Table 4 "IP Phone 2001 components list" (page 35) lists the IP Phone

2001 components and product codes.

Table 4
IP Phone 2001 components list

Australia, New Zealand
Note: ROHS does not apply in this region.

Component Product code

IP Phone 2001 (Ethergray) with Icon keycaps NTDU90AA16/A0533387
IP Phone 2001 (Ethergray) with English text label keycaps NTDU90BA16/A0533388
IP Phone 2001 (Charcoal) with Icon keycaps NTDU90AA70/A0053389
IP Phone 2001 (Charcoal) with English text label keycaps NTDU90BA70/A0533390
IP Phone 2001 (Charcoal with Bezel) with Icon keycaps NTDU90AB70

IP Phone 2001 (Charcoal with Bezel) with Icon keycaps (RoHS) NTDU90AC70E6

IP Phone 2001 (Charcoal with Bezel) with English text label keycaps | NTDU90BB70

IP Phone 2001 (Charcoal with Bezel) with English text label keycaps | NTDU90BC70E6
(RoHS)

Replacement parts

7-ft. CAT5-e NO0177422

Handset, Charcoal A0758634

Handset cord, Ethergray; for IP Phone 2004 and IP Phone 2001 A088682

Handset cord, Charcoal; for IP Phone 2004 and IP Phone 2001 N0000764

Power supply

Global power supply (for local power) NTYS17xxE6

IEC cables

1.8 m (5.9 ft), 10 amp, IEC320-C13 NTYS14AAE6

North America

2.4 m (8 ft), 240 VAC 10 amp, ANZ power cord AS-3, NTTK15AA
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Power supply

250 VAC, Option 11C Standard European power cord, NTTK16ABEG6
Other EMEA, Kenya, Korea, Thailand, Indonesia, Vietham, India,

Pakistan

3 m (9.9 ft) 125 VAC, Option 11C Swiss power cord NTTK17ABEG6
Switzerland

240 VAC, Option 11C UK power cord NTTK18ABEG6

Hong Kong, Ireland, United Kingdom, Singapore, Malaysia,
Bangladesh, Brunei, Sri Lanka

3 m (9.9 ft), 125 VAC, Option 11C Denmark power cord NTTK22ABEG6
Denmark

Argentina A0814961
Note: ROHS does not apply in this region.

1.8 m (5.9 ft), 10 amp, IEC320-C13 NTTK26AAE6
Japan

For more information, and for information about previous versions of the IP
Phone, contact your Nortel representative.

Installation and configuration
The following sections provide a step-by-step guide to install and configure
the IP Phone 2001:

“Before you begin” (page 36)

“First-time installation” (page 37)
“Configuring the IP Phone 2001” (page 37)
“Connecting the components” (page 38)

“Startup sequence” (page 39)

Before you begin
Before installing the IP Phone 2001, complete the following pre-installation
checklist:

Ensure one IP Phone 2001 boxed package exists for each IP Phone
2001 you install. For a list of IP Phone 2001 package components, see
Table 3 "Package components" (page 35).

Ensure one Software License exists for each IP Phone 2001 you
install.

Ensure the host Call Server is equipped with a Signaling Server that
runs the Line Terminal Proxy Server (LTPS) application.

If a global power supply is required, make sure you use the correct
global power supply supplied by Nortel and country specific IEC cable.
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The voltage rating of the global power supply must match the wall
outlet voltage. See Table 4 "IP Phone 2001 components list" (page

35).

* Ensure the latest IP Phone firmware is deployed to the IP telephony
node. For more information, see Signaling Server IP Line Applications
Fundamentals (NN43001-125).

First-time installation
You must first install an IP telephony node with the Communication Server.
For information about installing an IP telephony node, see Signaling Server
IP Line Applications Fundamentals (NN43001-125).

CAUTION
Do not plug your IP Phone 2001 into an ISDN connection.
Severe damage can result.

Configuring the IP Phone 2001
Use Procedure 1 “Configuring the IP Phone 2001” (page 37) to configure
the IP Phone 2001 for the first time.

Procedure 1
Configuring the IP Phone 2001

Step

Action

1

Configure a virtual loop on the Call Server using LD 97. For
more information about configuring a virtual loop, see Signaling
Server IP Line Applications Fundamentals (NN43001-125) and
Software Input Output Reference-Administration (NN43001-611).

Configure the IP Phone 2001 on the Call Server using LD 11. At
the prompt, enter the following:

REQ:new
TYPE:2001P2

For more information about configuring the IP Phone 2001 using
LD 11, see Software Input Output Reference-Administration
(NN43001-611).

Configure the IP Phone 2001 in Element Manager. IP Phones
are configured using the Phones section in the Element
Manager navigation tree. For more information about configuring
the IP Phone 2001 using Element Manager, see Element
Manager System Reference - Administration (NN43001-632).

—End--
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Connecting the components
Use “Connecting the components” (page 38) to connect the IP Phone
2001 components.

Procedure 2
Connecting the components

Step

Action

1

Connect one end of the handset cord to the handset jack on the
back of the IP Phone identified with a handset icon. See Figure 3
"IP Phone 2001 Ethernet network interface connections" (page
39).

Connect the other end of the handset cord to the handset.

Connect one end of the CAT5-e Ethernet cable to the network
interface located on the back of the IP Phone (identified with

a LAN icon, see Figure 3 "IP Phone 2001 Ethernet network
interface connections” (page 39)). The other end of the CAT5-e
Ethernet cable plugs into the IP network.

The LAN Ethernet port supports Auto-Media Dependent Interface
Crossover (MDIX). Auto-MDIX is supported only when the
Ethernet port is configured for autonegotiation.

Connect the global power supply (optional). Leave the global
power supply unplugged from the power outlet, connect the
global power supply to the AC adapter jack in the bottom of
the phone. Form a small bend in the cable and then thread the
global power supply cord through the channels in the stand.

Secure the IP Phone footstand to the base of the IP Phone. Use
the angle adjustment grip on the top back of the IP Phone to
adjust the position.

CAUTION

Damage to Equipment

Do not plug any device into your IP Phone 2001
Ethernet port other than an IEEE 802.3 Ethernet
network connection.
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Figure 3
IP Phone 2001 Ethernet network interface connections

LAN Ethemnet port
Handset jack

AC Adapter jack

Power the IP Phone 2001 using either the Power over Ethernet
or a global power supply (local power). If you are using local
power, plug the a global power supply into the nearest power
outlet. Make sure you use the correct global power supply
supplied by Nortel and country specific IEC cable. The voltage
rating of the power supply must match the wall outlet voltage.
See Table 4 "IP Phone 2001 components list" (page 35).

The IP Phone 2001 supports both AC power and Power over
LAN options, including IEEE 802.3af Power Classification 2. To
use Power over Ethernet, where power is delivered over the
CAT5-e cable, the LAN must support Power over Ethernet, and
the global power supply is not required. To use local AC power,
the optional global power supply can be ordered separately.

—End--

When you complete the IP Phone connection, you must connect the phone
to the network. See “Dynamic Host Configuration Protocol” (page 391).

Startup sequence
When an IP Phone 2001 connects to the network, it must perform a startup
sequence. The elements of the startup sequence include:

obtaining network access (if supported by the network infrastructure)
obtaining VLAN ID (if supported by the network infrastructure)

obtaining the IP parameters
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® connecting to the Call Server

* obtaining the provisioning parameters

For information about provisioning the IP Phone, see “Manual provisioning
of IP Phone 2000 Series” (page 531).

Redeploying an IP Phone 2001
You can redeploy an existing previously configured IP Phone 2001 on
the same system. For example, the IP Phone 2001 can be assigned to
a new user (new TN) or to an existing user who moved to a new subnet
by changing the TN of the IP Phone 2001. For further information, see
Converging the Data Network with VolP Fundamentals (NN43001-260).

Procedure 3
Changing the TN of an existing IP Phone 2001

Step Action

1 Repower the IP Phone 2001.

During the reboot sequence of a previously configured IP
Phone, the IP Phone 2001 displays the existing node number
for approximately five seconds.

2 If the node password is enabled and NULL, choose one of the
following:

a Disable the password.
b Set the password as non-NULL.

3 Press OK when the node number displays.
If Then
the node password is enabled a password screen displays. Go
and is not NULL to Step 4.
the node password is disabled a TN screen displays. Go to Step
5.
4 Enter password at the password screen, and press OK.

A TN screen displays.

To obtain the password, enter the nodePwdShow command in
Element Manager. For further information, see Element Manager
System Reference - Administration (NN43001-632).

Select the Clear soft key to clear the existing TN.
Enter the new TN.

—End--
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Replacing an IP Phone 2001

ATTENTION

Two IP Phones cannot share the same TN. You must remove the IP Phone
2001 that currently uses the TN.

Procedure 4
Replacing an IP Phone 2001

Step

Action

1

Obtain the node and TN information of the phone you want to
replace.

Disconnect the IP Phone 2001 that you want to replace.

Follow “Configuring the IP Phone 2001” (page 37) to install the
IP Phone 2001. To configure the IP Phone, “Manual provisioning
of IP Phone 2000 Series” (page 531).

Enter the same TN and Node Number as the IP Phone 2001 you
replaced. The system associates the new IP Phone 2001 with
the existing TN.

—End--

Removing an IP Phone 2001 from service
Procedure 5
Removing an IP Phone 2001 from service

Step

Action

1

Disconnect the IP Phone 2001 from the network or turn off the
power.

If the IP Phone 2001 was automatically configured, the DHCP
lease expires and the IP address returns to the available pool.

In LD 11, enter the following:
REQ: OUT

TYPE: 2001P2

TN: LLL S CC UU

—End--
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Nortel IP Phone 2002

Contents

This section contains the following topics:

Introduction

“Introduction” (page 43)

“Description” (page 44)

“Components and functions” (page 45)
“Features” (page 47)

“Display characteristics” (page 48)
“Package components” (page 50)
“Installation and configuration” (page 52)
“Redeploying an IP Phone 2002” (page 55)
“Replacing an IP Phone 2002” (page 56)

“Removing an IP Phone 2002 from service” (page 57)

This section explains how to install and maintain the IP Phone 2002. For
information about using the IP Phone 2002, see the IP Phone 2002 User
Guide (NN43116-104).

This section contains the following procedures:

Procedure 6 “Configuring the IP Phone 2002” (page 53)
Procedure 7 “Connecting the components” (page 53)

Procedure 8 “Changing the TN of an existing IP Phone 2002" (page
55).

Procedure 9 “Replacing an IP Phone 2002” (page 56).

Procedure 10 “Removing an IP Phone 2002 from service” (page 57).
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Description

Figure 4
IP_ Phone 2002

If power to the phone is interrupted after you install and configure an IP
phone, you are not required to reenter the IP Parameters, Node Numbers,
or Terminal Number (TN). There is also no need to again acquire the
firmware.

The IP Phone 2002 is a multi-line professional-level deskset with a
high-resolution, fully-backlit, QVGA color LCD display. The enhanced
configuration menus and USB peripheral support provide a superior
navigation experience. The integrated Bluetooth® Audio gateway offers
greater freedom and mobility. The set includes an integrated phone switch
with Gigabit Ethernet LAN and PC ports. When the phone is idle users
fully experience the personalized background images and capabilities, as
well as the Digital Picture Frame mode.

Figure 4 "IP Phone 2002" (page 44) shows the IP Phone 2002.
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Components and functions
This section describes the following components and functions of the IP
Phone 2002:

* “Keys and functions” (page 45)

* “Services menu” (page 46)

Keys and functions
Table 5 "IP Phone 2002 keys and functions" (page 45) describes the IP
Phone 2002 keys and functions.

Table 5
IP Phone 2002 keys and functions
Key Function
Speaker Press the Line key to activate the speaker for on-hook dialing and

Programmable line
(DN)/feature keys
(self-labeled)

Message waiting light/
Incoming call indicator

Context-sensitive soft keys
(self-labeled)

Navigation keys

Message (Inbox)
Outbox/Shift

Directory

Quit

listening.

Programmable line (DN)/feature keys (self-labeled) are configured
for various features on the IP Phone. One must be the prime DN
key.

A steady LCD light beside a line (DN) key indicates the feature or
line is active. A flashing LCD indicates the line is on hold or the
feature is being programmed.

The Message waiting light turns ON to indicate that a message has
been left for the user. This light also flashes when the set ringer is
ON.

Context-sensitive soft keys (self-labeled) are located below the
display area. The LCD label above the key changes, based on the
active feature.

A triangle before a key label indicates that the key is active.

Use the navigation keys to scroll through menus and lists in the
display area.

Press the Message (Inbox) key to access your voice mailbox.

Press the Outbox/Shift key to switch between two feature key pages
and access an additional six lines/features.

Press the Directory key to access Directory services.

Press the Quit key to end an active application.

Pressing the Quit key does not affect the status of the calls currently
on your IP Phone.
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Table 5
IP Phone 2002 keys and functions (cont’d.)
Key Function
Expand to PC The Expand to PC key is used to access external server
applications such as External Application Server (XAS).
Goodbye Press the Goodbye key to terminate an active call.
Hold Press the Hold key to put an active call on hold. Press the line (DN)

key beside the flashing LCD to return to the caller on hold.

Headset Press the Headset key to answer a call using the headset or to
switch a call from the handset or Handsfree to the headset.

Mute Press the Mute key to listen to the receiving party without
transmitting.

Press the Mute key again to return to a two-way conversation.

The Mute key applies to Handsfree, Handset, and Headset
microphones.

The Mute LED flashes when the Mute option is in use.

Volume control bar Use the volume control bar to adjust the volume of the handset,
headset, speaker, ringer, and, Handsfree feature.

Press the right side of the rocker bar to increase volume; press the
left side to decrease volume.

Handsfree key Press the Handsfree key to activate the Handsfree feature.

The LED lights to indicate when handsfree is active.

Services menu
Table 6 "Services menu" (page 46) shows the Services menu.

Table 6
Services menu

Services key Press the Services key to access the following items:

® Telephone Options
— Volume Adjustment
— Contrast Adjustment
— Language
— Date/Time Format
— Display diagnostics

— Local Dialpad Tone
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— Set Info
— Ring type
— OnHook Default Path
— Change Feature key label
— Call Timer
— Live Dialpad
— Normal Mode indication
— Caller ID display order
® Password Administration
® Virtual Office Login and Virtual Office Logout (if Virtual Office is configured)

® Test Local Mode and Resume Local Mode (if Branch Office is configured)

You can customize the IP Phone features to meet user requirements. For
more information, see the IP Phone 2002 User Guide (NN43116-104).

Double-press the Services key to access Network diagnostic utilities. For more information about
Network diagnostic utilities, see “IP Phone diagnostic utilities” (page 569).

If an incoming call is presented while you configure information in the Services menu, the phone
rings. However, the display does not update with the caller ID, and the programming text is not
disturbed.

While you are in the Services menu you cannot dial digits but you can use the programmable line
keys, such as Redial (double-press a line key) and Auto dial key to make a call. However, the
display does not update with the dialed digits or Caller ID.

Features
The IP Phone 2002 supports the following telephony features:

* four programmable line (DN)/feature keys (self-labeled)
* four context-sensitive soft keys (self-labeled)
Functions for the context-sensitive soft keys are configured in LD 11.

For more information about context-sensitive soft keys, see Features
and Services Fundamentals (NN43001-106).

* volume control bar to adjust ringer, speaker, handset, handsfree, and
headset volume

* ability to change the programmable line (DN)/feature key labels
* six specialized feature keys

— Quit

— Directory

— Message/Inbox
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— Shift/Outbox
— Services
— Expand to PC
* five call-processing fixed keys:
— Mute
— Handsfree
— Goodbye
— Headset
— Hold

For more information about IP Phone features, see “Features” (page 355).

Display characteristics
An IP Phone 2002 has three major display areas:

* “Programmable line (DN)/feature key label display” (page 49)
* “Information line display” (page 49)
* “Soft key label display” (page 49)

Figure 5 "IP Phone 2002 display areas" (page 48) shows these three
display areas.

Figure 5
IP Phone 2002 display areas

Upper display area
-programmable line
(DN)/feature keys
(self-labeled)

NEORTEL

Middle display area
-information display

Lower display area
-soft key labels

Cleaning the IP Phone display screen
Gently wipe the IP Phone display screen with a soft, dry cloth.
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CAUTION

Do not use any liquids or powders on the IP Phone. Using
anything other than a soft, dry cloth can contaminate IP Phone
components and cause premature failure.

Programmable line (DN)/feature key label display
The feature key label area displays a 10-character string for each of the
four feature keys. Each feature key includes the key label and an icon.
The icon state can be on, off, or flashing. A telephone icon displays the
status of the configured DN. Key labels are left-aligned for keys on the
left side of the screen, and right-aligned for keys on the right side of the
screen.

If a label is longer than 10 characters, the last 10 characters are displayed
and the excess characters are deleted from the beginning of the string.

Information line display
An IP Phone 2002 has a one-line information display area with the
following information:

* caller number

* caller name

* feature prompt strings
* user-entered digits

* date and time information (if the IP Phone is in an idle state) or Call
Timer (if provisioned in the Telephone options menu)

The information in the display area changes, according to the
call-processing state and active features.

Because the IP Phone 2002 only has a one-line information display area,
you are prompted to scroll through any additional lines of information.

Soft key label display
The soft key label has a maximum six characters. Each soft key includes
the soft key label and an icon. When a soft key is in use, a triangle icon
appears at the beginning of the soft key label, and the label shifts one
character to the right. (If the label is six characters in length, the last or
rightmost character is truncated.) If a feature is enabled, the icon state
turns to On. The icon remains in the on state until the feature key is
pressed again. This cancels the enabled feature and turns the icon off,
and returns the soft key label to its original state.
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Use the More soft key to navigate the layers of functions. If only four
functions are assigned to the soft keys, the More key does not appear,
and all four functions are displayed.

Package components

Table 7

The following information applies to IP Phone 2001, IP Phone 2002, and
IP Phone 2004. Product codes for these IP Phones are different from
previous sets.

See the product code on the back of the phone to confirm whether it is an
IP Phone 2001, IP Phone 2002, and IP Phone 2004. The product code for
IP Phone 2001, IP Phone 2002, and IP Phone 2004 appears as IP Phone
200x. The product code for previous versions of the IP Phone appears
with an i in front of the model number (for example, i200x).

You must order the global power supply separately if local power using the
global power supply is required, because IP Phone 2001, IP Phone 2002,

and IP Phone 2004 include integrated support for a number of power over
LAN options, including support for IEEE 802.3af standard power.

Table 7 "Package components" (page 50) lists the IP Phone 2002 package
components.

Package components

® handset

®* handset cord
* 2.1 m (7-ft) CAT5-e Ethernet cable
® (etting Started Card

®* |P Phone 2002

®* number plate and lens

Table 8 "IP Phone 2002 components list" (page 50) lists the IP Phone
2002 components and product codes.

Table 8

IP Phone 2002 components list
Component Product code
IP Phone 2002 (Ethergray) with Icon keycaps NTDU91AA16/A0533404
IP Phone 2002 (Ethergray) with English text label keycaps NTDU91BA16/A0533405
IP Phone 2002 (Charcoal) with Icon keycaps NTDU91AA70/A0533406
IP Phone 2002 (Charcoal) with English text label keycaps NTDU91BA70/A0533407
IP Phone 2002 (Charcoal with Bezel) with Icon keycaps NTDU91AB70
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Table 8
IP Phone 2002 components list (cont’d.)

Japan

Component Product code
IP Phone 2002 (Charcoal with Bezel) with Icon keycaps (RoHS) NTDU91AC70E6
IP Phone 2002 (Charcoal with Bezel) with English text label keycaps | NTDU91BB70
IP Phone 2002 (Charcoal with Bezel) with English text label keycaps | NTDU91BC70E6
(RoHS)

Replacement parts

7 ft CAT5-e Ethernet cable N0177422
Handset, Ethergray A0788874
Handset, Charcoal A0758634
Handset cord, Ethergray A0897725
Handset cord, Charcoal N0000763
Footstand, Charcoal (used for Ethergray and Charcoal models) A0891619
Power supply

Global power supply (for local power) NTYS17xxE6
IEC cables

1.8 m (5.9 ft), 10 amp, IEC320-C13 NTYS14AAE6
North America

2.4 m (8 ft), 240 VAC 10 amp, ANZ power cord AS-3, NTTK15AA
Australia, New Zealand

Note: ROHS does not apply in this region.

250 VAC, Option 11C Standard European power cord, NTTK16ABEG6
Other EMEA, Kenya, Korea, Thailand, Indonesia, Vietnam, India,

Pakistan

3 m (9.9 ft) 125 VAC, Option 11C Swiss power cord NTTK17ABEG6
Switzerland

240 VAC, Option 11C UK power cord NTTK18ABEG6
Hong Kong, Ireland, United Kingdom, Singapore, Malaysia,

Bangladesh, Brunei, Sri Lanka

3 m (9.9 ft), 125 VAC, Option 11C Denmark power cord NTTK22ABEG6
Denmark

Argentina A0814961
Note: ROHS does not apply in this region.

1.8 m (5.9 ft), 10 amp, IEC320-C13 NTTK26AAE6

For more information, and for information about previous versions of the IP

Phone, contact Nortel.
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Installation and configuration
The following sections provide a step-by-step guide to install and configure
the IP Phone 2002:

“Before you begin” (page 52)

“First-time installation” (page 52)
“Configuring the IP Phone 2002” (page 53)
“Connecting the components” (page 53)

“Startup sequence” (page 55)

Before you begin
Before installing the IP Phone 2002, complete the following pre-installation
checklist:

Ensure one IP Phone 2002 boxed package exists for each IP Phone
2002 you install. For a list of IP Phone 2002 package components, see
Table 7 "Package components" (page 50).

Ensure one Software License exists for each IP Phone 2002 you
install.

Ensure the host Call Server is equipped with a Signaling Server that
runs the Line Terminal Proxy Server (LTPS) application.

If a global power supply is required, make sure you use the correct
global power supply supplied by Nortel and country specific IEC cable.
The voltage rating of the global power supply must match the wall
outlet voltage. See Table 8 "IP Phone 2002 components list" (page
50).

Ensure the latest IP Phone firmware is deployed to the IP telephony
node. For more information, see Signaling Server IP Line Applications
Fundamentals (NN43001-125).

First-time installation
You must first install an IP telephony node with the Communication Server.
For information about installing an IP telephony node, see Signaling Server
IP Line Applications Fundamentals (NN43001-125).

CAUTION
Do not plug your IP Phone 2002 into an ISDN connection.
Severe damage can result.
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Configuring the IP Phone 2002
Use Procedure 6 “Configuring the IP Phone 2002” (page 53) to configure
the IP Phone 2002.

Procedure 6
Configuring the IP Phone 2002

Step

Action

1

Configure a virtual loop on the Call Server using LD 97.

For more information about configuring a virtual loop, see
Signaling Server IP Line Applications Fundamentals (NN430
01-125) and Software Input Output Reference-Administration
(NN43001-611).

Configure the IP Phone 2002 on the Call Server using LD 11. At
the prompt, enter the following:

REQ:new
TYPE:2002P1,2002P2

For more information about configuring the IP Phone 2002 using
LD 11, see Software Input Output Reference-Administration
(NN43001-611).

Configure the IP Phone 2002 in Element Manager. IP Phones
are configured using the Phones section in the Element
Manager navigation tree. For more information about configuring
the IP Phone 2002 using Element Manager, see Element
Manager System Reference - Administration (NN43001-632).

—End--

Connecting the components
Use Procedure 7 “Connecting the components” (page 53) to connect the
components for the IP Phone.

Procedure 7
Connecting the components

Step

Action

1

Connect one end of the handset cord to the handset jack on the
back of the IP Phone (identified with a handset icon). See Figure
6 "IP Phone 2002 Ethernet network interface connections" (page
54)

Connect the other end of the handset cord to the handset.
Choose one of the following connections:
* For an IP Phone not sharing LAN access with a PC:
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Connect one end of the CAT5-e Ethernet cable to the
network interface located on the back of the IP Phone
(identified with a LAN icon). The other end of the CAT5-e
Ethernet cable plugs into the IP network.

* For an IP Phone sharing LAN access with a PC:
Connect one end of the CAT5-e Ethernet cable to the
network interface located on the back of the IP Phone
(identified with a LAN icon) and the other end to the IP
network. Insert on end of a second CAT5-e Ethernet cable
into the PC network interface located on the back of the IP
Phone (identified with a PC icon) and the other end into the
computer.
See Figure 6 "IP Phone 2002 Ethernet network interface
connections" (page 54).

The LAN Ethernet port supports Auto-Media Dependent Interface
Crossover (MDIX). Auto-MDIX is supported only when the
Ethernet port is configured for autonegotiation. The PC Port
does not support Auto-MDIX.

CAUTION

Damage to Equipment

Do not plug any device into your IP Phone 2002
Ethernet port other than an IEEE 802.3 Ethernet
network connection. The IP Phone 2002 does not
support multiple devices connected through the PC

Ethernet port.

Figure 6
IP Phone 2002 Ethernet network interface connections

AC Adapter jack

LAN Ethernet port Handset jack

PC Ethernet port Headset jack

Connect the global power supply (optional). Leave the global
power supply unplugged from the power outlet, connect the
global power supply to the AC adapter jack in the bottom of
the phone. Form a small bend in the cable and then thread the
adapter cord through the channels in the stand.
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5 Secure the IP Phone footstand to the base of the IP Phone. Use
the angle adjustment grip on the top back of the IP Phone to
adjust the position.

6 Power the IP Phone 2002 using either the Power over Ethernet
or the global power supply (local power). If you are using local
power, plug the global power supply into the nearest power
outlet. Make sure you use the correct global power supply
supplied by Nortel and country specific IEC cable. The voltage
rating of the global power supply must match the wall outlet
voltage. See Table 8 "IP Phone 2002 components list" (page
50).

The IP Phone 2002 supports both AC power and Power over
LAN options, including IEEE 802.3af Power Classification 2. To
use Power over Ethernet, where power is delivered over the
CAT5-e cable, the LAN must support Power over Ethernet, and a
global power supply is not required. To use local AC power, the
optional global power supply can be ordered separately.

~End--

When you complete the IP Phone connection, you must connect the phone
to the network. See “Dynamic Host Configuration Protocol” (page 391).

Startup sequence
When an IP Phone 2002 connects to the network, it must perform a startup
sequence. The elements of the startup sequence include:

* obtaining network access (if supported by the network infrastructure)
* obtaining VLAN ID (if supported by the network infrastructure)

® obtaining the IP parameters

® connecting to the Call Server

* obtaining provisioning parameters

For information about provisioning the IP Phone, see “Manual provisioning
of IP Phone 2000 Series” (page 531).

Redeploying an IP Phone 2002
You can redeploy an existing previously configured IP Phone 2002 on the
same Call Server. For example, the IP Phone 2002 can be assigned to
a new user (new TN) or to an existing user who moved to a new subnet
by changing the TN of the IP Phone 2002. For further information, see
Converging the Data Network with VolP Fundamentals (NN43001-260).

Procedure 8
Changing the TN of an existing IP Phone 2002
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Step

Action

1

Repower the IP Phone 2002.

During the reboot sequence of a previously configured IP
Phone, the IP Phone 2002 displays the existing nhode number
for approximately 5 seconds.

If the node password is enabled and NULL, choose one of the
following:

a Disable the password.
b Set the password as non-NULL.
Press OK when the node number displays.

If Then

the node password is enabled a password screen displays. Go

and is not NULL to Step 4.

the node password is disabled a TN screen displays. Go to Step
5.

Enter the password at the password screen and press OK.

A TN screen displays.

To obtain the password, enter the nodePwdShow command in
Element Manager. For further information, see Element Manager
System Reference - Administration (NN43001-632).

Select the Clear soft key to clear the existing TN.
Enter the new TN.

—End--

Replacing an IP Phone 2002

ATTENTION

Two IP Phones cannot share the same TN. You must remove the IP Phone
2002 that currently uses the TN.

Procedure 9
Replacing an IP Phone 2002

Step

Action

1

Obtain the node and TN information of the phone you want to
replace.

Disconnect the IP Phone 2002 that you want to replace.
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Follow “Configuring the IP Phone 2002" (page 53) to install
the IP Phone 2002. To configure the IP Phone, see “Manual
provisioning of IP Phone 2000 Series” (page 531).

Enter the same TN and Node Number as the IP Phone 2002 you
replaced. The Call Server associates the new IP Phone 2002
with the existing TN.

—End--

Removing an IP Phone 2002 from service

Procedure 10
Removing an IP Phone 2002 from service

Step

Action

1

Disconnect the IP Phone 2002 from the network or turn off the
power.

The service to the PC is disconnected as well if the PC connects
to the IP Phone 2002.

If the IP Phone 2002 was automatically configured, the DHCP
lease expires and the IP address returns to the available pool.

In LD 11, enter the following:
REQ: OUT

TYPE: 2002P1, 2002P2
TN: LLL S CCUU

—End--
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Contents

This section contains the following topics:

Introduction

“Introduction” (page 59)

“Description” (page 60)

“Components and functions” (page 61)
“Features” (page 63)

“Package components” (page 66)
“Installation and configuration” (page 68)
“Redeploying an IP Phone 2004” (page 72)
“Replacing an IP Phone 2004” (page 73)

“Removing an IP Phone 2004 from service” (page 74)

This section explains how to install and maintain the IP Phone 2004. For
information about using the IP Phone 2004, see the IP Phone 2004 User
Guide (NN43117-102).

This section contains the following procedures:

Procedure 11 “Configuring the IP Phone 2004” (page 69)
Procedure 12 “Connecting the components” (page 70)

Procedure 13 “Changing the TN of an existing IP Phone 2004” (page
72).

Procedure 14 “Replacing an IP Phone 2004” (page 73).

Procedure 15 “Removing an IP Phone 2004 from service” (page 74).
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Description

Figure 7
IP Phone 2004

If power to the phone is interrupted after you install and configure an IP
phone, you are not required to reenter the IP Parameters, Node Numbers,
or Terminal Number (TN). There is also no need to again acquire the
firmware.

The IP Phone 2004 is a multi-line professional-level deskset with a
high-resolution, fully-backlit, QVGA color LCD display. The enhanced
configuration menus and USB peripheral support provide a superior
navigation experience. The integrated Bluetooth® Audio gateway offers
greater freedom and mobility. The set includes an integrated phone switch
with Gigabit Ethernet LAN and PC ports. When the phone is idle users
fully experience the personalized background images and capabilities, as
well as the Digital Picture Frame mode.

Figure 7 "IP Phone 2004" (page 60) shows the IP Phone 2004.

Handset

Dialpad

Handsfree LED

Handsfree key —=——1

Volume
control bar

Goodbye key

Hold key

Speaker i

Programmable line (DN)/feature keys (self-labeled)

Message waiting indicator/
Incoming call indicator

Primary Directory
Number key

Multi-field LCD
display screen

Soft keys
(self-labeled)

‘ S5 Expand to PC key
Copy key

Services key

Headset Key Navigation keys
Qutbox/Shift key

Directory key M gellnbox key
Quit key

Mute Key
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Components and functions
This section describes the following components and functions of the IP
Phone 2004:

* “Keys and functions” (page 61)

* “Services menu” (page 62)

Keys and functions
Table 9 "IP Phone 2004 keys and functions" (page 61) shows the IP
Phone 2004 keys and functions.

Table 9
IP Phone 2004 keys and functions
Key Function
Hold Press the Hold key to put an active call on hold. Press the line (DN) key
beside the flashing LCD to return to the caller on hold.
Goodbye Press the Goodbye key to terminate an active call.

Message waiting light/
Incoming call indicator

Programmable line
(DN)/feature keys
(self-labeled)

Context-sensitive soft
keys (self-labeled)

Fixed feature keys
Expand to PC

Copy
Navigation keys
Outbox/Shift

Message (Inbox)

The Message waiting indicator turns ON to indicate that a message has
been left for the user. This indicator also flashes when the set ringer is
ON.

Programmable line (DN)/feature keys (self-labeled) are configured for
various features on the IP Phones.

A steady LCD light beside a line (DN) key indicates the feature or line is
active. A flashing LCD indicates the line is on hold or the feature is being
programmed.

Context-sensitive soft keys (self-labeled) are located below the display
area. The LCD label above the key changes, based on the active feature.

A triangle before a key label indicates that the key is active.

Use these keys to access non-programmable standard features.

The Expand to PC key is used to access external server applications
such as External Application Server.

A fixed key reserved for future feature development. An audible
non-working tone is generated along with a display message.

Use the navigation keys to scroll through menus and lists in the display
area.

Press the Outbox/Shift key to switch between two feature key pages and
access an additional six lines/features.

Press the Message (Inbox) key to access your voice mailbox.
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Table 9
IP Phone 2004 keys and functions (cont’d.)
Key Function
Quit Press the Quit key to end an active application.
Pressing the Quit key does not affect the status of the calls currently on
your IP Phone.
Directory Press the Directory key to access Directory services.
Mute Press the Mute key to listen to the receiving party without transmitting.
Press the Mute key again to return to a two-way conversation.
The Mute key applies to Handsfree, Handset, and Headset microphones.
The Mute LED flashes when the Mute option is in use.
Headset Press the Headset key to answer a call using the headset or to switch a

Volume control bar

Handsfree key

call from the handset or Handsfree to the headset.

Use the Volume control bar to adjust the volume of the handset, headset,
speaker, ringer, and Handsfree feature.

Press the right side of the rocker bar to increase volume, the left side to
decrease volume.

Press the Handsfree key to activate handsfree.

The LED lights to indicate when the handsfree feature is active.

Services menu
Table 10 "Services menu" (page 62) shows the Services menu.

Table 10
Services menu

Services key Press the Services key to access the following items:

Telephone Options

— Volume Adjustment
— Contrast Adjustment
— Language

— Date/Time Format

— Display diagnostics
— Local Dialpad Tone

— Ring type
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— Call Timer
— OnHook Default Path
— Change Feature Key Label
— Set Info
— Live Dialpad
® Password Administration
® Virtual Office Login and Virtual Office Logout (if Virtual Office is configured)

® Test Local Mode and Resume Local Mode (if Branch Office is configured)

You can customize the IP Phone features to meet user requirements. For
more information, see the IP Phone 2004 User Guide (NN43117-102).

Double-press the Services key to access Network diagnostic utilities. For more information about
Network diagnostic utilities, see “IP Phone diagnostic utilities” (page 569).

If an incoming call is presented while you configure information in the Services menu, the phone
rings. However, the display does not update with the caller ID, and the programming text is not
disturbed.

While you are in the Services menu you cannot dial digits but you can use the programmable line
keys, such as Redial (double-press a line key) and Auto dial key to make a call. However, the
display does not update with the dialed digits or Caller ID.

During an incoming call, if the selected feature page does not contain the flashing DN line key, the
display reverts to the active feature key page. This enables the user to answer the call without
pressing the Shift key.

Features
The IP Phone 2004 supports the following telephony features:

* six programmable line (DN)/feature keys (self-labeled)
* four context-sensitive soft keys (self-labeled)
Functions for the context-sensitive soft keys are configured in LD 11.

For more information about context-sensitive soft keys, see Features
and Services Fundamentals (NN43001-106).

* volume control bar to adjust ringer, speaker, handset, handsfree, and
headset volume

* ability to change the programmable line (DN)/feature key labels
® seven specialized feature keys

— Quit

— Directory

— Message/Inbox
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— Shift/Outbox
— Services
— Copy
— Expand to PC
* five call-processing fixed keys
— Mute
— Handsfree
— Goodbye
— Headset
— Hold

For more information about IP Phone features, see “Features” (page 355).

Central Answering Position
The Central Answering Position (CAP) operates as an Automatic
Call Distribution (ACD) agent on the IP Phone 2004. A CAP provides
call-handling features, such as transferring a call, parking a call, and
answering a call. You can add an IP Phone Key Expansion Module (KEM)
to provide additional lines and features, Direct Station Select, and Busy
Lamp Field functionality.

For further information about Central Answering Position, see Central
Answering Position Implementation Guide (NN43011-501).

Display characteristics
An IP Phone 2004 has three major display areas:

* “Programmable line (DN)/feature key label display” (page 65)
* “Information line display” (page 65)

* “Soft key label display” (page 66)

Figure 8 "IP Phone 2004 display areas" (page 65) shows display areas.
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Figure 8
IP Phone 2004 display areas
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Cleaning the IP Phone display screen
Gently wipe the IP Phone display screen with a soft, dry cloth.

CAUTION

Do not use any liquids or powders on the IP Phone. Using
anything other than a soft, dry cloth can contaminate IP Phone
components and cause premature failure.

Programmable line (DN)/feature key label display
The feature key label area displays a 10-character string for each of the six
feature keys. Each feature key includes the key label and an icon. The
icon state can be on, off, or flashing. A telephone icon displays the status
of the configured DN. Key labels are left-aligned for keys on the left side of
the screen, and right-aligned for keys on the right side of the screen.

If a label is longer than 10 characters, the last 10 characters are displayed,
and the excess characters are deleted from the beginning of the string.

Information line display
An IP Phone 2004 has a three-line information display area with the
following information:

e caller number
e caller name

* feature prompt strings
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* user-entered digits

* date and time information (if the IP Phone is in an idle state) or Call
Timer (if provisioned in the Telephone options menu)

The information in the display area changes, according to the
call-processing state and active features.

Soft key label display
The soft key label has a maximum six characters. Each soft key includes
the soft key label and an icon. When a soft key is in use, a triangle icon
appears at the beginning of the soft key label, and the label shifts one
character to the right. (If the label is seven characters in length, the last or
rightmost character is truncated.) If a feature is enabled, the icon state
turns to On. The icon remains in the on state until the feature key is
pressed again. This cancels the enabled feature and turns the icon off,
and returns the soft key label to its original state.

Use the More soft key to navigate the layers of functions. If there are only
four functions assigned to the soft keys, the More key does not appear,
and all four functions are displayed.

Package components
The following information applies to IP Phone 2001, IP Phone 2002, and
IP Phone 2004. Product codes for these IP Phones are different from
previous sets.

See the product code on the back of the phone to confirm whether it is a
IP Phone 2001, IP Phone 2002, or IP Phone 2004. The product code for
IP Phone 2001, IP Phone 2002, and IP Phone 2004 appears as IP Phone
200x. The product code for previous versions of the IP Phone appears
with an i in front of the model number (for example, i200x).

You must order the global power supply separately if local power using the
global power supply is required, because IP Phone 2001, IP Phone 2002,

and IP Phone 2004 include integrated support for a number of power over
LAN options, including support for IEEE 802.3af standard power.

Table 11 "Package components" (page 67) lists the IP Phone 2004
package components.
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Table 11
Package components

* |P Phone 2004

® handset

® handset cord

® 2.1 m (7-ft) CAT5-e Ethernet cable
® (Getting Started Card

®* number plate and lens

Table 12 "IP Phone 2004 component list" (page 67) lists the IP Phone

2004 components and product codes.

Table 12
IP Phone 2004 component list

models

Component Product code

IP Phone 2004 (Ethergray) with Icon keycaps NTDU92AA16/A0533408
IP Phone 2004 (Ethergray) with English text label NTDU92BA16/A0533409
keycaps

IP Phone 2004 (Charcoal) with Icon keycaps NTDU92AA70/A0533410
IP Phone 2004 (Charcoal) with English text label NTDU92BA70/A0533411
keycaps

IP Phone 2004 (Charcoal with Bezel) with Icon keycaps NTDU92AB70

IP Phone 2004 (Charcoal with Bezel) with Icon keycaps NTDU92AC70E6
(RoHS)

IP Phone 2004 (Charcoal with Bezel) with English text NTDU92BB70

label keycaps

IP Phone 2004 (Charcoal with Bezel) with English text NTDU92BC70E6

label keycaps (RoHS)

IP Phone 2004 wall mount kit (Charcoal), used with NTMN15BA70/A0503076
Ethergray and Charcoal models

Replacement parts

7 ft Ethernet CAT5-e cable N0177422

Handset (Ethergray) A0788874

Handset (Charcoal) A0758634

Handset cord (Ethergray) A0788682

Handset cord (Charcoal) NO0000764

Footstand (Charcoal), used for Ethergray and Charcoal A0538587

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.



68 Nortel IP Phone 2004

Power supply

Global power supply (for local power) NTYS17xxE6
IEC cables
1.8 m (5.9 ft), 10 amp, IEC320-C13 NTYS14AAE6

North America

2.4 m (8 ft), 240 VAC 10 amp, ANZ power cord AS-3, NTTK15AA

Australia, New Zealand
Note: ROHS does not apply in this region.

250 VAC, Option 11C Standard European power cord, NTTK16ABEG6

Other EMEA, Kenya, Korea, Thailand, Indonesia,
Vietnam, India, Pakistan

3 m (9.9 ft) 125 VAC, Option 11C Swiss power cord NTTK17ABEG6
Switzerland
240 VAC, Option 11C UK power cord NTTK18ABEG6

Hong Kong, Ireland, United Kingdom, Singapore,
Malaysia, Bangladesh, Brunei, Sri Lanka

3 m (9.9 ft), 125 VAC, Option 11C Denmark power cord NTTK22ABEG6

Denmark

Argentina A0814961
Note: ROHS does not apply in this region.

1.8 m (5.9 ft), 10 amp, IEC320-C13 NTTK26AAE6

Japan

For more information, and for information about previous versions of the IP
Phone, contact your Nortel representative.

Installation and configuration
The following sections provide a step-by-step guide to install and configure
the IP Phone 2004:

“Before you begin” (page 69)

“First-time installation” (page 69)
“Configuring the IP Phone 2004” (page 69)
“Connecting the components” (page 70)

“Startup sequence” (page 72)
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Before you begin
Before installing the IP Phone 2004, complete the following pre-installation
checklist:

Ensure one IP Phone 2004 boxed package exists for each IP Phone
2004 you install. For a list of IP Phone 2004 package components, see
Table 11 "Package components" (page 67).

Ensure one Software License exists for each IP Phone 2004 you
install.

Ensure the host Call Server is equipped with a Signaling Server that
runs the Line TPS application.

If a global power supply is required, ensure you use the correct global
power supply supplied by Nortel and country specific IEC cable. The
voltage rating of the global power supply must match the wall outlet
voltage. See Table 12 "IP Phone 2004 component list" (page 67).

Ensure the latest IP Phone firmware is deployed to the IP telephony
node. For more information, see Signaling Server IP Line Applications
Fundamentals (NN43001-125).

First-time installation
You must first install an IP telephony node with the Communication Server.
For information about installing an IP telephony node, see Signaling Server
IP Line Applications Fundamentals (NN43001-125).

CAUTION
Do not plug your IP Phone 2004 into an ISDN connection.
Severe damage can result.

Configuring the IP Phone 2004
Use Procedure 11 “Configuring the IP Phone 2004” (page 69) to configure
the IP Phone 2004 for the first time.

Procedure 11
Configuring the IP Phone 2004

Step Action

1

Configure a virtual loop on the Call Server using LD 97.

For more information about configuring a virtual loop, see
Signaling Server IP Line Applications Fundamentals (NN430
01-125) and Software Input Output Reference-Administration
(NN43001-611).
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Configure the IP Phone 2004 on the Call Server using LD 11. At
the prompt, enter the following:

REQ:new
TYPE:2004P1,2004P2

For more information about configuring the IP Phone 2004 using
LD 11, see Software Input Output Reference-Administration
(NN43001-611).

Configure the IP Phone 2004 in Element Manager. IP Phones
are configured using the Phones section in the Element
Manager navigation tree. For more information about configuring
the IP Phone 2004 using Element Manager, see Element
Manager System Reference - Administration (NN43001-632).

~End--

Connecting the components
Use Procedure 12 “Connecting the components” (page 70) to connect the
components for the IP Phone.

Procedure 12
Connecting the components

Step

Action

1

Connect one end of the handset cord to the handset jack on the
back of the IP Phone (identified with a handset icon). See Figure
9 "IP Phone 2004 Ethernet network connections” (page 71).

Connect the other end of the handset cord to the handset.
Choose one of the following connections:

* For an IP Phone not sharing a LAN access with a PC:
Connect one end of the CAT5-e Ethernet cable to the LAN
Ethernet port located on the back of the IP Phone 2004
(identified with a LAN icon). The other end of the CAT5-e
Ethernet cable plugs into the IP network.

* For an IP Phone sharing a LAN access with a PC:
Connect one end of the CAT5-e Ethernet cable to the LAN
Ethernet port located on the back of the IP Phone (identified
with a LAN icon) and the other end to the IP network. Insert
one end of a second CAT5-e Ethernet cable into the PC
Ethernet port located on the back of the IP Phone (identified
with a PC icon) and the other end into the computer.
See Figure 9 "IP Phone 2004 Ethernet network connections"
(page 71).

The LAN Ethernet port supports Auto-Media Dependent Interface
Crossover (MDIX). Auto-MDIX is supported only when the
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Ethernet port is configured for autonegotiation. The PC Port
does not support Auto-MDIX.

CAUTION

Damage to Equipment

Do not plug any device into your IP Phone 2004
Ethernet port other than an IEEE 802.3 Ethernet
network connection. The IP Phone 2004 does not
support multiple devices connected through the PC
Ethernet port.

Figure 9
IP Phone 2004 Ethernet network connections

LAN Ethernet port
PC Ethernet port
AC Adapter jack

i Cord guides
Headset jack Attachment clips

Handset jack

Connect the global power supply (optional). Leave the global
power supply unplugged from the power outlet, connect the
global power supply to the AC adapter jack in the bottom of
the phone. Form a small bend in the cable and then thread the
global power supply cord through the channels in the stand.

Secure the IP Phone footstand to the base of the IP Phone. Use
the angle adjustment grip on the top back of the IP Phone to
adjust the position.

Power the IP Phone 2004 using either the Power over Ethernet
or the global power supply (local power). If you are using local
power, plug the global power supply into the nearest power
outlet. Make sure you use the correct global power supply
supplied by Nortel and country specific IEC cable. The voltage
rating of the global power supply must match the wall outlet
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voltage. See Table 12 "IP Phone 2004 component list" (page
67).

The IP Phone 2004 supports both AC power and Power over
LAN options, including IEEE 802.3af Power Classification 2. To
use Power over Ethernet, where power is delivered over the
CAT5-e cable, the LAN must support Power over Ethernet, and a
global power supply is not required. To use local AC power, the
optional global power supply can be ordered separately.

~End--

When you complete the IP Phone connection, you must connect the phone
to the network. See “Dynamic Host Configuration Protocol” (page 391).

Startup sequence
When an IP Phone 2004 connects to the network, it must perform a startup
sequence. The elements of the startup sequence include:

* obtaining network access (if supported by the network infrastructure)
* obtaining VLAN ID (if supported by the network infrastructure)

® obtaining the IP parameters

® connecting to the Call Server

* obtaining the provisioning parameters

For information about provisioning the IP Phone, see “Manual provisioning
of IP Phone 2000 Series” (page 531).

Redeploying an IP Phone 2004
You can redeploy an existing previously configured IP Phone 2004 on the
same Call Server. For example, the IP Phone 2004 can be assigned to
a new user (new TN) or to an existing user who moved to a new subnet
by changing the TN of the IP Phone 2004. For further information, see
Converging the Data Network with VolP Fundamentals (NN43001-260).

Procedure 13
Changing the TN of an existing IP Phone 2004

Step Action

1 Repower the IP Phone 2004.

During the reboot sequence of a previously configured IP
Phone, the IP Phone 2004 displays the existing nhode number
for approximately five seconds.

2 If the node password is enabled and NULL, choose one of the
following:
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a Disable the password.
b Set the password as non-NULL.
Press OK when the node number displays.

If Then

the node password is enabled a password screen displays. Go

and is not NULL to Step 4.

the node password is disabled a TN screen displays. Go to Step
5.

Enter the password at the password screen, and press OK.
A TN screen displays.

To obtain the password, enter the nodePwdShow command in
Element Manager. For further information, see Element Manager
System Reference - Administration (NN43001-632).

Select the Clear soft key to clear the existing TN.
Enter the new TN.

—End--

Replacing an IP Phone 2004

ATTENTION
Two IP Phones cannot share the same TN. You must remove the IP Phone
2004 that currently uses the TN.

Procedure 14
Replacing an IP Phone 2004

Step

Action

1

Obtain the node and TN information of the phone you want to
replace.

Disconnect the IP Phone 2004 that you want to replace.

Follow “Configuring the IP Phone 2004” (page 69) to install
the IP Phone 2004. To configure the IP Phone, see “Manual
provisioning of IP Phone 2000 Series” (page 531).

Enter the same TN and Node Number as the IP Phone 2004 you
replaced. The Call Server associates the new IP Phone 2004
with the existing TN.

—End--
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Removing an IP Phone 2004 from service
Procedure 15
Removing an IP Phone 2004 from service

Step Action

1 Disconnect the IP Phone 2004 from the network or turn the
power off.

The service to the PC is disconnected as well if the PC connects
to the IP Phone 2004.

If the IP Phone 2004 was automatically configured, the DHCP
lease expires and the IP address returns to the available pool.

2 In LD 11, enter the following:
REQ: OUT
TYPE: 2004P1, 2004P2
TN: LLL S CCUU

—End--
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IP Phone Key Expansion Module (KEM)

Contents

Description

This section contains the following topics

* “Description” (page 75)

* ‘“Features” (page 76)

* “Display characteristics” (page 76)

e “Key number assignments” (page 77)

* ‘“Package components” (page 77)

* “Configuration” (page 77)

* ‘“Installation” (page 80)

* “|P Phone KEM startup initialization” (page 81)

* “Operating parameters” (page 82)

The Nortel IP Phone Key Expansion Module (KEM) is a hardware
component that connects to IP Phone 2002 and IP Phone 2004 and
provides additional line appearances and feature keys (see Figure 10 "IP
Phone 2002 with one IP Phone KEM attached" (page 76)).

Up to two IP Phone KEMs can be connected to an IP Phone 2002 or IP
Phone 2004. With two IP Phone KEMs connected, the IP Phone can have
up to 48 additional line/feature keys.

The IP Phone 2004 can also have up to 48 additional line/feature keys
using the Shift key functionality and one IP Phone KEM. With two IP
Phone KEMs connected, the Shift key functionality does not affect the IP
Phone KEMs since the maximum number of line/feature keys is already
available. The IP Phone 2002 does not support Shift key functionality.
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Figure 10
IP Phone 2002 with one IP Phone KEM attached

HORTEL
HE TR

Features
The IP Phone KEM has the following features:

® 12 keys on each side of an LCD provide up to 24 additional
self-labeled line/feature keys. Using the Shift key functionality, an IP
Phone 2004 can have up to 48 additional logical line/feature keys.

* A desk-mount bracket and structural baseplate connect the IP Phone
KEM to an IP Phone 2002 or IP Phone 2004, or to another IP Phone
KEM.

* A wall-mount bracket installs the IP Phone KEM alongside a
wall-mounted IP Phone 2002 or IP Phone 2004.

Display characteristics
The IP Phone KEM has one LCD between the two rows of 12 Line/feature
keys (see Figure 10 "IP Phone 2002 with one IP Phone KEM attached"
(page 76)). Each of the 24 physical keys on the IP Phone KEM has a
10-character display label. This label is set automatically, however, the
user can edit the label using the controls on the IP Phone.
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To alter the display and contrast on the IP Phone KEM, use the Contrast
Adjustment option under the Telephone Options menu on the IP Phone.

Any contrast changes you make on the IP Phone affect the IP Phone
KEM. The IP Phone KEM and IP Phone do not have separate contrast
adjustments.

Key number assignments

Since the IP Phone 2002 and IP Phone 2004 have key number
assignments from 0 to 31, the IP Phone KEM key number assignments
begin at 32. Therefore, the first IP Phone KEM has key number
assignments from 32 to 55, and the second IP Phone KEM has key
number assignments from 56 to 79.

For more information about key number assignments, see “IP Phone
context-sensitive soft keys” (page 677).

Package components
Table 13 "IP Phone KEM components list" (page 77) lists the IP Phone
KEM package components.

Table 13

IP Phone KEM components list
Components Order code
IP Phone KEM - Ethergray A0540989
IP Phone KEM - Charcoal A0540990
IP Phone KEM wall mount kit - Charcoal A0555218

Configuration
The IP Phone KEM must be configured in LD 11 before it is used.

Table 14
LD 11: Configure the IP Phone KEM
Prompt Response Description
REQ: NEW CHG Add new data. Change existing data.
TYPE: 2002P2 IP Phone 2002
2004P2 IP Phone 2004
ZONE 0-255 Zone number to which the IP Phone 2002 or IP Phone
2004 belongs
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Table 14
LD 11: Configure the IP Phone KEM (cont’d.)
Prompt Response Description
KEM 0)-2 Number of attached IP Phone KEMs
Up to two IP Phone KEMSs can be attached to an IP
Phone. Pressing <CR> without entering a number leaves
the value unchanged.
KEY XX aaa yyyy

(cccc or D) zz..z

Telephone function key assignments

The following key assignments determine calling options
and features available to an IP Phone. Note that KEY is
prompted until a carriage return <CR> is entered.

Where:

xx = key number

aaa = key name or function

yyy = additional information required for the key

zz.z = additional information required for the key aaa.

The cccc or D entry deals specifically with the Calling Line
Identification feature, where:

cccc = CLID table entry of (0)-N, where N = the value
entered at the SIZE prompt in LD 15 minus 1.

D = the character "D". When the character "D" is entered,
the system searches the DN keys from key 0 and up,

to find a DN key with a CLID table entry. The CLID
associated with the found DN key is then used.

The position of the (cccc or D) field varies depending on
the key name or function.

You may enter a CLID table entry if aaa = ACD, HOT d,
HOT L, MCN, MCR, PVN, PVR, SCN, or SCR.

Type xx NUL to remove a key function or feature.
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Table 14

LD 11: Configure the IP Phone KEM (cont’d.)

Prompt

Response

Description

PAGEOFST

KEY xx

KEMOFST

<Page>
<KeyOffset>

<KEM>
<KeyOffset>

Automatically calculates the IP Phone KEM key based
on the entered values. This prompt enables the system
administrator to enter a Page number of 0 or 1 and a
Key Offset number from 0 to 23. Once entered, the KEY
prompt is prompted with the appropriate KEY value filled
in.

Enter <CR> to terminate data entry.

Applies to an IP Phone 2004 with

KEM = 1, and where <CR> was entered at the KEY
prompt.

Does not apply to an IP Phone 2002.

When values are entered for Page and KeyOffset, the
KEY xx prompt displays, followed by PAGEOFST prompt.
This loop continues until no values (<CR> only) are
entered at the PAGEOFST prompt.

Edit the IP Phone KEM key number specified by
PAGEOFST, where:
xx = the number of the key (for example, KEY 36)

Enter <CR> to keep the current setting.

Automatically calculates the IP Phone KEM key based
on the entered values. This prompt enables the system
administrator to enter a KEM number of 1 or 2 and a Key
Offset number from 0-23. Once entered, the KEY prompt
is prompted with the appropriate KEY value filled in.

Enter <CR> to terminate data entry.

When values are entered for KEM and KeyOffset, the KEY
xx prompt displays, followed by KEMOFST prompt. This
loop continues until no values (<CR> only) are entered at
the KEMOFST prompt.

Applies to an IP Phone 2002 if <CR> was entered at the
KEY prompt.
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Table 14
LD 11: Configure the IP Phone KEM (cont’d.)
Prompt Response Description
Applies to an IP Phone 2004 with
KEM = 2, and where <CR> was entered at the KEY
prompt.
KEY xx Edit the IP Phone KEM key number specified by
KEMOFST, where:
xX = the number of the key (for example, KEY 36)
Enter <CR> to keep the current setting.
Installation
The IP Phone KEM mounts on the right side of an IP Phone 2002 or IP
Phone 2004. The IP Phone KEM snaps into the receptacle on the back
of the IP Phone using the desk-mount bracket and structural baseplate
supplied with the IP Phone KEM (see Figure 11 "IP Phone KEM attached
to an IP Phone 2002" (page 80)).
The IP Phone KEM connects to the IP Phone 2002 or IP Phone 2004
using the Accessory Expansion Module (AEM) port on the IP Phone.
Figure 11

IP Phone KEM attached to an |IP Phone 2002

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.




IP Phone KEM startup initialization 81

Procedure 16
Connecting the IP Phone KEM to an IP Phone 2002 or IP Phone 2004

Step Action

1 Remove the IP Phone from the stand by pressing the IP Phone
tilt handle, and pulling the IP Phone away from the stand.

For the IP Phone 2004, you can also adjust the stand angle to
maximum, instead of removing the stand.

2 Place the connecting arm of the IP Phone KEM behind the IP
Phone and align the IP Phone KEM connection plug to the AEM
port on the back of the IP Phone.

The IP Phones 2002 with the product codes: NTDU76AB34,
NTDU76BB34, NTDU76AB70, and NTDU76BB70 have shorter
connector pins than the other IP Phone 2002. Therefore, the
ribbon cable connector of the IP Phone KEM must be detached
from the retaining clip and pressed manually into the header
connector before attaching the IP Phone KEM.

3 Press the IP Phone KEM and IP Phone firmly together until the
IP Phone KEM locks into place.

4 If connecting a second IP Phone KEM, repeat steps 1 to 3.

The second IP Phone KEM is attached to the right side of the
first IP Phone KEM.

5 Attach the IP Phone stand and the IP Phone KEM stand, if
removed. Adjust each IP Phone KEM stand to the same angle
as the IP Phone.

The IP Phone KEM powers up.

The IP Phone KEM uses the electrical connection of the IP
Phone 2002 or IP Phone 2004 for power. It does not have its
OWNn power source.

—End--

IP Phone KEM startup initialization
Once the IP Phone KEM has been installed and powered up on your IP
Phone 2002 or IP Phone 2004, the IP Phone KEM initializes (see Table 15
"Startup initialization process for the IP Phone KEM" (page 82)).
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Table 15

Startup initialization process for the IP Phone KEM

Phase

Description

self-test

1. IP Phone KEM performs | The self-test confirms the operation of the IP Phone KEM local

memory, CPU, and other circuitry. While undergoing this self-test,
the IP Phone KEM display lights up.

If the IP Phone KEM display does not light up, or lights up and then
goes blank, or fails to begin flashing, check that the IP Phone KEM
is correctly installed and configured.

2. IP Phone KEM

establishes communication | communication with the IP Phone.
with the IP Phone

The IP Phone KEM display flashes until it establishes

If the IP Phone KEM display does not stop flashing, communication
has not been established with the IP Phone. Check that the IP
Phone KEM is correctly installed and configured.

3. IP Phone KEM
downloads keymaps download, the display is blank.

The key labels download to the IP Phone KEM. During the

When the three phases complete successfully, you are ready to use the
additional line/feature keys on your IP Phone KEM.

If you have a second IP Phone KEM installed on your IP Phone, the one to
the immediate right of the IP Phone must be functional for the subsequent
IP Phone KEM to work. This is because the second IP Phone KEM
receives its power, and communicates with the IP Phone, through the first
IP Phone KEM.

Operating parameters

General

If an IP Phone KEM is not responding, and lines or features are configured
on keys 32 to 79, calls can be directed to those keys which the user
cannot access. This means the IP Phone 2002 or IP Phone 2004 rings but
the call cannot be answered. In such cases, the incoming call receives
Call Forward No Answer (CFNA) treatment.

IP Phone 2002

If only one IP Phone KEM is configured in LD 11, but two IP Phone KEMs
are detected on an IP Phone 2002, the second IP Phone KEM is ignored.
An error message displays to alert the administrator that the hardware
configuration does not match the administered configuration.

If two IP Phone KEMs are configured in LD 11, but only one IP Phone
KEM is responding, the keys on the second IP Phone KEM are available
for call processing but are not accessible to the user. This means that
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lines and features on keys 56 to 79 can cause the IP Phone 2002 to
ring, but there is no way to answer it. An error message displays to alert
the administrator that the hardware configuration does not match the
administered configuration.

IP Phone 2004
If only one IP Phone KEM is configured in LD 11, but two IP Phone KEMs
are detected on an IP Phone 2004, the Terminal Proxy Server (TPS)
assigns keys 56 to 79 to the second IP Phone KEM. An error message
displays to alert the administrator that the hardware configuration does not
match the administered configuration.

If two IP Phone KEMs are configured in LD 11 but only one IP Phone
KEM is responding, the TPS assigns keys 32 to 79 to the single IP Phone
KEM (using the Shift key functionality). An error message displays to
alert the administrator that the hardware configuration does not match the
administered configuration. When a second IP Phone KEM is detected,
the TPS changes the key assignments to display across both IP Phone
KEMs, as expected.

Virtual Office
When a Virtual Office (VO) login occurs from an IP Phone 2002 or IP
Phone 2004 that does not have the same number of IP Phone KEMs
responding as configured on the IP Phone used to log in, call processing
may terminate on a key that is not physically available. In other words, the
IP Phone rings but the call cannot be answered.

During the VO login process, the existence of any IP Phone KEM is
verified. If a mismatch is detected, the login proceeds normally; however,
an error message is generated to alert the administrator of the mismatch.

Firmware
The IP Phone KEM firmware is not downloadable. If the IP Phone KEM
firmware must be upgraded or changed, the IP Phone KEM must be
replaced with a new IP Phone KEM containing the updated firmware.
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Nortel IP Audio Conference Phone
2033

Contents
* “Introduction” (page 85)
* “Description” (page 86)
* “Extension microphones” (page 87)
* “Components and functions” (page 88)
* ‘“Features” (page 90)
* “Display characteristics” (page 91)
* “Package components” (page 93)
* ‘“Installation and configuration” (page 95)
* “Redeploying an IP Audio Conference Phone 2033” (page 99)
* *“Replacing an IP Audio Conference Phone 2033” (page 100)

* “Removing an IP Audio Conference Phone 2033 from service” (page
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Introduction
This section explains how to install and maintain the IP Audio Conference
Phone 2033. For information about using the IP Audio Conference Phone
2033, see the IP Phone Audio Conference Phone 2033 User Guide
(NN43111-100).

This section contains the following procedures:

® Procedure 17 “Configuring the IP Audio Conference Phone 2033
(page 96)

®* Procedure 18 “Connecting the components” (page 97)
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86 Nortel IP Audio Conference Phone 2033

* Procedure 19 “Changing the TN of an existing IP Audio Conference
Phone 2033” (page 100)

®* Procedure 20 “Replacing an IP Audio Conference Phone 2033” (page
100)

® Procedure 21 “Removing an IP Audio Conference Phone 2033 from
service” (page 101)

If power to the phone is interrupted after you install and configure an IP
phone, you are not required to reenter the IP Parameters, Node Numbers,
or Terminal Number (TN). There is also no need to again acquire the
firmware.

Description
The IP Audio Conference Phone 2033 is a multi-line professional-level
deskset with a high-resolution, fully-backlit, QVGA color LCD display. The
enhanced configuration menus and USB peripheral support provide a
superior navigation experience. The integrated Bluetooth® Audio gateway
offers greater freedom and mobility. The set includes an integrated
phone switch with Gigabit Ethernet LAN and PC ports. When the phone
is idle users fully experience the personalized background images and
capabilities, as well as the Digital Picture Frame mode.

Figure 12 "IP Audio Conference Phone 2033" (page 87) shows the IP
Audio Conference Phone 2033.
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Figure 12
IP Audio Conference Phone 2033
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Extension microphones
The IP Audio Conference Phone 2033 supports up to two extension
microphones that extend the microphone range in large rooms. Each
extension microphone has a Mute button and an LED indicator to indicate
the current mute state.

Figure 13 "Extension microphone" (page 88) shows an extension
microphone.
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88 Nortel IP Audio Conference Phone 2033

Figure 13
Extension microphone
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Components and functions
This section describes the following components and functions of the IP
Audio Conference Phone 2033:

* “Keys and functions” (page 88)

* *“Services menu” (page 89)

Keys and functions
Table 16 "IP Audio Conference Phone 2033 keys and functions" (page
88) describes the IP Audio Conference Phone 2033 keys and functions.

Table 16
IP Audio Conference Phone 2033 keys and functions
Key Function
Line key Use the Line key to access the single line and activate on-hook
dialing.
Volume control buttons Use the Volume control buttons to adjust the volume of the ringer

and speaker.

Mute button Use the Mute button on the main unit or any extension microphone
to mute the speaker.

Pressing the Mute button on the extension microphone toggles the
mute state of the entire IP Phone, not just the microphone.
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Table 16

IP Audio Conference Phone 2033 keys and functions (cont’d.)

Key

Function

Goodbye key
Hold key

Message (Inbox) key

Navigation keys

Context-sensitive soft keys

Use the Goodbye key to terminate an active call.

Press the Hold key to put an active call on hold. Press the Line (DN)
key to return to the caller on hold.

Press the Message (Inbox) key to access your voice mailbox.

Use the Navigation keys to scroll through menus and lists that
appear on the LCD display screen.

Arrows appear on the left side of display screen to indicate there is
more information to be displayed.

Context-sensitive soft keys (self-labeled) are located below the LCD
screen display. The LCD screen display above the key changes,
based on the active feature. See “Soft key label display” (page

92) for further information.

Press the Shift soft key labelled >> to access the second row of soft
keys.

When a triangle appears before a key label, the feature is active.

Services menu

Table 17 "Services menu" (page 89) shows the Services menu.

Table 17
Services menu

Services key Press the Services key to access the following items:

Telephone Options

Volume adjustment
Contrast adjustment
Language
Date/Time

Local DialPad Tone
Set Info

Diagnostics

Ring type
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90 Nortel IP Audio Conference Phone 2033

— Call Timer
— Live Dialpad
® Password Admin
® Station Control Password

® Virtual Office Login and Virtual Office Logout (if Virtual Office is
configured)

® Test Local Mode and Resume Local Mode (if Media Gateway 1000B
is configured)

Press the Services key to exit from any menu or menu item.

You can customize the IP Phone features to meet user requirements.
For more information, see the IP Phone Audio Conference Phone 2033
User Guide (NN43111-100).

Double-press the Services key to access Network diagnostic utilities. For more information about
Network diagnostic utilities, see “IP Phone diagnostic utilities” (page 569).

Network diagnostic utilities is available in Remote Mode only.

If an incoming call is presented while you configure information in the Services menu, the phone
rings. However, the display does not update with the caller ID, and the programming text is not
disturbed.

While you are in the Services menu you cannot dial digits but you can use the programmable line
keys, such as Redial (double-press a line key) and Auto dial key to make a call. However, the
display does not update with the dialed digits or Caller ID.

Features
The Nortel IP Audio Conference Phone 2033 supports the following
telephony features:

* three context-sensitive soft keys
Functions for the context-sensitive soft keys are configured in LD 11.

For more information about context-sensitive soft keys, see Features
and Services Fundamentals (NN43001-106).

* volume control keys to adjust ringer, speaker volume
* two specialized feature keys

— Message/Inbox

— Services

* three call processing keys
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Mute
Goodbye
Hold

For more information about IP Phone features, see “Features” (page 355).

Display characteristics
The IP Audio Conference Phone 2033 has two display areas:

* “Information line display” (page 92)

* “Soft key label display” (page 92)

Figure

14 "IP Audio Conference Phone 2033 display areas" (page

91) shows the two display areas.

Figure 14

IP Audio Conference Phone 2033 display areas
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Gently wipe the IP Phone display screen with a soft, dry cloth.

CAUTION

Do not use any liquids or powders on the IP Phone. Using
anything other than a soft, dry cloth can contaminate IP Phone
components and cause premature failure.
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92 Nortel IP Audio Conference Phone 2033

Information line display
The IP Audio Conference Phone 2033 has a one-line information display
area with the following information:

* caller number

* caller name

* feature prompt strings
* user-entered digits

* date and time information (if the IP Phone is in an idle state) or Call
Timer (if provisioned in the Telephone options menu)

* setinformation

The information in the display area changes, according to the
call-processing state and active features.

Soft key label display
The soft key label has a maximum of seven characters. Each soft key
includes the soft key label and an icon. When a soft key is in use, a
triangle icon displays at the beginning of the soft key label, and the label
shifts one character to the right. (If the label is six characters in length, the
last or rightmost character is truncated.) If a soft key is enabled, the icon
state changes to on. It remains in the on state until the soft key is pressed
again. This cancels the enabled soft key and turns the icon off, returning
the soft key label to its original state.

Use the Shift (>>) key to navigate through the layers of functions. If only
three functions are assigned to the soft keys, the Shift (>>) key does not
appear, and all three functions are displayed.

Figure 15 "Soft keys" (page 92) shows the soft keys on the display area.

Figure 15
Soft keys
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Package components 93

Package components

Table 18 "Components list for US, CA, CALA, AP, and GC" (page
93) lists the components for the IP Audio Conference Phone 2033 for the
Americas, Asia Pacific, and Greater China region.

Table 18
Components list for US, CA, CALA, AP, and GC

Component

Product code

IP Audio Conference Phone 2033 package contents include

® |P Audio Conference Phone 2033 (charcoal)

® 7 ft CAT5-e Ethernet cable

®* Power Interface Module (PIM) with 25 ft. console cable
® |P Audio Conference Phone 2033 Quick Reference Card

Universal power supply

NTEX11AA70

IP Audio Conference Phone 2033 package contents include

® |P Audio Conference Phone 2033 (charcoal)
® 7ft CAT5-e Ethernet cable

® |P Audio Conference Phone 2033 Quick Reference Card
® 2 Extension microphones (charcoal)

Universal power supply

®* Power over Ethernet (PoE) Module with 25 ft. console cable

NTEX11BA70

IP Audio Conference Phone 2033 package contents include

® |P Audio Conference Phone 2033 (charcoal)
® 7 ft CAT5-e Ethernet cable

® |P Audio Conference Phone 2033 Quick Reference Card

Universal power supply

® Power over Ethernet (PoE) module with 25 ft. console cable

NTEX11EA70

Accessories

Power accessory kit (PIM, Universal power supply, cabling)

NTEX11CA

Power over Ethernet module

NTEX11GAEG6

Extension microphone with 7-ft. cable

NTEX11DA70

Table 19 "Components list for EMEA" (page 94) lists the components for
Europe, Middle East and Africa (EMEA) regions.
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94 Nortel IP Audio Conference Phone 2033

Table 19
Components list for EMEA

Component

Product code

IP Audio Conference Phone 2033 package contents include

® |P Audio Conference Phone 2033 (charcoal)
® 7 ft CAT5-e Ethernet cable
® Power over Ethernet (PoE) module with 25 ft. console cable

IP Audio Conference Phone 2033 Quick Reference Card

NTEX11AA70E6

IP Audio Conference Phone 2033 package contents include

® |P Audio Conference Phone 2033 (charcoal)

® 7-ft. CAT5-e Ethernet cable

® Power over Ethernet (PoE) module with 25 ft. console cable
® |P Audio Conference Phone 2033 Quick Reference Card

2 Extension microphones (charcoal)

NTEX11BA70E6

IP Audio Conference Phone 2033 package contents include

® |P Audio Conference Phone 2033 (charcoal)

® 7 ft CAT5-e Ethernet cable

® Power over Ethernet (PoE) module with 25 ft. console cable
® |P Audio Conference Phone 2033 Quick Reference Card

® Universal Power Supply

NTEX11EA7OE6

IP Audio Conference Phone 2033 package contents include
IP Audio Conference Phone 2033 (charcoal)

® 7 ft CAT5-e Ethernet cable

® Power over Ethernet (PoE) module with 25 ft. console cable
® |P Audio Conference Phone 2033 Quick Reference Card

® 2 Extension microphones (charcoal) with cables

® Universal Power Supply

NTEX11FA70E6

Accessories

® Universal Power Supply (order power cord separately)

®* Power over Ethernet module

NTEX11CAEG6
NTEX11GAEG6

® Extension microphones (charcoal) with cables

NTEX11DA70E6
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Table 19

Components list for EMEA (cont’d.)

Table 20 "Power cords" (page 95) lists the IP Audio Conference Phone
2033 power cords.

Table 20
Power cords

IP Audio Conference Phone 2033 power cords

NA NEMA 5-15P, 125V 13A (10ft.) NTTK14AB
Euro CEE (7) VII, 250V, 10A (2.5m) NTTK16AB
ANZ AS3112, 250V 10A (2.5m) NTTK15AA
Swiss SEV 1011, 250V 10A (8ft.) NTTK17AB
UK/Ireland BS1363, 240V 10A (8ft.) NTTK18AB
Denmark AFSNIT, 250V 10A (2.5m) NTTK22AB
Argentina IRAM 2073, 250V 10A (8ft.) A0814961
Japan 1.8 m (5.9 ft), 10 amp, IEC320-C13 NTTK26AAE6G

Installation and configuration

The following sections provide a step-by-step guide to install and configure

the IP Audio Conference Phone 2033:

“Before you begin” (page 95)

“First-time installation” (page 96)

“Configuring the IP Audio Conference Phone 2033” (page 96)
“Connecting the components” (page 97)

“Startup sequence” (page 99)

Before you begin
Before installing the IP Audio Conference Phone 2033, complete the
following pre-installation checklist:

Ensure one Software License exists for each IP Audio Conference
2033 Phone you install.

Ensure one IP Audio Conference Phone 2033 boxed package exists
for each IP Audio Conference Phone 2033 you install. See Table

18 "Components list for US, CA, CALA, AP, and GC" (page 93) or
Table 19 "Components list for EMEA" (page 94) for a list of package
contents.

Ensure the host Call Server is equipped with a Signaling Server that
runs the Line TPS application.
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96 Nortel IP Audio Conference Phone 2033

* |f a global power supply is required, ensure you use the correct global
power supply supplied by Nortel and country specific IEC cable. The
voltage rating of the global power supply must match the wall outlet
voltage. See Table 18 "Components list for US, CA, CALA, AP, and
GC" (page 93) or Table 19 "Components list for EMEA" (page 94).

* Ensure the latest IP Phone firmware is deployed to the IP telephony
node. For more information, see Signaling Server IP Line Applications
Fundamentals (NN43001-125).

First-time installation
You must first install an IP telephony node with the Communication Server.
For information about installing an IP telephony node, see Signaling Server
IP Line Applications Fundamentals (NN43001-125).

CAUTION

Service Interruption

Do not plug your IP Audio Conference Phone 2033 into an ISDN
connection. Severe damage can result.

Configuring the IP Audio Conference Phone 2033
Use Procedure 17 “Configuring the IP Audio Conference Phone 2033”
(page 96) to configure the IP Audio Conference Phone 2033 for the first

time.

Procedure 17
Configuring the IP Audio Conference Phone 2033

Step

Action

1

Configure a virtual loop on the system using LD 97.

For more information about configuring a virtual loop, see
Signaling Server IP Line Applications Fundamentals (NN430
01-125) and Software Input Output Reference-Administration
(NN43001-611).

Configure the IP Audio Conference Phone 2033 on the system
using LD 11. At the prompts, enter the following:

REQ:new
TYPE:2033

TN 111 s cc uu
ECHG yes
ITEM cls
ITEM

For more information about configuring the IP Audio Conference
Phone 2033 using LD 11, see Software Input Output
Reference-Administration (NN43001-611).
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Configure the IP Audio Conference Phone 2033 in Element
Manager. IP Phones are configured using the Phones section
in the Element Manager navigation tree. For more information
about configuring the IP Audio Conference Phone 2033 using
Element Manager, see Element Manager System Reference -
Administration (NN43001-632).

—End--

Connecting the components
Use Procedure 18 “Connecting the components” (page 97) to connect the
components for the IP Phone.

Procedure 18
Connecting the components

Step

Action

1

Connect one end of the CAT5-e Ethernet cable to the network
interface located on the back of the Power over Ethernet (PoE)
module. See Figure 16 "POE module" (page 98). Plug the other
end of the CAT5-e Ethernet cable into your IP network interface.

Connect the CAT5-e Ethernet cable attached to the POE module
to the IP Phone. Thread the CAT5-e Ethernet cable through the
channel on the bottom of the IP Phone and plug it into the PoE
module port on the IP Phone.

The PoE module port supports Auto-Media Dependent Interface
Crossover (MDIX). Auto-MDIX is supported only when the
Ethernet port is configured for autonegotiation.

Connect the global power supply (optional) to the power supply
port located on the back of the POE module. Leave the global
power supply unplugged from the power outlet. Thread the cord
through the channel on the bottom of the POE module then

plug the other end into the AC power source. Ensure you use
the correct global power supply supplied by Nortel and country
specific IEC cable. The voltage rating of the global power supply
must match the wall outlet voltage. See Table 18 "Components
list for US, CA, CALA, AP, and GC" (page 93) or Table 19
"Components list for EMEA" (page 94).

Figure 16 "POE module" (page 98) shows the Power over
Ethernet (PoE) module.
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Figure 16
POE module

|
Network interface
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port

Red LEDs on the IP Audio Conference Phone 2033 indicate
power. Messages indicating system start up, such as Loading,
Initializing network, and Loading boot parameters appear after
a short delay.

Figure 17 "Bottom view of IP Audio Conference Phone 2033"
(page 99) shows the bottom view of the IP Audio Conference
Phone 2033.

The IP Audio Conference Phone 2033 supports both AC power
and Power over LAN options, including IEEE 802.3af Power
Classification 0. To use Power over Ethernet, where power is
delivered over the CAT5-e cable, the LAN must support Power
over Ethernet, and a global power supply is not required. To use
local AC power, the optional global power supply can be ordered
separately.
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Figure 17
Bottom view of IP Audio Conference Phone 2033
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~End--

When you complete the IP Phone connection, you must connect the phone
to the network. See “Dynamic Host Configuration Protocol” (page 391).

Startup sequence
When an IP Audio Conference Phone 2033 connects to the network, it
must perform a startup sequence. The elements of the startup sequence
include:

* obtaining network access (if supported by the network infrastructure)
* obtaining VLAN ID (if supported by the network infrastructure)

® obtaining the IP parameters

® connecting to the Call Server

® obtaining provisioning parameters

For information about provisioning the IP Phone, see “Manual provisioning
of IP Phone 2000 Series” (page 531).

Redeploying an IP Audio Conference Phone 2033
You can redeploy an existing previously configured IP Audio Conference
Phone 2033 on the same system. For example, the IP Audio Conference
Phone 2033 can be assigned to a new user (new TN) or to an existing
user who moved to a new subnet by changing the TN of the IP Audio
Conference Phone 2033. For further information, see Converging the Data
Network with VolP Fundamentals (NN43001-260).
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Procedure 19
Changing the TN of an existing IP Audio Conference Phone 2033

Step

Action

1

Repower the IP Audio Conference Phone 2033.

During the reboot sequence of a previously configured the
IP Audio Conference Phone 2033 displays the existing node
number for approximately five seconds.

If the node password is enabled and NULL, choose one of the
following:

a Disable the password.
b Set the password as non-NULL.
Press OK when the node number displays.

If Then

the node password is enabled a password screen displays. Go

and is not NULL to Step 4.

the node password is disabled a TN screen displays. Go to Step
5.

Enter the password at the password screen, and press OK.
A TN screen displays.

To obtain the password, enter the nodePwdShow command in
Element Manager. For further information, see Element Manager
System Reference - Administration (NN43001-632).

Select the Shift soft key labeled (>>) and press Clear to edit the
TN field. The IP Audio Conference Phone 2033 by default places
you in the units field of the TN. You cannot use backspace to
move to the loop, shelf or card fields.

Enter the new TN.

—End--

Replacing an IP Audio Conference Phone 2033

ATTENTION
Two IP Phones cannot share the same TN. You must remove the IP Audio
Conference Phone 2033 that currently uses the TN.

Procedure 20
Replacing an IP Audio Conference Phone 2033

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.




Connecting an extension microphone 101

Step Action

1 Obtain the node and TN information of the phone you want to
replace.

2 Disconnect the IP Audio Conference Phone 2033 that you want
to replace.

3 Follow “Configuring the IP Audio Conference Phone 2033”

(page 96) to install the IP Audio Conference Phone 2033. To
configure the IP Phone, see “Manual provisioning of IP Phone
2000 Series” (page 531).

4 Enter the same TN and Node Number as the IP Audio
Conference Phone 2033 you replaced. The system associates
the new IP Audio Conference Phone 2033 with the existing TN.

—End--

Removing an IP Audio Conference Phone 2033 from service

Procedure 21
Removing an IP Audio Conference Phone 2033 from service

Step Action

1 Disconnect the IP Audio Conference Phone 2033 from the
network or turn off the power.

If the IP Audio Conference Phone 2033 was automatically
configured, the DHCP lease expires and the IP address returns
to the available pool.

2 In LD 11, enter the following:
REQ: OUT
TYPE: 2033
TN: LLL S CC UU

—End--

Connecting an extension microphone
Procedure 22
Connecting an extension microphone to the IP Audio Conference Phone
2033

Step Action

1 Thread the microphone cord through the channels on the bottom
of the IP Phone.
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102 Nortel IP Audio Conference Phone 2033

A maximum of two microphone jacks are supported on the IP
Audio Conference Phone 2033.

2 Connect the microphone cord to one of the microphone jacks on
the bottom of the IP Phone.

—End--
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Nortel IP Phone 2007

Contents
This section contains the following topics:

* “Introduction” (page 103)

* “Description” (page 104)

* “Components and functions” (page 104)

* ‘“Features” (page 108)

* “Touch panel” (page 108)

* “Dialpad entry” (page 110)

® “Cleaning the IP Phone display screen” (page 111)
* “Display characteristics” (page 111)

* “Package components” (page 116)

* ‘“Installation and configuration” (page 117)

* “Redeploying an IP Phone 2007" (page 119)
* “Replacing an IP Phone 2007” (page 120)

* “Removing an IP Phone 2007 from service” (page 121)

Introduction
This section explains how to install and maintain the IP Phone 2007. For
information about using the IP Phone 2007, see the IP Phone 2007 User
Guide (NN43118-100).

This section contains the following procedures:
* Procedure 24 “Configuring the IP Phone 2007” (page 118)

® *“Connecting the components” (page 119)

* Procedure 25 “Changing the TN of an existing IP Phone 2007” (page
119).
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104 Nortel IP Phone 2007

* Procedure 26 “Replacing an IP Phone 2007” (page 120).

®* Procedure 27 “Removing an IP Phone 2007 from service” (page 121).

If power to the phone is interrupted after you install and configure an IP
phone, you are not required to reenter the IP Parameters, Node Numbers,
or Terminal Number (TN). There is also no need to again acquire the
firmware.

Description
The Nortel IP Phone 2007 is an advanced multi-line IP Phone with a large
color touchscreen display and integrated 10/100 switch. The IP Phone
2007 is an ideal solution for managers, executives, knowledge workers
and vertical applications wishing to leverage the large color display for
multimedia presentation of converged (voice and data) applications from
the Nortel Applications Gateway 2000.

Figure 18 "IP Phone 2007" (page 104) shows the IP Phone 2007.

Figure 18
IP Phone 2007
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Components and functions
This section describes the following components and functions of the IP
Phone 2007:

* *“Keys and functions” (page 105)
* “Services menu” (page 106)

* “Local Tools menu” (page 107)
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Keys and functions
Table 21 "IP Phone 2007 keys and functions" (page 105) lists the keys
and functions for the IP Phone 2007.

Table 21
IP Phone 2007 keys and functions
Key Function
Hold Press the Hold key to put an active call on hold. Tap the flashing line
(DN) soft key to return to the caller on hold.
Goodbye Press the Goodbye key to terminate an active call.
Handsfree Press the Handsfree key to activate handsfree.
The LED lights to indicate when the handsfree feature is active.
Headset Press the Headset key to answer a call using the headset or to switch a
call from the handset or handsfree to the headset.
Mute Press the Mute key to listen to the receiving party without transmitting.

Volume control bar

Message waiting
light/incoming call
indicator

Programmable line
(DN)/feature keys
(self-labeled)

keys (self-labeled)

Context-sensitive soft

Press the Mute key again to return to a two-way conversation. The Mute
key applies to handsfree, handset, and headset microphones.

The Mute LED flashes when the Mute option is in use.

Use the Volume control bar to adjust the volume of the ringer, handset,
headset, speaker, and the Handsfree feature.

Press the right side of the rocker bar to increase volume, the left side to
decrease volume.

The Message waiting indicator turns ON to indicate that a message has
been left for the user. This indicator also flashes when the set ringer is
ON.

Programmable line (DN)/feature keys (self-labeled) are located on the
touch panel display and are configured for various features on the IP
Phones.

A steady LCD light beside a programmable line (DN)/feature key
indicates the feature or line is active. A flashing LCD indicates the line is
on hold or the feature is being programmed.

Four context-sensitive soft keys (self-labeled) are located on the touch
panel display. The soft key label changes, based on the active feature.

Tap the More soft key to access the next layer of soft key functions.
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Table 21

IP Phone 2007 keys and functions (cont’d.)

Key

Function

Navigation keys

Context-sensitive keys

Use the navigation keys to scroll through menus and lists on the LCD
display screen. The key rocks for up, down, left, and right movement.

Soft key labels are enabled for the keys on either side of the navigation
cluster. The labels are context sensitive. When in an edit box, the soft
key labels appear as Clear and Backspace. This allows numeric editing
without using the soft keyboard. In normal use the soft key labels show
Quit and Copy.

Services menu
Table 22 "Services menu" (page 106) shows the Services menu.

Table 22
Services menu

Services key

Tap the Services key to access the following items:
® Volume adjustment

® Language

* Date/Time

® Display diagnostics

® Local DialPad Tone

® SetlInfo

® Diagnostics

® (Call Log Options

®* Ring type

* Call timer

® On hook default path
® Change Feature key label
® Name Display Format
® Live Dialpad

® Virtual Office Login and Virtual Office Logout (if Virtual Office is
configured)

® Test Local Mode and Resume Local Mode (if Branch Office is
configured)

® Password Admin (if configured)

You can customize the IP Phone features to meet user requirements. For
more information, see the IP Phone 2007 User Guide (NN43118-100).
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Local Tools menu
Tap the Tools icon to access the Local Tools menu. Table 23 "Local Tools
menu" (page 107) shows the options available in the Local Tools menu.

If you are prompted to enter a password when you tap the Tools icon,
password protection is enabled. For more information about password
protection, see “Local Tools menu” (page 441).

Table 23

Local Tools menu
Network Use this menu to configure or to display configuration information. This menu
Configuration contains the following items:

* 802.1x/EAP

* 802.1ab (LLDP)

* DHCP status

* |P network settings (IP address, mask, gateway address)
® Server 1 and Server 2 IP address, Port, Action, Retry, and PK numbers
® Voice VLAN, priority, and filtering

® PC port disable, speed, and duplex setting

® Data VLAN, priority, and filtering

* Network interface speed and duplex setting

® Ignore GARP protection

® Pre-Shared Key SRTP

® XAS IP address, graphical, port

® Provisioning Server IP address

Local Displays the Local Diagnostics menu containing the following items:
Diagnostics
® Network Diagnostic Tools

® Ethernet Statistics
® |P Network Statistics
® [P Set Information
® Advanced Diag Tools
® DHCP Information

For more information about the IP Phone 2007 Local Diagnostics menu, see
“IP Phone diagnostic utilities” (page 569).

Touch Panel Use the Touch Panel Setup tool to calibrate the touch panel and stylus.
Setup

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.



108 Nortel IP Phone 2007

Table 23

Local Tools menu (cont’d.)

Display settings

USB Devices

Preferences

Lock Menu

Use Display settings tools to alter display physical settings including
brightness, backlight, screen saver activation interval, and dimmer.

Use USB Devices menu to control the Universal Serial Bus (USB) device
plugged into the USB port in the back of the IP Phone.

Use the Preferences menu to configure individual user preferences.

Use the Lock menu to prevent unauthorized access to the Local Tools menu.

Features

Touch panel

The IP Phone 2007 supports the following features

12 programmable line (DN)/feature soft keys: six programmable line
(DN)/feature keys and six lines/features accessed by pressing the Shift
key.

large, color touch panel display screen
four context-sensitive soft keys (self-labeled)

volume control bar to adjust ringer, speaker, handset, handsfree, and
headset volume

High quality speakerphone for superior two-way communications
four call-processing fixed keys:

— Hold

— Goodbye

— Handsfree

— Mute

ability to change the programmable line (DN)/feature key labels
Feature keys support English characters only.

Note: Functions for the four display-based context-sensitive soft
keys are configured in LD 11; for more information, see Features and
Services Fundamentals (NN43001-106).

For more information about IP Phone features, see “Features” (page 355).

You perform point and click operations on your IP Phone 2007 using the
touch panel. The touch panel is used with the graphical user interface
(GUI) to present soft keys directly on the display. You can activate all
Line/DN keys and feature soft keys by using the touch panel.
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Calibrate the touch panel
Calibrate the touch panel through the Tools menu, which enables you to
fine-tune the touch panel. You are prompted to use the stylus to tap three

Stylus

targets.

For further information, see Procedure 23 “Calibrating the touch panel and
stylus” (page 109).

Operate the touch panel using a stylus or your finger. However, use of a
stylus is recommended to avoid damage to the touch panel.

Procedure 23
Calibrating the touch panel and stylus

Step Action
Tap the Tools icon to calibrate the touch panel and stylus.
Tap the Touch Panel Setup soft key.
The screen displays a calibration map, the Cancel soft key is
displayed, and the following system prompt is displayed:
Touch the center of the red ball.

3 Use the stylus and tap each of the red dots, in order, starting

with the lower left portion of the screen, and following the
sequence as prompted.

After the third dot is tapped, the display changes to indicate the
result of calibration.

¢ |f the calibration is successful, the IP Phone displays the
following report:
Data calibration is CORRECT.
Save Data calibration?

YES and NO soft keys and calibration statistics are displayed
on the screen.

Tap the YES soft key to save the calibration settings and exit
to the main display or tap the NO soft key to abandon the
calibration settings and exit to the main display.

¢ |f the calibration is unsuccessful, the IP Phone displays the
following report:
Data calibration is WRONG.
Repeat calibration?

YES and NO soft keys and calibration statistics are displayed
on the screen.
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Tap the YES soft key to retry the calibration or tap the NO
soft key to abandon the calibration and return to the main
display.

~End--

Dialpad entry
Certain configuration items on the phone require alpha-numeric, special
characters or hex input, depending on the input field. For ease of use,
Nortel recommends the use of the external USB keyboard. Nortel IP
Phone 2007 also provides an on-screen touch keyboard to facilitate data
input. However, dialpad may also be used for entering alpha-numeric or
special characters.

The following rules apply when you enter text and special characters using
the dialpad.

* Press a key from 0 to 9 once to enter the corresponding humber.

* Press a key from 2 to 9 repeatedly to cycle through the letters
assigned to that key, first in lower case and then in upper case.

For example, if you press the 5 key repeatedly, the following
characters are displayed, one at a time:

j->k->1->J->K->L->5->
See Table 24 "Character key mappings" (page 111) for character key
mappings.

* The insertion point remains in its current position as long as you
continue to press the same key.

®* The entry is accepted if either a new key is pressed or if two seconds
pass with no entry. The insertion point moves 1 space to the right.

For example, to enter the word Nortel, press the following key
sequence:

6 [2 second delay] 6 78 35

Although special characters are not required, key 1 generates
commonly used special characters, such as the period (.), at symbol
(@), and underscore ().

* Double press the asterisk key ** to generate a period (.). This is a
useful shortcut when entering IP addresses.
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Table 24

Character key mappings

Key

Generates

© 00 N O 0o b~ W DN PP

*
*

_-.l@%$%&+1
abcABC2
defDEF3
ghiGHI14
jklIJKL5
MNnoMNOG6
pqrsPQRSY
tuvTUV S8
wWXxyzWXYZ9

period (.)

With UNIStim Release 3.2 or later, you can use the numeric keys on the
IP Phone 2007 soft keyboard or an external USB keyboard to dial calling

numbers.

Cleaning the IP Phone display screen

Gently wipe the IP Phone display screen with a soft, dry cloth.

CAUTION

Do not use any liquids or powders on the IP Phone. Using
anything other than a soft, dry cloth can contaminate IP Phone
components and cause premature failure.

Display characteristics

The IP Phone 2007 window-based user interface has two display areas:

* “Application area” (page 113)

* “Tools/Navigation area” (page 115)

Figure 19 "IP Phone 2007 display areas" (page 112) shows these two
display areas.

See the “Phone mode” (page 112) section, which explains how the display

areas can be shown on the display and changed between Full, Hidden
and Reduced modes.
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ATTENTION

Phone 2007.

There are changes to the IP Phone 2007 graphical user interface (GUI),
including color and icon changes on the display. New IP Phone 2007 units are
shipped with new firmware and display the new GUI. Minimum release of IP
Phone UNISTim software 3.3 is required to support the new GUI for existing IP

Figure 19

IP Phone 2007 display areas

Line210

Page gen

Conference

Last num

Intercom

2000
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Feature
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Inbox Directory Qutbaox

Quit " Expand " Services ” Copy |

The display may differ from the above example.

Application Area

Tools/NAV Area

To extend the life of the LCD panel, the panel goes dark (sleep) after a
configured period of time. For further information, see the IP Phone 2007
User Guide (NN43118-100).

Phone mode

The IP Phone 2007 supports a phone mode option. With phone mode,
you can determine which portion of the IP Phone 2007 display screen is
dedicated to telephony display and which portion of the display screen
is controlled by applications, which are driven by external application

gateways.
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The following three phone modes are available with the IP Phone 2007:

Full— default screen mode, which displays the full telephony screen.

Full screen phone mode can be hidden behind applications controlled
by an application gateway (for example, the Nortel Application
Gateway 2000) and automatically appears in the foreground when you
receive an incoming call, pick up the handset, or press the hands free
or headset key.

If the toolbar at the bottom of the IP Phone display screen is visible,
you can force the telephony screen to appear in the foreground by
touching the telephone icon.

Hidden—telephony screen remains hidden behind applications
controlled by an application gateway and does not automatically
appear in the foreground when you receive an incoming call, pick up
the handset, or press the hands free or headset key.

When you select Hidden screen phone mode, the toolbar at the bottom
of the IP Phone display screen is not visible and the Hold key is
disabled.

You can force the telephony screen (with the toolbar) to appear

by entering the special key sequence, **26344+##. By forcing the
telephony screen to appear, you can perform configurations that
require the IP Phone display screen interface (for example, Node and
TN entry or access to the toolbar).

Reduced—IP Phone telephony screen appears as a small window with
a reduced number of telephony items displayed. In Reduced screen
phone mode, the following apply:

— Information messages and caller ID remain displayed.
— You can access only two line appearance Auto Dial keys.

— You cannot access any soft keys (including, Inbox, Directory,
Services, and Copy).

The remainder of the IP Phone display screen is controlled by an
application gateway application, including the section at the bottom of
the screen, where the toolbar typically appears.

You can force the toolbar to appear by entering the special key
sequence, **26344##.

The Reduced screen phone mode is useful when you require basic
phone functionality and application access at the same time.

Application area
The Application area provides:

“Programmable line (DN)/feature key label display” (page 114)
“Information line display ” (page 114)
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* “Soft key label display” (page 115)
* “Feature key label display” (page 115)

Figure 20 "IP Phone 2007 Application area" (page 114) shows the detail of
the Application area.

Figure 20
IP Phone 2007 Application area
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Programmable line (DN)/feature key label display

The feature key label area displays a 10-character string for each of the 12
programmable line (DN)/feature keys: six programmable line (DN)/feature
keys and six lines/features accessed by pressing the Shift key. Each

key includes the key label and an icon. The icon state can be on, off, or
flashing. Key labels are left-aligned for keys on the left side of the screen,
and right-aligned for keys on the right side of the screen.

If a label is longer than 10 characters, the last 10 characters are displayed,
and the excess characters are deleted from the beginning of the string.

Information line display

The information line display area contains the following sections:
* caller number

* caller name

* feature prompt strings
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* user-entered digits

* date and time information or Call Timer (if provisioned in the Telephone
options menu)

* setinformation

Soft key label display

Use the More key to navigate through the layers of functions. If only four
functions are assigned to the soft keys, the More key does not appear,
and all four functions are displayed.

The soft key label has a maximum of seven characters. Each soft key
includes the soft key label and an icon. When a soft key is in use, a
triangle icon displays at the beginning of the soft key label, and the label
shifts one character to the right. (If the label is six characters in length, the
last or rightmost character is truncated.) If a soft key is enabled, the icon
state changes to on. It remains in the on state until the soft key is pressed
again. This cancels the enabled soft key and turns the icon off, returning
the soft key label to its original state.

Soft key labels support different languages.

Feature key label display

The feature key labels may show either text or icons. The text labels are
displayed by default and are changed using the Tools menu. For further
information about the feature keys and their icon equivalents, see the IP
Phone 2007 User Guide (NN43118-100).

Tools/Navigation area
The Tools/Navigation area provides controls for navigating between
features and selecting tools.
The following five main elements are presented as touchable keys:
* Tools
* Primary application
* Applications
* Telephone
* Keyboard

Figure 21 "IP Phone 2007 Tools/Navigation area" (page 116) shows the
Tools/Navigation area.
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Figure 21
IP Phone 2007 Tools/Navigation area
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Primary application Telephone

Package components

The IP Phone 2007 includes integrated support for a number of LAN
options, including support for IEEE 802.3af Power Classification 3. The
Global power supply must be ordered separately if local power is required.

Table 25 "Package components" (page 116) lists the IP Phone 2007
package components.

Table 25
Package components

IP Phone 2007

Handset

Handset cord

Footstand

2.1 m (7-ft) CAT5-e Ethernet cable
Getting Started card

number plate and lens

Table 26 "IP Phone 2007 component list" (page 116) lists the IP
Phone 2007 components and product codes. Contact Nortel for further
information.

Table 26
IP Phone 2007 component list

Component Product code

Replacement parts

7-ft. CAT5-e Ethernet cable N0089675

Handset (charcoal) NO074886

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.




Installation and configuration 117

Table 26
IP Phone 2007 component list (cont’d.)

Component Product code
Handset cord (charcoal) NO0089571 / N0212463
Footstand (charcoal) NO0089561
Power supply

IP Phone Global power supply (2000, 1100, 1200) NTYS17xxE6
IP Phone 2007 power cords

Standard IEC Cable-North America NTYS14AAE6
Standard IEC Cable-Australia/NZ NTTK15AA
Standard IEC Cable-Europe NTTK16ABE6
Standard IEC Cable-Switzerland NTTK17ABE6
Standard |IEC Cable-UK NTTK18ABE6
Standard IEC Cable-Denmark NTTK22ABE6
Standard IEC Cable-Argentina A0814961
Standard IEC Cable-Japan NTTK26AAE6G
IP Phone 2007 Stylus

IP Phone 2007 Stylus (RoHS) N0089577

Installation and configuration

The following sections provide a step-by-step guide to install and configure

the IP Phone 2007:

e “Before you begin” (page 117)

* “First-time installation” (page 118)

* “Configuring the IP Phone 2007” (page 118)

* “Connecting the components” (page 119)

* ‘“Startup sequence” (page 119)

Before you begin

Before installing the IP Phone 2007, complete the following pre-installation

checklist:

* Ensure one IP Phone 2007 boxed package exists for each IP Phone
2007 you install. For a list of IP Phone 2007 package components, see
Table 25 "Package components" (page 116).

* Ensure one Software License exists for each IP Phone 2007 you

install.
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* Ensure the host Call Server is equipped with a Signaling Server that
runs the Line TPS application.

* If you are not using Power over Ethernet (POE) you must use the
global power supply or your phone fails to operate. See Table 26 "IP
Phone 2007 component list" (page 116).

* Ensure the latest IP Phone firmware is deployed to the IP telephony
node. For more information, see Signaling Server IP Line Applications
Fundamentals (NN43001-125).

First-time installation
You must first install an IP telephony node with the Communication Server.
For information about installing an IP telephony node, see Signaling Server
IP Line Applications Fundamentals (NN43001-125).

CAUTION

Damage to Equipment

Do not plug your IP Phone 2007 into an ISDN connection.
Severe damage can result.

Configuring the IP Phone 2007
Use Procedure 24 “Configuring the IP Phone 2007” (page 118) to
configure the IP Phone 2007.

Procedure 24
Configuring the IP Phone 2007

Step Action

1 Configure a virtual loop on the system using LD 97.

For more information about configuring a virtual loop, see
Signaling Server IP Line Applications Fundamentals (NN430
01-125) and Software Input Output Reference-Administration
(NN43001-611).

2 Configure the IP Phone 2007 on the system using LD 11. At the
prompt, enter the following:

REQ:new
TYPE:2007

To configure the IP Phone 2007 using LD 11, see Software Input
Output Reference-Administration (NN43001-611).

3 Configure the IP Phone 2007 in Element Manager. IP Phones
are configured using the Phones section in the Element
Manager navigation tree. For more information about configuring
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the IP Phone 2007 using Element Manager, see Element
Manager System Reference - Administration (NN43001-632).

—End--

Connecting the components
See the IP Phone 2007 User Guide (NN43118-100) or IP Phone 2007
Getting Started card (NN43118-110) for instructions to connect the IP
Phone 2007 components.

When you complete the IP Phone connection, you must connect the phone
to the network. See “Dynamic Host Configuration Protocol” (page 391).

Startup sequence
When an IP Phone 2007 connects to the network, it must perform a startup
sequence. The elements of the startup sequence include:

* obtaining network access (if supported by the network infrastructure)
* obtaining VLAN ID (if supported by the network infrastructure)

® obtaining the IP parameters

* obtaining the automatic provisioning parameters

® connecting to the Call Server

The IP Phone is configured for automatic provisioning by default. For
more information about provisioning the IP Phone automatically, see
“Provisioning the IP Phones” (page 461).

You can manually configure all or some parameters. For information about
provisioning the IP Phone manually, see “Manual provisioning of IP Phone
2007 and 1100 Series” (page 519).

Redeploying an IP Phone 2007
You can redeploy an existing, previously-configured IP Phone 2007 on
the same system. For example, the IP Phone 2007 can be assigned to
a new user (new TN) or to an existing user who moved to a new subnet
by changing the TN of the IP Phone 2007. For further information, see
Converging the Data Network with VolP Fundamentals (NN43001-260).

Procedure 25
Changing the TN of an existing IP Phone 2007

Step Action

1 Repower the IP Phone 2007.
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During the reboot sequence of a previously configured IP
Phone, the IP Phone 2007 displays the existing node number
for approximately five seconds.

If the node password is enabled and NULL, choose one of the
following:

a Disable the password.
b Set the password as non-NULL.
Press OK when the node number displays.

If Then

the node password is enabled a password screen displays. Go

and is not NULL to Step 4.

the node password is disabled a TN screen displays. Go to Step
5.

Enter the password at the password screen, and press OK.
A TN screen displays.

To obtain the password, enter the nodePwdShow command in
Element Manager. For further information, see Element Manager
System Reference - Administration (NN43001-632).

Select the Clear soft key to clear the existing TN.
Enter the new TN.

—End--

Replacing an IP Phone 2007

ATTENTION
Two IP Phones cannot share the same TN. You must remove the IP Phone

2007 that currently uses the TN.

Procedure 26
Replacing an IP Phone 2007

Step

Action

1

Obtain the node and TN information of the phone you want to
replace.

Disconnect the IP Phone 2007 that you want to replace.

Follow “Configuring the IP Phone 2007” (page 118) to install
the IP Phone 2007. To configure the IP Phone, see “Manual
provisioning of IP Phone 2007 and 1100 Series” (page 519).
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Enter the same TN and Node Number as the IP Phone 2007 you
replaced. The system associates the new IP Phone 2007 with
the existing TN.

—End--

Removing an IP Phone 2007 from service

Procedure 27
Removing an IP Phone 2007 from service

Step

Action

1

Disconnect the IP Phone 2007 from the network or turn the
power off.

The service to the PC is disconnected as well if the PC connects
to the IP Phone 2007.

If the IP Phone 2007 was automatically configured, the DHCP
lease expires and the IP address returns to the available pool.

In LD 11, enter the following:
REQ: OUT

TYPE: 2007

TN: LLL S CC UU

~End--
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Nortel IP Phone 1210

Contents

This section contains the following topics:

Introduction

“Introduction” (page 123)

“Description” (page 124)

“Components and functions” (page 125)
“Features” (page 129)

“Display characteristics” (page 129)
“Package components” (page 130)
“Installation and configuration” (page 132)
“Redeploying an IP Phone 1210" (page 136)
“Replacing an IP Phone 1210” (page 137)

“Removing an IP Phone 1210 from service” (page 138)

This section explains how to install and maintain the IP Phone 1210. For
information about using the IP Phone 1210, see the IP Phone 1210 User
Guide (NN43140-101).

This section contains the following procedures:

Procedure 28 “Configuring the IP Phone 1210” (page 133)
Procedure 29 “Connecting the components” (page 133)

Procedure 30 “Redeploying the TN of an existing IP Phone 1210”
(page 136)

Procedure 31 “Replacing an IP Phone 1210” (page 137)

Procedure 32 “Removing an IP Phone 1210 from service” (page 138)
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Description

If power to the phone is interrupted after you install and configure an IP
phone, you are not required to reenter the IP Parameters, Node Numbers,
or Terminal Number (TN). There is also no need to again acquire the
firmware.

The IP Phone 1210 is a multi-line professional-lelP Audio Conference
Phone 2033vel deskset with a high-resolution, fully-backlit, QVGA color
LCD display. The enhanced configuration menus and USB peripheral
support provide a superior navigation experience. The integrated
Bluetooth® Audio gateway offers greater freedom and mobility. The set
includes an integrated phone switch with Gigabit Ethernet LAN and PC
ports. When the phone is idle users fully experience the personalized
background images and capabilities, as well as the Digital Picture Frame
mode.

Figure 22 "IP Phone 1210" (page 125) shows the IP Phone 1210.
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Figure 22
IP Phone 1210
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Components and functions
This section describes the following components and functions of the IP
Phone 1210:

* *“Keys and functions” (page 125)
* “Services menu” (page 127)

* “Local Tools menu” (page 128)

Keys and functions
Table 27 "IP Phone 1210 keys and functions" (page 126) describes the
IP Phone 1210 keys and functions.

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.



126 Nortel IP Phone 1210

Table 27
IP Phone 1210 keys and functions
Key Function
Handsfree Press the Handsfree key to activate handsfree mode.

Visual Alerter/Message
Waiting indicator

Volume control buttons

Hold key

Conference key

Applications key

Navigation keys

Enter key

Context-sensitive soft keys
(self-labeled)

Goodbye key

The Handsfree light emitting diode (LED) indicator, located on the
Handsfree key, lights to indicate that the headset is in use.

If a message is waiting, the red Visual Alerter/Message Waiting
indicator LED at the top center of the phone flashes. The indicator
also flashes to indicate an incoming call. The flash cadences for
both alerts are different.

Use the Volume control buttons to adjust the volume of the ringer,
handset, headset, speaker, and Handsfree features. Press the
upper button to increase the volume, and press the lower button to
decrease the volume.

Press the Hold key to place an active call on hold. Press the Hold
key again to return to the caller on hold.

Press the Conference key (programmable memory button) to initiate
conference.

Press the Applications key to access external server applications,
such as Nortel Application Server.

Use the Navigation keys to scroll through menus and lists that
appear on the LCD screen. The Navigation keys to move up, down,
left, and right.

Use Up and Down keys to scroll up and down in lists, and the Left
and Right keys to position the cursor. You can also use the Left and
Right keys to select editable fields that appear on the phone. Press
the Right key to select the field below the current position, or press
the Left key to select the field above the current position.

Press the Enter key, at the center of the Navigation key cluster, to
confirm menu selections. You can also use the Enter key instead of
the Select soft key.

Context-sensitive soft keys are below the LCD. The soft key label is
dynamic and depends on the active feature. The label length is a
maximum of six characters.

A triangle before a key label indicates that the key is active.

Press the Goodbye key to terminate an active call.
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Table 27
IP Phone 1210 keys and functions (cont’d.)
Key Function
Mute key Press the Mute key to listen to the calling party without transmitting

Headset key

voice from your phone. Press the Mute key again to return to a
two-way conversation. Mute key functionality applies to handsfree,
handset, and headset modes.

After you mute the transmission path, the Mute indicator LED,
embedded in the Mute key, flashes.

Press the Headset key to answer a call using the headset or to
switch a call from the handset or handsfree to the headset.

The Headset LED indicator, located on the Headset key, lights to
indicate that the headset is in use.

Services menu

Table 28 "Services menu" (page 127) shows the Services menu.

Table 28
Services menu

Services key

Press the Services key to access the following items:

®* Telephone Options

Volume adjustment
Contrast adjustment
Language

Date/Time

Local Dialpad Tone
Set Info

Diagnostics

Ring type

Call Timer

On-hook Default Path
Live Dial Pad

Normal Mode Indication
Caller ID display order

® Password Administration
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— Station Control Password
® Virtual Office Login and Virtual Office Logout (if Virtual Office is configured)
® Test Local Mode and Resume Local Mode (if Branch Office is configured)

You can customize the IP Phone features to meet user requirements. For
more information, see the IP Phone 1210 User Guide (NN43140-101).

To access network diagnostic utilities, double-press the Services key. Press 2 2 on the dialpad to
access the Network Diagnostic Tools menu or use the Up or Down navigation keys to scroll and
highlight Network Diagnostic Tools option. For more information about network diagnostic utilities,
see “IP Phone diagnostic utilities” (page 569).

If an incoming call is presented while you configure information in the Services menu, the phone
rings. However, the display does not update with the caller ID, and the programming text is not
disturbed.

While you are in the Services menu you cannot dial digits but you can use the programmable line
keys, such as Redial (double-press a line key) and Auto dial key to make a call. However, the
display does not update with the dialed digits or Caller ID.

Local Tools menu
Table 29 "Local Tools menu" (page 128) shows the Local Tools menu.
For more information about the Local Tools menu, see “Local Tools menu”
(page 441).

Table 29
Local Tools menu

Services key Press the Services key twice to access the Local Tools menu. The following
items appear in the Local Tools menu:

* 1. Preferences

® 2. Local Diagnostics

® 3. Network Configuration
® 4. Lock Menu

If you are prompted to enter a password when you double-press the Services
key, password protection initiates. For more information about password
protection, see “Local Tools menu” (page 441).

To make a selection, press the number associated with the menu item, or use
the navigation keys to scroll through the menu items. Press the Enter key to

select the highlighted menu item.

Press the Cancel key to exit from a menu or menu item.
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Features
The IP Phone 1210 supports the following telephony features:

* four context-sensitive soft keys
Functions for the context-sensitive soft keys are configured in LD 11.

* volume control buttons to adjust ringer, speaker, handset, and headset
volume

* three specialized feature keys
— Conference
— Services
— Applications
* five call-processing keys
— Goodbye
— Hold
— Handsfree
— Mute
— Headset

For more information about IP Phone features, see “Features” (page 355).

Display characteristics
An IP Phone 1210 has two display areas:

* “Information line display” (page 130)
* “Soft key label display” (page 130)

Figure 23 "IP Phone 1210 display areas" (page 129) shows these two
display areas.

Figure 23
IP Phone 1210 display areas

Upper display area
-information display

Lower display area _E

-context-sensilive soft key labels
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Cleaning the IP Phone display screen
Gently wipe the IP Phone display screen with a soft, dry cloth.

CAUTION

Do not use any liquids or powders on the IP Phone 1210. If you
use anything other than a soft, dry cloth, you can contaminate IP
Phone components and cause premature failure.

Information line display
An IP Phone 1210 has a one-line information display area with the
following information:

* caller number

* caller name

* feature prompt strings
* user-entered digits

* date and time information (if the IP Phone is in an idle state) or call
timer (if provisioned in the Telephone options menu)

* |P Phone information

The information area changes according to the call-processing state and
active features.

Soft key label display
The soft key label has a maximum of six characters. Each soft key
includes the soft key label and an icon. When a soft key is in use, a
triangle icon appears at the beginning of the soft key label, and the label
shifts one character to the right. If the label is six characters in length, the
last or rightmost character is truncated. If you initiate a feature, the icon
state turns on. The icon remains in the on state until you press this feature
key again. This action cancels the enabled feature and turns the icon off,
and returns the soft key label to its original state.

Use the More soft key to navigate the layers of functions. If you assign
only four functions to the soft keys, the More key does not appear, and all
four functions display.

Package components
You must order the global power supply separately if local power using the
global power supply is required. IP Phones include integrated support for
a number of Power over LAN (PoL) options, including support for IEEE
802.3af standard power.
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Table 30 "Package components" (page 131) lists the package components

for the IP Phone 1210.

Table 30
Package components

* |P Phone 1210

® handset

® handset cord

¢ footstand

® 2.1 m (7-ft) CAT5-e Ethernet cable

®* number plate and lens

Table 31 "IP Phone 1210 components list" (page 131) lists the IP Phone

1210 components and product codes.

Table 31

IP Phone 1210 components list
Component
IP Phone 1210 (Charcoal) with icon keys NTYS18AA70E6
IP Phone 1210 (Charcoal) with English text keys NTYS18BA70E6
Power supply
Global power supply NTYS17xxE6
IEC cables
1.8 m (5.9 ft), 10 amp, IEC320-C13 North America NTYS14AAE6
2.4 m (8 ft), 240 VAC 10 amp, ANZ power cord AS-3, Australia, New | NTTK15AA
Zealand
Note: ROHS does not apply in this region.
250 VAC, Option 11C Standard European power cord, Other EMEA, | NTTK16ABE6
Kenya, Korea, Thailand, Indonesia, Vietnam, India, Pakistan
3 m (9.9 ft) 125 VAC, Option 11C Swiss power cord Switzerland NTTK17ABEG6
240 VAC, Option 11C UK power cord Hong Kong, Ireland, United NTTK18ABEG6
Kingdom, Singapore, Malaysia, Bangladesh, Brunei, Sri Lanka
3 m (9.9 ft), 125 VAC, Option 11C Denmark power cord Denmark NTTK22ABEG6
Argentina A0814961
Note: ROHS does not apply in this region.
1.8 m (5.9 ft), 10 amp, IEC320-C13 Japan NTTK26AAE6

For more information about previous versions of the IP Phone, contact

your Nortel representative.
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Installation and configuration
The following sections provide a step-by-step guide to install and configure
the IP Phone 1210:

“Before you begin” (page 132)

“First-time installation” (page 132)
“Configuring the IP Phone 1210” (page 133)
“Connecting the components” (page 133)

“Startup sequence” (page 136)

Before you begin
Before installing the IP Phone 1210, complete the following preinstallation
checklist:

Ensure one IP Phone 1210 boxed package exists for each IP Phone
1210 you install. For a list of IP Phone 1210 package components, see
Table 30 "Package components" (page 131).

Ensure one software license exists for each IP Phone 1210 you install.

Ensure the host call server is equipped with a Signaling Server that
runs the Line Terminal Proxy Server (LTPS) application.

If a global power supply is required, ensure you use the approved
Nortel global power supply (model number NTYS17xxEB).

Ensure the latest IP Phone firmware is deployed to the IP telephony
node. For more information, see Signaling Server IP Line Applications
Fundamentals (NN43001-125).

CAUTION

Ensure that the protective rubber cap on the Accessory
Expansion Module (AEM) port is in place when the port is not
in use. An improper connector can cause damage to the IP
Phone.

First-time installation
You must first install an IP telephony node with the Communication Server.
For information about installing an IP telephony node, see Signaling Server
IP Line Applications Fundamentals (NN43001-125).

CAUTION
Do not plug your IP Phone 1210 into an ISDN connection.
Severe damage can result.
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Configuring the IP Phone 1210
Use Procedure 28 “Configuring the IP Phone 1210” (page 133) to
configure the IP Phone 1210 for the first time.

Procedure 28
Configuring the IP Phone 1210

Step Action

1 Configure a virtual loop on the Call Server using LD 97.

For more information about configuring a virtual loop, see
Signaling Server IP Line Applications Fundamentals (NN430
01-125) and Software Input Output Reference-Administration
(NN43001-611).

2 Configure the IP Phone 1210 on the Call Server using LD 11. At
the prompt, enter the following command:

REQ:new
TYPE:1210

For more information about configuring the IP Phone 1210 using
LD 11, see Software Input Output Reference-Administration
(NN43001-611).

3 Configure the IP Phone 1210 in Element Manager. IP Phones
are configured using the Phones section in the Element
Manager navigation tree. For more information about configuring
the IP Phone 1210 using Element Manager, see Element
Manager System Reference - Administration (NN43001-632).

—End--

Connecting the components
Use Procedure 29 “Connecting the components” (page 133) to connect the
components for the IP Phone. See Figure 24 "IP Phone 1210 connections"
(page 134).

Procedure 29
Connecting the components

Step Action

1 Attach the footstand (optional). Attach the foot stand in the
appropriate slots depending on the desired angle for your IP
Phone. If you insert the foot stand into the upper slots, your IP
Phone sits at a 25-degree angle. If you insert the foot stand into
the lower slots, your IP Phone sits at a 55-degree angle.

If you install the IP Phone on the wall, do not attach the
footstand.

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.



134 Nortel IP Phone 1210

Figure 24 "IP Phone 1210 connections" (page 134) shows the
back of the IP Phone.

Figure 24

IP_ Phone 1210 connections

LAN Ethernet

Handset jack

Position 1 slots

Headset jack
= Paosition 2 slots

AC Power
PC Ethernet LAN LED

a

b

Align the bottom tabs on the foot stand with the position 1
slots or the position 2 slots on the back of your IP Phone. In
position 1 the IP Phone sits at a 25-degree angle. In position
2 the IP Phone sits at a 55-degree angle.

Press the footstand into the slots until it snaps into place.

Connect the handset:

a

b

Plug the end of the handset cord with the short straight
section into the handset.

Plug the other end of the handset cord with the long straight
section into the handset jack marked with the handset symbol
on the back of the IP Phone.

Thread the cord through the channel in the footstand
(if installed) so that it exits on the side of the foot stand
(optional).

Connect the headset (optional):

a

b

Plug the headset cord into the headset jack on the back of
the IP Phone marked with the headset symbol.

Thread the cord through the channel in the side of the foot
stand.

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.



Installation and configuration 135

c Set up the headset according to the instructions included with
the headset.

Connect the global power supply (optional).

The IP Phone 1210 supports both AC power and Power

over Ethernet (PoE) options, including IEEE 802.3af Power
Classification 2. To use PoE, where power is delivered over the
CAT5-e cable, the LAN must support PoE, and a global power
supply is not required. To use local AC power, you can order the
optional global power supply separately.

WARNING
Use your IP Phone 1210 with the approved Nortel
global power supply (model number NTYS17xxE6).

The IP Phone 1210 supports both AC power and PoL
options, including IEEE 802.3af Power Classification
2.

a Connect the Direct Current (DC) barrel connector to the
power jack on the back of the IP Phone.

b Thread the cable through the channel in the foot stand to
secure the cable.

¢ Plug the country-specific IEC cable into the Global Power
Supply, and then plug the global power supply into the
nearest AC power outlet.

Install the Ethernet cable. Connect one end of the supplied
Ethernet cable to the back of your phone using the CAT5-e
connector (LAN Ethernet port), and thread the network cable
through the channel in the footstand.

Connect the other end of the cable to your LAN Ethernet
connection. The LAN LED on the back of the IP Phone lights
when a LAN connection is established.

If you connect your PC through the phone, a second CAT5-e
cable is required. Only one cable is included with the IP Phone
1210 package. Install the Ethernet cable connecting the PC to
the phone (optional). Connect one end of the PC Ethernet cable
to your phone using the CAT5-e connector (PC Ethernet port),
and thread it through channel in the footstand. Connect the other
end to the LAN connector on the back of your PC.

The LAN Ethernet port supports Auto-Media Dependent Interface
Crossover (MDIX). Auto-MDIX is supported only when the
Ethernet port is configured for autonegotiation. The PC Port
does not support Auto-MDIX.

Wall mount the IP Phone 1210 (optional):

a Remove the footstand.
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b Ensure all cables are properly routed and the IP Phone is
functioning.

¢ Make small marks on the wall where you want to align each
of the two keyhole slots.

d Insert the screws (not provided), so that they protrude slightly
from the wall.

e Align the keyholes on the back of the IP Phone with the
screws in the wall.

f Slide the IP Phone down on the screws to secure the IP
Phone in position.

~End--

When you complete the IP Phone connection, you must connect the phone
to the network. See “Dynamic Host Configuration Protocol” (page 391).

Startup sequence
When you connect an IP Phone 1210 to the network, it must perform a
startup sequence. The elements of the startup sequence include

* obtaining network access (if supported by the network infrastructure)
* obtaining VLAN ID (if supported by the network infrastructure)

® obtaining the IP parameters

* obtaining the provisioning parameters

® connecting to the Call Server

The IP Phone is configured for automatic provisioning by default. For
more information about provisioning the IP Phone automatically, see
“Provisioning the IP Phones” (page 461).

You can manually configure all or some parameters. For information about
manually provisioning the IP Phone, see “Manual provisioning of IP Phone
1110 and 1200 Series” (page 509).

Redeploying an IP Phone 1210
You can redeploy an existing previously-configured IP Phone 1210 on
the same system. For example, you can assign the IP Phone 1210 to a
new user (new TN) or to an existing user who moved to a new subnet
by changing the TN of the IP Phone 1210. For further information, see
Converging the Data Network with VolP Fundamentals (NN43001-260).

Procedure 30
Redeploying the TN of an existing IP Phone 1210
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Step

Action

Repower the IP Phone 1210.

During the reboot sequence of a previously configured IP
Phone, the IP Phone 1210 displays the existing node number
for approximately 5 seconds.

If you configure the node password to NULL, choose one of the
following:

a Disable the password.
b Set the password as nonNULL.
Press OK when the node number displays.

If Then

you configure the node password a password screen displays. Go

to NULL to Step 4.

the node password is disabled a TN screen displays. Go to Step
5.

Enter password at the password screen, and press OK.
A TN screen displays.

To obtain the password, enter the nodePwdShow command in
Element Manager. For more information, see Element Manager
System Reference - Administration (NN43001-632).

Select the Clear soft key to clear the existing TN.
Enter the new TN.
Click OK to save and accept changes.

—End--

Replacing an IP Phone 1210

ATTENTION
Two IP Phones cannot share the same TN. You must remove the IP Phone
1210 that currently uses the TN.

Procedure 31
Replacing an IP Phone 1210

Step

Action

1

Obtain the node and TN information of the phone you want to
replace.

Disconnect the IP Phone 1210 that you want to replace.
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Follow “Configuring the IP Phone 1210” (page 133) to install
the IP Phone 1210. To configure the IP Phone, see “Manual
provisioning of IP Phone 1110 and 1200 Series” (page 509).

Enter the same TN and node number as the IP Phone 1210 you
replaced. The system associates the new IP Phone 1210 with
the existing TN.

—End--

Removing an IP Phone 1210 from service

Procedure 32
Removing an IP Phone 1210 from service

Step

Action

1

Disconnect the IP Phone 1210 from the network or turn off the
power.

If the IP Phone 1210 was automatically configured, the DHCP
lease expires and the IP address returns to the available pool.

In LD 11, enter the following:
REQ: OUT

TYPE: 1210

TN: LLL S CC UU

—End--
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Contents

This section contains the following topics:

Introduction

“Introduction” (page 139)

“Description” (page 140)

“Components and functions” (page 141)
“Features” (page 145)

“Display characteristics” (page 146)
“Package components” (page 148)
“Installation and configuration” (page 149)
“Redeploying an IP Phone 1220” (page 154)
“Replacing an IP Phone 1220” (page 155)

“Removing an IP Phone 1220 from service” (page 155)

This section explains how to install and maintain the IP Phone 1220. For
information about using the IP Phone 1220, see the IP Phone 1220 User
Guide (NN43141-101).

This section contains the following procedures:

Procedure 33 “Configuring the IP Phone” (page 150)
Procedure 34 “Connecting the components” (page 151)

Procedure 35 “Redeploying the TN of an existing IP Phone 1220”
(page 154).

Procedure 36 “Replacing an IP Phone 1220” (page 155).

Procedure 37 “Removing an IP Phone 1220 from service” (page 155).
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Description

If power to the phone is interrupted after you install and configure an IP
phone, you are not required to reenter the IP Parameters, Node Numbers,
or Terminal Number (TN). There is also no need to again acquire the
firmware.

The IP Phone 1220 is a multi-line professional-lelP Audio Conference
Phone 2033vel deskset with a high-resolution, fully-backlit, QVGA color
LCD display. The enhanced configuration menus and USB peripheral
support provide a superior navigation experience. The integrated
Bluetooth® Audio gateway offers greater freedom and mobility. The set
includes an integrated phone switch with Gigabit Ethernet LAN and PC
ports. When the phone is idle users fully experience the personalized
background images and capabilities, as well as the Digital Picture Frame
mode.

Figure 25 "IP Phone 1220" (page 141) shows the IP Phone 1220.
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Figure 25
IP Phone 1220

Programmable line (DN)
feature keys (self-labeled)

Message waiting indicator/
Incoming call indicator

Display screen

Context-sensitive
soft keys
(self-labeled)

Enter key
Messages key
Redial key
Directory key
Navigation keys
Goodbye key

Conference key
Services key
Quit key

Applications key
Headset key

Hold key

Mute key

olume control keys Dialpad
Handsfree key

Components and functions
This section describes the following components and functions of the IP

Phone 1220:

* “Keys and functions” (page 141)
® “Services menu” (page 143)

* “Local Tools menu” (page 144)

Keys and functions
Table 32 "IP Phone 1220 keys and functions" (page 142) describes the

IP Phone 1220 keys and functions.
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Table 32
IP Phone 1220 keys and functions
Key Function
Handsfree Press the Handsfree key to activate handsfree mode.

Programmable line
(DN)/feature keys
(self-labeled)

Visual Alerter/Message
Waiting indicator

Context-sensitive soft keys
(self-labeled)

Navigation keys

The Handsfree light emitting diode (LED) indicator, located on the
Handsfree key, lights to indicate that the headset is in use.

Programmable line (Directory Number [DN]/feature keys
(self-labeled) are configured for various features on the IP Phone.
One must be the prime DN key.

A steady icon beside a line (DN) key indicates the line is active. A
flashing icon indicates the line is on hold. After a call arrives on a
DN key, which is not on the currently displayed page of keys, the IP
Phone automatically moves to the page with the active key.

A steady icon beside a feature key indicates the feature is active.
A flashing icon indicates the feature is being programmed. After a
call arrives on a feature key, which is not on the currently displayed
page of keys, the IP Phone automatically moves to the page with
the active key.

These keys also function as line (DN) keys. Press the Left or Right
arrow keys to access the second page of feature keys. This feature
is called Second Page functionality.

If a message is waiting, the red Visual Alerter/Message Waiting
indicator LED at the top center of the phone flashes. The indicator
also flashes to indicate an incoming call. The flash cadences for
both alerts are different.

Context-sensitive soft keys are below the LCD. The soft key label is
dynamic and depends on the active feature. The label length is a
maximum of six characters.

A triangle before a key label indicates that the key is active.

Use the Navigation keys to scroll through menus and lists that
appear on the LCD screen. The Navigation keys to move up, down,
left, and right.

Use Up and Down keys to scroll up and down in lists, and the Left
and Right keys to position the cursor. You can also use the Left and
Right keys to select editable fields that appear on the phone. Press
the Right key to select the field below the current position, or press
the Left key to select the field above the current position.
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Table 32
IP Phone 1220 keys and functions (cont’d.)
Key Function
Enter Press the Enter key, at the center of the Navigation key cluster, to

Messages (Inbox)

Redial (Outbox)

Directory

Quit

Conference

Applications

Goodbye
Hold

Headset

Mute

Volume control buttons

confirm menu selections. You can also use the Enter key instead of
the Select soft key.

Press the Messages (Inbox) key to access your voice mailbox when
the message waiting indicator flashes.

Press the Redial (Outbox) key to access your Redial list.
Press the Directory key to access Directory services.

Press the Quit key to end an active application.

Pressing the Quit key does not affect the status of the calls currently
on your IP Phone.

Press the Conference key to initiate conference.

Press the Applications key to access external server applications,
such as Nortel Application Server.

Press the Goodbye key to terminate an active call.

Press the Hold key to place an active call on hold. Press the
flashing line (DN) key to return to the caller on hold.

Press the Headset key to answer a call using the headset or to
switch a call from the handset or handsfree to the headset.

The Headset LED indicator, located on the Headset key, lights to
indicate that the headset is in use.

Press the Mute key to listen to the calling party without transmitting
voice from your phone. Press the Mute key again to return to a
two-way conversation. Mute key functionality applies to handsfree,
handset, and headset modes.

After you mute the transmission path, the Mute indicator LED,
embedded in the Mute key, flashes.

Use the Volume control buttons to adjust the volume of the ringer,
handset, headset, speaker, and Handsfree features. Press the
upper button to increase the volume, and press the lower button to
decrease the volume.

Services menu

Table 33 "Services menu" (page 144) shows the Services menu.
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Table 33
Services menu

Services key Press the Services key to access the following items:

® Telephone Options
— Volume Adjustment
— Contrast Adjustment
— Language
— Date/Time Format
— Display diagnostics
— Local Dialpad Tone
— Set Info
— Ring type
— Change Feature key label
— Call Timer
— On-hook Default Path
— Live Dial Pad
— Normal Mode Indication
— Caller ID display order
® Password Administration
* Virtual Office Login and Virtual Office Logout (if Virtual Office is configured)

® Test Local Mode and Resume Local Mode (if Branch Office is configured)

You can customize the IP Phone features to meet user requirements. For
more information, see the IP Phone 1220 User Guide (NN43141-101).

To access network diagnostic utilities, double-press the Services key. Press 2 2 on the dialpad to
access the Network Diagnostic Tools menu or use the Up or Down navigation keys to scroll and
highlight Network Diagnostic Tools option. For more information about network diagnostic utilities,
see “IP Phone diagnostic utilities” (page 569).

If an incoming call is presented while you configure information in the Services menu, the phone
rings. However, the display does not update with the caller ID, and the programming text is not
disturbed.

While you are in the Services menu you cannot dial digits but you can use the programmable line
keys, such as Redial (double-press a line key) and Auto dial key to make a call. However, the
display does not update with the dialed digits or Caller ID.

Local Tools menu
Table 34 "Local Tools menu" (page 145) shows the Local Tools menu.
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Table 34

Local Tools menu

Services key

Press the Services key twice to access the Local Tools menu. The
following items appear in the Local Tools menu:

® 1. Preferences

® 2. Local Diagnostics

® 3. Network Configuration
® 4. Lock Menu

If you are prompted to enter a password when you double-press the
Services key, password protection is enabled. For more information
about password protection and the Local Tools menu, see “Local
Tools menu” (page 441).

To make a selection, press the number associated with the menu
item, or use the navigation keys to scroll through the menu items.
Press the Enter key to select the highlighted menu item.

Press the Cancel key to exit from any menu or menu item.

Features

For information about configuring the Local Tools menu, see “Local Tools
menu” (page 441).

The IP Phone 1220 supports the following telephony features:

four programmable line (DN)/ feature keys (self-labeled)
four context-sensitive soft keys (self-labeled)
Functions for the context-sensitive soft keys are configured in LD 11.

volume control bar to adjust ringer, speaker, handset, and headset
volume

ability to change the programmable line (DN)/feature key labels
six specialized feature keys

— Quit

— Directory

— Message/Inbox

— Redial (Outbox)

— Services

— Conference

six call-processing fixed keys:
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— Mute

— Handsfree
— Goodbye
— Applications
— Headset
— Hold

For more information about IP Phone features, see “Features” (page 355).

Display characteristics
An IP Phone 1220 has three major display areas:

* “Programmable line (DN)/feature key label display” (page 147)
* ‘“Information line display” (page 147)
* “Soft key label display” (page 147)

Figure 26 "IP Phone 1220 display areas" (page 146) shows these three
display areas.

Figure 26
IP Phone 1220 display areas

Upper display area
Programmable line/DN
feature keys (self-labeled)

Middle display area
Date/time display

Call party information
Feature status information
Options information
Directories information

Lower display area
Context-sensitive
soft keys

Cleaning the IP Phone display screen
Gently wipe the IP Phone display screen with a soft, dry cloth.

CAUTION

Do not use any liquids or powders on the IP Phone 1220. If you
use anything other than a soft, dry cloth, you can contaminate IP
Phone components and cause premature failure.
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Programmable line (DN)/feature key label display
The feature key label area displays a 9-character string for each of the four
feature keys. Each feature key includes the key label and an icon. The
icon state can be on, off, or flashing. A telephone icon displays the status
of the configured DN. Key labels are left-aligned for keys on the left side of
the screen, and right-aligned for keys on the right side of the screen.

If a label is longer than 9 characters, the last 9 characters are displayed
and the excess characters are deleted from the beginning of the string
when the string is a DN, otherwise excess characters are deleted from end
of the string.

You can use the Programmable line (DN)/feature key label feature to add
a text label on the Auto Dial keys that have a 10 digit number.

Information line display
An IP Phone 1220 has a one-line information display area with the
following information:

* caller number

* caller name

* feature prompt strings
* user-entered digits

* date and time information (if the IP Phone is in an idle state) or Call
Timer (if provisioned in the Telephone options menu)

The information in the display area changes, according to the
call-processing state and active features.

Because the IP Phone 1220 only has a one-line information display area,
you are prompted to scroll through any additional lines of information.

During an incoming call, only the Directory Number (DN) displays if the
caller name is greater than 9 characters. Press the flashing arrow to
display the caller name.

Soft key label display
The soft key label has a maximum of six characters. Each soft key
includes the soft key label and an icon. When a soft key is in use, a
triangle icon appears at the beginning of the soft key label, and the label
shifts one character to the right. If the label is six characters in length, the
last or rightmost character is truncated. If you initiate a feature, the icon
state turns on. The icon remains in the on state until you press this feature
key again. This action cancels the enabled feature and turns the icon off,
and returns the soft key label to its original state.
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Use the More soft key to navigate the layers of functions. If you assign
only four functions to the soft keys, the More key does not appear, and all
four functions display.

Package components
You must order the global power supply separately if local power using the
global power supply is required. IP Phones include integrated support for
a number of Power over LAN (PoL) options, including support for IEEE
802.3af standard power.

Table 35 "Package components" (page 148) lists the IP Phone 1220
package components.

Table 35
Package components

* |P Phone 1220

®* handset

® handset cord

* footstand

® 2.1 m (7-ft) CAT5-e Ethernet cable

®* number plate and lens

Table 36 "IP Phone 1220 components list" (page 148) lists the IP Phone
1220 package components and product codes.

Table 36

IP Phone 1220 components list
Component Product code
IP Phone 1220 (Charcoal with icon keys) NTYS19AA70E6
IP Phone 1220 (Charcoal with English text keys) NTYS19BA70E6
Power supply
Global power supply NTYS17xxE6
IEC cables
1.8 m (5.9 ft), 10 amp, IEC320-C13 North America NTYS14AAE6
2.4 m (8 ft), 240 VAC 10 amp, ANZ power cord AS-3, Australia, NTTK15AA

New Zealand
Note: ROHS does not apply in this region.

250 VAC, Option 11C Standard European power cord, Other EMEA, | NTTK16ABEG6
Kenya, Korea, Thailand, Indonesia, Vietnam, India, Pakistan

3 m (9.9 ft) 125 VAC, Option 11C Swiss power cord Switzerland NTTK17ABEG6
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Table 36

IP Phone 1220 components list (cont’d.)

Component

Product code

240 VAC, Option 11C UK power cord Hong Kong, Ireland, United NTTK18ABEG6
Kingdom, Singapore, Malaysia, Bangladesh, Brunei, Sri Lanka

3 m (9.9 ft), 125 VAC, Option 11C Denmark power cord Denmark NTTK22ABEG6

Argentina A0814961
Note: ROHS does not apply in this region.
1.8 m (5.9 ft), 10 amp, IEC320-C13 Japan NTTK26AAE6

For more information about previous versions of the IP Phone, contact
Nortel.

Installation and configuration
The following sections provide a step-by-step guide to install and configure
the IP Phone 1220:

“Before you begin” (page 149)

“First-time installation” (page 150)
“Configuring the IP Phone 1220” (page 150)
“Connecting the components” (page 151)

“Startup sequence” (page 153)

Before you begin
Before installing the IP Phone 1220, complete the following pre-installation
checklist:

Ensure one IP Phone 1220 boxed package exists for each IP Phone
1220 you install. For a list of IP Phone 1220 package components, see
Table 35 "Package components" (page 148).

Ensure one software license exists for each IP Phone 1220 you install.

Ensure the host call server is equipped with a Signaling Server that
runs the Line Terminal Proxy Server (LTPS) application.

If a global power supply is required, ensure you use the approved
Nortel global power supply (model number NTYS17xxE6).

Ensure the latest IP Phone firmware is deployed to the IP telephony
node. For more information, see Signaling Server IP Line Applications
Fundamentals (NN43001-125).

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.



150 Nortel IP Phone 1220

CAUTION

Ensure that the protective rubber cap on the Accessory
Expansion Module (AEM) port is in place when the port is not
in use. An improper connector can cause damage to the IP
Phone.

First-time installation
You must first install an IP telephony node with the Communication Server.
For information about installing an IP telephony node, see Signaling Server
IP Line Applications Fundamentals (NN43001-125).

CAUTION
Do not plug your IP Phone 1220 into an ISDN connection.
Severe damage can result.

Configuring the IP Phone 1220
Use Procedure 33 “Configuring the IP Phone” (page 150) to configure the
IP Phone 1220 for the first time.

Procedure 33
Configuring the IP Phone

Step Action

1 Configure a virtual loop on the Call Server using LD 97.

For more information about configuring a virtual loop, see
Signaling Server IP Line Applications Fundamentals (NN430
01-125) and Software Input Output Reference-Administration
(NN43001-611).

2 Configure the IP Phone 1220 on the Call Server using LD 11. At
the prompt, enter the following command:

REQ:new
TYPE:1220

For more information about configuring the IP Phone 1220 using
LD 11, see Software Input Output Reference-Administration
(NN43001-611).

3 Configure the IP Phone 1220 in Element Manager. IP Phones
are configured using the Phones section in the Element
Manager navigation tree. For more information about configuring
the IP Phone 1220 using Element Manager, see Element
Manager System Reference - Administration (NN43001-632).

—End--
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Connecting the components
Use Procedure 34 “Connecting the components” (page 151) to connect the
components for the IP Phone. See Figure 27 "IP Phone 1220 connections"
(page 151).

Procedure 34
Connecting the components

Step Action

1 Attach the footstand (optional). Attach the foot stand in the
appropriate slots depending on the desired angle for your IP
Phone. If you insert the foot stand into the upper slots, your IP
Phone sits at a 25-degree angle. If you insert the foot stand into
the lower slots, your IP Phone sits at a 55-degree angle.

If you install the IP Phone on the wall, do not attach the
footstand.

Figure 27 "IP Phone 1220 connections" (page 151) shows the IP
Phone 1220 connections.

Figure 27

IP_ Phone 1220 connections

WORTIL
¥ om0

LAN Ethernet

Handset jack

Position 1 slots

Headset jack

= Position 2 slots

PC Ethernet LAN LED

a Align the bottom tabs on the foot stand with the position 1
slots or the position 2 slots on the back of your IP Phone. In
position 1 the IP Phone sits at a 25-degree angle. In position
2 the IP Phone sits at a 55-degree angle.

b Press the footstand into the slots until it snaps into place.
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2 Connect the handset:

a Plug the end of the handset cord with the short straight
section into the handset.

b Plug the other end of the handset cord with the long straight
section into the handset jack marked with the handset symbol
on the back of the IP Phone.

¢ Thread the cord through the channel in the footstand
(if installed) so that it exits on the side of the foot stand
(optional).

3 Connect the headset (optional):

a Plug the headset cord into the headset jack on the back of
the IP Phone marked with the headset symbol.

b Thread the cord through the channel in the side of the foot
stand.

c Set up the headset according to the instructions included with
the headset.

4 Connect the global power supply (optional).

The IP Phone 1220 supports both AC power and Power over
LAN options, including IEEE 802.3af Power Classification 2.
To use PoE, where power is delivered over the CAT5-e cable,
the LAN must support PoE, and the global power supply is not
required. To use local AC power, you can order the optional
global power supply separately.

WARNING
Use your IP Phone 1220 with the approved Nortel
global power supply (model number NTYS17xxE6).

The IP Phone 1220 supports both AC power and PoL
options, including IEEE 802.3af Power Classification
2.

a Connect the Direct Current (DC) barrel connector to the
power jack on the back of the IP Phone.

b Thread the cable through the channel in the foot stand to
secure the cable.

¢ Plug the country-specific IEC cable into the global power
supply, and then plug the global power supply into the
nearest AC power outlet.

5 Install the Ethernet cable. Connect one end of the supplied
Ethernet cable to the back of your phone using the CAT5-e
connector (LAN Ethernet port), and thread the network cable
through the channel in the footstand.
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Connect the other end of the cable to your LAN Ethernet
connection. The LAN LED on the back of the IP Phone lights
when a LAN connection is established.

If you connect your PC through the phone, a second CAT5-e
cable is required. Only one cable is included with the IP Phone
1220 package. Install the Ethernet cable connecting the PC to
the phone (optional). Connect one end of the PC Ethernet cable
to your phone using the CAT5-e connector (PC Ethernet port),
and thread it through channel in the footstand. Connect the other
end to the LAN connector on the back of your PC.

The LAN Ethernet port supports Auto-Media Dependent Interface
Crossover (MDIX). Auto-MDIX is supported only when the
Ethernet port is configured for autonegotiation. The PC Port
does not support Auto-MDIX.

Wall mount the IP Phone 1220 (optional):

a Remove the footstand.

b Ensure all cables are properly routed and the IP Phone is
functioning.

¢ Make small marks on the wall where you want to align each
of the two keyhole slots.

d Insert the screws (not provided), so that they protrude slightly
from the wall.

e Align the keyholes on the back of the IP Phone with the
screws in the wall.

f Slide the IP Phone down on the screws to secure the IP
Phone in position.

—End--

When you complete the IP Phone connection, you must connect the phone
to the network. See “Dynamic Host Configuration Protocol” (page 391).

Startup sequence
When you connect an IP Phone 1220 to the network, it must perform a
startup sequence. The elements of the startup sequence include

obtaining network access (if supported by the network infrastructure)
obtaining VLAN ID (if supported by the network infrastructure)
obtaining the IP parameters

obtaining the provisioning parameters

connecting to the Call Server
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The IP Phone is configured for automatic provisioning by default. For
more information about provisioning the IP Phone automatically, see
“Provisioning the IP Phones” (page 461).

You can manually configure all or some parameters. For information about
manually provisioning the IP Phone, see “Manual provisioning of IP Phone
1110 and 1200 Series” (page 509).

Redeploying an IP Phone 1220
You can redeploy a previously-configured IP Phone 1220 on the same Call
Server. For example, the IP Phone 1220 can be assigned to a new user
(new TN) or to an existing user who moved to a new subnet by changing
the TN of the IP Phone 1220. For more information, see Converging the
Data Network with VolP Fundamentals (NN43001-260).

Procedure 35
Redeploying the TN of an existing IP Phone 1220

Step Action

1 Repower the IP Phone 1220.

During the reboot sequence of a previously-configured IP
Phone, the IP Phone 1220 displays the existing nhode number
for approximately 5 seconds.

2 If you configure the node password to NULL, choose one of the
following:

a Disable the password.
b Set the password as nonNULL.

3 Press OK when the node number displays.
If Then
you configure the node password a password screen displays. Go
to NULL to Step 4.
the node password is disabled a TN screen displays. Go to Step
5.
4 Enter the password at the password screen and press OK.

A TN screen displays.

To obtain the password, enter the nodePwdShow command in
Element Manager. For more information, see Element Manager
System Reference - Administration (NN43001-632).

Select the Clear soft key to clear the existing TN.
Enter the new TN.
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Click OK to save and accept changes.

—End--

Replacing an IP Phone 1220

ATTENTION
Two IP Phones cannot share the same TN. You must remove the IP Phone
1220 that currently uses the TN.

Procedure 36
Replacing an IP Phone 1220

Step

Action

1

Obtain the node and TN information of the phone you want to
replace.

Disconnect the IP Phone 1220 that you want to replace.

Follow “Configuring the IP Phone 1220” (page 150) to install
the IP Phone 1220. To configure the IP Phone, see “Manual
provisioning of IP Phone 1110 and 1200 Series” (page 509).

Enter the same TN and node number as the IP Phone 1220 you
replaced. The Call Server associates the new IP Phone 1220
with the existing TN.

—End--

Removing an IP Phone 1220 from service
Procedure 37
Removing an IP Phone 1220 from service

Step

Action

1

Disconnect the IP Phone 1220 from the network or turn off the
power.

The service to the PC is disconnected as well if the PC connects
to the IP Phone 1220.

If the IP Phone 1220 was automatically configured, the DHCP
lease expires and the IP address returns to the available pool.

In LD 11, enter the following:
REQ: OUT
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TYPE: 1220
TN: LLL S CC UU

—End--

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.



157

Nortel IP Phone 1230

Contents

This section contains the following topics:

Introduction

“Introduction” (page 157)

“Description” (page 158)

“Components and functions” (page 159)
“Features” (page 163)

“Display characteristics” (page 164)
“Package components” (page 166)
“Installation and configuration” (page 167)
“Redeploying an IP Phone 1230” (page 172)
“Replacing an IP Phone 1230” (page 173)

“Removing an IP Phone 1230 from service” (page 173)

This section explains how to install and maintain the IP Phone 1230. For
information about using the IP Phone 1230, see the IP Phone 1230 User
Guide (NN43142-101).

This section contains the following procedures:

Procedure 38 “Configuring the IP Phone 1230” (page 168)
Procedure 39 “Connecting the components” (page 169)

Procedure 40 “Redeploying the TN of an existing IP Phone 1230”
(page 172).

Procedure 41 “Replacing an IP Phone 1230” (page 173).

Procedure 42 “Removing an IP Phone 1230 from service” (page 173).
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Description

If power to the phone is interrupted after you install and configure an IP
phone, you are not required to reenter the IP Parameters, Node Numbers,
or Terminal Number (TN). There is also no need to again acquire the
firmware.

The IP Phone 1230 is a multi-line professional-lelP Audio Conference
Phone 2033vel deskset with a high-resolution, fully-backlit, QVGA color
LCD display. The enhanced configuration menus and USB peripheral
support provide a superior navigation experience. The integrated
Bluetooth® Audio gateway offers greater freedom and mobility. The set
includes an integrated phone switch with Gigabit Ethernet LAN and PC
ports. When the phone is idle users fully experience the personalized
background images and capabilities, as well as the Digital Picture Frame
mode.

Figure 28 "IP Phone 1230" (page 159) shows the IP Phone 1230.
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Figure 28
IP Phone 1230
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feature keys (self-labeled)
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Volume control keys Dialpad
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Components and functions
This section describes the following components and functions of the IP
Phone 1230:

* “Keys and functions” (page 159)
* “Services menu” (page 161)

* “Local Tools menu” (page 162)

Keys and functions
Table 37 "IP Phone 1230 keys and functions" (page 160) describes the
IP Phone 1230 keys and functions.
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Table 37
IP Phone 1230 keys and functions
Key Function
Handsfree Press the Handsfree key to activate handsfree mode.

Programmable line
(DN)/feature keys
(self-labeled)

Visual Alerter/Message
Waiting indicator

Context-sensitive soft keys
(self-labeled)

Navigation keys

Enter

The Handsfree light emitting diode (LED) indicator, located on the
Handsfree key, lights to indicate that the headset is in use.

Programmable line (Directory Number [DN]/feature keys
(self-labeled) are configured for various features on the IP Phone.
One must be the prime DN key.

A steady icon beside a line (DN) key indicates the line is active. A
flashing icon indicates the line is on hold. After a call arrives on a
DN key, which is not on the currently displayed page of keys, the IP
Phone automatically moves to the page with the active key.

A steady icon beside a feature key indicates the feature is active.
A flashing icon indicates the feature is being programmed. After a
call arrives on a feature key, which is not on the currently displayed
page of keys, the IP Phone automatically moves to the page with
the active key.

These keys also function as line (DN) keys. Press the Left or Right
arrow keys to access the second page of feature keys. This feature
is called Second Page functionality.

If a message is waiting, the red Visual Alerter/Message Waiting
indicator LED at the top center of the phone flashes. The indicator
also flashes to indicate an incoming call. The flash cadences for
both alerts are different.

Context-sensitive soft keys are below the LCD. The soft key label is
dynamic and depends on the active feature. The label length is a
maximum of six characters.

A triangle before a key label indicates that the key is active.

Use the Navigation keys to scroll through menus and lists that
appear on the LCD screen. The Navigation keys to move up, down,
left, and right.

Use Up and Down keys to scroll up and down in lists, and the Left
and Right keys to position the cursor. You can also use the Left and
Right keys to select editable fields that appear on the phone. Press
the Right key to select the field below the current position, or press
the Left key to select the field above the current position.

Press the Enter key, at the center of the Navigation key cluster, to
confirm menu selections. You can also use the Enter key instead of
the Select soft key.
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Table 37
IP Phone 1230 keys and functions (cont’d.)
Key Function
Message (Inbox) Press the Message (Inbox) key to access your voice mailbox when

the message waiting indicator flashes.

Redial (Outbox) Press the Redial (Outbox) key to access the Redial list.
Conference Press the Conference key to initiate conference.
Directory Press the Directory key to access Directory services.
Quit Press the Quit key to end an active application.

Pressing the Quit key does not affect the status of the calls currently
on your IP Phone.

Applications Press the Applications key to access external server applications,
such as Nortel Application Server.

Goodbye Press the Goodbye key to terminate an active call.

Hold Press the Hold key to place an active call on hold. Tap the flashing

line (DN) key to return to the caller on hold.

Headset Press the Headset key to answer a call using the headset or to
switch a call from the handset or handsfree to the headset.
The Headset LED indicator, located on the Headset key, lights to
indicate that the headset is in use.

Mute Press the Mute key to listen to the calling party without transmitting
voice from your phone. Press the Mute key again to return to a
two-way conversation. Mute key functionality applies to handsfree,
handset, and headset modes.

After you mute the transmission path, the Mute indicator LED,
embedded in the Mute key, flashes.

Volume control buttons Use the Volume control buttons to adjust the volume of the ringer,
handset, headset, speaker, and Handsfree features. Press the
upper button to increase the volume, and press the lower button to
decrease the volume.

Handsfree key Press the Handsfree key to activate the Handsfree feature.

The LED lights to indicate when handsfree is active.

Services menu
Table 38 "Services menu" (page 162) shows the Services menu.
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Table 38
Services menu

Services key Press the Services key to access the following items:

® Telephone Options
— Volume Adjustment
— Contrast Adjustment
— Language
— Date/Time Format
— Display diagnostics
— Local Dialpad Tone
— Set Info
— Ring type
— Change Feature key label
— Call Timer
— On-hook Default Path
— Live Dial Pad
— Normal Mode Indication
— Caller ID display order
® Password Administration
* Virtual Office Login and Virtual Office Logout (if Virtual Office is configured)

® Test Local Mode and Resume Local Mode (if Branch Office is configured)

You can customize the IP Phone features to meet user requirements. For
more information, see the IP Phone 1230 User Guide (NN43142-101).

To access network diagnostic utilities, double-press the Services key. Press 2 2 on the dialpad to
access the Network Diagnostic Tools menu or use the Up or Down navigation keys to scroll and
highlight Network Diagnostic Tools option. For more information about network diagnostic utilities,
see “IP Phone diagnostic utilities” (page 569).

If an incoming call is presented while you configure information in the Services menu, the phone
rings. However, the display does not update with the caller ID, and the programming text is not
disturbed.

While you are in the Services menu you cannot dial digits but you can use the programmable line
keys, such as Redial (double-press a line key) and Auto dial key to make a call. However, the
display does not update with the dialed digits or Caller ID.

Local Tools menu
Table 39 "Local Tools menu" (page 163) shows the Local Tools menu.
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Table 39

Local Tools menu

Services key

Press the Services key twice to access the Local Tools menu. The following
items appear in the Local Tools menu:

* 1. Preferences

® 2. Local Diagnostics

® 3. Network Configuration
® 4. Lock Menu

If you are prompted to enter a password when you double-press the Services
key, password protection is enabled. For more information about password
protection and the Local Tools menu, see “Local Tools menu” (page 441).

To make a selection, press the number associated with the menu item, or use
the navigation keys to scroll through the menu items. Press the Enter key to
select the highlighted menu item.

Press the Cancel key to exit from any menu or menu item.

Features

The IP Phone 1230 supports the following telephony features:
* 20 programmable line (DN)/ feature keys (self-labeled) on two pages

Use the Left or Right key to access the second page of DNs or
features.

* four context-sensitive soft keys (self-labeled)
Functions for the context-sensitive soft keys are configured in LD 11.

* volume control bar to adjust ringer, speaker, handset, and headset
volume

* Call Duration Timer
* ability to change the programmable line (DN)/feature key labels
® seven specialized feature keys

— Quit

— Directory

— Message/Inbox

— Redial (Outbox)

— Services
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— Conference
— Expand
¢ five call-processing fixed keys:
— Mute
— Handsfree
— Goodbye
— Headset
— Hold

For more information about IP Phone features, see “Features” (page 355).

Display characteristics
An IP Phone 1230 has three major display areas:

* “Programmable line (DN)/feature key label display” (page 165)
* “Information line display” (page 165)
* “Soft key label display” (page 165)

Figure 29 "IP Phone 1230 display areas" (page 164) shows these three
display areas.

Figure 29
IP Phone 1230 display areas

Upper display area
Programmable line/DN —
feature keys (self-labeled)

Middle display area
Dateftime display

Call party information
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Options information
Directories information

Lower display area e
Context-sensitive
soft keys

Cleaning the IP Phone display screen
Gently wipe the IP Phone display screen with a soft, dry cloth.
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CAUTION

Do not use any liquids or powders on the IP Phone 1230. If you
use anything other than a soft, dry cloth, you can contaminate IP
Phone components and cause premature failure.

Programmable line (DN)/feature key label display
The feature key label area displays a 9-character string for each of the four
feature keys. Each feature key includes the key label and an icon. The
icon state can be on, off, or flashing. A telephone icon displays the status
of the configured DN. Key labels are left-aligned for keys on the left side of
the screen, and right-aligned for keys on the right side of the screen.

If a label is longer than 9 characters, the last 9 characters are displayed
and the excess characters are deleted from the beginning of the string
when the string is a DN, otherwise excess characters are deleted from end
of the string.

You can use the Programmable line (DN)/feature key label feature to add
a text label on the Auto Dial keys that have a 10 digit number.

Information line display
An IP Phone 1230 has a three-line information display area with the
following information:

* caller number

* caller name

* feature prompt strings

* user-entered digits

* date and time information (if the IP Phone is in an idle state) or Call
Timer (if provisioned in the Telephone options menu)

The information in the display area changes, according to the
call-processing state and active features.

Because the IP Phone 1230 only has a one-line information display area,
you are prompted to scroll through any additional lines of information.

During an incoming call, only the Directory Number (DN) displays if the
caller name is greater than 9 characters. Press the flashing arrow to
display the caller name.

Soft key label display
The soft key label has a maximum of six characters. Each soft key
includes the soft key label and an icon. When a soft key is in use, a
triangle icon appears at the beginning of the soft key label, and the label
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shifts one character to the right. If the label is six characters in length, the
last or rightmost character is truncated. If you initiate a feature, the icon
state turns on. The icon remains in the on state until you press this feature
key again. This action cancels the enabled feature and turns the icon off,
and returns the soft key label to its original state.

Use the More soft key to navigate the layers of functions. If you assign
only four functions to the soft keys, the More key does not appear, and all
four functions display.

Package components

You must order the global power supply separately if local power using the
global power supply is required. IP Phones include integrated support for
a number of Power over LAN (Pol) options, including support for IEEE
802.3af standard power.

Table 40 "Package components" (page 166) lists the IP Phone 1230
package components.

Table 40
Package components

IP Phone 1230

handset

handset cord

footstand

2.1 m (7-ft) CAT5-e Ethernet cable

number plate and lens

Table 41 "IP Phone 1230 components list" (page 166) lists the IP Phone
1230 components and product codes.

Table 41

IP Phone 1230 components list
Component Product code
IP Phone 1230 (Charcoal with icon keys) NTYS20AA70E6
IP Phone 1230 (Charcoal with English text keys) NTYS20BA70E6
Power supply
Global power supply N0146475
IEC cables
1.8 m (5.9 ft), 10 amp, IEC320-C13 North America NTYS14AAE6
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Table 41

IP Phone 1230 components list (cont’d.)

Component

Product code

Zealand

Note: ROHS does not apply in this region.

2.4 m (8 ft), 240 VAC 10 amp, ANZ power cord AS-3, Australia, New | NTTK15AA

250 VAC, Option 11C Standard European power cord, Other EMEA, | NTTK16ABE6
Kenya, Korea, Thailand, Indonesia, Vietnam, India, Pakistan

Note: ROHS does not apply in this region.

3 m (9.9 ft) 125 VAC, Option 11C Swiss power cord Switzerland NTTK17ABEG6
240 VAC, Option 11C UK power cord Hong Kong, Ireland, United NTTK18ABEG6
Kingdom, Singapore, Malaysia, Bangladesh, Brunei, Sri Lanka

3 m (9.9 ft), 125 VAC, Option 11C Denmark power cord Denmark NTTK22ABEG6
Argentina A0814961

1.8 m (5.9 ft), 10 amp, IEC320-C13 Japan NTTK26AAE6

For more information about previous versions of the IP Phone, contact
Nortel.

Installation and configuration
The following sections provide a step-by-step guide to install and configure
the IP Phone 1230:

“Before you begin” (page 167)

“First-time installation” (page 168)
“Configuring the IP Phone 1230” (page 168)
“Connecting the components” (page 169)

“Startup sequence” (page 171)

Before you begin
Before installing the IP Phone 1230, complete the following pre-installation
checkilist:

Ensure one IP Phone 1230 boxed package exists for each IP Phone
1230 you install. For a list of IP Phone 1230 package components, see
Table 40 "Package components" (page 166).

Ensure one software license exists for each IP Phone 1230 you install.

Ensure the host call server is equipped with a Signaling Server that
runs the Line Terminal Proxy Server (LTPS) application.
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* |f a global power supply is required, ensure you use the approved
Nortel global power supply (model number NTYS17xxEB).

* Ensure the latest IP Phone firmware is deployed to the IP telephony
node. For more information, see Signaling Server IP Line Applications
Fundamentals (NN43001-125).

CAUTION

Ensure that the protective rubber cap on the Accessory
Expansion Module (AEM) port is in place when the port is not
in use. An improper connector can cause damage to the IP
Phone.

First-time installation
You must first install an IP telephony node with the Communication Server.
For information about installing an IP telephony node, see Signaling Server
IP Line Applications Fundamentals (NN43001-125).

CAUTION
Do not plug your IP Phone 1230 into an ISDN connection.
Severe damage can result.

Configuring the IP Phone 1230
Use Procedure 38 “Configuring the IP Phone 1230” (page 168) to
configure the IP Phone 1230 for the first time.

Procedure 38
Configuring the IP Phone 1230

Step Action

1 Configure a virtual loop on the Call Server using LD 97.

For more information about configuring a virtual loop, see
Signaling Server IP Line Applications Fundamentals (NN430
01-125) and Software Input Output Reference-Administration
(NN43001-611).

2 Configure the IP Phone 1230 on the Call Server using LD 11. At
the prompt, enter the following commands:

REQ:new
TYPE:1230

For more information about configuring the IP Phone 1230 using
LD 11, see Software Input Output Reference-Administration
(NN43001-611).

3 Configure the IP Phone 1230 in Element Manager. IP Phones
are configured using the Phones section in the Element
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Manager navigation tree. For more information about configuring
the IP Phone 1230 using Element Manager, see Element
Manager System Reference - Administration (NN43001-632).

—End--

Connecting the components
Use Procedure 39 “Connecting the components” (page 169) to connect the

components for the IP Phone. See Figure 30 "IP Phone 1230 connections"
(page 169).

Procedure 39
Connecting the components

Step Action

1 Attach the footstand (optional). Attach the foot stand in the
appropriate slots depending on the desired angle for your IP
Phone. If you insert the foot stand into the upper slots, your IP
Phone sits at a 25-degree angle. If you insert the foot stand into
the lower slots, your IP Phone sits at a 55-degree angle.

If you install the IP Phone on the wall, do not attach the
footstand.

Figure 30 "IP Phone 1230 connections" (page 169) shows the IP
Phone 1230 connections.

Figure 30

IP_ Phone 1230 connections

LAN Ethernet

Handset jack

Position 1 slots

Headset jack

Position 2 slots

PC Ethernet LAN LED
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a

b

Align the bottom tabs on the foot stand with the position 1
slots or the position 2 slots on the back of your IP Phone. In
position 1 the IP Phone sits at a 25-degree angle. In position
2 the IP Phone sits at a 55-degree angle.

Press the footstand into the slots until it snaps into place.

Connect the handset:

a

b

Plug the end of the handset cord with the short straight
section into the handset.

Plug the other end of the handset cord with the long straight
section into the handset jack marked with the handset symbol
on the back of the IP Phone.

Thread the cord through the channel in the footstand
(if installed) so that it exits on the side of the foot stand
(optional).

Connect the headset (optional):

a

b

Plug the headset cord into the headset jack on the back of
the IP Phone marked with the headset symbol.

Thread the cord through the channel in the side of the foot
stand.

Set up the headset according to the instructions included with
the headset.

Connect the global power supply (optional).

The IP Phone 1230 supports both AC power and Power

over Ethernet (PoE) options, including IEEE 802.3af Power
Classification 2. To use PoE, where power is delivered over the
CAT5-e cable, the LAN must support PoE, and the global power
supply is not required. To use local AC power, you can order the
optional global power supply separately.

WARNING
Use your IP Phone 1230 with the approved Nortel
global power supply (model number NTYS17xxE6).

The IP Phone 1230 supports both AC power and PoL
options, including IEEE 802.3af Power Classification
2.

a

b

Connect the Direct Current (DC) barrel connector to the
power jack on the back of the IP Phone.

Thread the cable through the channel in the footstand to
secure the cable.

Plug the country-specific IEC cable into the global power
supply, and then plug the global power supply into the
nearest AC power outlet.
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Install the Ethernet cable. Connect one end of the supplied
Ethernet cable to the back of your phone using the CAT5-e
connector (LAN Ethernet port), and thread the network cable
through the channel in the footstand.

Connect the other end of the cable to your LAN Ethernet
connection. The LAN LED on the back of the IP Phone lights
when a LAN connection is established.

If you connect your PC through the phone, a second CAT5-e
cable is required. Only one cable is included with the IP Phone
1230 package. Install the Ethernet cable connecting the PC to
the phone (optional). Connect one end of the PC Ethernet cable
to your phone using the CAT5-e connector (PC Ethernet port),
and thread it through channel in the footstand. Connect the other
end to the LAN connector on the back of your PC.

The LAN Ethernet port supports Auto-Media Dependent Interface
Crossover (MDIX). Auto-MDIX is supported only when the
Ethernet port is configured for autonegotiation. The PC Port
does not support Auto-MDIX.

Wall mount the IP Phone 1230 (optional):

a Remove the footstand.

b Ensure all cables are properly routed and the IP Phone is
functioning.

¢ Make small marks on the wall where you want to align each
of the two keyhole slots.

d Insert the screws (not provided), so that they protrude slightly
from the wall.

e Align the keyholes on the back of the IP Phone with the
screws in the wall.

f Slide the IP Phone down on the screws to secure the IP
Phone in position.

—End--

When you complete the IP Phone connection, you must connect the phone
to the network. See “Dynamic Host Configuration Protocol” (page 391).

Startup sequence
When you connect an IP Phone 1230 to the network, it must perform a
startup sequence. The elements of the startup sequence include

obtaining network access (if supported by the network infrastructure)
obtaining VLAN ID (if supported by the network infrastructure)

obtaining the IP parameters
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* obtaining the provisioning parameters

® connecting to the Call Server

The IP Phone is configured for automatic provisioning by default. For
more information about provisioning the IP Phone automatically, see
“Provisioning the IP Phones” (page 461).

You can manually configure all or some parameters. For information about
manually provisioning the IP Phone, see “Manual provisioning of IP Phone
1110 and 1200 Series” (page 509).

Redeploying an IP Phone 1230
You can redeploy a previously-configured IP Phone 1230 on the same Call
Server. For example, you can assign the IP Phone 1230 to a new user
(new TN) or to an existing user who moved to a new subnet by changing
the TN of the IP Phone 1230. For more information, see Converging the
Data Network with VolP Fundamentals (NN43001-260).

Procedure 40
Redeploying the TN of an existing IP Phone 1230

Step Action

1 Repower the IP Phone 1230.

During the reboot sequence of a previously-configured IP
Phone, the IP Phone 1230 displays the existing node number
for approximately 5 seconds.

2 If you configure the node password to NULL, choose one of the
following:

a Disable the password.
b Set the password as nonNULL.

3 Press OK when the node number displays.
If Then
you configure the node password a password screen displays. Go
to NULL to Step 4.
the node password is disabled a TN screen displays. Go to Step
5.
4 Enter the password at the password screen and press OK.

A TN screen displays.

To obtain the password, enter the nodePwdShow command in
Element Manager. For more information, see Element Manager
System Reference - Administration (NN43001-632).
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Select the Clear soft key to clear the existing TN.
Enter the new TN.
Click OK to save and accept changes.

—End--

Replacing an IP Phone 1230

ATTENTION
Two IP Phones cannot share the same TN. You must remove the IP Phone
1230 that currently uses the TN.

Procedure 41
Replacing an IP Phone 1230

Step

Action

1

Obtain the node and TN information of the phone you want to
replace.

Disconnect the IP Phone 1230 that you want to replace.

Follow “Configuring the IP Phone 1230” (page 168) to install
the IP Phone 1230. To configure the IP Phone, see “Manual
provisioning of IP Phone 1110 and 1200 Series” (page 509).

Enter the same TN and node number as the IP Phone 1230 you
replaced. The Call Server associates the new IP Phone 1230
with the existing TN.

—End--

Removing an IP Phone 1230 from service
Procedure 42
Removing an IP Phone 1230 from service

Step

Action

1

Disconnect the IP Phone 1230 from the network or turn off the
power.

The service to the PC is disconnected as well if the PC connects
to the IP Phone 1230.

If the IP Phone 1230 was automatically configured, the DHCP
lease expires and the IP address returns to the available pool.

In LD 11, enter the following:
REQ: OUT

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.




174 Nortel IP Phone 1230

TYPE: 1230
TN: LLL S CC UU

—End--
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Contents

This section contains the following topics:

Introduction

“Introduction” (page 175)

“Description” (page 176)

“Components” (page 179)

“Display characteristics” (page 182)

“Licenses” (page 189)

“Key number assignments” (page 206)

“Minimum system requirements” (page 207)

“System components” (page 208)

“Before you begin” (page 209)

“First-time installation” (page 210)

“Installing or upgrading the IP Softphone 2050” (page 211)
“Running the IP Softphone 2050 for the first time” (page 221)
“Redeploying the IP Softphone 2050” (page 221)
“Removing an IP Softphone 2050 from service” (page 222)
“Maintenance” (page 222)

This section explains how to install and maintain the IP Softphone 2050.
For information about using the IP Softphone 2050, see IP Softphone 2050
User Guide (NN43119-101).
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This section contains the following procedures:
* Procedure 56 “Configuring an IP Softphone 2050 ” (page 210).

® Procedure 63 “Upgrading the IP Softphone 2050 on your PC” (page
218).

* Procedure 64 “Removing IP Softphone 2050 (Version 1)” (page 219).

* Procedure 65 “Removing IP Softphone 2050 (Version 2 or Release
3)” (page 219).
* Procedure 66 “Installing the Accessibility Interface” (page 219)

* Procedure 67 “Installing the Windows QoS Packet Scheduler” (page
220)

* Procedure 68 “Redeploying the TN of an existing IP Softphone 2050”
(page 222).

* Procedure 69 “Removing an IP Softphone 2050 from service” (page
222).

Description
The IP Softphone 2050 is a Windows-based application that provides
voice services for Personal Computers (PC). The IP Softphone 2050
operates on PC that run Windows Vista, Windows XP, and Windows 2000
Professional.

Designed to work with IP-based phone systems, the IP Softphone 2050
provides Voice Over IP (VoIP) services using a telephony server and an
enterprise Local Area Network (LAN). The VolP application is comprised of
the following components:

* Settings—used to configure the IP Softphone
* |P Softphone 2050—the IP Softphone user interface
* |P Softphone 2050 QoS

Features
The IP Softphone 2050 supports the following features:

* 12 user-defined feature keys: six programmable line (DN)/feature keys
and six lines/features accessed by pressing the Shift key

* four context-sensitive soft keys that provide access to a maximum of
nine features

For more information about context-sensitive soft keys, see Features
and Services Fundamentals (NN43001-106).

* four-line display
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directory capabilities stored locally on the PC or linked to external
directories, such as LDAP, Microsoft Outlook, and Windows Address
Book Directory

one-click direct dialing from various windows and applications

user-selected ringer lets the PC speakers or the headset ring for
incoming calls

choice of two window themes, as well as an Accessibility Interface
option for the visually-impaired

The Accessibility Interface operates with screen reading software,
such as JAWS® for Windows from Freedom Scientific, which enables
visually-impaired users to access the full range of IP Softphone 2050
features. Visually-impaired users can follow Procedure 66 “Installing
the Accessibility Interface” (page 219) to install the Accessibility
Interface from the IP Softphone 2050 CD ROM.

Secure Real-time Transport Protocol (SRTP) media encryption.

For more information about SRTP media encryption, see “Features”
(page 355).

UNIStim Security (USec) signaling encryption
ATTENTION

USec signaling encryption requires a Secure Multimedia Controller.

UNIStim Security (USec) signaling encryption or UNIStim Security with
Datagram Transport Layer Security (DTLS)

ATTENTION

USec signaling encryption requires a Secure Multimedia Controller. DTLS
encryption can coexist with the Secure Multimedia Controller; therefore,
both types of encryption can be simultaneously on a single system. For
more information about security, see Security Management Fundamentals
(NN43001-604).

Global IP Sound (GIPS) Voice Engine

headset support (for example, Bluetooth® wireless technology and
USB)

client-side licensing
quality monitoring

programmable hot keys allow single-key access to user-definable
features

two supported input modes: Digit and Alpha

Native mode appears dimmed in the list because it is not supported.
For more information about Native mode, see IP Softphone 2050 User
Guide (NN43119-101).
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macro functions available for programming long dialing patterns

support for G.711 and G.729 codecs for operation at a variety of
network connection speeds

Additional features
The IP Softphone 2050 supports the following additional features:

Call Duration Timer
ability to change the feature key labels
Corporate Directory
Personal Directory
Redial List

Callers List

Password Administration
Virtual office

Branch Office

Call Recording

Active Call Failover

language support: English, French, Swedish, Danish, Norwegian,
German, Dutch, Traditional Chinese, Simplified Chinese, Japanese
Kanji, Japanese Katakana, Korean, Arabic, Greek, Hebrew,
Portuguese, Czech, Finnish, Hungarian, Italian, Polish, Spanish,
Russian, Latvian, and Turkish

Graphical External Application Server (GXAS)

IP Client cookie mechanism (requires patch MPLR 24248 for CS 1000
Release 5.0 and earlier)

Call Notification (requires patch MPLR 24100 for CS 1000 Release 5.0
and earlier)

Call Natification pop up screen for incoming calls feature requires
MPLR25221 for CS 1000 Release 4.50.88, MPLR24100 for CS 1000
Release 4.5 and CS 1000 Release 5.0, MPLR24248 for CS 1000
Release 5.00.31, and CNDA and DNDA defined as CLS in LD 11.
MPLR222796 is required to support UBS call pickup.

Call Disconnect Notification
drag and drop dialing
Telephony Application Programming Interface (TAPI) 3
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The Telephony Service Provider (TSP) supports basic telephony
level functions only, such as making and answering a call and ending
an active call. The IP Softphone 2050 Call Recording feature is not
accessible from the TAPI feature.

Expansion Module for IP Softphone 2050

network diagnostic utilities

For more information about IP Softphone 2050 features and the IP
Softphone 2050 Expansion Module, see IP Softphone 2050 User Guide
(NN43119-101).

Language support
The IP Softphone 2050 is affected by the following language controls:

Components

Operating system language

IP Softphone 2050 language selection—sets the language displayed
in the help screens and in the menus (select the IP Softphone 2050
language from the Application menu or during installation)

The IP Softphone 2050 supports the following main components:

Call Control window

Local Directory window

Settings window

System tray icon and menu
third-party supported applications
2050.exe application

Call Control window
You can use the 1140 Call Control Window (see Figure 31 "1140 Call
Control window" (page 180) to make and manage IP Phone calls.
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Figure 31
1140 Call Control window
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Table 42 "Call Control window elements and functions" (page 180) lists the
elements and functions of the Call Control window.

Table 42
Call Control window elements and functions
Element Function
Primary display The primary display area provides call information (for

example, Caller ID) and instructions for using certain soft
key features. In the idle state, only the date and time are

displayed.
Soft keys Four additional soft-labeled keys on the IP Softphone
2050 support a specific subset of the key features.
Answer - Click the Answer key to answer and make calls.
Hold Click the Hold key to place an active call on hold. The
el | feature key label for the line placed on hold displays a

flashing icon. Click the Line key to return to the call.

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.




Components 181

Table 42

Call Control window elements and functions (cont’d.)

Element

Release

Line keys

Volume

Mute

Directory

Inbox/Message

Shift/Outbox

Copy

Quit

Navigation arrows

Function

Click the Release key to end an active call.

Six programmable line keys represent line appearances,
DN, or features.

Use the volume keys to increase or decrease the headset
volume.

Click the Mute key to listen to the receiving party
without transmitting. Click the Mute key to return to a
two-way conversation. The Mute key mutes the headset
microphone.

Click the Directory key to access the Network Directory.

Click the Inbox/Message key to access messages or
return a call.

Click the Shift key to shift between two feature key pages
when a second feature key page exists.

Click the Copy key to copy a network service, feature, or
folder.

Click the Quit key to quit a network service or feature.

Use the navigation arrows to scroll through menus and
lists in the display area.
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Table 42

Call Control window elements and functions (cont’d.)

Element
Send/Enter

j

Dialpad
Speaker

Expand
2

Services
=

Function

Press the Send/Enter key, at the center of the Navigation
key cluster, to confirm menu selections.

The Send/Enter key is only available on the 1140E Call
Control window.

Click numbers on the dialpad to dial a number.

Press the Speaker key to answer and make calls using
the handsfree speaker.

Click the Expand key to launch the GXAS applications
window.

Press the Services key to access the following items:

Language

Date/Time

Set Info

Call Log Options

Ring type

Call Timer

Change Feature Key Label
Name Display Format

Virtual Office Login and Virtual Office Logout (if Virtual
Office is configured)

Test Local Mode and Resume Local Mode (if Branch
Office is configured)

Password Admin

— Station Control Password

Display characteristics

The IP Softphone 2050 provides the following display areas:

* information display

* soft key label display
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* keypad dialing keys display

* feature keys display

Information display area
The information display area can contain four lines of text, up to a
maximum of twenty four characters for each line. The display area
consists of 2 areas: Info line and Info window.

Info line

The Info Line is the first (top) line of display text. The left 10-character
area shows the Call Server type. The right part of the Info Line shows the
current time and date.

Info window

The Info Window display area that shows prompts and information about
calls. During a call the information area is used to display dialed digits,
calling line ID, called party name, application-specific information, and
various messages such as Release and Try Again.

When the information exceeds 3 x 24 characters, a scroll icon tells the
user to press the scroll keys to view the second line of the display.

Soft key label display
A maximum of 10 functions can be assigned to the soft keys. Functions
are assigned to the soft keys in layers in LD 11.

Use the More soft key to navigate through the layers of functions. If only
4 functions are assigned to the soft keys, the More key does not appear
and all four functions are displayed.

The soft key label has a maximum of 7 characters. Each soft key includes
the soft key label and an icon. When a soft key is in use, a flashing icon
displays at the beginning of the soft key label, and the label shifts one
character to the right. (If the label is six characters in length, the last, or
rightmost, character is truncated.) If a feature is enabled, the icon state
turns to ON. It remains in the ON state until the feature key is pressed
again. This cancels the enabled feature and turns the icon off, returning
the soft key label to its original state.

System Tray
The System Tray provides fast access to most of the IP Softphone 2050
functionality. The user can make, answer, and manage a call, as well as
access macros and features from the System Tray without opening the
Call Control window.
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USB audio adapters

The USB audio adapter enables the user to speak and hear callers and
also provides call control features, such as answer a call and place a call.
The USB Audio Kit includes the following

®* USB Headset Adapter (desktop or mobile)
* |Installation Guide
e USB cord

The following USB adapters are supported on the IP Softphone 2050
* Nortel Enhanced USB Adapter (desktop)
* Nortel Mobile USB Adapter (mobile)

* Plantronics USB wireless headsets (digital cordless and Bluetooth®
wireless technology)

* Algo Analog Terminal Adapter (ATA) is a USB adapter that lets you
use analog terminals instead of headsets. With an Algo ATA users
can, for example, use a cordless headset with their IP Softphone 2050.

The IP Softphone 2050 is compatible with the Algo ATA. For support, see
www.algosolutions.com.

USB Headset Adapter

The USB Headset Adapter provides a controlled high-quality audio
environment. For more about USB headset adapters, see IP Softphone
2050 User Guide (NN43119-101).

Registration

GIPS

When you add an IP Softphone 2050 to the network, depending on
configuration, the IP Softphone 2050 can connect to a predefined IP
address or can request an IP address from a DHCP server. The IP
Softphone 2050 then contacts the Connect Server, which instructs the 1P
Softphone 2050 to display a message on its display screen requesting the
customer node number and TN.

After you enter this information, the IP Softphone 2050 contacts the
Node Master, which selects a TPS with sufficient capacity to register the
IP Softphone 2050. The IP Softphone 2050 contacts the chosen TPS
and, if the IP Softphone 2050 is valid, registers it with the system. The
registration information saves to the IP Softphone 2050.

GIPS provides the following abilities
* voice encoding and decoding

* sound devices handling
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* network voice data flow processing
* voice quality improvement
* Dual-tone Multifrequency

* Telchemy VQMon library

For more information about configurable settings in the Sound Settings
tab, see IP Softphone 2050 User Guide (NN43119-101).

Voice encoding and decoding
GIPS supports G.711 A-law, G.711 p-law, and g.729 codecs.

Sound devices handling
You can change the volume level for input and output devices in the
Sound devices tab.

Network voice data flow processing

GIPS uses GQoS API to modify the DiffSERV code point and the 802.1p
marker bits (when supported) by setting a GQoS service level that the
Windows operating system maps to a Diffserv code point and to a 802.1p
setting. According to Microsoft Developer Network (MSDN), these settings
are set to the following recommended values for voice applications

®* ToS DSCP field is set to 0x28
® 802.1p priority field is setto 5

Voice quality

GIPS implements NetEQ, Echo Cancellation, and Noise Suppression
features. NetEQ feature is an integral part of all GIPS codecs. GIPS
NetEq software compensates for up to 30% lost packets in a LAN or WAN
environment.

The GIPS Echo Cancellation and Noise Suppression features improve the
quality of conversations by removing echo and background noise.

You can enable or disable Echo Cancellation and Noise Suppression
features in the Sound Settings tab.

Dual-tone Multifrequency

GIPS implements Dual-tone Multifrequency (DTMF) tones playing and
sends in accordance to RFC 2833. DTMF supports event numbers from
1to 16.

Telchemy VQMon
GIPS includes Telchemy VQMon library. The Telchemy VQMon library
collects and provides Voice Quality statistics information.
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Echo cancellation

Echo can generate electrically when an impedance mismatch occurs,

or can generate acoustically by feedback from a speaker or ear piece to

a microphone. Any echo that returns to the IP Softphone 2050 is more
noticeable to the listener because of the additional delay the IP connection
introduces.

The Voice Gateway Media Card includes echo cancelers as part of

its function cancels echo which the TDM side of the Media Gateway
generates. Echo cancellers enable when audio passes through the Voice
Gateway Media Card.

Because the IP Softphone 2050 does not provide an echo canceller, a
slight echo from acoustic coupling on the headset can occur in some call
situations.

Clock synchronization

Buffer underruns and overruns can occur since no sample clock is at the
receiving end of an IP audio stream synchronized to the transmitting clock.
The buffer overruns and underruns are corrected by two mechanisms,
both of which apply to the IP Phones and the DSPs on the Voice Gateway
Media Card.

Jitter buffer

QoS

Use the default value sent from the TPS (the value configured in TM—
[Nortel recommends that you use the default value]) to configure the IP
Softphone 2050 jitter buffer.

The jitter buffer has a desired size and a maximum allowable size. If the
jitter buffer exceeds its maximum allowable size, sufficient frames are
discarded to reduce the contents of the jitter buffer to the desired setting.
If the jitter buffer underruns, frames are held in the jitter buffer until it fills
to the desired level. Both underrun and overrun result in a discontinuity
in the audio.

For codecs that support silence suppression, the jitter buffer is
resynchronized at the beginning of each talk spurt.

A combination of codec selection, jitter buffer and packet time, and the
use of the DiffServ Code Point (DSCP) of the network contributes to the
end-to-end Quality of Service (Qo0S).

However, the IP Softphone 2050 is an application within the context
of the PC operating system, so the operating system has an effect
on the end-to-end QoS for the IP Softphone 2050. Functionality,
which is commonly handled in DSP hardware (such as, the codec

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.



Display characteristics 187

packetization implementation from within the Voice Gateway Media Card)
is implemented in software for the IP Softphone 2050. It runs as part of the
application code on the PC CPU. If the CPU is busy with other tasks, voice
quality can be negatively affected.

The number of buffers used to buffer audio data between the application
and PC audio hardware device driver is adjustable from the Settings >
Sound Devices window. Using fewer buffers reduces the audio path delay
but increases the chances of dropouts and choppy speech, depending on
the speed and utilization of the PC CPU.

This system-wide registry key setting affects other applications and
operating system components but is only effective if Windows QoS Packet
Scheduler is installed. For more information about Windows QoS Packet
Scheduler, see “Windows QoS Packet Scheduler” (page 220).

For Windows 2000 the Windows QoS Packet Scheduler is not installed by
default and the EnablePriorityBoost registry setting is not created.

For Windows XP the Windows QoS Packet Scheduler is installed by
default and the EnablePriorityBoost registry setting is created. The default
setting is 1 (enable QoS).

Windows 2000 and Windows XP require a system-wide registry key to
enable QoS capabilities. You must have Administrator privileges to create
or modify the following value:

HKEY_LOCAL_MACHINE/SYSTEM/CurrentControlSet/Services/Qossp/
EnablePriorityBoost

Value 0—do not enable QoS

Valuel—enable QoS

Trace utilities can be used to verify QoS settings. See “Ethereal traces”
(page 189).

QoS settings

The IP Softphone Version 1 includes a QoS tab in the Configuration utility.
You can enable or disable 802.1Q/p settings. The QoS tab provides the
following settings:

* Enable—sends 802.1Q/p whether it is supported by the network or not

* Disable—does not send 802.1Q/p whether it is supported by the
network or not

* Automatic Detection—sends 802.1Q/p packet, which requires a
response from the TPS. If the TPS replies, 802.1Q.p is used. If the
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TPS does not reply, the same packet is sent without 802.1Q/p. If the
TPS replies, then 802.1Q/p is not used.

To prevent improper assignment of these settings, this tab is removed in
IP Softphone Version 2. The 802.1Q p settings are automatically detected.

QoS is otherwise supported in IP Softphone 2050 Version 2 as it was in IP
Softphone 2050 Version 1.

Application thread priorities

Priorities are determined by thread priorities. The i2050QosSvc.exe
application consists of threads, which run the Graphical User Interface
(GUI) and audio threads. Thread priorities increase from the base priority
of the process, as needed. The audio threads boost to high priority, as
recommended by Microsoft, while the GUI maintains a normal priority.
Increasing the process priority implies that the operating system may not
perform properly. This concern restrains the IP Softphone 2050 to use
Windows recommended priorities to avoid an unpredictable degradation
in general OS performance.

Codec
The IP Softphone 2050 provides the following codecs:

* G.711 provides the highest quality (if the network facilities can handle
the packet flow) because there is no compression.

* (G.729 is ranked best; it has 8:1 compression but no voice activity
detection.

Frame size
The IP Softphone 2050 supports the following range of frame sizes

* (G.711-64 A-law and plaw: 10-960—10 ms increments
* (G.729A: 10-960—10 ms frames
e (G.729AB: 10-960—10 ms frames

i2050QosSvc.exe
i2050QosSvc.exe provides QoS tagging to outgoing 2050 IP packets.
When the IP Softphone 2050 application opens a socket, the i2050QosSvc
software monitors traffic destined for the specified IP address and port.
1i2050QosSvc software sets DiffServ QoS priority bits.

802.1 p priority bits in the 802.1Q header can be set. 802.1Q headers
must be enabled by the Network Interface Card (NIC) or NIC driver.
The i2050QosSvc does not fill in other fields in the 802.1Q header (for
example, no values are assigned to the VLAN ID field).
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ATTENTION

VLAN ID

The default VLAN ID value in Windows is 0. This can be overwritten for Network
Interface Cards (NIC) that support 802,1Q. The 2050 processes do not assign
values to the VLAN ID field. This setting is documented with the NIC or the NIC
driver.

The VLAN ID for an application must match the VLAN ID for the PC because the
PC has only one IP stack for each NIC. A second IP stack is required to assign
a specific VLAN ID tag for an application which is different than the PC tag.

You can use two different IP cards, each with different VLAN ID values on a
single PC; however, this can cause security gaps on the voice VLAN, which is
normally a more secure network than the data LAN.

DiffSERV (DSCP)
The IP Softphone 2050 uses DSCP settings assigned by the TPS. The
IP Softphone 2050 supports DSCP on Windows 2000 Professional and
Windows XP. For information about configuring DiffServ values, see
Signaling Server IP Line Applications Fundamentals (NN43001-125).

802.1p
For information about configuring 802.1p values, see Signaling Server IP
Line Applications Fundamentals (NN43001-125).

Ethereal traces
Current versions of Ethereal show 802.1Q headers, if they are present.
802.1Q must be enabled on the NIC for the headers, which includes
802.1p to be captured.

GXAS
The IP Softphone 2050 Release 3.1 supports GXAS, which enables the
user to start applications that are available on the GXAS server. You must
manually configure the CSV file on the GXAS server to support the IP
Softphone 2050. For more information, see Nortel Application Gateway
1000/2000 Administration Guide (NN42360-600).
Licenses

The IP Softphone 2050 Release 3.0 requires a license to operate. If the
phone cannot obtain a license from one of the licensing schemes then it
cannot connect to a Call Server and an error message appears on the
phone screen.

While the IP Softphone 2050 runs, it first goes through three licensing
schemes before it connects to Call Server. After the phone obtains a
license, it repeats the procedure at a random interval. If the licensing
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scheme fails then the IP Softphone 2050 disconnects from the Call Server
unless you are on an active call, in which case the phone does not
disconnect until the call ends.

The licensing schemes are as follows:
®* “Check out license” (page 190)

® “Cached license” (page 190)

* ‘“Evaluation period " (page 190)

Check out license
The IP Softphone 2050 tries to obtain or checkout a license from a License
Server. These licenses are stored on a License Server machine located
on your network. For information about how to install and configure a
Licensing Server, see “Provisioning a License Server” (page 193). After
a client successfully checks out a license from the License Server a
heartbeat mechanism activates to validate the license every 2 minutes. If
the heartbeat is lost then the client attempts to reconnect to the server 5
times before it loses the checked out license.

Cached license
After the IP Softphone 2050 successfully checks out a license from the
License Server, it records the license details in a secure location. You can
refer to this license as a backup license. The cached license is available
for 5 days.

Evaluation period
After you install the IP Softphone 2050, it can run without a license for a
period of 30 days. After the expiration date passes, you must run the IP
Softphone 2050 Settings tool to specify a License Server. Otherwise, the
phone cannot connect to the Call Server.

License restrictions
The following license restrictions apply to the IP Softphone 2050 Release
3.0.

* If at any time you rewind the system date by more than 24 hours, the
IP Softphone 2050 evaluation period license and cached license are
both invalidated.

* Software reinstallation does not reset the license to provide another
30-day evaluation period.

* After you receive a valid license, you cannot return to the evaluation
license even if the evaluation period has not expired.
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* The IP Softphone 2050 requires a connection to the Licence Server, a
cached license, or time remaining for the evaluation period to place
an emergency call.

* |f you configure redundant license servers, the licenses sold are locked
to the Fully Qualified Domain Name (FQDN) of the license server host
machine. If the host machine fails, you can reconfigure a computer
with the same host domain name to host the licenses (license file). For
information about configuring redundant license servers, see “Server
Redundancy” (page 196).

License types
The following two types of licenses exist:

®* ‘“Upgrade licenses” (page 191)
*  “Normal R3 licenses” (page 191)

* “Post-R3 licenses” (page 191)

Upgrade licenses

An IP Softphone 2050 that upgrades from the IP Softphone 2050 V2 or
lower attempts to check out an Upgrade License before it checks out a
Normal R3 license from the License Server. In other words, if you upgrade
your IP Softphone 2050 from a previous release then you can use an
upgrade license instead of a Normal R3 License.

If you upgrade your IP Softphone 2050 R3 to a later release, use Post-R3
licenses.

Normal R3 licenses
A Normal R3 License is a regular license that non-upgrade clients attempt
to check out from the server.

The distinction should be made when you request licenses from your
distributor. If your site has prior releases of the IP Softphone 2050 you can
be eligible to purchase Upgrade Licenses instead of Normal R3 Licenses.

Post-R3 licenses
Post-R3 (upgrade) licenses convert licenses from a major license version
to a later version.

License Server
The License Server Manager and the vendor daemon make up the
License Server system. The License Server Manager is the main point of
contact for FLEX-enabled applications, which require license certificates.
These applications then redirect to the appropriate vendor daemon.
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The License Server contains Licenses certificates.

Because the License Server components are lightweight, you can install
the components on any machine, which runs one of the following operating
systems

Microsoft Windows 2000
Microsoft Windows 2000 Server
Microsoft Windows XP
Microsoft Windows 2003 Server

Microsoft Windows Vista

The Licensing Server requires ports 27000 and 27001 to be accessible.
You can modify the TCP/IP port number of the License Server Manager
(Imgrd) in the Server line. For information about modifying the Server line,
see “License file” (page 196).

How to configure ports for licensing
The following are the steps to configure ports for licensing:

1. The 2050 starts to send the TCP packets to the license server. The IP

address and port are retrieved from the 2050 settings (License Servers
prop page). If no port information is typed, the default range (27000

- 27009) is used. If you need to change this port range, you need to
make changes on both sides: 2050 settings and license file (SERVER
line). Make sure that this port is opened and listened on by server.

Settings
The settings -> License Servers prop page: 172.2.2.2:27001

the counted.lic file: SERVER this_host HOSTNAME=host-1.corp.norte
l.com PORT=27001

The vendor daemon starts to work and uses the random port for server
(it is not random always). The vendor information is transmitted to
2050 client by the Server Manager and the 2050 starts to send the
TCP packets to this port.

To control the port for vendor daemon you need to change the
VENDOR line in counted.lic file.

VENDOR line in counted.lic file
VENDOR nortelip PORT=1052
2050 client side changes are no longer required
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License Server components
The License Server includes the following components:

* vendor daemon-service which provides license rights to IP Softphone
2050 clients (nortellP.exe)

* License Server Manager (Imgrd.exe)
* FLEXnet Licensing Administration Tools
— command line tools available with the installer
— Imtools.exe—graphical user interface (GUI) for license server
management

For FLEXnet Licensing and license management provided by Macrovision,
go to www.macrovision.com.

Provisioning a License Server
This following sections provide steps on how to provision a licensing server
with valid licenses:

* “Installing the License Server” (page 193)
® “Obtaining a valid license” (page 194)

® “Starting the License Server Manager” (page 195)

Installing the License Server
Use the following procedure to install the License Server components.

Procedure 43
Installing the License Server

Step Action

1 Obtain the IP Softphone 2050 License Server Installer
from the IP Softphone 2050 CD-ROM or download it from
www.nortel.com.

On your license server, execute the file setup_server.exe.
Click Next on the Welcome window.

If you agree with the terms of the License Agreement, select the
appropriate button and click Next.

The Welcome to the InstallShield Wizard opens.
Click Next.

Choose the Installation Path of the target directory for the
License Server component files.

A Confirmation window appears.
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7 Click Next.
A progress bar appears to show the progress of the installation.
8 To install the License Server as a Windows Service, select the
"Install as a service" checkbox.
9 Click Finish.

The window closes.

—End--

Obtaining a valid license

The Nortel Keycode Retrieval System (KRS) generates the
keycode license file. You must register for access to KRS. Go to
www.nortel.com/support/tools/krs to register to KRS.

ATTENTION
Before you can obtain a license, you must possess a valid Fully Qualified
Domain Name (FQDN), for example, yourlicenseserverl.yourcompany.com.

Use the following procedure to obtain a valid license. In this procedure,
yourlicenseserverl.yourcompany.com is used as the FQDN.

Procedure 44
Obtaining a valid license

Step Action

1 To view your FQDN, select Start > All Programs > Nortel > IP
Softphone 2050 Licensing Server > GetHostID.

Go to www.nortel.com/support/tools/krs.

Login to Keycode Retrieval System (KRS).

For information about creating key codes, see the KRS User
Guide at www.nortel.com/support/tools/krs. Select Product
family, Documentation, Forms and User Guides.

4 On the Retrieve Keycode page, enter your FQDN (for example,
yourlicenseserverl.yourcompany.com) in the System ID (site ID)
field.

5 Select the product keycode from the list, then save file, for

example, yourlicenseserverl.yourcompany.com.lic to a
directory on your PC .

Before you continue with the following steps, Nortel recommends
that you shut down your license server.

6 To shut down your license server, go to Start > All Programs >
Nortel > IP Softphone 2050 License Server > Manual Server
> Shut Down License Server.
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7 Go to the directory on your PC where the License
server software is located, for example, C:\Program
Files\Nortel\IPSoftphone2050. Rename the file counted.lic to
counted_old.lic.

8 Go to the directory where yourlicenseserverl.yourcompany.co
m.lic is located. Move yourlicenseserverl.yourcompany.com.
lic to the directory where the License Server software is located,
for example, C:\Program Files\Norte\IPSoftphone2050.

9 Rename yourlicenseserverl.yourcompany.com.lic to
counted.lic.
10 Restart the License Server. Go to Start > All Programs >

Nortel > IP Softphone 2050 License Server > Manual Server
> Restart License Server.

--End--
Procedure 45
Verifying user licenses
Step Action
1 Go to Start > All Programs > Accessories > Command

Prompt to open the Command Prompt window.

2 From the Command Prompt window, go to the directory on your
PC where the License server software is located, for example,
C:\Program Files\Norte\IPSoftphone2050.

3 At the prompt, enter Imstat -A.

The number of user licenses and the number of licenses in use
display.

—End--

Starting the License Server Manager
Use one of the following options to start the License Server Manager:

* “Manual server ” (page 195)

* “Configure as a service” (page 196)

Manual server

If the server is run as "manual server” a console window appears on the
desktop, which displays the output of both the Imgrd.exe and nortelip.exe
processes.
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Server

You can select one of the following options from Start > All Programs >
Nortel > IP Softphone 2050 License Server > Manual Server.

* Restart Licensing Server
® Shut Down Licensing Server

® Start Up Licensing Server

Configure as a service

If the server is run as “server service” the server can supply licenses even
when you are not logged on to the computer. You can observe the status
of the service in the Windows Services administrative tool. The output

of the Imgrd.exe and nortelip.exe processes, writes to a log file called
“ServicelLog.log” in the installation path of the licensing server.

You can select one of the following options from Start > All Programs >
Nortel > IP Softphone 2050 License Server > Server Service.

* Install Licensing Server as a Service
* Uninstall Licensing Server Service

* Restart Licensing Server Service

Redundancy

Select a stable machine for server redundancy. When a server is no
longer available (for example, failure), the Site Administrator can rename
the new server with the existing host domain name and can then reinstall
the licensing server software and the associated counted.lic file. For
information about installing the licensing server software, see “Installing
the License Server” (page 193).

License file

You can modify the following elements in the license file
®* Host name on the SERVER line
®* TCP/IP port number on the SERVER line

The SERVER line specifies the host name and hostid of the license server
system and the TCP/IP port number of the license server manager (Imgrd).

The format of the SERVER line is:
SERVER host hostid [port]

For more information, see Table 43 "License file" (page 197).

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.



Licenses 197

Table 43
License file
Field Description
host The system host name or IP address.
On NT/2000/XP, ipconfig / all; on Windows 95/98/ME, winipcfg/all
return the host name.
hostid The hostid generated by the Get Host ID command.
KRS requires the host ID in order to provision the server system
with valid licenses.
port TCP/IP port number to use. A valid number is any used port

number between 0 and 64000.
If you do not specify a TCP/IP port number, one of the default
ports in the range of 27000 to 27009 is used.

For information about port numbers, see “Port numbers” (page 669).

FLEXnet licensing error codes

For information about FLEXnet licensing error codes, see “FLEXnet
licensing error codes” (page 683).

Troubleshooting

The section assumes you have installed the License Server on a PC in the
customer’s network. Nortel recommends you install the License Server

as a Service. This ensures the server supplies licenses even if you are

not logged on to the computer. Install the Licensing Server on a server
that is always on.

You can use the Imtools.exe utility to manage the License Manager.
It can be found in a directory on your PC. For example, D:\Program
Files\Nortel\IP Softphone 2050 Licensing Server\imtools.exe.

This section describes the following procedures:

* Procedure 46 “Checking the status of the server” (page 198)

* Procedure 47 “Verifying Config Services” (page 199)

* Procedure 48 “Viewing the ServicelLog.log file” (page 199)

* Procedure 49 “Viewing log files for IP Softphone 2050 clients” (page
200)

®* Procedure 50 “Viewing System Settings” (page 201)
* Procedure 51 “Displaying License Server DNS information” (page 201)

* Procedure 52 “Verifying an IP Softphone 2050 registers with the
License Server” (page 202)
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* Procedure 53 “Validating connection to the License Server” (page 204)

* Procedure 54 “Releasing an unused license on the IP Softphone 2050”
(page 205)

Procedure 46
Checking the status of the server

Step

Action

1

Launch the Imtools.exe utility from the directory on your PC. For
example, D:\Program Files\Nortel\IP Softphone 2050 Licensing
Server\imtools.exe.

The LMTools Graphical User Interface (GUI) opens.
Click the Server Status tab.
Click the Perform Status Enquiry button.

Information about the server status, the license server file, and
the number of licenses available and in use display in the bottom
section of the LMTools GUI window. See Figure 32 "Server
status window" (page 198).

Figure 32

Server status window

LMTOOLS by Macrovision Corporation hitp:/fewsw.macrovision.com
Fle Edt Mode Help

Senvice/License File | System Sefings | Uties | Siat/Stop/Reead Server Stalus . Server Diags | Conlig Services | Bonowang |

Helps 1o morstor the status of networ: kcenng activiie:

Options
Indirvidual Dasmon [
[ Padorn St Enaty | IndvidlFostue |

Server Name |

[Detecting lmgrd processss...]
License server status: I7000@47.11.186.178

License fileis) on 47.11.186.178: D:\Program Files\Nortel\IP Softphone 2050
Licensing Server\countaed. lic

47.11.18€.178: licenss server UP vlil.4

[Vendor daemcon status (on dhoward-1): A

[Usng Ucense Fle: D:\Program Fles\NorehIP Soliphone 2050 Licensng Server\counted ke

If the total number of licenses do not match the number

you purchased ensure that you have the latest license file
installed. The KRS generates the keycode license file. For more
information, see “Obtaining a valid license” (page 194).

—End--
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Procedure 47
Verifying Config Services

Step

Action

1

Launch the Imtools.exe utility.
The LMTools Graphical User Interface (GUI) opens.
Click the Config Service tab.

Ensure the Start Server at Power Up and Use Services check
boxes are selected. See Figure 33 "Config Services window"
(page 199).

Figure 33

Config Services window

LMTOOLS by Macrovision Corporation hitp:/fww. macrovision,com
File Edt Mode Help
Service/License Fie | System Seting: | Utiiies | Stan/Stop/Reread | Server Status | Server Diage  Conbig Senvices | Bancwang |

Conliguie Service ’
Save Service |

SeraceName  [Noel [P Saltphone 2050 Licenting Server 5 |
- Aemove Sernce

Palhtothe Ingrdexefle |0 \Progrom Fies\NortelP Scltphone 2050 Lice Biowz |
Pahoheioametls [0 Popen FlerWonP Sciphars 50T Bowse |
Pathlathe debuglog e [Serviceloglog Biowse | [View Log. |

I Start Server at Power Up W Use Services

—End--

Procedure 48
Viewing the ServicelLog.log file

Step Action

1 Launch the Imtools.exe utility.
The LMTools Graphical User Interface (GUI) opens.
Click the Config Service tab.
Click View Log to view the ServicelLog.log file.
The ServicelLog.log file shows if the license server is active and
which users have checked in or checked out licenses. See
Figure 34 "Servicelog.log file window" (page 200).

4 Click Close Log.
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Figure 34
Servicelog.log file window

[GorviceLog log

20:24 (imgrd) FLEXnet Licensing (v11.4.100.0 buid 50818 185_n3) stated on dhoward-1 (|BM PC) [2/4/2008] &
2024 (mgrd) Copynight (c) 1988-2007 Macrovision Ewope Lid. and/or M acrovision Coeporation. All Flights Resery
20:24 (Imgrd) US Patents 5,390,297 and 5,671 412

20024 (mgrd) ‘World Wide Web: hitp://vww mactovison com

20:24 (imgrd] License file{s} D;\Program Files\NortelUP Softphone 2050 Licensing Server\counted ic

20:24 [ingre] Imgrd tep-port 27000

20024 (ingrd] Starting vendor dasmons

20075 (ngrd) Started nortelp (pid 1484)

20:26 (nontelp] FLEX et Licensing version v11.4.100.0 buld 50818 i86_n3

3 20: 26 [noitelp) Server started on dhoward-1 for: 2050

320:26 [nortelip) EXTERNAL FILTERS ae OFF

92026 (imgrd] nortelip using TCP-port 1054

11:31:23 [notelip) TCP_NODELAY NOT enabled

11:57 57 [nortelip) OUT: 2050 DHOWARD @dhoward-1

11:58:00 [nodtelip] IN: 2050 DHOWARD @dhoward-1

11:58:00 [nortelip) OUT. 2050 DHOWARD @dhoward-1

11:58:20 [nodelp] IM: 2050 DHOWARD @dhoward-1

11:58:20 [nostelip) OUT: “2050" DHOWARD @dhoward-1 w

< >

2
3
3
2
3
3
2
3
2

~End--

You can also view logs for all IP Softphone 2050 clients that hold licenses.

Procedure 49
Viewing log files for IP Softphone 2050 clients

Step Action

1 On your PC, click Start > Search to open the Search Results
window. Search for usec.log in files and folders.

2 Enter usec.log to locate the log files.
Click Tools > Folder Options.

4 Select the View tab.
Ensure that "Search hidden files and folders" check box is
selected.
Click OK.

Click Search Now.

Log files appear in the left pane. Log files usually store in the
Profiles folder. For example, D:\Profiles\jsmith\Application
Data\Nortel\IP Softphone 2050\Logs.

—End--
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Procedure 50
Viewing System Settings

Step Action
1 Launch the Imtools.exe utility.

The LMTools Graphical User Interface (GUI) opens.
2 Click the System Settings tab.

The System Settings tab displays basic information, such as
Server IP address and HostID. Select the "Include Domain”
checkbox to display the Fully Qualified Domain Name (FQDN)
Host ID. Ensure the Host ID is a FQDN. Also, ensure it is exactly
the same as the name registered with KRS that was used to
generate the keycode. If the names do not match the server
does not come up.

—End--

Procedure 51
Displaying License Server DNS information

Step Action

1 Go to Start > All Programs > Accessories > Command
Prompt to open the Command Prompt window.

2 From the Command Prompt window, enter ipconfig -all.

The Host Name and Primary DNS Suffix display. Ensure you
configure the Primary DNS Suffix with the registered domain
name; otherwise, your FQDN license keycode file does not work.
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Figure 35
License Server DNS information
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—End--

Procedure 52
Verifying an IP Softphone 2050 registers with the License Server

Step Action

Click the Menu button.
Select Help > IP Softphone 2050 Diagnostics.

If the IP Softphone 2050 is registered with the License Server,
the License Server address appears and show the Current
License Expiration field appears as “No Expiration”. See Figure
36 "IP Softphone registered with the Licence Server" (page 203).
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Figure 36
IP Softphone registered with the Licence Server
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~End--

If the IP Softphone 2050 loses communication with the License Server
the following occurs: the License type appears as Cashed License, the

License Server Address appears as Not Applicable and the Current
License Expiration field shows the cached license expiry date. The

Licensing Server issue must be resolved by this date; otherwise, the IP

Softphone 2050 does not function. See Figure 37 "IP Softphone 2050 not

registered with the License Server" (page 204).

ATTENTION

5 days is the maximum time allowed before the IP Softphone 2050 becomes

non-functional.
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Figure 37

IP Softphone 2050 not registered with the License Server
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If the License Type field displays "Cached License", use the following
steps to validate connectivity to the Licensing Server.

Procedure 53
Validating connection to the License Server

Step Action

1 Go to Start > All Programs > Accessories > Command
Prompt to open the Command Prompt window.

2 From the Command Prompt window, enter Ping and the Licence

Server |IP address.

See Figure 38 "Successful Ping" (page 204).
Figure 38
Successful Ping
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v Command Prompt i-O x
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Validate License Server settings. Use one of the following
options to open the Settings window:

* From the Windows operating system:

— Select Start > Programs > Nortel > |IP Softphone 2050
> |P Softphone 2050 Settings.

— Select Start > Control Panel > IP Softphone 2050. (In
Windows XP, select Switch to Classic View to view the
list of settings.)

* From the IP Softphone 2050 Call Control window:
— Click the Menu button and select File > Settings.
Select Server from the list in the left pane of the Settings

window. Validate that the correct IP address or host name is
configured.

—End--

Also, check with the system administrator that the port used for the
License Server is open and is not blocked. If you are using a VPN
connection, make sure it is connected and there are no port restrictions
that can block access to the Licensing Server.

When two or more licenses are being used by the IP Softphone 2050, you
can release the unused licenses.

Procedure 54
Releasing an unused license on the IP Softphone 2050

Step Action

1 Press Ctrl + Alt + Delete simultaneously on your keyboard.
The Window Security window opens.

2 Press Task Manager.
The Windows Task Manager window opens.

3 Select the Applications tab.

Select the i2050.exe application(s) that you want to release.
Click End Task.

—End--
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Key number assignments

The IP Softphone 2050 has 6 keys that present 12 feature keys, with 6 on
each feature key page. The keys are numbered from 0 to 11. The Shift
key is used to change between two feature pages, 0 to 5 and 6 to 11.

If a feature requires a feature package that is not present for the Call
Server installation, that feature does not appear within the default
configuration for the IP Softphone 2050.

The Message key is numbered 16. If Message Waiting is not configured,
then key 16 must be NUL.

Key numbers between 17 to 31 are assigned to the four soft label keys
immediately below the display area. The supported features are: A03,
A06, CFW, CHG, CPN, PRK, PRS, RGA, RPN, SCU, SCC, SSU, SSC,
and TRN. For more information, see “IP Phone context-sensitive soft keys”
(page 677).

Table 44 "IP Softphone 2050 soft keys" (page 206) describes the IP Phone
feature assignment for each soft key. Use LD 11 to program keys 16 to 26
on the IP Softphone 2050.

If you attempt to configure anything other than the permitted response, the
Call Server generates an error code.

Table 44
IP Softphone 2050 soft keys
Prompt Response Description
Key 16 MWK Message Waiting key
NUL Removes function or feature from key
Key 17 TRN Call Transfer key
NUL Removes function or feature from key
Key 18 A03 three-party conference key
A06 six-party conference key
NUL Removes function or feature from key
Key 19 CFwW Call Forward key
NUL Removes function or feature from key
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Table 44
IP Softphone 2050 soft keys (cont’d.)

Prompt Response Description
Key 20 RGA Ring Again key

NUL Removes function or feature from key
Key 21 PRK Call Park key

NUL Removes function or feature from key
Key 22 RNP Ringing Number pickup key

NUL Removes function or feature from key
Key 23 SCU Speed Call User

SSsuU System Speed Call User

SCC Speed Call Controller

SSC System Speed Call Controller

NUL Removes function or feature from key
Key 24 PRS Privacy Release key

NUL Removes function or feature from key
Key 25 CHG Charge Account key

NUL Removes function or feature from key
Key 26 CPN Calling Party Number key

NUL Removes function or feature from key

Keys 27 to 31

Reserved

Minimum system requirements
The minimum recommended system hardware for the IP Softphone 2050
application are as follows:

Pentium-compatible CPU (2.5 gigabits or higher)

128 megabytes (MB) RAM or higher for Microsoft Windows 2000

256 MB RAM or higher for Windows XP
55 MB free hard drive space (all languages)
800 by 600 resolution monitor (16-bit color)
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Universal Serial Bus (USB) port (version 1.1 or 2.0)
USB Audio adapter

For information about supported operating systems, see IP Softphone
2050 User Guide (NN43119-101).

Perform the software version upgrade for IP Softphone 2050 manually.
The technician must do this at the PC. The Voice Gateway Media Card
does not download any software to the IP Softphone 2050.

The IP Softphone 2050 does not have an ACD Supervisor headset
jack. Agent walkaway is supported with the Nortel Enhanced USB
Adapter (desktop) and the Nortel Mobile USB Adapter (mobile).

An IP Softphone 2050 does not register against a TN configured for
any other type of IP Phone.

Soundcard audio is supported only for incoming call notification. Nortel
supports USB Headset Adapter for the speech path.

3 menu options available on the IP Phone 2004, not required on the IP

Softphone 2050, are

— Volume adjustment
— Contrast adjustment
— Key click

System components

The IP Softphone 2050 is comprised of an external Universal Serial Bus
headset adapter (Nortel Enhanced USB Adapter [desktop]) and a software
application installed on the user PC. The IP Softphone 2050 also supports

a mobile adapter (Nortel Mobile USB Adapter).

Table 45 "IP Softphone 2050 package components" (page 208) lists the IP

Softphone 2050 package components.

Table 45
IP Softphone 2050 package components

Component

Code

Nortel Mobile USB Adapter

Nortel Mobile USB Adapter Monaural Headset IP Softphone
2050 Kit includes

® |P Softphone 2050 application software CD/ROM

* Nortel Mobile USB Headset Adapter with Monaural
Headset (Non-RoHS)

NTEX14MD

NTDWS83BA
NTEX14MB
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Table 45

IP Softphone 2050 package components (cont’d.)
Component Code
Nortel Mobile USB Headset Adapter (no headset) NTEX14MA
Nortel Mobile USB Headset Adapter (no headset) (RoHS) NTEX14MAE6
Nortel Enhanced USB Adapter (desktop)
Nortel Enhanced USB Audio (desktop) kit NTEX14AA
Nortel Enhanced USB Audio Adapter (no headset) NTEX14AB
USB Audio Kit with GNN DuraPlus Monaural Headset NTEX14AC
(Non-RoHS)
USB Audio kit with GNN DuraPlus Monaural Headset (RoHS) | NTEX14ACE6
Nortel Handset cord (Charcoal) for use with the Nortel NTEX14BA

Enhanced USB Audio Adapter Kit

Before you begin

The following section provides a step-by-step guide through the
IP Softphone 2050 configuration process. Complete the following

pre-installation checkilist.

Procedure 55
Preinstallation checklist

Step Action

Ensure you have the IP Softphone 2050 application software CD.

Ensure you install the Licensing Server.

Ensure the host call server is equipped with a Signaling Server
that runs the Line Terminal Proxy Server (LTPS) application.

4 Understand the following configuration modes from which you
can choose from as you proceed through the installation of the

IP Softphone 2050.

¢ Static IP address—During installation, use the dialpad to
enter the IP address, subnet mask, and default Gateway

address. You must also enter the Connect Server parameters

including IP address, port number, action, and retry count.

¢ Partial DHCP—During installation, use the dialpad to enter
the Connect Server parameters including: IP address, port
number, action, retry count, IP Phone password, node ID,
and TN. Other parameters (IP Phone IP address, subnet
mask, and default Gateway) are obtained from the DHCP

server.
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5

A DHCP server and DHCP relay agents, if required, must also
be installed, configured, and running.

—End--

First-time installation
During the first-time installation, the two IP address parameters
entered either manually or automatically, depending on the installation
configuration. They are as follows:

Static IP address assignment
Partial DHCP

Installing the IP Softphone 2050 for the first time
Use Procedure 56 “Configuring an IP Softphone 2050 ” (page 210) to
install an IP Softphone 2050 for the first time.

Procedure 56
Configuring an IP Softphone 2050

Step

Action

1

Install the Voice Gateway Media Card. For more information,
see Signaling Server IP Line Applications Fundamentals
(NN43001-125).

Configure a virtual loop on the Call Server, using LD 97.

For more information, see Software Input Output
Reference-Administration (NN43001-611).

Configure the IP Softphone 2050 using LD 11. At the prompt,
enter the following

REQ: new
TYPE: 2050PC

Install the USB Headset Adapter. If you are using the mobile
adapter, connect the headset to the adapter. If you are using the
desktop adapter, you must

a Connect the coiled lower cord to the headset cord with the
Quick Disconnect connector. Ensure the Quick Disconnect
connector is securely fastened.

b Connect the headset cord to the RJ9 jack on the adapter.

Connect the USB cable to the headset adapter and to one of the
USB jacks on the back of your PC or USB hub.

The first time the headset adapter is plugged in, a delay occurs
while Windows configures the device and locates the appropriate
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driver softw are. During the installation, you are prompted to
supply the original Windows CD-ROM so Windows can locate
the required drivers.

Install the IP Softphone 2050.

Configure the IP Softphone 2050 parameters. Click the Server
tab in the Settings window and choose one of the following

* To manually configure the IP Softphone 2050 parameters,
enter the IP address of the Signaling Server type, port
number, and retries.

®* For DHCP, select the check box beside Automatic (DHCP).
The IP address, Server type, port number, and retries are
automatically retrieved from the DHCP Server.

For more information about using partial DHCP, see “Dynamic
Host Configuration Protocol” (page 391).

8 Click Apply.

—End--

Installing or upgrading the IP Softphone 2050
Use the following options to obtain Version 1 and Version 2 software for
the IP Softphone 2050

* new installation—installing the IP Softphone 2050 for the first time

* upgrade—upgrading the IP Softphone 2050 to the latest version

IP Softphone Version 1 and IP Softphone Version 2 can coexist on a PC,
although both versions cannot run at the same time.

After you install Release 3.0, you must remove previous versions of
software. License certificates issued for the IP Softphone 2050 work for all
minor version variations in the same major release. But when you plan a
major software upgrade, you must purchase new license certificates. For
information about upgrading to Release 3, see “Licenses” (page 189).

IP Softphone 2050 Release 3.1 supports remote installation, which
enables you to deploy the software without the need to install it on each
PC.

Before performing a new installation or an upgrade, check the version of IP
Softphone 2050 software.
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ATTENTION
Before you upgrade an IP Softphone 2050, record the information found in the
Server window. You may require this information later.

Remote installation
IP Softphone 2050 Release 3.1 uses Active Directory to perform the
remote installation. The Microsoft Installer Package (.MSl file) publishes or
assigns the application. The Group Policy Object distributes the software
to the groups you specify.
This section describes the following tasks:
®* Procedure 57 “Creating a distribution point ” (page 212)
®* Procedure 58 “Creating a Group Policy Object” (page 212)
* Procedure 59 “Assigning software ” (page 213)
* Procedure 60 “Publishing software” (page 214)
* Procedure 61 “Redeploying software” (page 215)

* Procedure 62 “Removing software” (page 216)

Procedure 57
Creating a distribution point

Step Action

Log on to the server computer as an administrator.

Create a shared network folder, in which to place the Microsoft
Software Installer (MSI) package that you want to distribute.

3 Configure permissions on the shared network folder to allow
access to the distribution package.
4 Copy or install the MSI package to the distribution point.
--End--

Procedure 58
Creating a Group Policy Object

Step Action

1 Click Start > Programs > Administrative Tools > Active
Directory Users and Computers to start the Active Directory
Users and Computers snap-in.

In the console tree, right-click on your domain name.
Click Properties.
Click the Group Policy tab.
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ol

Click New.

Enter a name for this policy.
For example, Office distribution.
Press Enter.

Click Properties.

9 Click the Security tab.

10 Select the Apply Group Policy check box to clear it and to
prevent the security groups from having this policy applied.
Select the Apply Group Policy check box for the groups to
which you want to apply this policy.

—End--
Procedure 59

Assigning software

Step Action

1 Click Start > Programs > Administrative Tools > Active

Directory Users and Computers to start the Active Directory
Users and Computers snap-in.

In the console tree, right-click on your domain name.
Click Properties.

Click the Group Policy tab.

Select the group policy object.

Click Edit.

Press the plus (+) sign beside Computer Configuration, to
expand it.

N oo o~ WDN

Press + beside Software Settings to expand it.
Right-click on Software Installation.

10 Select New.

11 Click Package.

12 In the Open dialog box, enter the full Universal Naming
Convention (UNC) path to the shared folder that contains the
MSI package that you want.

For example, \\file server\share\file name.msi.
ATTENTION

Do not browse to the location. Ensure that you use the UNC path to
the shared folder.

13 Click Open.

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.



214 Nortel IP Softphone 2050

14 Click Assigned.
15 Click OK.
The package lists in the right pane of the Group Policy window.
16 Close the Group Policy snap-in.
17 Click OK.

The package lists in the right pane of the Group Policy window.
18 Exit the Active Directory Users and Computers snap-in.

When the client computer starts, the managed software package
automatically installs.

--End--
Procedure 60

Publishing software

Step Action

1 Click Start > Programs > Administrative Tools > Active

Directory Users and Computers to start the Active Directory
Users and Computers snap-in.

In the console tree, right-click on your domain name.
Click Properties.

Click the Group Policy tab.

Select the group policy object.

Click Edit.

Press the plus (+) sign beside Computer Configuration, to
expand it.

N o 0o A WN

Press + beside Software Settings to expand it.
Right-click on Software Installation.

10 Select New.

11 Click Package.

12 In the Open dialog box, enter the full Universal Naming
Convention (UNC) path to the shared folder that contains the
MSI package that you want.

For example, \file server\share\file name.msi.

ATTENTION
Do not browse to the location. Ensure that you use the UNC path to
the shared folder.

13 Click Open.
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14
15

16

17

Click Published.

Click OK.

The package lists in the right pane of the Group Policy window.
Exit the Active Directory Users and Computers snap-in.

When the client computer starts, the managed software package
automatically installs.

To test the package, perform the following steps:

1. Log on to a workstation that is running Windows 2000
Professional or Windows XP Professional by using an
account to which you published the package.

2. In Windows 2000, click Start > Settings > Control Panel. In
Windows XP, click Start > Control Panel.

3. Double-click Add/Remove Programs (Windows 2000) or
Add or Remove Programs (Windows XP).

Click Add New Programs.

In the Add Programs from your network list, click the program
that you published.

Click Add.The program is installed.
Click OK.
Close the program.

—End--

Procedure 61
Redeploying software

Step

Action

1

N o 0o~ WN

Click Start > Programs > Administrative Tools > Active
Directory Users and Computers to start the Active Directory
Users and Computers snap-in.

In the console tree, right-click on your domain name.
Click Properties.

Click the Group Policy tab.

Select the group policy object.

Click Edit.

Press the plus (+) sign beside Computer Configuration, to
expand it.
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10
11

12
13
14
15

Press + beside Software Settings that contains the Software
installation item with which you deployed the package.

Click the Software installation container that contains the
package.

The package lists in the right pane of the Group Policy window.
Right-click the program and select All Tasks.
Click Redeploy application.

The following message displays: "Redeploying this application
will reinstall the application everywhere it is already installed. Do
you want to continue?"

Click Yes.

Close the Group Policy snap-in.

Click OK.

Exit the Active Directory Users and Computers snap-in.

—End--

Procedure 62
Removing software

Step

Action

1

N o 0o~ WN

10
11
12

Click Start > Programs > Administrative Tools > Active
Directory Users and Computers to start the Active Directory
Users and Computers snap-in.

In the console tree, right-click on your domain name.
Click Properties.

Click the Group Policy tab.

Select the group policy object.

Click Edit.

Press the plus (+) sign beside Computer Configuration, to
expand it.

Press + beside Software Settings that contains the Software
installation item with which you deployed the package.

Click the Software installation container that contains the
package.

The package lists in the right pane of the Group Policy window.
Right-click the program and select All Tasks.

Click Remove.

Perform one of the following actions:
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13
14
15

1. Click Immediately uninstall the software from users and
computers.

2. Click OK.

Or

1. Click Allow users to continue to use the software, but
prevent new installations.

2. Click OK.

Close the Group Policy snap-in.
Click OK.
Exit the Active Directory Users and Computers snap-in.

~End--

Silent installation
Silent installations run without a user interface. Configure the values
of public properties, such as USERNAME, COMPANYNAME, and
INSTALLDIR at the command line.

Use the following methods to pass data to the installation:

The /v argument is used to pass command line switches and values
of public properties.

The /g option is used to configure the user interface level in conjunction
with the following flags:

— ( or gn creates no user interface
— @b creates a basic user interface (progress bar)

To run a setup.msi silently, enter msiexec/i setup.msi/gn at the
command line.

To run a setup.exe silently, enter setup.exe/s /v/gn at the command
line.

To set installation properties run a command line, such as msiexec/i
Product.msi/gnINSTALLDIR=D:\ProductFolderUSERNAME="Valued
Customer".

To repair or reinstall missing or corrupted files, install with the /f option,
in conjunction with the following flags:

— p reinstalls a file if it is missing

— o reinstalls a file if it is missing or if an older version of the file is
present on the user’s system

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.



218 Nortel IP Softphone 2050

e reinstalls a file if it is missing or if an equivalent or older version
of the file is present on the user’s system

c reinstalls a file if it is missing or if the stored checksum of the
installed file does not match the new file’s value

a forces a reinstall of all files
u or m rewrite all required user registry entries
s overwrites any existing shortcuts

For example, to force a reinstall of all files, use the following syntax:
msiexec/fasetup.msi

* Th

e /x switch causes Setup.exe to uninstall a previously installed

product.

Fo

Upgrading
Use P

r example, msiexec /x setup.msi or setup.exe/s /x.

rocedure 63 “Upgrading the IP Softphone 2050 on your PC” (page

218) to upgrade the IP Softphone 2050 on the PC.

Procedure 63
Upgrading the IP Softphone 2050 on your PC

Step

Action

1

You must download the file of Product Category: Phones,
Clients & Accessories, Product Name: IP Softphone 2050,
Content type: Release. Obtain the precise Release, Status,
and Title of the file from your next level of support. See
www.nortel.com/downloadingconten for download instructions.

Double-click the My Computer icon and navigate to the working
directory.

Double-click the Setup icon.
Follow the instructions on-screen to complete the installation.

Compare the values currently in the configuration utility to the
values recorded prior to the upgrade. These should be identical.

Select Start > Programs > Nortel > IP Softphone 2050 to start
the IP Softphone 2050 application.

Select Settings to assign a server address, select sound
devices, and select a server type.

—End--
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Use Procedure 64 “Removing IP Softphone 2050 (Version 1)” (page
219) to uninstall IP Softphone 2050 (Version 1).

Procedure 64
Removing IP Softphone 2050 (Version 1)

Step

Action

1

Select Start > Settings > Control Panel > Add/Remove
Programs.

Choose Nortel Networks i2050 Software Phone.
Select Remove.
Select Yes to confirm.

—End--

Procedure 65
Removing IP Softphone 2050 (Version 2 or Release 3)

Step Action

1 Select Start > Settings > Control Panel > Add/Remove
Programs.
Choose Nortel Softphone 2050.
Select Remove.

4 Select Yes to confirm.

—End--

Visually impaired users can follow Procedure 66 “Installing the
Accessibility Interface” (page 219) to install the Accessibility Interface from
the IP Softphone 2050 CD-ROM.

Procedure 66
Installing the Accessibility Interface

Step

Action

Press and hold Shift.

Insert the IP Softphone 2050 installation CD into your CD-ROM

drive.

Press and hold Shift for several seconds to prevent Autorun
from starting.

If the Installation Wizard starts
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a Wait until the Welcome to the Install Shield Wizard for the
Nortel IP Softphone 2050 screen appears.

Press Tab to select Cancel.

Press Return.

Click Yes to confirm that you want to cancel the installation.
Click Finish.

From Windows Explorer, select your CD-ROM.

® QO O T

Select Accessibility.bat.

The file Accessibility.bat executes the command line "setup /s
Ivgb/vUI508=1". This installs the application and sets the user
interface to the Accessibility Interface.

~End--

Windows QoS Packet Scheduler
For Windows XP, the Windows QoS Packet Scheduler is installed and
selected by default.

For Windows 2000, you must install the Windows QoS Packet Scheduler.

Use Procedure 67 “Installing the Windows QoS Packet Scheduler” (page
220) to install to install the Windows QoS Packet Scheduler for Windows

2000.

Procedure 67
Installing the Windows QoS Packet Scheduler

Step

Action

Select Start > Control Panel.

Select Network Connections (Classic View or Windows XP), or
Network and Dialup Connections (Windows 2000).

Right-click Local Area Connection.

Select Properties.

Click Install.

The Select Network Component Type window opens.
Click Add.

The Select Network Service window opens.

Select QoS Packet Scheduler.
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8 Click OK.

—End--

To verify Windows QoS Packet Scheduler is installed, go to Control Panel
> Network Connections (Windows XP) or Network and Dialup Connections
(Windows 2000) > Local Area Connection > Properties > QoS Packet
Scheduler.

Running the IP Softphone 2050 for the first time
Start the IP Softphone 2050 in one of the following ways

® Select Start > Programs > Nortel > IP Softphone 2050.
® Click the desktop shortcut (if one was created during the installation).
* Click Automatic startup sequence.

If you want the IP Softphone 2050 to start automatically when the PC
starts, create a shortcut to the application in the Startup folder

When an IP Softphone 2050 is started for the first time and connects to the
network, the IP Softphone executes the following start-up sequence

1. Obtain the IP parameters.

2. Find a Media Gateway server and authenticate the user.

As the IP Softphone 2050 registers with the Signaling Server, one of the
following occurs

* If a non-null node password is enabled, you are prompted to enter the
node number and password. Use the keyboard or numeric keypad
to enter the prompts for a node number and password. After the
password is verified, enter the TN of the IP Softphone 2050. See
Signaling Server IP Line Applications Fundamentals (NN43001-125) for
further information about the password feature.

* |f the null node password is configured and enabled, these screens are
skipped and no option is provided to change the password.

* If the node password is disabled or not configured, it prompts for
a node number and TN. Enter the node number and TN using the
keyboard or numeric keypad.

Redeploying the IP Softphone 2050
This procedure is required for a new user of the IP Softphone 2050
application.
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Procedure 68
Redeploying the TN of an existing IP Softphone 2050

Step

Action

Exit the IP Softphone 2050 application.
Restart the IP Softphone 2050 application.

If you do not configure or enable the node password, go to step
3.

If you configure and enable the node password, go to step 4.

During startup, the IP Softphone 2050 registers again with the
TPS, and the IP Softphone 2050 displays the existing node
number and TN for approximately five seconds.

If you configure and the password for the node, the node number
and password prompt displays for approximately 5 seconds;
enter the correct password within this 5-second period.

If you activate the Clear soft key during the 5-second period, the
existing node and TN clear and you can enter new parameters.

—End--

Removing an IP Softphone 2050 from service

Procedure 69
Removing an IP Softphone 2050 from service

Step

Action

Maintenance

Exit the IP Softphone 2050 application.

Uninstall the IP Softphone 2050 application from the PC using
the Windows Add/Remove Programs.

In LD 11, enter OUT at the TN prompt.

—End--

Diagnostics provides a method to detect and resolve issues you encounter
with the IP Softphone 2050. Launch the Diagnostic feature from the Help

menu.

The data coverage for this feature includes

* “System data” (page 223)

* ‘“User data” (page 223)
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* ‘“Ethernet statistics” (page 224)

* “|P Networking Statistics” (page 225)

* “|ICMP Statistics” (page 226)

* “Audio Connection Data” (page 226)

* “USB Headset Data” (page 228)

* *“Telchemy VQMon" (page 228)

* “PC System Information” (page 229)

* “Personal Call Recording Data” (page 230)

* ‘“Licensing Data” (page 230)

* “Duplicate Media Stream Call Recording Data” (page 230)

The Diagnostics feature uses an Hyper Text Markup Language (HTML)
view, which splits each category of data into tables.

If diagnostics are not available for a specific parameter, the label
Unavailable Data appears.

System data
The system data displays the following information which is consistent
across all users.

® 2050 Version

* |Install Path

* Last Profile Used

* Last Language Used

* Last Theme Used

* Status of the Quick Start & Profiles Dialog
* Auto-Hide Menu

* Hardware ID

* Launch 2050 on Windows Startup

User data
The user data displays the profile configuration for all profiles of the IP
Softphone 2050. The user configures the following data by browsing to
File > Settings from the main application window:

* DHCP status

* Server IP Address
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* Server Name

* Node

® Large System TN

e TN

* Server Port

* Server Type

®* Number of Retries

®* Symposium Status

* Modem Status

* Listener IP Address

* Listener Port

® Echo Cancellation

* NetEq Status

* lLanguage

®* Theme Selected

* Action

* FingerPrint

* Expansion Module Display Format (Number, Name/Name, Number)
* Expansion Module View Style (Group/Spatial)

® Show Number on Expansion Module Buttons (Enabled/Disabled)

* Show Annotation on Expansion Module Buttons (Enabled/Disabled)

Ethernet statistics
The Ethernet statistics displays information regarding the state of the
network interface card. The Windows Operating system collects and
provides the following Ethernet data:

* Adapter Name

* Adapter Description
* Physical Address

* Adaptor Type

* Link Status

* Speed

e MTU
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DHCP Status
Current IP Address
Subnet Mask

Default Gateway

ATTENTION
A maximum of 5 IP addresses display but it is possible to assign more than 5 IP
addresses to one NIC.

IP Networking Statistics
The IP Network statistics displays information regarding the state of the
IP Network. The Windows Operating system collects and provides the
following IP Network data:

Host Name (for the local PC)

Domain Name (Domain PC is registered to)
DNS Servers

Node Type (Broadcast/P2P/Mixed/Hybrid)
IP Routing Status

IP Forwarding Status

Default Packet Time-to-Live

Packets Received

Received Packets with Header Errors
Received Packets with Address Errors
Packets Forwarded

Packet Received with an Unknown Protocol
Incoming Packets Discarded

Received Packets Delivered

Outgoing Packets Requested

Outgoing Packets Discarded

Transmitted Packets Discarded

Number of Network Interfaces for this PC
Number of IP Addresses for this PC

Number of Routes in the IP Routing Table

ATTENTION
A maximum of 5 DNS Server addresses display.
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ICMP Statistics
ICMP Statistics display information regarding the Internet Control Message
Protocol for the PC. ICMP messages send and receive when no errors
occur in the packet or in network routing. The following ICMP statistics
display:

®* Messages Received

®* Messages Sent

* Destination-Unreachable Messages Received

* Destination-Unreachable Messages Sent

* Time-To-Live Exceeded Messages Received

* Time-To-Live Exceeded Messages Sent

* Parameter Problem Messages Received (IP Header)
* Parameter Problem Messages Sent (IP Header)

* Redirect Packets Sent

* Redirect Packets Received

Audio Connection Data
The Audio Connection data displays information pertinent to the last call,
as well as other general audio parameters, such as:

* PC Audio Buffer

* PC Audio Buffer Range

* Audio Attenuation Percentage

e Jitter

* High Water Mark

* Early Packet Resync

* Late Packet Resync

* Supported codecs

* Echo Cancellation Mode

* Echo Cancellation Type

* Noise Reduction Level

* Microphone Auto Gain Control Status
®* SRTP Status for Last Call (Enabled/Disabled)

The last call parameters for both the RX and TX displayed are as follows:
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* Time of Connection

* Codec Used

* Frames per Packet

* Local/Remote RTP Port Used

* Local/Remote RTCP Port Used

®* RTCP Type of Service (ToS)/Diffserv Codepoint
e RTCP 802.1p

* Remote IP Address

Last call parameters
The last call parameters for both the RX and TX displays the following
parameters:

* Time of Connection

®* Codec Used

* Frames per Packet

* Local/Remote RTP Port Used

* Local/Remote RTCP Port Used

* RTCP Type of Service (ToS)/Diffserv Codepoint
* RTP/RTCP 802.1p

* Remote IP Address

General audio parameters
The general audio parameters displays the following parameters:

* PC Audio Buffer

* PC Audio Buffer Range

* Audio Attenuation Percentage
e Jitter

* High Water Mark

* Early Packet Resync

* Late Packet Resync

® Supported codecs

® Echo Cancellation Mode

* Echo Cancellation Type
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Noise Reduction Level
Microphone Auto Gain Control Status
SRTP Status for Last Call (Enabled/Disabled)

USB Headset Data
The USB headset data displays the following information on the current
and all other supported headsets:

Default Audio Device
USB Adapter Status

USB Adapter Type (Nortel/Algo USB Audio Adapter/Nortel USB
IP-ATA)

Adapter Firmware Version
Headset Type

Active Call Indication

Alert Condition Indication
Message Waiting Indication
Headset Disconnected Indication
Use Backlight

Supported USB Headsets

Telchemy VQMon
The Telchemy VQMon section displays the following information, which
generates using the libraries currently implemented for the IP Softphone
2050:

Packet Loss Rate
Packet Discard Rate
Burst Density Average
Burst Duration

Gap Density

Round Trip Delay

End System Delay
RERL

MOS LQ

MOS CQ

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.



Maintenance 229

PC System Information
PC System Information displays information related to hardware, the
Operation System, and computer names. The following information
displays about the computer in which the IP Softphone 2050 runs.

OS Name

OS Version

Processor Architecture

Number of Processors

System Name

User Name

Windows Directory

System Directory

System Manufacturer

System Model

Total Physical Memory

Free Memory

Percentage of Memory in use
Total Page File Limit (MB)

Total Page File Available (MB)
Total Virtual Memory (MB)

Total Virtual Memory Available (MB)
Number of Page Faults

Peak Working Set Size (MB)
Current Working Set Size (MB)
Peak Paged Pool Usage (MB)
Current Paged Pool Usage (MB)
Peak NonPaged Pool Usage (MB)
Current NonPaged Pool Usage (MB)
Current PageFile Allocation (MB)
Peak PageFile Allocation (MB)
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Personal Call Recording Data
The IP Softphone 2050 allows a Nortel-certified third party call recording
application to record calls. The following diagnostics data reflects the
status of this third party application:

* Application Name

* Application Version

* Application Vendor

* Application Path

® Call Recording Status (Enabled/Disabled)

* Launch PCR at 2050 startup (Enabled/Disabled)

® Call recording warning message (Enabled/Disabled)

Duplicate Media Stream Call Recording Data
The IP Softphone 2050 supports centralized duplicate media stream
call recording to record calls on a recorder server, which is in a remote
location. This is primarily used in Contact Center Solutions. The following
information displays for both the TX & RX Stream:

® Local Port Used
* |P Call Recorder Address (Remote)
* [P Call Recorder Port (Remote)

Licensing Data
The Licensing feature provides keycode (software license) protection
against reuse of invalid copies of the IP Softphone 2050 application. You
can download and copy the IP Softphone 2050 application but the clients
do not operate until you purchase legitimate keycodes.
The following diagnostic information displays:
* License Status
* License Type
* License Flavor
® License Server Address

® Current License Expiration
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Nortel Mobile Voice Client 2050

Contents

This section contains the following topics:

Introduction

“Introduction” (page 231)
“Description” (page 232)

“System requirements” (page 232)
“Supported features” (page 232)
“MVC 2050 components” (page 234)
“Operation” (page 241)

“MVC 2050 installation” (page 242)
“MVC 2050 removal” (page 243)
“Configuration” (page 244)

“802.1p and DiffServ” (page 251)
“MVC 2050 and WLAN” (page 251)

This section describes how to install, configure, and remove the Nortel
Mobile Voice Client 2050 for Release 2.0. For information about using the
MVC 2050, see Mobile Voice Client 2050 User Guide (NN43119-103).

This section contains the following procedures

Procedure 70 “Starting MVC 2050” (page 241).

Procedure 71 “Synchronizing a PDA with a desktop PC using
ActiveSync” (page 242).

Procedure 72 “Installing MVC 2050” (page 243).
Procedure 73 “Removing MVC 2050 from your PDA” (page 243).
Procedure 74 “Enabling Auto-Create” (page 246).
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Description
Mobile Voice Client (MVC) 2050 adds wireless IP Phone services to the
convenience of Personal Digital Assistants (PDAs). MVC 2050 functions
like an IP Softphone 2050. However, MVC 2050 cannot be used as an
Agent or Supervisor in Call Center Portal applications.

MVC 2050 is UNIStim-based software that provide real-time voice
communication, over a WLAN, to PDAs.

MVC 2050 operates on PDAs running the following operating systems

* Pocket PC 2003

* Windows Mobile 5.0

WLAN 802.11b can interwork with various enterprise communication
servers. MVC 2050 can also interwork with WLAN Access Points (WAP)

and can use the WSS 2250 WLAN Security Switch. MVC 2050 can coexist
with a secure Virtual Private Network (VPN) client on the same PDA.

MVC 2050 requires access to an enterprise or public WLAN Access Point
(WAP).

System requirements
MVC 2050 requires PDAs to meet the following minimum specifications

® 240x320 screen size
* 624MHz CPU speed
* 64 MB RAM

Supported features
MVC 2050 supports the following telephony features

* six programmable line/feature keys
* four soft keys (self-labeled)
* seven specialized feature keys

— Messages

— Directory

— Shift

— Copy

— Quit

— Services

— Expand
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e four call-processing keys
— Hold
— Goodbye
— Mute
— Answer
* volume Up/Down keys
®* navigation keys
* online help
® 12-button dialpad
* multifield display
* audible notification of connection or disconnection to the server
* macro functions available for programming lengthy dialing patterns

Pause is available to build into the macro to introduce a delay which
may be required to access some Interactive Voice Response (IVR)
applications and voice mail systems.

* Redial List
* Callers List
* profiles

* skins

® connection to user-supplied headsets for the speech path features and
services provided by the network (such as call features and voice mail)

* run-in-background application (MVC 2050 interface is closed but the
application runs in the background to allow incoming calls)

* 802.11b WLAN interface
* automatic network configuration through DHCP

® (G.711 codec for operation without compression

Application software
MVC 2050 is a software application that enables voice communications
over a WLAN from a PDA.

The MVC 2050 software application is comprised of the following
components

* MVC 2050 software

* NetEQ software (included in MVC 2050 software)
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ClearType
MVC 2050 uses a special screen font which requires that Microsoft
ClearType® be enabled on your PDA. ClearType software improves the
appearance and readability of text on liquid crystal display (LCD), pocket
PC screens, and flat panel monitors.

MVC 2050 components

MVC 2050 includes the following components

* MVC 2050 application software, including Global IP Sound NetEQ™
software

* user-supplied compatible PDA

* user-supplied headset

Compatible PDAs
Because the PDA industry evolves at a rapid pace, go to www.nortel.com.
Select Products > Phones, Clients, and Accessories > IP Phones and
Clients > Mobile Voice Client 2050 > Technical Specifications to determine
the latest PDA models tested and supported, along with any known issues.

Headsets
A headset is required in order to send and receive telephone calls using
the MVC 2050 and your PDA. The headset is an important part of audio
quality.

PDAs that support stereo headphones with microphones are
recommended.

The Dell specific headset with a button on the wire, when used with the
X51v, allows the MVC 2050 to answer an incoming call or release an
active call by pressing the button.

ATTENTION

Bluetooth® and 802.11b operate on the same frequency band and use the same
WLAN hardware on the PDA. Therefore, the use of Bluetooth® accessories with
MVC 2050 can lead to poor call quality.

Contact your PDA vendor to obtain headset recommendations.

Automatic Gain Control and feedback
Because MVC 2050 requires a headset to operate properly, disable
Automatic Gain Control. Refer to your PDA documentation to disable
Automatic Gain Control.
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When the PDA is used in handsfree mode, without a headset, the PDA
microphone picks up sounds from the speaker, which creates a feedback
loop. Automatic Gain Control is used in this instance to avoid feedback.

ATTENTION
When the PDA is used in handsfree mode, without a headset, the PDA
microphone picks up sounds from the speaker, creating a feedback loop.

Audio quality
MVC 2050 provides a high-quality audio environment, which includes

* NetEQ software (included with the software package)

* Interworking with G.711 codec that provide high audio quality without
compression; MVC 2050 supports G.711-64 A-law and U-law

* Audio selection tab that provide a user-selectable quality slider

* Advanced Audio tab for expert users

For more information about Audio quality, see “Audio Quality” (page 248).

MVC 2050 Call Handling screen
You can access and operate most MVC 2050 features from the Call
Handling screen. Select Answer from the Keys menu or use the
Headset/Answer icon to answer calls or obtain a dial tone.

The Call Handling screen contains the telephone dialpad. The appearance
of the Call Handling screen differs with each available skin. Use the
Settings > Skin dialog box to determine the current skin. All skins share
common components.

You can use the up, down, left, and right cursor control arrow keys on your
PDA as navigation buttons to navigate around the skin and move through
the menu items.

Display
The display is located in the central area of the skin. View messages and
text on the display.

Dialpad
The 12-button dialpad is located on the left side of the skin.

Soft keys (self-labeled)
Four soft keys (self-labeled) are located in the bottom row of the display.
The labels on these keys depend on the call server.
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Programmable line/feature keys

Menus

Six programmable line/feature keys are located on the right side of the
skin. They are aligned vertically and are the same color as the display.
The number of features available depends on the call server.

MVC 2050 provides the following menus

* File
e Keys
* Help
File

The File menu provides the following items

* Run-in-background

®* Paste

* Contacts
® Settings
* Exit

Run-in-background Select Run-in-background to close MVC 2050 but
allow it to continue running in the background so that incoming calls can
ring on your PDA.

After you complete your call, press the X in the upper right-hand corner
of the PDA display to close the MVC 2050 application and return it to the
background.

Paste Select Paste to paste a telephone number into your PDA from
another application rather than entering an existing telephone number
through your Call Handling screen dialpad.

Contacts Select Contacts to launch the Contacts dialog box. The
Contacts application reads a list of contacts from the PDA Contacts list or
from a list, which you synchronized onto your PDA from Microsoft Outlook.

Settings Select Settings to provide access to the Settings submenu. The
Settings menu provides windows for Personal settings, System settings,
and Connections settings.
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The System settings window provides access to settings for memory,
power, remove programs, screen and regional settings, iTask settings, and
self test.

You must restart MVC 2050 for changes to Profiles, Hardware ID, Sounds,
Servers, and Listener IP to take effect.

Exit Select Exit to close MVC 2050. Calls cannot be received until the
application restarts.

Select Exit to free up PDA-processing resources.

Keys

The Keys menu provides the following items
* Headset

* Answer

* Goodbye

* Hold

* Features

* Macros

Headset Select Headset to answer an incoming call or to obtain a dial
tone. You can also use the Headset/Answer icon located at the top center
of the Call Handling screen.

Answer Select Answer to answer an incoming call or to obtain dial tone
to place a call. You can also use the Headset/Answer icon located at the
top center of the Call Handling screen.

Goodbye Select Goodbye to end a call. You can also use the Goodbye
icon located at the top right of the screen.

Hold Select Hold to place a call on hold. You can also use the Hold icon
located at the top left of the screen.

Features Select Features from the Keys menu to access a menu of
interface keys.

To re-arrange items in the Features list, open the Settings menu and
select the Features tab. Items in the Features list cannot be added or
removed.
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Macros Select Macros from the Keys > Features submenu to access
macros (also available through the Settings > Macros dialog box). Macros
are used to make speed-dials, access voice mail, and other routine
functions quickly and easily. For more information about macros see
“Macros” (page 250)

Help
Select Help to access the MVC 2050 PDA-specific version of Help. The
Help menu provides the following items

* Contents
* Diagnostics
* About MVC 2050

Contents Select the Contents menu item to access the Help system.

Diagnostics Select Diagnostics to access to a list of methods to
determine server connection state.

Diagnostic methods are as follows

* Ping

* TraceRoute

* RUDP Ping

See “Profiles” (page 247) for information about importing and exporting
profiles to assist in troubleshooting.

About MVC 2050 About MVC 2050 identifies the MVC 2050 application.
Select About MVC 2050 to view configuration information for your MVC
2050 (such as system product name, version number, copyright indication,
manufacturer name and logo, and Global IP Sound name and logo). MVC
2050 uses packet loss concealment provided by Global IP Sound NetEQ
software.

MVC 2050 graphical interface (skins) components
MVC 2050 provides alternative graphical images known as skins. The
dialpad, menu, and icon buttons on the skin. Skins are available in several
colors and arrangements.
All skins share the following common components
* programmable line/feature keys
* soft keys (self-labeled)

e (dialpad
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Icons

e (display

® Call Handling icons

®* Toolbar icons

®* Menu Bar icons

* retractable toolbar

®* Message Waiting light

* System Input Panel icon

The MVC 2050 Call Handling screen presents icon equivalents for menu
items.

Icons are divided into three types

® Call Handling icons

®* Toolbar icons

* Menu Bar icons

Call Handling icons
The following three Call Handling icons appear across the top of the Call
Handling screen

* Hold
* Headset/Answer

* Release

Menu Bar icons
MVC 2050 provides the following icons, which is used instead of text menu
equivalents

* Paste
e Contacts
® Settings

®* Toolbar switch

* System Input icon
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Toolbar icons

The retractable toolbar contains icons, which are not present on the
remainder of the display. The icons at the bottom of the skin and are
visible when the Toolbar is retracted. Use the Toolbar switch icon at the
bottom of the screen to retract the Toolbar.

The following are the icons visible on the Toolbar

* Mute

* Volume Down

* Volume Up

The following icons are visible when the Toolbar is retracted
* Mute

* Volume Down

* Volume Up

* Directory

* Messages

* Shift

® Services
* Expand
* Copy

*  Quit

System Input Panel

To access the System Input Panel from MVC 2050, tap the System Input
Panel icon on the Menu Bar on the bottom right-hand corner of the PDA.
Consult the PDA documentation for a description of the System Input
Panel.

You can use the System Input Panel to enter data for MVC 2050 and other
applications. Use the keyboard to enter data.

The default System Input Panels are as follows

* Block Recognizer

* Keyboard

* Letter Recognizer
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Operation

The MVC 2050 application enables the keyboard to act like a dialpad,
interpreting the alphabetical keys as numbers. For example, J, K, or L, are
interpreted as the number five (5). Nonalphanumeric keys are ignored.

Use Procedure 70 “Starting MVC 2050” (page 241) to start MVC 2050.

Procedure 70
Starting MVC 2050

Step Action

From the Main Application screen, select Programs.
Select Start.

Select Mobile Voice Client 2050. The Call Handling screen
appears.

—End--

CAUTION

PDA processor models, speed, and amount of memory vary.
To maintain audio quality, do not overload the processor with
intensive tasks while using MVC 2050. For example, Nortel
does not recommend using your PDA version of Internet

Explorer while using MVC 2050.

PDA processor speed can have adverse effects on MVC 2050
performance.

ATTENTION
Set the PDA processor speed to the highest setting or to auto, which changes
the processor speed according to system status. To set the PDA processor

speed. Refer to the PDA user guide.

ATTENTION

If the Wireless Fidelity (WiFi) application goes down while your PDA is set to
Standby mode, you cannot receive incoming calls on your device. To continue
the WiFi application running and receive incoming calls, disable the power

settings for Standby mode. Go to the Settings option on your PDA.

PDA battery life can affect the MVC 2050 call duration and the call volume.
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ATTENTION

PDA vendors offer two types of rechargeable battery: standard and
extended-life. The extended-life battery is recommended. It provides longer call
duration and increased call volume than the standard-life battery.

MVC 2050 installation
If an older version of MCV 2050 is installed on the PDA, remove it prior to
installing a newer version. See “MVC 2050 removal” (page 243).

To install MVC 2050 on the PDA

1.
2.

Place the PDA in its cradle.

Synchronize the PDA with a desktop PC running Microsoft®
ActiveSync® using Procedure 71 “Synchronizing a PDA with a desktop
PC using ActiveSync” (page 242).

Install the MVC 2050 from a Desktop using Procedure 72 “Installing
MVC 2050” (page 243).

MVC 2050 installation method
MVC 2050 supports installation from a docked PDA with a Microsoft
ActiveSync connection to a desktop PC.

Synchronizing a PDA with a desktop PC
Use Procedure 71 “Synchronizing a PDA with a desktop PC using
ActiveSync” (page 242) to synchronize your PDA with your desktop PC.

Procedure 71
Synchronizing a PDA with a desktop PC using ActiveSync

Step Action

Place the PDA in its cradle.
Ensure that ActiveSync is running.
Wait for the PDA and the PC to synchronize.

—End--

For details about synchronizing a PDA with a desktop PC, see the PDA
Users Manual.

Installing MVC 2050 from a Desktop PC using ActiveSync
Use the following procedure to install MVC 2050 using the product CD.
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Procedure 72
Installing MVC 2050

Step Action

1 Synchronize the PC and PDA. See Procedure 71 “Synchronizing
a PDA with a desktop PC using ActiveSync” (page 242).

2 Insert the MVC 2050 CD into the CD-ROM drive of your desktop
PC.

3 Go to your desktop and double-click My Computer. The PC files

and folders menu appears.
Select the CD Drive.
Select Setup.

Follow the instructions on the screen until the Install Wizard asks
you if you want to modify, install, or remove MVC 2050.

7 Select Install. The Install Wizard installs MVC 2050. When
installation finishes, Attend to your device (PDA) message
displays on the PC and Do you want to perform a soft restart?
message displays on the PDA.

8 Select Yes to restart your PDA.

—End--

MVC 2050 removal
Use the following procedure to remove MVC 2050 from your PDA.

Procedure 73
Removing MVC 2050 from your PDA

Step Action

Select Start. A drop-down menu appears.

N

Select Settings. A Windows folder with a number of programs,
usually shown as icons with names and a row of tabs across the
bottom, opens.

Select the System tab. Another Windows program folder opens.
Select Remove Programs. A list of programs opens.

Select Nortel MVC 2050.

Select Remove. A confirmation dialog box opens.

~N o o~ W

Select Yes. There is a brief pause during removal of MVC 2050.
After the pause, a confirmation dialog box opens.
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8 Select Yes. Your PDA restarts and MVC 2050 has been
removed.

—End--

Configuration
MVC 2050 has a flexible interface which enables end users to customize
configurations for a variety of connections.

Settings
For information about settings, see “Settings” (page 236) .

Server

The Server tab, accessible from the Settings screen, contains all the
settings necessary for MVC 2050 to contact a server. On the Server tab,
you can perform the following

* change the settings on the Server tab to access a different server

* implement the profile containing the desired server
For more information about Profiles, see “Profiles” (page 247).

Connection history

Connection history writes connection and disconnection indication
messages to the registry key HKCU\Software\Nortel \MVC2050\Log. This
is a circular queue of 29 entries. Each time a connection or disconnection
event occurs, a log entry containing a date, time, and a description of the
connection or disconnection event is written.

The descriptions of the connection and disconnection events are as follows
* Soft reset, server n

® Server connected

* Recovering: Server unreachable

* Hard reset

* Hardware ID

Soft reset, server n

Server n indicates that the server has instructed MVC 2050 to reset and
connect to a server n where n and its value is determined, and possibly
written, by the server. This message maps directly to a UNIStim message.

Server connected
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Server connected indicates that MVC 2050 has successfully connected
to the server. It means that MVC 2050 received the Assign TerminallD
UNIStim message, which is the last message received by MVC 2050
before a normal session is started.

Recovering: Server unreachable

The Recovering: Server unreachable message generates after MVC 2050
loses connection with the server. It indicates that the UNIStim watchdog
timer has expired and indicates loss of network connection.

Hard Reset

The Hard Reset message indicates that the server has instructed MVC
2050 to reset and clear its UNIStim-related memory. This message maps
directly to a UNIStim message.

Hardware ID

The Hardware ID screen is used to select the MAC address that MVC
2050 reports to the communication server. The MAC address can be
reset.

View the Hardware ID in the MVC 2050 Settings on the Hardware ID tab.

Hardware IDs are generated by reading MAC addresses from the PDA
Network Interface Card (NIC). When MVC 2050 is used with most server
types, the Hardware ID must be unique.

Some software, such as VPN client software, creates artificial network
interfaces with MAC addresses, which are not unique. Without a unique
MAC address, the following conflicts can occur

e MVC 2050 cannot connect to a server

* MVC 2050 connects to the server but another device with the same
Hardware ID is disconnected from the server

* MVC 2050 disconnects from the server then automatically attempts
to reconnect

To prevent conflicts with other devices, enable Auto-Create. Auto-Create
fabricates a MAC address with a random value that is unlikely to be
repeated by another device.

Use Procedure 74 “Enabling Auto-Create” (page 246) to enable
Auto-Create.
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Procedure 74
Enabling Auto-Create

Step Action

Select Settings.
Select Hardware ID.
Select Auto-Create.

—End--

Table 46 "Hardware ID screen" (page 246) provides information about the
Hardware ID screen.

Table 46
Hardware ID screen
Selection Description
Hardware ID This box contains the MAC address for

the Ethernet hardware installed in your
device. MVC 2050 uses the MAC address
of the Ethernet hardware as its hardware
ID. You may have to change this value if
there is more than one MAC address, or if
the device is using an extranet client that
hides the true MAC address. For example,
the Nortel Contivity Extranet Switch uses
a single MAC address for all clients. This
might cause connection problems with
your communication server.

Auto-create This changes the MAC address that
appears in the Hardware ID box. If your
device has more than one MAC address,
tap the Auto-Create button to cycle
through the set of MAC addresses on your
computer. Auto-Create also makes up
random hardware IDs in case the Ethernet
hardware addresses are not unique to the
communication server.

Firmware Version Shows the build number of MVC 2050
installed on your device. This value is
the version number of the application last
reported by the server.
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Dialing formats

Dialing Locations settings set the dialing rules to be applied to properly
route a call when an end user dials a number. The dialing rules establish
prefixes to access local and long-distance numbers using the location of
the user server. To establish the dialing rules and dialing patterns, see
Mobile Voice Client 2050 User Guide (NN43119-103).

Profiles

Each profile is a named file, which contains a combination of servers and
other attributes that control connection, behavior, and appearance of the
MVC 2050.

A number of profiles can be created and saved to allow easy switching
among different servers, feature programming, and audio programming.

Profiles can be created, selected, modified, or deleted. When you select
profile you can change the name, modify it, or delete it.

When a profile is selected, all other Settings tabs see the selected profile.
The name of the selected profile is shown in the lower right corner on each
tab.

From the Profiles screen you can do the following

* create profiles

* delete profiles

* modify a profile name

* change the profile used by the application

* export profiles

* import profiles

When a new profile is created and selected, the values on all of the other
tabs are set to the defaults for this profile. Any value modified on any

of the other tabs are associated with this profile until another profile is
selected. To change settings on other tabs for this profile, select the

tab you wish to change. For example, go to the Server tab to modify the
server settings.

Sounds
MVC 2050 can make sounds to indicate server connection or
disconnection.
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Sound files and sound settings are not saved when Profiles are saved,
so the use must program the sounds. Up to three sounds can be
programmed for use with audible notification of server connection or
disconnection.

Following are descriptions of the events for which the sounds are used.

Descriptions of the events for which the sounds are used are as follows
® Server unreachable
® Server unresponsive

®* Server connected

Server unreachable

The sound you select for this event plays when MVC 2050 loses contact
with the server. The message "Server unreachable" displays on the PDA
screen.

Server unresponsive

The sound you select for this event plays if MVC 2050 fails to connect
to the server. The message Server unresponsive displays on the PDA
screen.

Server connected

The sound you select for this event plays when MVC 2050 connects to a
server.

Audio Quality
Audio quality is controlled from the following screens
* Audio quality slider tab

e Advanced Audio

To control audio quality, use the slider tab to reduce audio delay and
increase audio clarity. control audio quality. This slider controls the
number of audio buffers the PDA uses to smooth out incoming audio
streams.

If you experience audio delay, use the slider on the Audio screen to
decrease the number of buffers.
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If you experience broken or choppy speech at either end of the call, or
the dial tone sounds choppy, use the volume controls on the MVC 2050
toolbar to adjust volume while using the MVC 2050.

If you experience reduced audio clarity in the receive audio stream,
increase the Audio clarity setting. This increases the number of audio
buffers used to process incoming audio. If the delay is too large, you can
decrease the Audio clarity setting.

Advanced Audio

Global IP Sound NetEQ software provides loss concealment and
compensation.

NetEQ is the default setting and MVC 2050 Advanced Audio settings
cannot be adjusted.

Table 47 "Advanced Audio screen" (page 249) provides information about
the Advanced Audio screen.

Table 47
Advanced Audio screen
Selection Description
NetEQ (Global IP Sound) NetEQ packet loss concealment software

is the default mode of operation.

Jitter Buffer A Jitter Buffer is used to minimize a
change in rate for arriving voice frames.
The Jitter Buffer sends voice frames to
your PDA sound system at a fixed rate.
The rate of arrival of voice frames is
variable. The value of "jitter" is the normal
number of voice frames the application
should have in its jitter buffer.

Highwater Mark Highwater Mark indicates the maximum
number of voice frames the application
should have in its jitter buffer before it
starts discarding packets. This value
should be at least 2.5 times the value of
jitter. If a smaller value is assigned, MVC
2050 regards it as an error and corrects it.

Early Packet and Late Packet Early Packet Resync and Late Packet
Resync Resync indicate the points at which MVC
2050 discards and restarts the jitter buffer
contents. This value should be at least five
times the Highwater Mark.
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Listener IP
Use the Listener IP screen to override the port assignments when there is
a conflicting application on the PDA.

See Table 48 "Listener IP screen” (page 250) for information about
selections available on the Listener IP screen .

Table 48
Listener IP screen
Selection Description
Use a specific address MVC 2050 normally listens to all

IP addresses on the device for
communication server-to-terminal
(UNIStim) messaging on all the
network interface cards on the device.
This is the default mode of operation.
To override this behavior, select the
check box and enter a specific IP
address.

Use a specific port MVC 2050 listens to IP port 5000
on the device for communication
server-to-terminal (UNIStim)
messaging.

Macros

The Mobile Voice Client (MVC) 2050 Macros tab enables you to record
and use macros. A macro is a recorded sequence of steps that saves you
keystrokes.

For example, you can create macros that select a particular line and then
dials the telephone number automatically, or program voice mail access
numbers and codes for faster access.

Macro screen

To enter a new macro name, or to select an existing macro to modify or
delete, select the New icon to the right of the list box.

To select an existing macro, tap the down arrow in the Macro list box and
make your selection.

To delete a selected macro, tap the Delete icon (the button to the right of
the list box).

Keys

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.



MVC 2050 and WLAN 251

Once you have selected a macro name, tap the down arrow in the Keys
drop-down list to select a key to add to the macro. Press the Add button
to add the key.

Use the Pause key to insert a short pause in the macro. A pause
introduces a delay which may be required to access some Interactive
Voice Response (IVR) applications and the voice mail systems.

Contents

A list of the macro contents appears in the Contents list box. Once there
are two or more entries in this box, use the up and down buttons, which
appear on the right of the box to move around the keystrokes.

To remove keystrokes from the Contents box, select the keystroke and
press the Remove button.

Preview

To preview your macro in a single view, view the read-only field under the
Contents box.

Dialpad

To enter numbers into your macro, select the Keys list box, press the Add
button, or use the numbers on the dialpad.

802.1p and DiffServ
MVC 2050 does not support 802.1p and DiffServ.

Global Packet Loss Concealment algorithm
The Global Packet Loss Concealment (GIPS) algorithm searches for
missing incoming packets. When one is found, GIPS algorithm stretches
the previous packet to conceal the loss and to remove noises associated
with the audio system starting and stopping at volume. Part of this
concealment alters the pitch of the sound to make it appear more natural.
It assumes that human is the type of sound, which permits better pitch
changes. For more information, see www.globalipsound.com

MVC 2050 and WLAN
802.11b wireless ethernet networking
MVC 2050 uses an 802.11b WLAN interface.
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Audio quality is affected by the distance from the AP and enclosed spaces.
Audio quality is also affected by using Bluetooth® accessories while on a
voice call due to interference and contention.

QoS
Due to device constraints, 802.11 p/q is hot supported.

Wireless Fidelity
ActiveSync of a PDA with a PC can be accomplished using Wireless
Fidelity (WiFi).

CAUTION

When you return the PDA to its cradle, if you want to maintain
the MVC 2050 connection to the server, deactivate ActiveSync.
Otherwise the connection is lost because ActiveSync uses
Point-to-Point Protocol (PPP). This causes the PDA connection
to the voice network to be dropped and connected to the PC.

Roaming and handover
If you experience slight gaps and pauses in transmission and reception
during calls, MVC 2050 may be experiencing roaming/handover difficulties
attributable to the wireless network.
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Expansion Module for IP Softphone
2050

Contents

This section contains the following topics:

* “Description” (page 253)

* ‘“Features” (page 254)

* “Display characteristics” (page 254)

* “Configuration” (page 255)

* ‘“Installation” (page 256)
Description

The Nortel Expansion Module for the IP Softphone 2050 is a stimulus
device, which provides additional line appearances and feature keys.

You can connect up to three Expansion Module for IP Softphone 2050.
With three Expansion Modules connected, the IP Softphone 2050 provides
up to 54 additional line/feature keys.

Figure 39 "IP Softphone 2050 with Expansion Module" (page 254) shows
the IP Softphone 2050 1140 theme with the Expansion Module.
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Figure 39
IP Softphone 2050 with Expansion Module
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Features
The Expansion Module provides the following features:

* 54 keys in up to three groups of 18 keys
* docks to the right side or left side of the IP Softphone 2050
® up to 30 characters for button annotation text

For more information, see IP Softphone 2050 User Guide (NN43119-101).

Display characteristics
Each of the 54 keys on the Expansion Module 2050 provides a
10-character display label area. This label is set automatically; however
the user can edit the label using the controls from the IP Softphone 2050
Settings panel.

For more information, see the IP Softphone 2050 User Guide
(NN43119-101).
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Configuration

Use LD 11 to configure the Expansion Module 2050.

Table 49
LD 11 - Configure the Expansion Module
Prompt Response Description
REQ: NEW/CHG Add new or change existing data.
TYPE 2050 For IP Softphone 2050
KEM (0) - 3/<CR> Number of attached Expansion Modules 2050 (0).
Supports up to three Expansion Modules 2050.
CLS KEM3 KEMS3 CLS must be defined
KEY 0 - <see text>/<C | Key number range expanded to support number of
R> Expansion Modules 2050 specified by KEM prompt. The
range on the IP Softphone 2050 is as follows:
KEM value: KEY range:
0 0to 31
1 321to0 49
2 50 to 67
3 68 to 85
PAGEOFST <Page> <KeyOff- | PAGEOFST is prompted if one Expansion Module 2050 is
set>/ <CR> specified at the KEM prompt and <CR> is entered at the
KEY prompt. This prompt enables you to enter a Page
number of 0, or 1, and a Key Offset number from 0 to 17.
Once entered, the KEY is prompted with the appropriate
KEY value filled in. <CR> ends the input.
KEY <key> <keys conf data>/ | <key> is the key number for the Page + Key Offset
<CR> entered at PAGEOFST. Enter the key configuration <CR>
or just <CR>,
KEMOFST <KEM> <Key-Off- | KEMOFST is prompted if two or three Expansion Modules
set>/ <CR> are specified at the KEM prompt and <CR> is entered for
KEY prompt.
This prompt enables you to enter a KEM number of 1,
2, or 3 and a KEY Offset number from 0 to 17. Once
entered, the KEY prompt is prompted with the appropriate
KEY value filled in. <CR> ends the input.
KEY <key> <keys conf data>/ | <key> is the key number for the KEM + Key Offset
<CR> entered at KEYOFST. Enter the key configuration <CR>
or just <CR>,
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Installation

Operation

The Expansion Module 2050 can dock to the right side or the left side
of the IP Softphone 2050 main window. You can move the Expansion
Module 2050 close the IP Softphone 2050 and it snaps into place.

Before you can operate the Expansion Module 2050, you must configure
settings in IP Softphone 2050 Settings. You can set the default value
either to Spatial or Group, set the Expansion Module 2050 back to the
default state, and configure annotated labels.

For further information about IP Softphone 2050 Settings, see IP
Softphone 2050 User Guide (NN43119-101).
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Nortel IP Phone 1110

Contents
This section contains the following topics:

* “Introduction” (page 257)

* “Description” (page 258)

* “Components and functions” (page 259)

* ‘“Features” (page 261)

* “Display characteristics” (page 262)

* *“Cleaning the IP Phone display screen” (page 263)
* *“Package components” (page 263)

* “Installation and configuration” (page 265)

* “TFTP firmware upgrade " (page 271)

* *“Redeploying an IP Phone 1110” (page 271)
* “Replacing an IP Phone 1110” (page 272)

* “Removing an IP Phone 1110 from service” (page 273)

Introduction
This section explains how to install and maintain the IP Phone 1110.
For information about using the IP Phone 1110, see the IP Phone 1110
User Guide (NN43110-101) or the IP Phone 1110 Getting Started Card
(NN43100-300).

This section contains the following procedures
* Procedure 75 “Configuring the IP Phone 1110” (page 266)

* Procedure 76 “Connecting the components” (page 266)

* Procedure 77 “Changing the TN of an existing IP Phone 1110” (page
271)
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Description

Figure 40
IP Phone 1110

* Procedure 78 “Replacing an IP Phone 1110" (page 272)

®* Procedure 79 “Removing an IP Phone 1110 from service” (page 273)

The IP Phone 1110 is a multi-line professional-lelP Audio Conference
Phone 2033vel deskset with a high-resolution, fully-backlit, QVGA color
LCD display. The enhanced configuration menus and USB peripheral
support provide a superior navigation experience. The integrated
Bluetooth® Audio gateway offers greater freedom and mobility. The set
includes an integrated phone switch with Gigabit Ethernet LAN and PC
ports. When the phone is idle users fully experience the personalized
background images and capabilities, as well as the Digital Picture Frame
mode.

Figure 40 "IP Phone 1110" (page 258) shows the IP Phone 1110.
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Components and functions
This section describes the following components and functions of the IP
Phone 1110

* “Keys and functions” (page 259)

® “Services menu” (page 260)

* “Local Tools menu” (page 261)

Keys and functions
Table 50 "IP Phone 1110 keys and functions" (page 259) describes the
IP Phone 1110 keys and functions.

Table 50
IP Phone 1110 keys and functions
Key Function
Line key Press the Line key to access the single DN and make a call.
Hold Press the Hold key to put an active call on hold. Press the green
Line (DN) key to return to the caller on hold.
Goodbye Press the Goodbye key to terminate an active call.

Visual Alerter/Message
waiting indicator

Feature Status Lamp
indicator

Context-sensitive soft keys

Expand

Navigation keys

When a message is waiting, the red Visual Alerter/Message waiting
indicator lights. Also, when the ringer sounds, this indicator flashes.

When the firmware is updating, the blue Feature Status Lamp
indicator flashes.

This function requires server support and, therefore, is not available
on all phones.

Soft keys are located below the display area. The LCD label above
the key changes, based on the active feature.
A triangle before a key label indicates that the key is active.

The Expand key is used to access external server applications, such
as External Application Server (XAS).
The Expand key is reserved for future feature development.

Use the Navigation keys to scroll through menus and lists that
appear on the LCD display screen. The outer part of this key cluster
rocks for up, down, left, and right movements.

Use Up and Down keys to scroll up and down in lists, and the Left
and Right keys to position the cursor. You can also use the Left and
Right keys to select editable fields that appear on the phone. Press
the Right key to select the field below the current position, or press
the Left key to select the field above the current position.
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Table 50
IP Phone 1110 keys and functions (cont’d.)
Key Function
Enter Press the Enter key, at the center of the Navigation key cluster, to

Message/Inbox

Volume control keys

confirm menu selections. In many cases, you can use the Enter key
instead of the Select soft key.

Press the Message/Inbox key to access your voice mailbox.

Press the volume control keys to adjust the volume of the handset,
headset, speaker, ringer, and, Handsfree feature.

Press the volume key with the loudspeaker icon to increase volume;
press the volume key without the loudspeaker icon to decrease
volume.

Services menu

Table 51 "Services menu" (page 260) shows the Services menu.

Table 51
Services menu

Services

Press the Services key to access the following items

®* Telephone Options

Volume Adjustment
Contrast Adjustment
Language
Date/Time

Display diagnostics
Local Dialpad Tone
Set Info

Diagnostics

Call Log Options
Ring type

Call Timer

Live Dialpad

Normal Mode Indication

Caller ID display order

® Virtual Office Login and Virtual Office Logout (if Virtual Office is
configured)
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® Test Local Mode and Resume Local Mode (if Branch Office is
configured)

® Password Admin

You can customize the IP Phone features to meet user
requirements. For more information, see the IP Phone 1110 User
Guide (NN43110-101).

If an incoming call is presented while you configure information in the Services menu, the phone
rings. However, the display does not update with the caller ID, and the programming text is not
disturbed.

While you are in the Services menu you cannot dial digits but you can use the programmable line
keys, such as Redial (double-press a line key) and Auto dial key to make a call. However, the
display does not update with the dialed digits or Caller ID.

Local Tools menu
Table 52 "Local Tools menu" (page 261) shows the Local Tools menu.

Table 52
Local Tools menu

Press the Services key twice to access the Local Tools menu. The following
items appear in the Local Tools menu

1. Preferences

2. Local Diagnostics

3. Network Configuration
4. Lock Menu

If you are prompted to enter a password when you double-press the Services
key, password protection is enabled. For more information about password
protection and the Local Tools menu, see “Local Tools menu” (page 441).

To make a selection, press the number associated with the menu item, or use the navigation keys
to scroll through the menu items. Press the Enter key to select the highlighted menu item.

Press the Quit/Stop key to exit from any menu or menu item.

Features
The IP Phone 1110 supports the following telephony features:

* four context-sensitive soft keys
Functions for the context-sensitive soft keys are configured in LD 11.
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For more information about context-sensitive soft keys, see Features
and Services Fundamentals (NN43001-106).

* volume control keys to adjust ringer, listen-only speaker, and handset
volume

* three specialized feature keys

— Message/Inbox

— Services

— Expand-reserved for future feature development
* three call-processing fixed keys

— Line key

— Goodbye

— Hold

For more information about IP Phone features, see “Features” (page 355).

Display characteristics
An IP Phone 1110 has two major display areas:

* ‘“Context-sensitive soft key label display” (page 262)
* “Information line display” (page 263)

Figure 41 "IP Phone 1110 display area" (page 262) shows the two display
areas.

Figure 41
IP Phone 1110 display area
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Context-sensitive soft key label display
The context-sensitive soft key label has a maximum of seven characters.
Each soft key includes the soft key label and an icon. When a soft key is
in use, a triangle icon displays at the beginning of the soft key label, and
the label shifts one character to the right. (If the label is six characters in
length, the last or rightmost character is truncated.) If a feature is enabled,
the icon state turns to On. It remains in the on state until the feature key
is pressed again. This cancels the enabled feature and turns the icon off,
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returning the soft key label to its original state. Use the More soft key to
navigate through the layers of functions. If only four functions are assigned
to the soft keys, the More key does not appear and all four functions are
displayed.

Information line display
An IP Phone 1110 has a one-line information display area with the
following information:

* caller number

* caller name

* feature prompt strings

* user-entered digits

* date and time information (if the IP Phone is in an idle state), or Call
Timer (if provisioned in the Telephone options menu)

The information in the display area changes, according to the
call-processing state and active features.

Cleaning the IP Phone display screen
Gently wipe the IP Phone display with a soft, dry cloth.

ATTENTION

Do not use any liquids or powders on the IP Phone. Using anything other than
a soft, dry cloth can contaminate IP Phone components and cause premature
failure.

Package components
The IP Phone 1110 includes integrated support for a number of Power
over Ethernet options, including support for IEEE 802.3af Power
Classification 2.

Table 53 "Package components" (page 263) lists the IP Phone 1110
package components.

Table 53
Package components

® |P Phone 1110

®* handset
®* handset cord
® 2.1 m (7-ft) CAT5-e Ethernet cable
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®* number plate and lens

® (Getting Started Card

Table 54 "IP Phone 1110 components list" (page 264) lists the IP Phone

1110 components and product codes.

Table 54
IP Phone 1110 components list

Japan

Component Product code
IP Phone 1110 with icon key caps, without power supply (RoHS) NTYS02AAE6
IP Phone 1110 with English key caps, without power supply (RoHS) NTYS02BAE6
Replacement parts

Handset, Charcoal NTYS09AA70
Handset cord, Charcoal NTYS10AA70
Footstand kit, Charcoal (includes the stand and stand cover) NTYS11AA70
Phone number label and lens kit NTYS12AA
2.1 m (7-ft) CAT5-e Ethernet cable NTYS13ABE6
Power supply

Global power supply (for local power) NTYS17xxE6
IEC cables

1.8 m (5.9 ft), 10 amp, IEC320-C13 NTYS14AAE6
North America

Nortel recommends you use the thinner cord (NTYS14AA) as an

alternative to NTTK14AB.

3 m (9.9 ft),125 VAC 13 amp, NA power cord, NEMA North America, NTTK14ABEG6
Middle East, Taiwan, Philippines, Thailand, and Japan

2.4 m (8 ft), 240 VAC 10 amp, ANZ power cord AS-3, Australia, New NTTK15AA
Zealand

Note: ROHS does not apply in this region.

250 VAC, Option 11C Standard European power cord, Other EMEA, NTTK16ABEG6
Kenya, Korea, Thailand, Indonesia, Vietnam, India, Pakistan

3 m (9.9 ft) 125 VAC, Option 11C Swiss power cord Switzerland NTTK17ABEG6
240 VAC, Option 11C UK power cord Hong Kong, Ireland, United NTTK18ABEG6
Kingdom, Singapore, Malaysia, Bangladesh, Brunei, Sri Lanka

3 m (9.9 ft), 125 VAC, Option 11C Denmark power cord Denmark NTTK22ABEG6
Argentina A0814961
Note: ROHS does not apply in this region.

1.8 m (5.9 ft), 10 amp, IEC320-C13 NTTK26AAE6
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Installation and configuration
The following sections provide a step-by-step guide to install and configure
the IP Phone 1110

“Before you begin” (page 265)

“First-time installation” (page 265)
“Configuring the IP Phone 1110” (page 265)
“Connecting the components” (page 266)

“Startup sequence” (page 271)

Before you begin
Before installing the IP Phone 1110, complete the following pre-installation
checklist

Ensure one IP Phone 1110 boxed package exists for each IP Phone
1110 you install. For a list of IP Phone 1110 package components, see
Table 53 "Package components" (page 263).

Ensure one Software License exists for each IP Phone 1110 you
install.

Ensure the host Call Server is equipped with a Signaling Server that
runs the Line TPS application.

If a global power supply is required, ensure the approved Nortel global
power supply (model number NTYS17xxE6) is used. See Table 54 "IP
Phone 1110 components list" (page 264).

Ensure the latest IP Phone firmware is deployed to the IP telephony
node. For more information, see Signaling Server IP Line Applications
Fundamentals (NN43001-125).

First-time installation
You must first install an IP telephony node with the Communication Server.
For information about installing an IP telephony node, see Signaling Server
IP Line Applications Fundamentals (NN43001-125).

CAUTION
Do not plug your IP Phone 1110 into an ISDN connection.
Severe damage can result.

Configuring the IP Phone 1110
Use Procedure 75 “Configuring the IP Phone 1110” (page 266) to
configure the IP Phone 1110 for the first time.
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Procedure 75
Configuring the IP Phone 1110

Step Action

1 Configure a virtual loop on the Call Server using LD 97.

For more information about configuring a virtual loop, see
Signaling Server IP Line Applications Fundamentals (NN430
01-125) and Software Input Output Reference-Administration
(NN43001-611).

2 Configure the IP Phone 1110 on the Call Server using LD 11. At
the prompt, enter the following

REQ:new
TYPE: 1110

For more information about configuring the IP Phone 1110 using
LD 11, see Software Input Output Reference-Administration
(NN43001-611).

3 Configure the IP Phone 1110 in Element Manager. IP Phones
are configured using the Phones section in the Element
Manager navigation tree. For more information about configuring
the IP Phone 1110 using Element Manager, see Element
Manager System Reference - Administration (NN43001-632).

—End--

Connecting the components
Use Procedure 76 “Connecting the components” (page 266) to connect
the components for the IP Phone.

CAUTION

The IP Phone 1110 is shipped with the stand and stand cover
locked in position. To avoid damaging the IP Phone, press the
wall-mount lever to release the stand and pull it away from the
base using the tilt lever.

Procedure 76
Connecting the components

Step Action

1 Press the wall-mount lever to release the stand and pull it away
from the base using the tilt lever. See Figure 42 "Release the IP
Phone 1110 from the stand" (page 267).
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Figure 42
Release the IP Phone 1110 from the stand

Wall-mount
Tilt lever lever

Pull upward on the center catch and remove the stand cover, as
indicated in Figure 43 "Stand cover removed" (page 267). The
cable routing tracks are now accessible.
Figure 43

Stand cover removed

Tilt Lever

/ Button

Handset
cord channel

Connect the global power supply (optional). Leave the global
power supply unplugged from the power outlet, connect the
global power supply to the AC adapter jack in the bottom of the
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phone. Form a small bend in the cable, and then thread the
global power supply cord through the channels in the stand.

WARNING
Use your IP Phone 1110 with the approved Nortel
global power supply (model number NTYS17xxEB6).

The IP Phone 1110 supports both AC power and Power over
LAN options, including IEEE 802.3af Power Classification 2. To
use Power over Ethernet, where power is delivered over the
CAT5-e cable, the LAN must support Power over Ethernet, and a
global power supply is not required. To use local AC power, the
optional global power supply can be ordered separately.

Figure 44 "IP Phone 1110 connections" (page 268) shows the IP
Phone 1110 connections.

Figure 44

IP Phone 1110 connections

PC Ethernet port

LAN Ethernet port

-..-__-_ . 1:: I|I
/ Tilt lever
> | |

Handset jack

Install the handset. Connect the end of the handset cable with
the short straight section into the handset. Connect the end of
the handset cable with the long straight section to the back of the
phone, using the RJ-9 handset jack. Form a small bend in the
cable, and then thread the handset cord through the channels in
the stand so that it exits behind the handset on the right side, in
the channel exit in the stand base. See Figure 45 "Cable routing
tracks" (page 269).
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Although a headset cord channel appears on the base of the
IP Phone 1110, the IP Phone 1110 does not support a headset
port.

Figure 45

Cable routing tracks

Method A

Method B

Install the Ethernet cable. Connect one end of the supplied
Ethernet cable to the back of your phone using the CAT5-e
cable (not provided), and thread the network cable through the
channel.

If you are connecting your PC through the phone a second
CATS5-e cable is required. Only one cable is included with the
IP Phone 1110 package. Connect one end of the PC Ethernet
cable to your phone using the CAT5-e connector (PC Ethernet
port), and thread it through the channel. Connect the other end
to the LAN connector on the back of your PC.

The LAN Ethernet port supports Auto-Media Dependent Interface
Crossover (MDIX). Auto-MDIX is supported only when the
Ethernet port is configured for autonegotiation. The PC Port
does not support Auto-MDIX.

CAUTION

Damage to Equipment

Do not plug any device into your IP Phone 1110
Ethernet port other than an IEEE 802.3 Ethernet
network connection. The IP Phone 1110 does not
support multiple devices connected through the PC
Ethernet Port.
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10

Complete steps 1 to 6, as needed, before wall-mounting the IP
Phone.

Wall-mount your phone (optional). Use Method A or Method B to
wall-mount the IP Phone. See Method A—using the mounting
holes on the bottom of the phone stand, or Method B—using the
traditional-style wall-mount box with a CAT5-e connector and

a 15 cm (6 inch) CAT5-e cord (not provided). See Figure 45
"Cable routing tracks" (page 269).

* Method A: Press the wall-mount lever, and pull away from
the stand. Using the stand cover (see step 2), mark the
wall-mount holes by pressing the bottom of the stand cover
firmly against the wall in the location where you wish to install
the phone. Four small pins on the bottom of the stand cover
make the marks on the wall. Use the marks as a guideline to
install the wall-mount screws (not provided).

Install the screws so that they protrude 3 mm (1/8 inch) from
the wall, and then install the phone stand mounting holes
over the screw heads. You may need to remove the phone
from the wall to adjust the lower screws. When the lower
screws are snug, install the phone on the mounting screws,
and then tighten the top screws.

* Method B: Attach the 15 cm (6 inch) CAT5-e cable (not
provided), position the stand over the mounting rivets, and
slide the phone down the wall so that the rivets fit into the
slots on the stand.

Replace the stand cover. Ensure that all cables are neatly routed
and press the stand cover into place until you hear a click.

If you wall-mount the phone, put it in the wall-mount position by
holding the tilt lever and press the phone towards the base until
the phone is parallel with the base. Release the tilt lever and
continue to push the phone towards the base until you hear an
audible click. Ensure the phone is securely locked in to position.

Connect additional cables. Connect the Ethernet cable to the
LAN Ethernet connection. If you are using a global power supply,
plug the global power supply into an AC outlet.

—End--

When you complete the IP Phone connection, you must connect the phone
to the network. See “Dynamic Host Configuration Protocol” (page 391).
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Startup sequence
When an IP Phone 1110 connects to the network, it must perform a startup
sequence. The elements of the startup sequence include

* obtaining network access (if supported by the network infrastructure)
* obtaining VLAN ID (if supported by the network infrastructure)

® obtaining the IP parameters

* obtaining the provisioning parameters

® connecting to the Call Server

The IP Phone is configured for automatic provisioning by default. For
more information about provisioning the IP Phone automatically, see
“Provisioning the IP Phones” (page 461).

You can manually configure all or some parameters. For information about
manually provisioning the IP Phone, see “Manual provisioning of IP Phone
1110 and 1200 Series” (page 509).

TFTP firmware upgrade
When you enter Cfg TFTP =1 (for yes), and enter an IP address, the IP
Phone searches for an upgrade file on the TFTP Server.

Users of CS 1000 Release 4.5 or later do not need to enter a TFTP IP
address.

For further information about TFTP firmware upgrade, see “TFTP Server”
(page 647).

Redeploying an IP Phone 1110
You can redeploy an existing previously configured IP Phone 1110 on the
same Call Server. For example, the IP Phone 1110 can be assigned to
a new user (new TN) or to an existing user who moved to a new subnet
by changing the TN of the IP Phone 1110. For further information, see
Converging the Data Network with VolP Fundamentals (NN43001-260).

Procedure 77
Changing the TN of an existing IP Phone 1110

Step Action

1 Repower the IP Phone 1110.

During the reboot sequence of a previously configured IP
Phone, the IP Phone 1110 displays the existing node number
for approximately 5 seconds.
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If the node password is enabled and NULL, choose one of the
following

a Disable the password.
b Set the password as non-NULL.
Press OK when the node number displays.

If Then

the node password is enabled a password screen displays. Go

and is not NULL to Step 4.

the node password is disabled a TN screen displays. Go to Step
5.

Enter the password at the password screen and press OK.
A TN screen displays.

To obtain the password, enter the nodePwdShow command in
Element Manager. For further information, see Element Manager
System Reference - Administration (NN43001-632).

Select the Clear soft key to clear the existing TN.
Enter the new TN.

—End--

Replacing an IP Phone 1110

ATTENTION
Two IP Phones cannot share the same TN. You must remove the IP Phone
1110 that currently uses the TN.

Procedure 78
Replacing an IP Phone 1110

Step

Action

1

Obtain the node and TN information of the phone you want to
replace.

Disconnect the IP Phone 1110 that you want to replace.

Follow “Configuring the IP Phone 1110” (page 265) to install
the IP Phone 1110. To configure the IP Phone, see “Manual
provisioning of IP Phone 1110 and 1200 Series” (page 509).

Enter the same TN and Node Number as the IP Phone 1110 you
replaced. The Call Server associates the new IP Phone 1110
with the existing TN.

—End--
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Removing an IP Phone 1110 from service
Procedure 79
Removing an IP Phone 1110 from service

Step

Action

1

Disconnect the IP Phone 1110 from the network or turn off the
power.

The service to the PC is disconnected as well if the PC connects
to the IP Phone 1110.

If the IP Phone 1110 was automatically configured, the DHCP
lease expires and the IP address returns to the available pool.

In LD 11, enter the following:
REQ: OUT

TYPE: 1110

TN: LLL S CCUU

—End--
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Contents

This section contains the following topics:

Introduction

“Introduction” (page 275)

“Description” (page 276)

“Components and functions” (page 277)
“Features” (page 280)

“Dialpad entry” (page 281)

“Display characteristics” (page 282)

“Package components” (page 284)
“Installation and configuration” (page 286)
“Redeploying an IP Phone 1120E” (page 293)
“Replacing an IP Phone 1120E” (page 294)
“Removing an IP Phone 1120E from service” (page 294)

This section explains how to install and maintain the IP Phone 1120E. For
information about using the IP Phone 1120E, see the IP Phone 1120E
User Guide (NN43112-103) or the IP Phone 1120E Getting Started Card
(NN43112-100).

This section contains the following procedures

Procedure 80 “Configuring the IP Phone 1120E” (page 287)
Procedure 81 “Connecting the components” (page 288)

Procedure 82 “Changing the TN of an existing IP Phone 1120E” (page
293).

Procedure 83 “Replacing an IP Phone 1120E” (page 294).
Procedure 84 “Removing an IP Phone 1120E from service” (page 294).
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If power to the phone is interrupted after you install and configure an IP
phone, you are not required to reenter the IP Parameters, Node Numbers,
or Terminal Number (TN). There is also no need to again acquire the
firmware.

Description
The IP Phone 1120E is a multi-line professional-lelP Audio Conference
Phone 2033vel deskset with a high-resolution, fully-backlit, QVGA color
LCD display. The enhanced configuration menus and USB peripheral
support provide a superior navigation experience. The integrated
Bluetooth® Audio gateway offers greater freedom and mobility. The set
includes an integrated phone switch with Gigabit Ethernet LAN and PC
ports. When the phone is idle users fully experience the personalized
background images and capabilities, as well as the Digital Picture Frame
mode.

Figure 46 "IP Phone 1120E" (page 276) shows the IP Phone 1120E.

Figure 46
IP Phone 1120E

Self-labeled line/programmable feature keys

Data message waiting indicator Message waiting indicator

HIIRTEL

Handset

High-reselution
graphical display screen

Context-sensitive soft keys

Navigation keys

Message/Inbox key
Shift/Outbox key
Directory key

Enter key
Goodbye key

Speaker —

Copy key
Services key
Quit/Stop key

Volume control
Expand key

Headset key

Mute key
Handsfree k8 , — * Bo Ne ) - Hold key

Dialpad
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Components and functions
This section describes the following components of the IP Phone 1120E

* “Keys and functions” (page 277)

® “Services menu” (page 279)

* “Local Tools menu” (page 280)

Keys and functions
Table 55 "IP Phone 1120E keys and functions" (page 277) lists the keys
and functions for the IP Phone 1120E.

Table 55
IP Phone 1120E keys and functions
Key Function
Hold Press the Hold key to put an active call on hold. Press the line (DN)
key beside the flashing LCD to return to the caller on hold.
Goodbye Press the Goodbye key to terminate an active call.

Visual Alerter/Message
waiting indicator

Feature Status Lamp
indicator

Self-labeled line/programma
ble feature keys

Context-sensitive soft keys

Fixed feature keys

Expand

When a message is waiting, the red Visual Alerter/Message waiting
indicator lights. Also, when the ringer sounds, this indicator flashes.

When the firmware is updating, the blue Feature Status Lamp
indicator flashes.

This function requires server support and, therefore, is not available
on all phones.

Self-labeled line/programmable feature key labels are configured for
various features on the IP Phones.

A steady LCD light beside a line (DN) key indicates the feature or
line is active. A flashing LCD indicates the line is on hold or the
feature is being programmed.

Context-sensitive soft keys are located below the display area. The
LCD label above the key changes, based on the active feature.
A triangle before a key label indicates that the key is active.

Use these keys to access non-programmable standard features.

The Expand key is used to access an External Application Server
such as, Nortel Application Server.
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Table 55

IP Phone 1120E keys and functions (cont’d.)

Key

Function

Navigation keys

Enter

Message/Inbox
Shift/Outbox

Quit/Stop

Directory
Mute

Headset

Volume control keys

Use the Navigation keys to scroll through menus and lists that
appear on the LCD display screen. The outer part of this key cluster
rocks for up, down, left, and right movements.

Use Up and Down keys to scroll up and down in lists, and the Left
and Right keys to position the cursor. You can also use the Left and
Right keys to select editable fields that appear on the phone. Press
the Right key to select the field below the current position, or press
the Left key to select the field above the current position.

Press the Enter key, at the center of the Navigation key cluster, to
confirm menu selections. In many cases, you can use the Enter key
instead of the Select soft key.

Press the Message/Inbox key to access your voice mailbox.

The Shift/Outbox key is a fixed key that is reserved for future feature
development.

Press the Quit/Stop key to end an active application.

Pressing the Quit/Stop key does not affect the status of the calls
currently on your IP Phone.

Press the Directory key to access Directory services

Press the Mute key to listen to the receiving party without
transmitting.

Press the Mute key again to return to a two-way conversation.

The Mute key applies to Handsfree, Handset, and Headset
microphones.

The Mute LED flashes when the Mute option is in use.

Press the Headset key to answer a call using the headset or to
switch a call from the handset or Handsfree to the headset.

The Headset LED flashes when the Headset option is in use.

Press the volume control keys to adjust the volume of the handset,
headset, speaker, ringer, and, Handsfree feature.

Press the volume key with the loudspeaker icon to increase volume;
press the volume key without the loudspeaker icon to decrease
volume.
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Table 55
IP Phone 1120E keys and functions (cont’d.)
Key Function
Copy Press the Copy Key to copy entries to your Personal Directory
from other lists, such as the Caller List, Redial List and Corporate
Directory.
Speaker Press the Handsfree key to activate the speaker.
Handsfree Press the Handsfree key to activate the Handsfree feature.
The LED lights to indicate when handsfree is active.
Services menu
Table 56 "Services menu" (page 279) shows the Services menu.
Table 56

Services menu

Services

Press the Services key to access the following items

®* Telephone Options

Volume Adjustment
Contrast Adjustment
Language

Date/Time

Display diagnostics
Local Dialpad Tone

Set Info

Diagnostics

Call Log Options

Ring type

Call Timer

OnHook Default Path
Change Feature Key Label
Name Display Format
Live Dialpad

Normal Mode Indication

Caller ID display order

® Virtual Office Login and Virtual Office Logout (if Virtual Office is
configured)
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® Test Local Mode and Resume Local Mode (if Branch Office is
configured)

® Password Admin

You can customize the IP Phone features to meet user
requirements. For more information, see the IP Phone 1120E User
Guide (NN43112-103).

If a call is presented while the user is manipulating an option, the IP Phone 1120E rings and the
DN key flashes. However, the display is not updated with the Caller ID, and the programming
text is not disturbed.

While you are in the Services menu you cannot dial digits but you can use the programmable line
keys, such as Redial (double-press a line key) and Auto dial key to make a call. However, the
display does not update with the dialed digits or Caller ID.

Local Tools menu
Table 57 "Local Tools menu" (page 280) shows the Local Tools menu.

Table 57
Local Tools menu

Press the Services key twice to access the Local Tools menu. The following
items appear in the Local Tools menu

1. Preferences

2. Local Diagnostics

3. Network Configuration
4. Lock Menu

To make a selection, press the number associated with the menu item, or use the navigation keys
to scroll through the menu items. Press the Enter key to select the highlighted menu item.

If you are prompted to enter a password when you double-press the Services key, password
protection is enabled. For more information about password protection and the Local Tools menu,

see “Local Tools menu” (page 441).

Press the Quit/Stop key to exit from any menu or menu item.

Features
The IP Phone 1120E supports the following telephony features

* four self-labeled line/programmable feature keys with labels and
indicators

* four context-sensitive soft keys
Functions for the context-sensitive soft keys are configured in LD 11.

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.



Dialpad entry 281

For more information about context-sensitive soft keys, see Features
and Services Fundamentals (NN43001-106).

high quality speaker phone

volume control keys to adjust ringer, speaker, handset, and headset
volume

ability to change the self-labeled line/programmable feature key labels
seven specialized feature keys
— Quit

— Directory

— Message/Inbox

— Shift/Outbox

— Services

— Copy

— Expand

five call-processing fixed keys
— Mute

— Handsfree

— Goodbye

— Headset

— Hold

For more information about the Expansion Module, see “Expansion
Module for IP Phone 1100 Series” (page 343).

For more information about IP Phone features, see “Features” (page 355).

Dialpad entry

The following rules apply when you enter text and special characters using
the dialpad.

Press a key from 0 to 9 once to enter the corresponding humber.

Press a key from 2 to 9 repeatedly to cycle through the letters
assigned to that key, first in lower case and then in upper case.

For example, if you press the 5 key repeatedly, the following
characters are displayed, one at a time:

j->k->|->J->K->L->5->

See Table 64 "Character key mappings" (page 304) for character key
mappings.
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* The insertion point remains in its current position as long as you
continue to press the same key.

®* The entry is accepted if either a new key is pressed or if two seconds
pass with no entry. The insertion point moves 1 space to the right.

For example, to enter the word Nortel, press the following key
sequence:

6 [2 second delay] 6 78 35

Although special characters are not required, key 1 generates
commonly used special characters, such as the period (.), at symbol
(@), and underscore ().

Table 58
Character key mappings

Key Generates

_-.l@%$%&+1
abcABC2
defDEF3
ghiGHI14
jklIJKL5
mnoMNOG6
paqrsPQRS7
tuvTUVS8
wWXxyzWXYZ9

period (.)

© 00 N o 0o B~ W N P

*

With UNIStim firmware release 3.2 or later, you can use the numeric keys
on an external USB keyboard connected to the IP Phone 1120E to dial
calling numbers.

Display characteristics
An IP Phone 1120E has three major display areas

* “Self-labeled line/programmable feature key label display” (page 283)
* “Information line display” (page 283)
* “Context-sensitive soft key label display” (page 284)

Figure 47 "1120E IP display area" (page 283) shows these three display
areas.
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Figure 47
1120E IP display area

Upper display area NEORTEL
Self-labeled line/
programmable feature keys
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< 10/30 4:30pm
T Trans Conf “Forward  More...
Lower display area - e .
Context-sensitive soft keys x - : l u L‘ d

Self-labeled line/programmable feature key label display
The feature key label area displays a 10-character string for each of the
four feature keys. Each feature key includes the key label and an icon.
The icon state can be on, off, or flashing. A telephone icon displays the
status of the configured DN. Key labels are left-aligned for keys on the
left side of the screen, and right-aligned for keys on the right side of
the screen. To change the feature key label, press the Services key to
access Telephone Options > Change Feature key label option. For more
information about changing the feature key label, see the IP Phone 1120E
User Guide (NN43112-103).

If a label is longer than 10 characters, the last 10 characters are displayed
and the excess characters are deleted from the beginning of the string.

Information line display
An IP Phone 1120E has a one-line information display area with the
following information

* caller number

* caller name

* feature prompt strings

* user-entered digits

* date and time information (if the IP Phone is in an idle state) or Call
Timer (if provisioned in the Telephone options menu)

The information in the display area changes, according to the
call-processing state and active features.
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Because the IP Phone 1120E only has a one-line information display area,
you are prompted to scroll through any additional lines of information.

During an incoming call, only the Directory Number (DN) displays if the
caller name is greater than 10 characters. Press the flashing arrow to
display the caller name.

Context-sensitive soft key label display

The context-sensitive soft key label has a maximum of seven characters.
Each soft key includes the soft key label and an icon. When a soft key is
in use, a triangle icon displays at the beginning of the soft key label, and
the label shifts one character to the right. (If the label is six characters in
length, the last or rightmost character is truncated.) If a feature is enabled,
the icon state turns to On. It remains in the on state until the feature key
is pressed again. This cancels the enabled feature and turns the icon off,
returning the soft key label to its original state.

Use the More soft key to navigate through the layers of functions. If only
four functions are assigned to the soft keys, the More key does not appear,
and all four functions are displayed.

Cleaning the IP Phone display screen
Gently wipe the IP Phone display screen with a soft, dry cloth.

CAUTION

Do not use any liquids or powders on the IP Phone. Using
anything other than a soft, dry cloth can contaminate IP Phone
components and cause premature failure.

Package components
The IP Phone 1120E includes integrated support for a number of
Power over Ethernet options, including support for IEEE 802.3af Power
Classification 3.

Table 59 "Package components" (page 285) lists the IP Phone 1120E
package components.
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Table 59
Package components

* |P Phone 1120E

® handset

® handset cord

® 2.1 m (7-ft) CAT5-e Ethernet cable

®* number plate and lens

® (Getting Started Card

Table 60 "IP Phone 1120E components list" (page 285) lists the IP Phone
1120E components and product codes.

Table 60

IP Phone 1120E components list
Component Product code
IP Phone 1120E with icon key caps (Graphite) NTYSO03AC
IP Phone 1120E with English key caps (Graphite) NTYS03BC
IP Phone 1120E with icon key caps (Graphite) RoHS NTYSO03ACE6
IP Phone 1120E with English key caps (Graphite) RoHS NTYS03BCE6
Replacement parts
Handset, Charcoal NTYSO09AAT70
Handset cord, Charcoal NTYS10AA70
Footstand kit, Charcoal NTYS11AA70
Phone number label and lens kit NTYS12AA
2.1 m (7-ft) CAT5-e Ethernet cable NTYS13ABE
Power supply
Global power supply (for local power) NTYS17xxE6
IEC cables
1.8 m (5.9 ft), 10 amp, IEC320-C13 NTYS14AAEG6
North America
2.4 m (8 ft), 240 VAC 10 amp, ANZ power cord AS-3, NTTK15AA
Australia, New Zealand
Note: ROHS does not apply in this region.
250 VAC, Option 11C Standard European power cord, NTTK16ABE6
Other EMEA, Kenya, Korea, Thailand, Indonesia, Vietham, India,
Pakistan
3 m (9.9 ft) 125 VAC, Option 11C Swiss power cord NTTK17ABE6
Switzerland
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Table 60

IP Phone 1120E components list (cont’d.)

Component

Product code

240 VAC, Option 11C UK power cord NTTK18ABEG6
Hong Kong, Ireland, United Kingdom, Singapore, Malaysia,
Bangladesh, Brunei, Sri Lanka

3 m (9.9 ft), 125 VAC, Option 11C Denmark power cord NTTK22ABEG6
Denmark

Argentina A0814961
Note: ROHS does not apply in this region.

1.8 m (5.9 ft), 10 amp, IEC320-C13 NTTK26AAE6
Japan

Installation and configuration
The following sections provide a step-by-step guide to install and configure
the IP Phone 1120E

“Before you begin” (page 286)

“First-time installation” (page 287)
“Configuring the IP Phone 1120E” (page 287)
“Connecting the components” (page 287)

“Startup sequence” (page 292)

Before you begin
Before installing the IP Phone 1120E, complete the following
pre-installation checklist

Ensure one IP Phone 1120E boxed package exists for each IP Phone
1120E you install. For a list of IP Phone 1120E package components,
see Table 59 "Package components" (page 285).

Ensure one Software License exists for each IP Phone 1120E you
install.

Ensure the host Call Server is equipped with the a voice Gateway
Media Card and a Signaling Server with the Line TPS application.

If a global power supply is required, ensure the approved Nortel global
power supply (model number NTYS17xxE6) is used. See Table 60 "IP
Phone 1120E components list" (page 285).

Ensure the latest IP Phone firmware is deployed to the IP telephony
node. For more information, see Signaling Server IP Line Applications
Fundamentals (NN43001-125).
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First-time installation
You must first install an IP telephony node with the Communication Server.
For information about installing an IP telephony node, see Signaling Server
IP Line Applications Fundamentals (NN43001-125).

CAUTION

Damage to Equipment

Do not plug your IP Phone 1120E into an ISDN connection.
Severe damage can result. The IP Phone 1120E does not
support multiple devices connected through the PC Ethernet
port.

Configuring the IP Phone 1120E
Use Procedure 80 “Configuring the IP Phone 1120E” (page 287) to
configure the IP Phone 1120E for the first time.

Procedure 80
Configuring the IP Phone 1120E

Step Action

1 Configure a virtual loop on the Call Server using LD 97.

For more information about configuring a virtual loop, see
Signaling Server IP Line Applications Fundamentals (NN430
01-125) and Software Input Output Reference-Administration
(NN43001-611).

2 Configure the IP Phone 1120E on the Call Server using LD 11.
At the prompt, enter the following

REQ:new
TYPE: 1120

For more information about configuring the IP Phone 1120E usi
ng LD 11, see Software Input Output Reference-Administration
(NN43001-611).

3 Configure the IP Phone 1120E in Element Manager. IP Phones
are configured using the Phones section in the Element
Manager navigation tree. For more information about configuring
the IP Phone 1120E using Element Manager, see Element
Manager System Reference - Administration (NN43001-632).

—End--

Connecting the components
Use Procedure 81 “Connecting the components” (page 288) to connect
the components for the IP Phone.
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CAUTION

The IP Phone 1120E is shipped with the stand locked in
position. To avoid damaging the IP Phone, press the wall-mount
lever located under the Handsfree key to release the stand and
pull it away from the phone.

Procedure 81
Connecting the components

Step Action

1 Press the wall-mount lever located under the Handsfree key to
release the stand and pull it away from the phone. See Figure 48
"Release the IP Phone 1120E from the stand" (page 288).

Figure 48
Release the IP Phone 1120E from the stand

‘Wall mount lever

Tilt lever

2 Remove the stand cover. Pull upward on the center catch and
remove the stand cover. The cable routing tracks are now
accessible. See Figure 43 "Stand cover removed" (page 267).
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Figure 49
Stand cover removed

Tilt lever button

Center Catch

Connect the global power supply (optional). Leave the global
power supply unplugged from the power outlet, connect the
global power supply to the AC adapter jack in the bottom of the
phone. Form a small bend in the cable, and then thread the
global power supply cord through the channels in the stand.

WARNING
Use your IP Phone 1120E with the approved Nortel
global power supply (model number NTYS17xxE6).

The IP Phone 1120E supports both AC power and
Power over LAN options, including IEEE 802.3af
Power Classification 3. To use Power over Ethernet,
where power is delivered over the CAT5-e cable, the
LAN must support Power over Ethernet, and a global
power supply is not required. To use local AC power,
the global power supply can be ordered separately.
You must use CAT5-e (or later) cables if you want to
use Gigabit Ethernet.
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Figure 50
IP Phone 1120E connections

Accessory Expansion Module port

PC Ethemet port

LAM Ethernet port

Tilt lever

Link lamp

AC adapter jack
Headset jack

USB connector Handset jack

4 Install the handset. Connect the end of the handset cable with
the short straight section into the handset. Connect the end of
the handset cable with the long straight section to the back of the
phone, using the RJ-9 handset jack. Form a small bend in the
cable, and then thread the handset cord through the channels in
the stand so that it exits behind the handset on the right side, in
the channel exit in the stand base. See Figure 51 "Cable routing
tracks" (page 291).
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Figure 51
Cable routing tracks

Method B

S =1 aannaaaans
— == i T

Install the Ethernet cable. Connect one end of the supplied
Ethernet cable to the back of your phone using the CAT5-e
connector (LAN Ethernet port), and thread the network cable
through the channel (LAN Ethernet port).

If you are connecting your PC through the phone, a second
CAT5-e cable is required. Only one cable is included with the IP
Phone 1120E package. Install the Ethernet cable connecting the
PC to the phone (optional). Connect one end of the PC Ethernet
cable to your phone using the CAT5-e connector (PC Ethernet
port), and thread it through the channel. Connect the other end
to the LAN connector on the back of your PC.

The LAN Ethernet port supports Auto-Media Dependent Interface
Crossover (MDIX). Auto-MDIX is supported only when the
Ethernet port is configured for autonegotiation. The PC Port
does not support Auto-MDIX.

CAUTION

Damage to Equipment

Do not plug any device into your IP Phone 1120E
Ethernet port other than an IEEE 802.3 Ethernet
network connection.

Connect additional cables. If applicable, plug in optional USB
devices. Connect the Ethernet cable to the LAN Ethernet
connection. If you are using a global power supply, plug the
adapter into an AC outlet.

Complete steps 1 to 7, as needed, before wall-mounting the IP
Phone.
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10

Wall-mount your phone (optional). Use Method A or Method B to
wall-mount the IP Phone. See Method A—using the mounting
holes on the bottom of the phone stand, or Method B—using the
traditional-style wall-mount box with a CAT5-e connector and a
15 cm (6 inch) CAT5-e cord (not provided).

* Method A: Press the wall-mount lever, and pull away from
the stand. Using the stand cover (see step 2), mark the
wall-mount holes by pressing the bottom of the stand cover
firmly against the wall in the location where you wish to install
the phone. Four small pins on the bottom of the stand cover
make the marks on the wall. Use the marks as a guideline to
install the wall-mount screws (not provided).

Install the screws so that they protrude 3 mm (1/8 inch) from
the wall, and then install the phone stand mounting holes
over the screw heads. You may need to remove the phone
from the wall to adjust the lower screws. When the lower
screws are snug, install the phone on the mounting screws,
and then tighten the top screws.

* Method B: Attach the 15 cm (6 inch) CAT5-e cable, position
the stand over the mounting rivets, and slide the phone down
the wall so that the rivets fit into the slots on the stand.

Replace the stand cover. Ensure that all cables are neatly routed
and press the stand cover into place until you hear a click.

If you wall-mount the phone, put it in the wall-mount position by
holding the tilt lever and press the phone towards the base until
the phone is parallel with the base. Release the tilt lever and
continue to push the phone towards the base until you hear a
click. Ensure the phone is securely locked in to position.

—End--

When you complete the IP Phone connection, you must connect the phone
to the network. See “Dynamic Host Configuration Protocol” (page 391).

Startup sequence

When an

IP Phone 1120E connects to the network, it must perform a

startup sequence. The elements of the startup sequence include

* obtaining network access (if supported by the network infrastructure)

* obtaining VLAN ID (if supported by the network infrastructure)

® obtaining the IP parameters

* obtaining the provisioning parameters

® connecting to the Call Server
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The IP Phone is configured for automatic provisioning by default. For
more information about provisioning the IP Phone automatically, see
“Provisioning the IP Phones” (page 461).

You can manually configure all or some parameters. For information about
manually provisioning the IP Phone, see “Manual provisioning of IP Phone
2007 and 1100 Series” (page 519).

TFTP firmware upgrade
When you enter Cfg TFTP =1 (for yes), and enter an IP address, the IP
Phone searches for an upgrade file on the TFTP Server.

Users of CS 1000 Release 4.5, or later do not need to enter a TFTP IP
address.

For further information about TFTP firmware upgrade, see “TFTP Server”
(page 647).

Redeploying an IP Phone 1120E
You can redeploy an existing previously configured IP Phone 1120E on
the same Call Server. For example, the IP Phone 1120E can be assigned
to a new user (new TN) or to an existing user who moved to a new subnet
by changing the TN of the IP Phone 1120E. For further information, see
Converging the Data Network with VolP Fundamentals (NN43001-260).

Procedure 82
Changing the TN of an existing IP Phone 1120E

Step Action

1 Repower the IP Phone 1120E.

During the reboot sequence of a previously configured IP Phone,
the IP Phone 1120E displays the existing node number for
approximately 5 seconds.

2 If the node password is enabled and NULL, choose one of the
following

a Disable the password.
b Set the password as non-NULL.

3 Press OK when the node number displays.
If Then
the node password is enabled a password screen displays. Go
and is not NULL to Step 4.
the node password is disabled a TN screen displays. Go to Step
5.
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Enter the password at the password screen and press OK.
A TN screen displays.

To obtain the password, enter the nodePwdShow command in
Element Manager. For further information, see Element Manager
System Reference - Administration (NN43001-632).

Select the Clear soft key to clear the existing TN.
Enter the new TN.

—End--

Replacing an IP Phone 1120E

ATTENTION

Two IP Phones cannot share the same TN. You must remove the IP Phone
1120E that currently uses the TN.

Procedure 83
Replacing an IP Phone 1120E

Step

Action

1

Obtain the node and TN information of the phone you want to
replace.

Disconnect the IP Phone 1120E that you want to replace.

Follow “Configuring the IP Phone 1120E” (page 287) to install
the IP Phone 1120E. To configure the IP Phone, see “Manual
provisioning of IP Phone 2007 and 1100 Series” (page 519).

Enter the same TN and Node Number as the IP Phone 1120E
you replaced. The Call Server associates the new IP Phone
1120E with the existing TN.

—End--

Removing an IP Phone 1120E from service

Procedure 84
Removing an IP Phone 1120E from service

Step

Action

1

Disconnect the IP Phone 1120E from the network or turn off the
power.

The service to the PC is disconnected as well if the PC connects
to the IP Phone 1120E.
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If the IP Phone 1120E was automatically configured, the DHCP
lease expires and the IP address returns to the available pool.

In LD 11, enter the following:
REQ: OUT

TYPE: 1120

TN: LLL S CC UU

—End--

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.



296 Nortel IP Phone 1120E

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.



297

Nortel IP Phone 1140E

Contents

This section contains the following topics:

Introduction

“Introduction” (page 297)

“Description” (page 298)

“Components and functions” (page 299)
“Features” (page 302)

“Dialpad entry” (page 303)

“Display characteristics” (page 304)

“Cleaning the IP Phone display screen” (page 306)
“Package components” (page 306)

“Installation and configuration” (page 308)

“TFTP firmware upgrade " (page 314)

“Bluetooth® wireless technology” (page 314)
“Redeploying an IP Phone 1140E” (page 314)
“Replacing an IP Phone 1140E” (page 315)
“Removing an IP Phone 1140E from service” (page 316)

This section explains how to install and maintain the IP Phone 1140E. For
information about using the IP Phone 1140E, see the IP Phone 1140E
User Guide (NN43113-106) or IP Phone 1140E Getting Started Card
(NN43113-103).

This section contains the following procedures

Procedure 85 “Configuring the IP Phone 1140E” (page 309)

Procedure 86 “Connecting the components” (page 309)
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Description

Figure 52
IP Phone 1140E

* Procedure 87 “Changing the TN of an existing IP Phone 1140E” (page
314).

* Procedure 88 “Replacing an IP Phone 1140E” (page 315).
* Procedure 89 “Removing an IP Phone 1140E from service” (page 316).

If power to the phone is interrupted after you install and configure an IP
phone, you are not required to reenter the IP Parameters, Node Numbers,
or Terminal Number (TN). There is also no need to again acquire the
firmware.

The IP Phone 1140E is a multi-line professional-leIP Audio Conference
Phone 2033vel deskset with a high-resolution, fully-backlit, QVGA color
LCD display. The enhanced configuration menus and USB peripheral
support provide a superior navigation experience. The integrated
Bluetooth® Audio gateway offers greater freedom and mobility. The set
includes an integrated phone switch with Gigabit Ethernet LAN and PC
ports. When the phone is idle users fully experience the personalized
background images and capabilities, as well as the Digital Picture Frame
mode.

Figure 52 "IP Phone 1140E" (page 298) shows the IP Phone 1140E.

Data message waiting indicator

Handset

Speaker

Copy key
Services key
Quit/Stop key

Volume control

Mute key
Handsfree keyg

Self-labeled line/programmable feature keys

Message waiting indicator

High-resolution
graphical display screen

Context-sensitive
soft keys

Enter key
Message/Inbox key
Shift/Outbox key
Directory key

Goodbye key
Expand key
g Headset key
Hold key

Navigation keys
Dialpad
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Components and functions
This section describes the following components of the IP Phone 1140E

* “Keys and functions” (page 299)

* “Services menu” (page 301)

* “Local Tools menu” (page 302)

Keys and functions
Table 61 "IP Phone 1140E keys and functions" (page 299) lists keys and
functions for the IP Phone 1140E.

Table 61
IP Phone 1140E keys and functions
Key Function
Hold Press the Hold key to put an active call on hold. Press the line (DN)
key beside the flashing LCD to return to the caller on hold.
Goodbye Press the Goodbye key to terminate an active call.

Visual Alerter/Message
waiting indicator

Feature Status Lamp
indicator

Self-labeled line/programma
ble feature keys labels

Context-sensitive soft keys

Fixed feature keys

Expand

When a message is waiting, the red Visual Alerter/Message waiting
indicator lights. Also, when the ringer sounds, this indicator flashes.

When the firmware is updating, the blue Feature Status Lamp
indicator flashes.

This function requires server support and, therefore, is not available
on all phones.

Self-labeled line/programmable key labels are configured for various
features on the IP Phones.

A steady LCD light beside a line (DN) key indicates the feature or
line is active. A flashing LCD indicates the line is on hold or the
feature is being programmed.

Context-sensitive soft keys are located below the display area. The
LCD label above the key changes, based on the active feature.

A triangle before a key label indicates that the key is active.

Use these keys to access non-programmable standard features.

The Expand key is used to access external server applications, such
as Nortel Application Server.
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Table 61

IP Phone 1140E keys and functions (cont’d.)

Key

Function

Navigation keys

Enter

Message/Inbox
Shift/Outbox

Quit/Stop

Directory
Mute

Headset

Use the Navigation keys to scroll through menus and lists that
appear on the LCD display screen. The outer part of this key cluster
rocks for up, down, left, and right movements.

Use Up and Down keys to scroll up and down in lists, and the Left
and Right keys to position the cursor. You can also use the Left and
Right keys to select editable fields that appear on the phone. Press
the Right key to select the field below the current position, or press
the Left key to select the field above the current position.

Press the Enter key, at the center of the Navigation key cluster, to
confirm menu selections. In many cases, you can use the Enter key
instead of the Select soft key.

Press the Message/Inbox key to access your voice mailbox.

The Shift/Outbox key is a fixed key that is reserved for future feature
development.

Press the Quit/Stop key to end an active application.

Pressing the Quit/Stop key does not affect the status of the calls
currently on your IP Phone.

Press the Directory key to access Directory services.

Press the Mute key to listen to the receiving party without
transmitting.

Press the Mute key again to return to a two-way conversation.

The Mute key applies to Handsfree, Handset, and Headset
microphones.

The Mute LED flashes when the Mute option is in use.

Press the Headset key to answer a call using the headset or to
switch a call from the handset or Handsfree to the headset.

Press the Headset key twice to access Bluetooth® Setup menu.
If Bluetooth® wireless technology is not enabled, this menu is not
available.
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Table 61
IP Phone 1140E keys and functions (cont’d.)

Key Function

Volume control keys

Use the Volume control keys to adjust the volume of the handset,
headset, speaker, ringer, and Handsfree feature.

Press the volume key with the loudspeaker icon to increase volume;
press the volume key without the loudspeaker icon to decrease

volume.

Copy Press the Copy Key to copy entries to your Personal Directory
from other lists, such as the Caller List, Redial List and Corporate
Directory.

Speaker Press the Handsfree key to activate the speaker.

Handsfree key Press the Handsfree key to activate handsfree.

The LED lights to indicate when the handsfree feature is active.

Services menu

Table 62 "Services menu" (page 301) shows the Services menu.

Table 62
Services menu

® Telephone Options

— Language

— Date/Time

— Set Info

— Diagnostics

— Call Log Options
— Ring type

— Call Timer

— Volume Adjustment

— Contrast Adjustment

— Display diagnostics

— Local Dialpad Tone

Services Press the Services key to access the following items

OnHook Default Path
Change Feature Key Label
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— Name Display Format

— Live Dialpad
® Virtual Office Login and Virtual Office Logout (if Virtual Office is configured)
® Test Local Mode and Resume Local Mode (if Branch Office is configured)

® Password Admin

You can customize the IP Phone features to meet user requirements. For
more information, see the IP Phone 1140E User Guide (NN43113-106).

If a call is presented while the user is manipulating an option, the IP Phone 1140E rings and the
DN key flashes. However, the display is not updated with the Caller ID, and the programming
text is not disturbed.

While you are in the Services menu you cannot dial digits but you can use the programmable line
keys, such as Redial (double-press a line key) and Auto dial key to make a call. However, the
display does not update with the dialed digits or Caller ID.

Local Tools menu
Table 63 "Local Tools menu" (page 302) shows the Local Tools menu.

Table 63
Local Tools menu

Press the Services key twice to access the Local Tools menu. The following
items appear in the Local Tools menu

1. Preferences

2. Local Diagnostics

3. Network Configuration
4. Lock Menu

To make a selection, press the number associated with the menu item, or use
the navigation keys to scroll through the menu items. Press the Enter key to
select the highlighted menu item.

If you are prompted to enter a password when you double-press the Services
key, password protection is enabled. For more information about password
protection and the Local Tools menu, see “Local Tools menu” (page 441).

Press the Quit/Stop key to exit from any menu or menu item.

Features
The IP Phone 1140E supports the following telephony features

* six self-labeled line/programmable feature keys with labels and
indicators
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Supports up to 12 DNs or features on 2 pages. Use the Shift/Outbox
key to access the second page of DNs or features.

four context-sensitive soft keys
Functions for the context-sensitive soft keys are configured in LD 11.

For more information about context-sensitive soft keys, see Features
and Services Fundamentals (NN43001-106).

high quality speaker phone

volume control keys to adjust ringer, speaker, handset, and headset
volume

ability to change user-defined feature key labels
seven specialized feature keys
— Quit/Stop

— Directory

— Message/Inbox

— Shift/Outbox

— Services

— Copy

— Expand

five call-processing fixed keys
— Mute

— Handsfree

— Goodbye

— Headset

— Hold

For more information about the Expansion Module, see “Expansion
Module for IP Phone 1100 Series” (page 343).

For more information about IP Phone features, see “Features” (page 355).

Dialpad entry

The following rules apply when you enter text and special characters using
the dialpad.

Press a key from 0 to 9 once to enter the corresponding humber.

Press a key from 2 to 9 repeatedly to cycle through the letters
assigned to that key, first in lower case and then in upper case.
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For example, if you press the 5 key repeatedly, the following
characters are displayed, one at a time:

j>k->1->J->K->L->5->
See Table 64 "Character key mappings" (page 304) for character key mappings.

* The insertion point remains in its current position as long as you
continue to press the same key.

* The entry is accepted if either a new key is pressed or if two seconds
pass with no entry. The insertion point moves 1 space to the right.

For example, to enter the word Nortel, press the following key
sequence:

6 [2 second delay] 6 78 35

Although special characters are not required, key 1 generates
commonly used special characters, such as the period (.), at symbol
(@), and underscore ().

Table 64
Character key mappings

Key Generates

- l@swe&+1
abcABC2
defDEF3
ghiGHI14
jkIJKLS5
mnoMNOG6
pgqrsPQRS7
tuvTUVS

WXYyzWXYZ9

© 00 N o o b~ WDN PP

With UNIStim firmware release 3.2 or later, you can use the numeric keys
on an external USB keyboard connected to the IP Phone 1140E to dial
calling numbers.

Display characteristics
The IP Phone 1140E has three major display areas

* “Self-labeled line/programmable feature key label display” (page 305)
* “Information line display” (page 305)
* ‘“Context-sensitive soft key label display” (page 306)

Figure 53 "IP Phone 1140E display area" (page 305) shows the three
display areas.

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.



Display characteristics 305

Figure 53
IP Phone 1140E display area
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Self-labeled line/programmable feature key label display
The feature key label area displays a 10-character string for each of the six
feature keys. Each feature key includes the key label and an icon. The
icon state can be on, off, or flashing. A telephone icon displays the status
of the configured DN. Key labels are left-aligned for keys on the left side of
the screen, and right-aligned for keys on the right side of the screen. To
change the feature key label, press the Services key to access Telephone
Options > Change Feature key label option. For more information about
changing the feature key label, see the IP Phone 1140E User Guide
(NN43113-106).

If a label is longer than 10 characters, the last 10 characters are displayed
and the excess characters are deleted from the beginning of the string.

Information line display
The IP Phone 1140E has a three-line information display area with the
following information

e caller number

* caller name

* feature prompt strings

* user-entered digits

* date and time information (if the IP Phone is in an idle state) or Call
Timer (if provisioned in the Telephone options menu)

The information in the display area changes, according to the
call-processing state and active features.
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Context-sensitive soft key label display

The context-sensitive soft key label has a maximum of seven characters.
Each soft key includes the soft key label and an icon. When a soft key is
in use, a triangle icon displays at the beginning of the soft key label, and
the label shifts one character to the right. (If the label is six characters in
length, the last or rightmost character is truncated.) If a feature is enabled,
the icon state turns to On. It remains in the on state until the feature key
is pressed again. This cancels the enabled feature and turns the icon off,
returning the soft key label to its original state.

Use the More soft key to navigate through the layers of functions. If only
four functions are assigned to the soft keys, the More key does not appear,
and all four functions are displayed.

Cleaning the IP Phone display screen

Gently wipe the IP Phone display screen with a soft, dry cloth.

CAUTION

Do not use any liquids or powders on the IP Phone. Using
anything other than a soft, dry cloth can contaminate IP Phone
components and cause premature failure.

Package components

Table 65

The IP Phone 1140E includes integrated support for a number of
Power over Ethernet options, including support for IEEE 802.3af Power
Classification 3.

Table 65 "Package components" (page 306) lists the IP Phone 1140E
package components.

Package components

handset cord
2.1 m (7-ft) CAT5-e Ethernet cable

IP Phone 1140E

number plate and lens

Getting Started Card

Table 66 "IP Phone 1140E component list" (page 307) lists the IP Phone
1140E components and product codes.
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Table 66
IP Phone 1140E component list

Japan

Component Product code
IP Phone 1140E with icon keycaps (Graphite) NTYSO05AC
IP Phone 1140E with English keycaps (Graphite) NTYS05BC
IP Phone 1140E with icon keycaps (Graphite) RoHS NTYSO05ACE6
IP Phone 1140E with English keycaps (Graphite) RoHS NTYSO05BBE6
Replacement parts

Handset, Charcoal NTYSO09AA70
Handset cord, Charcoal NTYS10AA70
Footstand kit, Charcoal NTYS11AA70
Phone number label and lens kit NTYS12AA
2.1 m (7-ft) CAT5-e Ethernet cable NTYS13ABE6
Power supply

Global power supply NTYS17xxE6
IEC cable

1.8m (5.9 ﬁ), 10 amp, IEC320-C13 NTYS14AAEG
North America

2.4 m (8 ft), 240 VAC 10 amp, ANZ power cord AS-3,

Australia, New Zealand NTTK15AA
Note: ROHS does not apply in this region.

250 VAC, Option 11C Standard European power cord,

Other EMEA, Kenya, Korea, Thailand, Indonesia, Vietham, India, NTTK16ABEG6
Pakistan

3 m (9.9 ft) 125 VAC, Option 11C Swiss power cord NTTK17ABE6G
Switzerland

240 VAC, Option 11C UK power cord

Hong Kong, Ireland, United Kingdom, Singapore, Malaysia, NTTK18ABEG6
Bangladesh, Brunei, Sri Lanka

3 m (9.9 ft), 125 VAC, Option 11C Denmark power cord NTTK22ABE6G
Denmark

Argentina

Note: ROHS does not apply in this region. A0814961

1.8 m (5.9 ft), 10 amp, IEC320-C13 NTTK26AAES
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Installation and configuration
The following sections provide a step-by-step guide to install and configure
the IP Phone 1140E

“Before you begin” (page 308)

“First-time installation” (page 308)
“Configuring the IP Phone 1140E” (page 308)
“Connecting the components” (page 309)

“Startup sequence” (page 314)

Before you begin
Before installing the IP Phone 1140E, complete the following
pre-installation checklist

Ensure one IP Phone 1140E boxed package exists for each IP Phone
1140E you install. For a list of IP Phone 1140E package components,
see Table 65 "Package components" (page 306).

Ensure one Software License exists for each IP Phone 1140E you
install.

Ensure the host Call Server is equipped with a Voice Gateway Media
Card and a Signaling Server with the Line TPS application.

If a global power supply is required, ensure the approved Nortel global
power supply (model number NTYS17xxEB6) is used. See Table 66 "IP
Phone 1140E component list" (page 307).

Ensure the latest IP Phone firmware is deployed to the IP telephony
node. For more information, see Signaling Server IP Line Applications
Fundamentals (NN43001-125).

First-time installation
You must first install an IP telephony node with the Communication Server.
For information about installing an IP telephony node, see Signaling Server
IP Line Applications Fundamentals (NN43001-125).

CAUTION

Damage to Equipment

Do not plug your IP Phone 1140E into an ISDN connection.
Severe damage can result.

Configuring the IP Phone 1140E
Use Procedure 85 “Configuring the IP Phone 1140E” (page 309) to
configure the IP Phone 1140E.
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Procedure 85
Configuring the IP Phone 1140E

Step

Action

1

Configure a virtual loop on the Call Server using LD 97.

For more information about configuring a virtual loop, see
Signaling Server IP Line Applications Fundamentals (NN430
01-125) and Software Input Output Reference-Administration
(NN43001-611).

Configure the IP Phone 1140E on the Call Server using LD 11.
At the prompt, enter the following

REQ: new
TYPE: 1140

For more information about configuring the IP Phone 1140E usi
ng LD 11, see Software Input Output Reference-Administration
(NN43001-611).

Configure the IP Phone 1140E in Element Manager. IP Phones
are configured using the Phones section in the Element
Manager navigation tree. For more information about configuring
the IP Phone 1140E using Element Manager, see Element
Manager System Reference - Administration (NN43001-632).

—End--

Connecting the components
Use Procedure 86 “Connecting the components” (page 309) to connect
the components for the IP Phone.

CAUTION

The IP Phone 1140E is shipped with the stand locked in
position. To avoid damaging the IP Phone, press the wall-mount
lever located under the Handsfree key to release the stand and
pull it away from the phone.

Procedure 86
Connecting the components

Step

Action

1

Press the wall-mount lever located under the Handsfree key to
release the stand and pull it away from the phone. See Figure 54
"Release the IP Phone 1140E from the stand" (page 310).
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Figure 54
Release the IP Phone 1140E from the stand

‘Wall mount lever

Tilt lever

2 Remove the stand cover. Pull upward on the center catch and
remove the stand cover. The cable routing tracks are now
accessible. See Figure 55 "Stand cover removed" (page 310).
Figure 55
Stand cover removed

Tilt lever button

Center Catch

3 Connect the global power supply (optional). Leave the global
power supply unplugged from the power outlet, connect the
global power supply to the AC adapter jack in the bottom of the
phone. Form a small bend in the cable, and then thread the
global power supply cord through the channels in the stand.
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WARNING
Use your IP Phone 1140E with the approved Nortel
global power supply (model number NTYS17xxE6).

The IP Phone 1140E supports both AC power and Power over
Ethernet options, including IEEE 802.3af Power Classification 3.
To use Power over Ethernet, where power is delivered over the
CAT5-e cable, the LAN must support Power over Ethernet, and a
global power supply is not required. To use local AC power, the
optional global power supply can be ordered separately.

You must use CAT5-e (or later) cables if you want to use Gigabit
Ethernet.

Figure 56

IP_ Phone 1140E connections

Accessory Expansion Module port

PC Ethemet port

LAM Ethernet port

Tilt lever

Link lamp

AC adapter jack
Headset jack

USB connector Handset jack

Install the handset. Connect the end of the handset cable with
the short straight section into the handset. Connect the end of
the handset cable with the long straight section to the back of the
phone, using the RJ-9 handset jack. Form a small bend in the
cable, and then thread the handset cord through the channels

in the stand so that it exits behind the handset on the right side,
in the channel exit in the stand base marked with the handset
symbol. See Figure 57 "Cable routing tracks" (page 312).
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Figure 57
Cable routing tracks

Method B

Method A

I G R0

Install the headset (optional). If you are installing a headset,
plug the connector into the RJ-9 headset jack on the back of the
phone, and thread the headset cord along with the handset cord
through the channels in the stand, so that the headset cord exits
the channel marked with the headset symbol. See Figure 57
"Cable routing tracks" (page 312).

Install the Ethernet cable. Connect one end of the supplied
Ethernet cable to the back of your phone using the CAT5-e
connector (LAN Ethernet port), and thread the network cable
through the channel.

If you are connecting your PC through the phone, a second
CAT5-e cable is required. Only one cable is included with the IP
Phone 1140E package. Install the Ethernet cable connecting the
PC to the phone (optional). Connect one end of the PC Ethernet
cable to your phone using the CAT5-e (PC Ethernet port), and
thread it through the channel marked with the symbol. Connect
the other end to the LAN connector on the back of your PC.

The LAN Ethernet port supports Auto-Media Dependent Interface
Crossover (MDIX). Auto-MDIX is supported only when the
Ethernet port is configured for autonegotiation. The PC Port
does not support Auto-MDIX.
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10

11

CAUTION

Damage to Equipment

Do not plug any device into your IP Phone 1140E
Ethernet port other than an IEEE 802.3 Ethernet
network connection. The IP Phone 1140E does not
support multiple devices connected through the PC

Ethernet port.

Connect additional cables. If applicable, plug in optional USB
devices. Connect the Ethernet cable to the LAN Ethernet
connection. If you are using a global power supply, plug the
adapter into an AC oultlet.

Complete steps 1 to 8, as needed, before wall-mounting the IP
Phone.

Wall-mount your phone (optional). Use Method A or Method B to
wall-mount the IP Phone. See Method A—using the mounting
holes on the bottom of the phone stand, or Method B—using the
traditional-style wall-mount box with a CAT5-e connector and a
15 cm (6 inch) CAT5-e cord (not provided).

* Method A: Press the wall-mount lever, and pull away from
the stand. Using the stand cover (see step 2), mark the
wall-mount holes by pressing the bottom of the stand cover
firmly against the wall in the location where you wish to install
the phone. Four small pins on the bottom of the stand cover
make the marks on the wall. Use the marks as a guideline to
install the wall-mount screws (not provided).

Install the screws so that they protrude 3 mm (1/8 inch) from
the wall, and then install the phone stand mounting holes
over the screw heads. You may need to remove the phone
from the wall to adjust the lower screws. When the lower
screws are snug, install the phone on the mounting screws,
and then tighten the top screws.

* Method B: Attach the 15 cm (6 inch) CAT5-e cable, position
the stand over the mounting rivets, and slide the phone down
the wall so that the rivets fit into the slots on the stand.

Replace the stand cover. Ensure that all cables are neatly routed
and press the stand cover into place until you hear a click.

If you wall-mount the phone, put it in the wall-mount position by
holding the tilt lever and press the phone towards the base until
the phone is parallel with the base. Release the tilt lever and
continue to push the phone towards the base until you hear a
click. Ensure the phone is securely locked in to position.

—End--
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When you complete the IP Phone connection, you must connect the phone
to the network. See “Dynamic Host Configuration Protocol” (page 391).

Startup sequence
When an IP Phone 1140E connects to the network, it must perform a
startup sequence. The elements of the startup sequence include

* obtaining network access (if supported by the network infrastructure)
* obtaining VLAN ID (if supported by the network infrastructure)

® obtaining the IP parameters

* obtaining the provisioning parameters

® connecting to the Call Server

The IP Phone is configured for automatic provisioning by default. For
more information about provisioning the IP Phone automatically, see
“Provisioning the IP Phones” (page 461).

You can manually configure all or some parameters. For information about
manually provisioning the IP Phone, see “Manual provisioning of IP Phone
2007 and 1100 Series” (page 519).

TFTP firmware upgrade
When you enter Cfg TFTP =1 (for yes), and enter an IP address, the IP
Phone searches for an upgrade file on the TFTP Server.

Users of CS 1000 Release 4.5, or later do not need to enter a TFTP IP
address.

For further information about TFTP firmware upgrade, see “TFTP Server”
(page 647).

Bluetooth® wireless technology
The IP Phone 1140E supports Bluetooth® wireless technology. For
information about configuring Bluetooth® wireless technology on the IP
Phone 1140E, see Headset “Headset support” (page 541).

Redeploying an IP Phone 1140E
You can redeploy an existing previously configured IP Phone 1140E on
the same Call Server. For example, the IP Phone 1140E can be assigned
to a new user (new TN) or to an existing user who moved to a new subnet
by changing the TN of the IP Phone 1140E. For further information, see
Converging the Data Network with VolP Fundamentals (NN43001-260).

Procedure 87
Changing the TN of an existing IP Phone 1140E
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Step

Action

Repower the IP Phone 1140E.

During the reboot sequence of a previously configured IP Phone,
the IP Phone 1140E displays the existing node number for
approximately five seconds.

If the node password is enabled and NULL, choose one of the
following

a Disable the password.
b Set the password as non-NULL.
Press OK when the node number displays.

If Then

the node password is enabled a password screen displays. Go

and is not NULL to Step 4.

the node password is disabled a TN screen displays. Go to Step
5.

Enter the password at the password screen, and press OK.
A TN screen displays.

To obtain the password, enter the nodePwdShow command in
Element Manager. For further information, see Element Manager
System Reference - Administration (NN43001-632).

Select the Clear soft key to clear the existing TN.
Enter the new TN.

—End--

Replacing an IP Phone 1140E

ATTENTION
Two IP Phones cannot share the same TN. You must remove the IP Phone
1140E that currently uses the TN.

Procedure 88
Replacing an IP Phone 1140E

Step

Action

1

Obtain the node and TN information of the phone you want to
replace.

Disconnect the IP Phone 1140E that you want to replace.
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Follow “Configuring the IP Phone 1140E” (page 308) to install
the IP Phone 1140E. To configure the IP Phone, see “Manual
provisioning of IP Phone 2007 and 1100 Series” (page 519).

Enter the same TN and Node Number as the IP Phone 1140E
you replaced. The Call Server associates the new IP Phone
1140E with the existing TN.

—End--

Removing an IP Phone 1140E from service
Procedure 89
Removing an IP Phone 1140E from service

Step

Action

1

Disconnect the IP Phone 1140E from the network or turn the
power off.

The service to the PC is disconnected as well if the PC connects
to the IP Phone 1140E.

If the IP Phone 1140E was automatically configured, the DHCP
lease expires and the IP address returns to the available pool.

In LD 11, enter the following:
REQ: OUT

TYPE: 1140

TN: LLL S CCUU

—End--
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Contents

This section contains the following topics:

Introduction

“Introduction” (page 317)

“Description” (page 318)

“Components and functions” (page 320)
“Features” (page 325)

“Dialpad entry” (page 327)

“Display characteristics” (page 328)

“Headset support” (page 329)

“Package components” (page 330)
“Installation and configuration” (page 331)
“TFTP firmware upgrade " (page 338)
“Bluetooth® wireless technology” (page 338)
“Redeploying an IP Phone 1150E” (page 339)
“Replacing an IP Phone 1150E” (page 340)
“Removing an IP Phone 1150E from service” (page 340)

This section explains how to install and maintain the IP Phone 1150E. For
information about using the IP Phone 1150E, see the IP Phone 1150E
User Guide (NN43114-100) or IP Phone 1150E Getting Started Card
(NN43114-103).

This section contains the following procedures

Procedure 90 “Configuring the IP Phone 1150E” (page 332)

Procedure 91 “Connecting the components” (page 333)
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Description

* Procedure 92 “Changing the TN of an existing IP Phone 1150E” (page
339).

®* Procedure 93 “Replacing an IP Phone 1150E” (page 340).
* Procedure 94 “Removing an IP Phone 1150E from service” (page 340).

If power to the phone is interrupted after you install and configure an IP
phone, you are not required to reenter the IP Parameters, Node Numbers,
or Terminal Number (TN). There is also no need to again acquire the
firmware.

The IP Phone 1150E is a multi-line professional-lelP Audio Conference
Phone 2033vel deskset with a high-resolution, fully-backlit, QVGA color
LCD display. The enhanced configuration menus and USB peripheral
support provide a superior navigation experience. The integrated
Bluetooth® Audio gateway offers greater freedom and mobility. The set
includes an integrated phone switch with Gigabit Ethernet LAN and PC
ports. When the phone is idle users fully experience the personalized
background images and capabilities, as well as the Digital Picture Frame
mode.

The IP Phone 1150E is configured for either an Agent, or a Supervisor.
The IP Phone 1150E is shipped with Agent key configuration but can be
modified to support Supervisor key configuration by replacing the key
caps. Remove the key caps using the Key Cap removal tool (product
number NTNM19AA). For information about IP Phone 1150E components,
see “Package components” (page 330).

Figure 58 "IP Phone 1150E default Agent key configuration" (page
319) shows the IP Phone 1150E default Agent key configuration.
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Figure 58
IP Phone 1150E default Agent key configuration

Self-labeled line/programmable feature keys
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Speaker
*Supervisor key
Hold key
e “\ake Busy key
Expand key *Not Ready key
In-Calls key

Volume control

Dialpad

You can program the keys indicated with asterisks for different functions.

Figure 59 "IP Phone 1150E Supervisor key configuration” (page
320) shows the IP Phone 1150E Supervisor key configuration.
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Figure 59
IP Phone 1150E Supervisor key configuration
Self-labeled line/programmable feature keys

Data message | Message
waiting indicator waiting indicator

Send/Enter key - — _____...--— Caontext-sensitive soft keys
Message/Inbox key
Copy key /
W) Outbc:dShift key
Services key l : ..___!..-— Directory key
Quit/Stop key — Navigation keys

Supervisor (s ) —— Goodbye key
Talk/Listen key = *Feature key
Mute key em—— \"""-— *“Ans Emergency key
Speaker *Interflow key
Hold key *Ans Agent key
“Call Agent key
Expund logy *Obv Agent key
Volume control In-Calls key

Dialpad

You can program the keys indicated with asterisks for different functions.

Components and functions
This section describes the following components of the IP Phone 1150E

* “Keys and functions” (page 320)
* “Services menu” (page 323)

* “Local Tools menu” (page 324)

Keys and functions

Table 67 "IP Phone 1150E keys and functions" (page 321) shows the keys
and functions for the IP Phone 1150E.
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Table 67
IP Phone 1150E keys and functions
Key Function
Hold Press the Hold key to put an active call on hold. Press the Line (DN) key
beside the flashing LCD to return to the caller on hold.
Goodbye Press the Goodbye key to terminate an active call.

Visual Alerter/Messag
e waiting indicator

Feature Status Lamp
indicator

Self-labeled
line/programmable
feature keys labels

Context-sensitive soft
keys

Fixed feature keys

Expand

Navigation keys

Enter

Message/Inbox
Shift/Outbox

When a message is waiting, the red Visual Alerter/Message waiting
indicator lights. Also, when the ringer sounds, this indicator flashes.

When the firmware is updating, the blue Feature Status Lamp indicator
flashes.

Self-labeled line/programmable feature key labels are configured for
various features on IP Phones.

A steady LCD light beside a line (DN) key indicates that the feature or
line is active. A flashing LCD indicates the line is on hold, or the feature
is being programmed.

Context-sensitive soft keys are located below the display area. The LCD
label above the key changes, based on the active feature.

A triangle before a key label indicates that the key is active.

Use these keys to access non-programmable features.

The Expand key is used to access external server applications, such as
Nortel Application Server.

Use the Navigation keys to scroll through menus and lists that appear on
the LCD display screen. The outer part of this key cluster rocks for up,
down, left, and right movements.

Use Up and Down keys to scroll up and down in lists, and use the Left
and Right keys to position the cursor. You can also use the Left and
Right keys to select editable fields that appear on the phone. Press the
Right key to select the field below the current position, or press the Left
key to select the field above the current position.

Press the Enter key, at the center of the Navigation key cluster, to
confirm menu selections. In many cases, you can use the Enter key
instead of the Select soft key.

Press the Message/Inbox key to access your voice mailbox.

Press the Shift/Outbox key to switch between two feature key pages,
or any Expansion Modules for IP Phones 1100 Series attached to the
phone.
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Table 67
IP Phone 1150E keys and functions (cont’d.)
Key Function
Copy Press the Copy Key to copy entries to your Personal Directory from other

lists, such as the Caller List, Redial List and Corporate Directory.

Quit/Stop Press the Quit/Stop key to end an active application.

Pressing the Quit/Stop key does not affect the status of the calls currently
on your IP Phone.

Directory Press the Directory key to access Directory services including Corporate
Directory, Personal Directory, Caller’s Log, and Redial.

Mute Press the Mute key to listen to the receiving party without transmitting.
Press the Mute key again to return to a two-way conversation.

The Mute key applies to Headset microphones. The Mute LED flashes
when the Mute option is in use.

Volume control keys Use the Volume control keys to adjust the volume of the headset, ringer,
and alerter/pager.

Press the volume key with the plus sign icon to increase volume; press
the volume key with the minus sign icon to decrease volume.

Supervisor Talk/Listen  For Supervisor use. Press the Supervisor Talk/Listen key to participate in
key an active conversation. The LED lights to indicate talk/listen mode is on.
If the LED is off, the Supervisor can only listen to an active conversation.

A headset must be connected to the Supervisor port on the IP Phone
1150E to use this feature.

In-Calls key Press the In-Calls key to answer incoming calls. This mirrors the key
function and state of the Primary DN key. The In-Calls LED lights when
the In-Calls key is in use.

Agent default configuration

Table 68 "IP Phone 1150E keys and functions for default Agent key
configuration" (page 323) shows IP Phone 1150E keys and functions for
default Agent key configuration. You can configure these keys for different
functions.
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Table 68
IP Phone 1150E keys and functions for default Agent key configuration
Key Function
Activity key Press the Activity key and enter the appropriate activity code to

record the activity the agent is performing. This key is reserved for
future implementation.

Feature key The Feature key supports the assignment of any telephony feature.
This key is reserved for future implementation.

Not Ready Press the Not Ready key to exit the Automatic Call Distribution
(ACD) queue without logging out.

Make Set Busy Press the Make Set Busy key to log out of the ACD queue and
agent position.

Supervisor Press the Supervisor key to open a direct line between the agent IP
Phone and the supervisor IP Phone.

Emergency Press the Emergency key to place an emergency call to the
Supervisor.

Supervisor key configuration

Table 69 "IP Phone 1150E keys and functions for Supervisor key
configuration" (page 323) shows IP Phone 1150E components and
functions for Supervisor key configuration. You can configure these keys
for different functions.

Table 69
IP Phone 1150E keys and functions for Supervisor key configuration
Key Function
Display Agents Press the Dsply Agents key to obtain a summary of the current

status of all agent positions.

Interflow Press the Interflow key to forward calls to a predefined target queue
when the call backlog, or the waiting time in the queue exceeds a
set threshold.

Answer Emergency Press the Ans Emerg key to join the agent in an emergency situation
call.
Answer Agent The Ans Agent key corresponds to the agent Supervisor key.

Press the Ans Agent key to open the direct line between the
Supervisor and the agent.

Call Agent Press the Call Agent key to connect to an agent position.

Observe Agent Press the Obv Agent key to monitor activity on the agent phone.

Services menu
Table 70 "Services menu" (page 324) shows the Services menu.
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Table 70
Services menu

Press the Services key to access the following items

® Telephone Options

— Volume Adjustment

— Contrast Adjustment

— Language

— Date/Time

— Display diagnostics

— Local Dialpad Tone

— Set Info

— Diagnostics

— Headset Type

— Call Log Options

— Ring type

— Call Timer

— Call Indicator Light

— Change Feature Key Label

— Name Display Format

— Live Dialpad
® Virtual Office Login and Virtual Office Logout (if Virtual Office is configured)
® Test Local Mode and Resume Local Mode (if Branch Office is configured)

® Password Admin

You can customize the IP Phone features to meet user requirements. For
more information, see the IP Phone 1150E User Guide (NN43114-100).

If a call is presented while the user is manipulating an option, the IP Phone 1150E rings and the
DN key flashes. However, the display is not updated with the Caller ID, and the programming
text is not disturbed.

While you are in the Services menu you cannot dial digits but you can use the programmable line
keys, such as Redial (double-press a line key) and Auto dial key to make a call. However, the
display does not update with the dialed digits or Caller ID.

Local Tools menu
Table 71 "Local Tools menu" (page 325) shows the Local Tools menu.
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Table 71
Local Tools menu

1
2
3.
4

Press the Services key twice to access the Local Tools menu. The following items appear in the
Local Tools menu

Preferences
Local Diagnostics
Network Configuration

Lock Menu

To make a selection, press the number associated with the menu item or use the navigation keys
to scroll through the menu items. Press the Enter key to select the highlighted menu item.

If you are prompted to enter a password when you double-press the Services key, password
protection is enabled. For more information about password protection and the Local Tools menu,
see “Local Tools menu” (page 441).

Press the Quit/Stop key to exit from any menu or menu item.

Features

The IP Phone 1150E supports the following telephony features

* six self-labeled line/programmable feature keys with labels and
indicators

Supports up to 12 DNs or features on two pages. Use the Shift/Outbox
key to access the second page of DNs or features.

* four context-sensitive soft keys
Functions for the context-sensitive soft keys are configured in LD 11.

For more information about context-sensitive soft keys, see Features
and Services Fundamentals (NN43001-106).

* ability to change user-defined feature key labels
® seven specialized feature keys

— Copy

— Services

— Quit/Stop

— Shift/Outbox

— Inbox/Message
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— Directory
— Feature key (reserved for future implementation)

* seven dedicated Automatic Call Distribution (ACD) fixed keys for
default Agent key configuration with an integrated LED

— Supervisor Talk/Listen

— Emergency

— Supervisor

— Make Busy

— Not Ready

— In-Calls

— Activity (reserved for future implementation)

* nine dedicated ACD fixed keys for Supervisor key configuration with an
integrated LED

— Supervisor Talk/Listen
— Display Agents
— Interflow
— Answer Emergency
— Answer Agent
— Call Agent
— Observe Agent
— In-Calls
— Expand
* four call-processing fixed keys
— Mute
— Release
— Expand
— Hold
— Volume increase/decrease

For more information about the Expansion Module, see “Expansion
Module for IP Phone 1100 Series” (page 343).

For more information about IP Phone features, see “Features” (page 355).
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Dialpad entry

For ease of use, Nortel recommends the use of the external USB
keyboard.

The following rules apply when you enter text and special characters using
the dialpad.

Press a key from 0 to 9 once to enter the corresponding humber.

Press a key from 2 to 9 repeatedly to cycle through the letters
assigned to that key, first in lower case and then in upper case.

For example, if you press the 5 key repeatedly, the following
characters are displayed, one at a time:

j>k->1>3J->K->L->5->

See Table 72 "Character key mappings" (page 327) for character key mappings.

The insertion point remains in its current position as long as you
continue to press the same key.

The entry is accepted if either a new key is pressed or if two seconds
pass with no entry. The insertion point moves 1 space to the right.

For example, to enter the word Nortel, press the following key
sequence:

6 [2 second delay] 6 78 35

Although special characters are not required, key 1 generates
commonly used special characters, such as the period (.), at symbol
(@), and underscore ().

Table 72
Character key mappings

Key

Generates

© 00 N O 0o A W DN PP

_-.l@%$%&+1
abcABC2
defDEF3
ghiGHI14
jklIJKL5
mnoMNOG6
paqrsPQRSY
tuvTUVS8

wWXxyzWXYZ9

With UNIStim firmware release 3.2 or later, you can use the numeric keys
on an external USB keyboard connected to the IP Phone 1150E to dial
calling numbers.
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Display characteristics
An IP Phone 1150E has three major display areas

* “Self-labeled line/programmable feature key label” (page 328)
* “Information line display” (page 329)
* “Context-sensitive soft key label” (page 329)

Figure 60
IP Phone 1150E display area

Upper display area
Self-labeled
line/programmable
feature key labels

Middle display area
Information line _I-

Lower display area
Context-sensitive
soft key labels

Self-labeled line/programmable feature key label
The self-labeled line/programmable feature key label area displays a
10-character string for each of the six self-labeled line/programmable
feature keys. Each self-labeled line/programmable feature key includes
the key label and an icon. The icon state can be on, off, or flashing.
A telephone icon displays the status of the configured DN. Key labels
are left-aligned for keys on the left side of the screen, and right-aligned
for keys on the right side of the screen. To change the self-labeled
line/programmable feature key label, press the Services key to access
Telephone Options > Change Feature key label option. For more
information about changing the feature key label, see the IP Phone 1150E
User Guide (NN43114-100)

If a label is longer than 10 characters, the last 10 characters are displayed,
and the excess characters are deleted from the beginning of the string.
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Information line display
An IP Phone 1150E has a four-line information display area with the
following information

* caller number

* caller name

* feature prompt strings
* user-entered digits

* date and time information (if the IP Phone is in an idle state), or Call
Timer (if provisioned in the Telephone options menu)

The information in the display area changes, according to the
call-processing state and active features.

Context-sensitive soft key label

The context-sensitive soft key label has a maximum of seven characters.
Each soft key includes the soft key label and an icon. When a soft key is
in use, a triangle icon displays at the beginning of the soft key label, and
the label shifts one character to the right. (If the label is six characters in
length, the last, or rightmost character is truncated.) If a feature is enabled,
the icon state turns to On. It remains in the on state until the feature key

is pressed again. This cancels the enabled feature and turns the icon off,
returning the soft key label to its original state.

Use the More soft key to navigate through the layers of functions. If there
are only four functions assigned to the soft keys, the More key does not
appear, and all four functions are displayed.

Cleaning the IP Phone display screen
Gently wipe the IP Phone display screen with a soft, dry cloth.

CAUTION

Do not use any liquids or powders on the IP Phone. Using
anything other than a soft, dry cloth can contaminate IP Phone
components and cause premature failure.

Headset support
Press the Services key to open the Telephone Options menu and to
access the Headset Type menu item.
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The IP Phone 1150E supports the following headsets
* Type 1: Plantronics P251N, P261N, CS55, Voyager 510S
®* Type 2: GNNetcom GN 2120 NCD, GN9120 Flex

* GNNetcom Liberation

Package components
The IP Phone 1150E includes integrated support for a number of
Power over Ethernet options, including support for IEEE 802.3af Power
Classification 3.

Table 73 "Package components" (page 330) lists the IP Phone 1150E
package components.

Table 73
Package components

® |P Phone 1150E
* 2.1 m (7-ft) CAT5-e Ethernet cable
® (Getting Started Card

Table 74 "IP Phone 1150E component list" (page 330) lists the IP Phone
1150E components and product codes.

Table 74

IP Phone 1150E component list
Component Product code
IP Phone 1150E with Agent icon keycaps NTYSO06AA
IP Phone 1150E with English keycaps NTYSO06BA
IP Phone 1150E with Supervisor icon key caps NTYS15AAE6
Replacement parts
Footstand kit, Charcoal NTYS11BA70
2.1 m (7-ft) CAT5-e Ethernet cable NTYS13ABE6
Accessories
Key cap removal tool NTNM19AA
Expansion Module for IP Phone 1100 Series NTYS08AA
Power supply
Global power supply NTYS17xxE6
IEC cable
1.8 m (5.9 ft), 10 amp, IEC320-C13 NTYS14AAEG

North America
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Table 74

IP Phone 1150E component list (cont’d.)

Component

Product code

2.4 m (8 ft), 240 VAC 10 amp, ANZ power cord AS-3, NTTK15AA
Australia, New Zealand
Note: ROHS does not apply in this region.

250 VAC, Option 11C Standard European power cord, NTTK16ABEG6
Other EMEA, Kenya, Korea, Thailand, Indonesia, Vietham, India,

Hong Kong, Ireland, United Kingdom, Singapore, Malaysia,
Bangladesh, Brunei, Sri Lanka

Pakistan

3 m (9.9 ft) 125 VAC, Option 11C Swiss power cord NTTK17ABEG6
Switzerland

240 VAC, Option 11C UK power cord NTTK18ABEG6

Note: ROHS does not apply in this region.

3 m (9.9 ft), 125 VAC, Option 11C Denmark power cord NTTK22ABEG6
Denmark
Argentina A0814961

1.8 m (5.9 ft), 10 amp, IEC320-C13 Japan NTTK26AAE6

Installation and configuration
The following sections provide a step-by-step guide to install and configure
the IP Phone 1150E

“Before you begin” (page 331)

“First-time installation” (page 332)
“Configuring the IP Phone 1150E” (page 332)
“Connecting the components” (page 333)

“Startup sequence” (page 338)

Before you begin
Before installing the IP Phone 1150E, complete the following
pre-installation checklist

Ensure one IP Phone 1150E boxed package exists for each IP Phone
1150E you install. For a list of IP Phone 1150E package components,
see Table 73 "Package components" (page 330).

Ensure one Software License exists for each IP Phone 1150E you
install.

Ensure the host Call Server is equipped with a voice Gateway Media
Card and a Signaling Server with the Line TPS application.
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* |f a global power supply is required, ensure the approved Nortel global
power supply (model number NTYS17xxE6) is used. See Table 74 "IP
Phone 1150E component list" (page 330).

* Ensure the latest IP Phone firmware is deployed to the IP telephony
node. For more information, see Signaling Server IP Line Applications
Fundamentals (NN43001-125).

First-time installation
You must first install an IP telephony node with the Communication Server.
For information about installing an IP telephony node, see Signaling Server
IP Line Applications Fundamentals (NN43001-125).

CAUTION

Damage to Equipment

Do not plug your IP Phone 1150E into an ISDN connection.
Severe damage can result.

Configuring the IP Phone 1150E
Use Procedure 90 “Configuring the IP Phone 1150E” (page 332) to
configure the IP Phone 1150E.

Procedure 90
Configuring the IP Phone 1150E

Step Action

1 Configure a virtual loop on the Call Server using LD 97.

For more information about configuring a virtual loop, see
Signaling Server IP Line Applications Fundamentals (NN430
01-125) and Software Input Output Reference-Administration
(NN43001-611).

2 Configure the IP Phone 1150E on the Call Server using LD 11.
At the prompt, enter the following:

REQ: new
TYPE: 1150

For more information about configuring the IP Phone 1150E usi
ng LD 11, see Software Input Output Reference-Administration
(NN43001-611).

3 Configure the IP Phone 1150E in Element Manager. IP Phones
are configured using the Phones section in the Element
Manager navigation tree. For more information about configuring
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the IP Phone 1150E using Element Manager, see Element
Manager System Reference - Administration (NN43001-632).

—End--

Connecting the components
Use Procedure 91 “Connecting the components” (page 333) to connect
the components for the IP Phone.

CAUTION

The IP Phone 1150E is shipped with the stand locked in
position. To avoid damaging the IP Phone, press the wall-mount
lever located under the base to release the stand and pull it
away from the phone.

Procedure 91
Connecting the components

Step Action

1 Press the wall-mount lever located under the base to release the
stand and pull it away from the phone. See Figure 61 "Release
the IP Phone 1150E from the stand" (page 333).
Figure 61
Release the IP Phone 1150E from the stand

Tilt lever button

Wall mount lever

2 Remove the stand cover. Pull upward on the center catch and
remove the stand cover. The cable routing tracks are now
accessible. See Figure 62 "Remove the stand cover" (page 334).
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Figure 62
Remove the stand cover
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Connect the global power supply (optional). Leave the global
power supply unplugged from the power outlet, connect the
global power supply to the AC adapter jack in the bottom of the
phone. Form a small bend in the cable, and then thread the
global power supply cord through the channels in the stand.

WARNING
Use your IP Phone 1150E with the approved Nortel
global power supply (model number NTYS17xxE6).

The IP Phone 1150E supports both AC power and Power over
Ethernet options, including IEEE 802.3af Power Classification 3.
To use Power over Ethernet, where power is delivered over the
CAT5-e cable, the LAN must support Power over Ethernet, and a
global power supply is not required. To use local AC power, the
optional global power supply can be ordered separately.

You must use CAT5-e (or later) cables if you want to use Gigabit
Ethernet.
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Figure 63

IP Phone 1150E connections
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PC Ethernet port \

LAN Ethernet port =

AC adapter jack

Agent headset port / AT

Tilt lever button

Supervisor
headset port

USB port

Install the headset. If you are installing a headset, plug the

connector into the RJ-9 headset jack, and thread the headset
cord along with the handset cord through the channels in the
stand, so that the headset cord exits the channel.

Although a handset cord channel appears on the base of the IP
Phone 1150E, the IP Phone 1150E does not support a handset

port.
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Figure 64
Cable routing tracks

4 wall-mount holes
(Method A)

Cable routing tracks

5 Install the Ethernet cable. Connect one end of the supplied
Ethernet cable to the back of your phone using the CAT5-e
connector (LAN Ethernet port), and thread the network cable
through the channel.

6 If you are connecting your PC through the phone, a second
CAT5-e cable is required. Only one cable is included with the IP
Phone 1150E package. Install the Ethernet cable connecting the
PC to the phone (optional). Connect one end of the PC Ethernet
cable to your phone using the CAT5-e connector (PC Ethernet
port) and thread it through the channel. Connect the other end to
the LAN connector on the back of your PC.

The LAN Ethernet port supports Auto-Media Dependent Interface
Crossover (MDIX). Auto-MDIX is supported only when the
Ethernet port is configured for autonegotiation. The PC Port
does not support Auto-MDIX.
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10

CAUTION

Damage to Equipment

Do not plug any device into your IP Phone 1150E
Ethernet port other than an IEEE 802.3 Ethernet
network connection. The IP Phone 1150E does not
support multiple devices connected through the PC

Ethernet port.

Connect additional cables. If applicable, plug in optional USB
devices. Connect the Ethernet cable to the LAN Ethernet
connection. If you are using a global power supply, plug the
adapter into an AC oultlet.

Complete steps 1 to 7, as needed, before wall-mounting the IP
Phone.

Wall-mount your phone (optional). Use Method A or Method B to
wall-mount the IP Phone. See Method A—using the mounting
holes on the bottom of the phone stand, or Method B—using the
traditional-style wall-mount box with a CAT5-e connector and a
15 cm (6 inch) CAT5-e cord (not provided).

* Method A: Press the wall-mount lever, and pull away from
the stand. Using the stand cover (see Figure 62 "Remove
the stand cover" (page 334)), mark the wall-mount holes
by pressing the bottom of the stand cover firmly against
the wall in the location where you wish to install the phone.
Four small pins on the bottom of the stand cover make the
marks on the wall. Use the marks as a guideline to install
the wall-mount screws (not provided). See Figure 64 "Cable
routing tracks" (page 336).

Install the screws so that they protrude 3 mm (1/8 inch) from
the wall, and then install the phone stand mounting holes
over the screw heads. You may need to remove the phone
from the wall to adjust the lower screws. When the lower
screws are snug, install the phone on the mounting screws,
and then tighten the top screws.

* Method B: Attach the 15 cm (6 inch) CAT5-e cable, position
the stand over the mounting rivets, and slide the phone down
the wall so that the rivets fit into the slots on the stand. See
Figure 64 "Cable routing tracks" (page 336).

Replace the stand cover. Ensure that all cables are neatly routed
and press the stand cover into place until you hear a click.

If you wall-mount the phone, put it in the wall-mount position by
holding the tilt lever and press the phone towards the base until
the phone is parallel with the base. Release the tilt lever and
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continue to push the phone towards the base until you hear a
click. Ensure the phone is securely locked in to position.

—End--

When you complete the IP Phone connection, you must connect the phone
to the network. See “Dynamic Host Configuration Protocol” (page 391).

Startup sequence
When an IP Phone 1150E connects to the network, it must perform a
startup sequence. The elements of the startup sequence include

* obtaining network access (if supported by the network infrastructure)
* obtaining VLAN ID (if supported by the network infrastructure)

® obtaining the IP parameters

* obtaining the provisioning parameters

® connecting to the Call Server

The IP Phone is configured for automatic provisioning by default. For

more information about provisioning the IP Phone automatically, see
“Provisioning the IP Phones” (page 461).

You can manually configure all or some parameters. For information about
manually provisioning the IP Phone, see “Manual provisioning of IP Phone
2007 and 1100 Series” (page 519).

TFTP firmware upgrade
When you enter the IP address of the TFTP Server, the IP Phone
searches for an upgrade file on the TFTP Server.

Users of CS 1000 Release 4.5 or later do not need to enter a TFTP IP
address.

For further information about TFTP firmware upgrade, see “TFTP Server”
(page 647).

Bluetooth® wireless technology
The IP Phone 1150E supports Bluetooth® wireless technology . For
information about configuring Bluetooth® wireless technology on the IP
Phone 1150E, see “Headset support” (page 541).
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Redeploying an IP Phone 1150E
You can redeploy an existing previously configured IP Phone 1150E on
the same system. For example, the IP Phone 1150E can be assigned to
a new user (new TN) or to an existing user who moved to a new subnet
by changing the TN of the IP Phone 1150E. For further information, see
Converging the Data Network with VolP Fundamentals (NN43001-260).

Procedure 92
Changing the TN of an existing IP Phone 1150E

Step

Action

1

Repower the IP Phone 1150E.

During the reboot sequence of a previously configured IP Phone,
the IP Phone 1150E displays the existing node number for
approximately five seconds.

If the node password is enabled and NULL, choose one of the
following

a Disable the password.
b Set the password as non-NULL.
Press OK when the node number displays.

If Then

the node password is enabled a password screen displays. Go

and is not NULL to Step 4.

the node password is disabled a TN screen displays. Go to Step
5.

Enter the password at the password screen, and press OK.
A TN screen displays.

To obtain the password, enter the nodePwdShow command in
Element Manager. For further information, see Element Manager
System Reference - Administration (NN43001-632).

Select the Clear soft key to clear the existing TN.
Enter the new TN.

—End--
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Replacing an IP Phone 1150E

ATTENTION

Two IP Phones cannot share the same TN. You must remove the IP Phone
1150E that currently uses the TN.

Procedure 93
Replacing an IP Phone 1150E

Step

Action

1

Obtain the node and TN information of the phone you want to
replace.

Disconnect the IP Phone 1150E that you want to replace.

Follow “Configuring the IP Phone 1150E” (page 332) to install
the IP Phone 1150E. To configure the IP Phone, see “Manual
provisioning of IP Phone 2007 and 1100 Series” (page 519).

Enter the same TN and Node Number as the IP Phone 1150E
you replaced. The system associates the new IP Phone 1150E
with the existing TN.

—End--

Removing an IP Phone 1150E from service
Procedure 94
Removing an IP Phone 1150E from service

Step

Action

1

Disconnect the IP Phone 1150E from the network or turn the
power Off.

The service to the PC is disconnected as well if the PC connects
to the IP Phone 1150E.

If the IP Phone 1150E was automatically configured, the DHCP
lease expires and the IP address returns to the available pool.

In LD 11, enter the following:
REQ: OUT

TYPE: 1150

TN: LLL S CC UU

—End--
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IP Phones with SIP firmware

The following Nortel IP Phones are available with SIP firmware and are
available in CS 1000 Release 6.0. For more information about these IP
Phones with SIP firmware, see the following NTPs and User Guides.

Table 75
IP Phones with SIP firmware
Supported IP Phones NTPs and User Guides
IP Phone 1120E SIP Firmware for Release 2.0 IP Phone 1120E User Guide

(NN43112-101)

SIP Firmware Release 2.0 for IP Phone 1120E Administration
(NN43112-300)

IP Phone 1140E SIP Firmware for Release 2.0 IP Phone 1140E User Guide
(NN43113-101)

SIP Firmware Release 2.0 for IP Phone 1140E Administration
(NN43113-300)

IP Phone 1535 IP Phone 1535 User Guide (NN43160-101)
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Expansion Module for IP Phone 1100

Series

Contents

Description

This section contains the following topics:

* “Description” (page 343)

* ‘“Features” (page 344)

* “Display characteristics” (page 345)

* “Package components” (page 345)

* *“Configuration” (page 345)

* ‘“Installation” (page 346)

* ‘“Expansion Module startup initialization” (page 350)
* “Operating parameters” (page 351)

* “Services key operation” (page 352)

* ‘“Firmware” (page 354)

The Expansion Module for IP Phone 1100 Series (Expansion Module) is
supported on the following IP Phones

* |P Phone 1120E
* |P Phone 1140E
* |P Phone 1150E

The Expansion Module is a hardware component that connects to the IP
Phones and provides additional line appearances and feature keys.

Up to three Expansion Modules are supported on the IP Phones. With
three Expansion Modules, the IP Phones provide up to 54 additional
line/feature keys.
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The IP Phone 1140E, IP Phone 1165E, and IP Phone 1150E can

also provide up to 36 additional line/feature keys using the Shift key
functionality and one Expansion Module. With more than one Expansion
Module connected, the Shift key functionality does not affect the

Expansion Module since the maximum number of line/feature keys is
already available.

The IP Phone 1120E does not support Shift key functionality.

Figure 65 "IP Phone 1140E with Expansion Module for IP Phone 1100

Series" (page 344) shows an IP Phone 1140E with the Expansion Module
attached.

Figure 65
IP Phone 1140E with Expansion Module for IP Phone 1100 Series
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Features
The Expansion Module provides the following features
* 18 self-labeled line/programmable feature keys provide up to 36
additional self-labeled line/programmable feature keys. Using the Shift

key functionality, an IP Phone 1140E, for example, can have up to 66
additional logical self-labeled line/programmable feature keys.

® Upgradeable firmware using a TFTP or UFTP Server.
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* A desk-mount bracket and structural baseplate connect the Expansion
Module to an IP Phone or to another Expansion Module.

* [P Phone and Expansion Module combination can be wall-mounted
using the wall mount template provided.

Display characteristics

The Expansion Module has the following display characteristics

* LCD display area—Each of the 18 line/feature keys on the Expansion
Module has a 10-character display label (see Figure 65 "IP Phone
1140E with Expansion Module for IP Phone 1100 Series" (page 344)).
This label is set automatically; however, the user can edit the label
using the controls on the IP Phone.

* adjustable display and contrast settings—Use the Contrast Adjustment
option in the Telephone Options menu on the IP Phone to adjust the
display and contrast settings. Any contrast changes you make on the
IP Phone affect the Expansion Module. The Expansion Module and IP
Phone do not have separate contrast adjustments.

* backlight—The local 48 V power supply is required to operate the
backlight on the Expansion Module; however, you can use either the
local 48 V power supply or Power over Ethernet (PoE) to operate all
other Expansion Module functionality.

Package components

Table 76 "Expansion Module components list" (page 345) lists the
Expansion Module package components.

Table 76
Expansion Module components list

Expansion Module for IP Phone 1100 Series

NTYSOBAAEG

Configuration

Use LD 11 to configure the Expansion Module.

Table 77
LD 11 - Configure the Expansion Module
Prompt Response Description
REQ: NEW/CHG Add new or change existing data.
TYPE 1120/1140/1150 | For IP Phone 1120E, IP Phone 1140E, and IP Phone
1150E
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346 Expansion Module for IP Phone 1100 Series

Table 77
LD 11 - Configure the Expansion Module (cont’d.)
Prompt Response Description
KEM (0) - 3/<CR> Number of attached Expansion Modules (0). Up to three
Expansion Modules are supported.
CLS KEM3 KEMS3 CLS must be defined
KEY 0 - <see text>/<C | Key number range expanded to support number of
R> Expansion Modules specified by KEM prompt. The range
on the IP Phone is as follows:
KEM value: KEY range:
0 Oto 31
1 32to0 49
2 50 to 67
3 68 to 85
PAGEOFST <Page> <KeyOff- | PAGEOFST is prompted if one Expansion Modules is
set>/ <CR> specified at the KEM prompt and <CR> is entered at the
KEY prompt. This prompt enables you to enter a Page
number of 0, or 1, and a Key Offset number from 0 to 17.
Once entered, the KEY is prompted with the appropriate
KEY value filled in. <CR> ends the input.
KEY <key> <keys conf data>/ | <key> is the key number for the Page + Key Offset
<CR> entered at PAGEOFST. Enter the key configuration <CR>
or just <CR>.
KEMOFST <KEM> <Key-Off- [ KEMOFST is prompted if two or three Expansion Modules
set>/ <CR> are specified at the KEM prompt and <CR> is entered for
KEY prompt.
This prompt enables you to enter a KEM number of 1,
2, or 3 and a KEY Offset number from 0 to 17. Once
entered, the KEY prompt is prompted with the appropriate
KEY value filled in. <CR> ends the input.
KEY <key> <keys conf data>/ | <key> is the key number for the KEM + Key Offset
<CR> entered at KEYOFST. Enter the key configuration <CR>
or just <CR>.
Installation

The Expansion Module mounts on the right side of the IP Phone. The
Expansion Module snaps into the receptacle on the back of the IP Phone
using the desk-mount bracket and structural baseplate supplied with the
Expansion Module.
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The Expansion Module connects to the IP Phone using the Accessory
Expansion Module (AEM) port on the IP Phone.

Use Procedure 95 “Connecting the Expansion Module to the IP Phone”
(page 347) to connect the Expansion Module for IP Phone 1100 Series
to the IP Phone.

CAUTION

Damage to Equipment

To avoid damaging the equipment, remove the power (PoE
cable, or local power) from the IP Phone before connecting the
Expansion Module.

CAUTION

The Expansion Module is shipped with the base locked in
position. To avoid damaging the Expansion Module, press
the wall-mount lever, located on the base at the front of the
Expansion Module.

Procedure 95
Connecting the Expansion Module to the IP Phone

Step Action

1 Press the tilt lever to adjust the stand angle on the IP Phone.
See Figure 66 "Wall-mount lever" (page 347). You can adjust
the stand angle to maximum, instead of removing the stand. See
Figure 67 "Adjusting the stand angle on the IP Phone" (page
348).

Figure 66
Wall-mount lever
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348 Expansion Module for IP Phone 1100 Series

Figure 67
Adjusting the stand angle on the IP Phone

2 At the back of the IP Phone, remove the rubber plug from the
Accessory Expansion Module (AEM) port. Place the connecting
arm of the Expansion Module behind the IP Phone and align the
Expansion Module connection plug to the AEM port on the back
of the IP Phone.

3 Insert the screws in to the top and bottom holes of the
connecting arm of the Expansion Module and tighten until snug.
See Figure 68 "Connecting the Expansion Module" (page 349).

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.



Installation 349

Figure 68
Connecting the Expansion Module

Wheel

AR e &
&
Attachment ’/ﬁ\‘_//;‘ o

SCrews

If connecting a second, or a third Expansion Module, repeat
steps 2 to 4.

The second Expansion Module is attached to the right side of the
first Expansion Module. The third Expansion Module is attached
to the right side of the second Expansion Module.

Adjust the height of the IP Phone tilt adjustment to a comfortable
viewing angle. Then adjust each of the Expansion Module foot
stands so they are flush to the desk surface. Turn the wheel

on the back right side of the Expansion Module to the right (if
viewed from the front) to tighten the Expansion Module.

CAUTION

Do not over tighten the wheel on the Expansion
Module.

Connect power to the IP Phone. The Expansion Module powers
up.

The Expansion Module uses the electrical connection of the IP
Phone for power. It does not have its own power source.

—End--
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Expansion Module startup initialization
Once the Expansion Module has been installed and powered up on the IP
Phone, the Expansion Module initializes.

Table 78 "Startup initialization process for the Expansion Module" (page
350) lists the initialization process for the Expansion Module.

Table 78
Startup initialization process for the Expansion Module
Phase Description
1  Expansion Module performs The self-test confirms the operation of the Expansion
self-test Modules local memory, CPU, and other circuitry. While
undergoing this self-test, the Expansion Modules display
lights up.

If the Expansion Modules display does not light up, or
lights up and then goes blank, or fails to begin flashing,
check that the Expansion Modules is correctly installed
and configured.

2  Expansion Module establishes The Expansion Modules display flashes until it establishes
communication with the IP communication with the IP Phone.
Phone

If the Expansion Modules display does not stop flashing,
communication is not established with the IP Phone.
Check that the Expansion Modules is correctly installed
and configured.

3  Expansion Module downloads The key labels download to the Expansion Modules.
key maps During the download, the display is blank.

When the three phases complete successfully, you are ready to use the
additional self-labeled line/programmable feature keys on the Expansion
Module.

If you have a second or a third Expansion Module installed on your IP
Phone, the one to the immediate right of the IP Phone must be functional
so that subsequent Expansion Module to work. This is necessary because
the second Expansion Module receives its power, and communicates with
the IP Phone, through the first Expansion Module; and the third Expansion
Module receives its power, and communicates with the IP Phone, through
the second Expansion Module.
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Operating parameters
If the Expansion Module does not respond, and lines or features are
configured on keys 32 to 85, calls can be directed to those keys which
the user cannot access. This means that the IP Phone rings, but the
call cannot be answered. In such cases, the incoming call receives Call
Forward No Answer (CFNA) treatment.

IP Phone 1120E
The IP Phone 1120E does not support Shift key functionality.

If only one Expansion Module is configured in LD 11, but two or three
Expansion Modules are detected on an IP Phone 1120E, the second and
third Expansion Modules are ignored. An error message displays to alert
the administrator that the hardware configuration does not match the
administered configuration.

If two Expansion Modules are configured in LD 11, but only one Expansion
Module responds, the keys on the second Expansion Module are available
for call processing but are not accessible to the user. This means that
lines and features on keys 32 to 67 can cause the IP Phone 1120E to

ring, but there is no way to answer it. An error message displays to alert
the administrator that the hardware configuration does not match the
administered configuration.

If three Expansion Modules are configured in LD 11, but only one or two
Expansion Modules respond, the keys on the third Expansion Module are
available for call processing but are not accessible to the user. This means
that lines and features on keys 68 to 85 can cause the IP Phone 1120E

to ring, but there is no way to answer it. An error message displays to
alert the administrator that the hardware configuration does not match the
administered configuration.

IP Phone 1140E and IP Phone 1150E
If only one Expansion Module is configured in LD 11, but two or three
Expansion Modules are detected on the IP Phone, the Terminal Proxy
Server (TPS) assigns keys 50 to 67 to the second Expansion Module. The
third Expansion Module does not have keys assigned until it is configured
in LD 11.
An error message displays to alert the administrator that the hardware
configuration does not match the administered configuration.

If two Expansion Modules are configured in LD 11 but only one Expansion
Module responds, the TPS assigns keys 32 to 67 to the single Expansion
Module (using the Shift key functionality). An error message displays to

alert the administrator that the hardware configuration does not match the
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352 Expansion Module for IP Phone 1100 Series

administered configuration. When a second Expansion Module is detected,
the TPS changes the key assignments to display across both Expansion
Modules.

If two Expansion Modules are configured in LD 11 but three Expansion
Module respond, the TPS assigns the keys 32 to 67 to the first two
Expansion Modules. The third Expansion Module does not have keys
assigned until it is configured in LD 11. An error message displays to
alert the administrator that the hardware configuration does not match the
administered configuration.

If three Expansion Modules are configured but only one Expansion Module
responds, the TPS assigns the keys 32 to 67 to the single Expansion
Module (using the Shift key functionality). When a second Expansion
Module is detected, the TPS changes the key assignments to display
across both Expansion Modules. Keys on the third Expansion Module are
inaccessible.

If three Expansion Modules are configured in LD 11 but two Expansion
Modules respond, the TPS assigns keys 32 to 85 to the first two
Expansion Modules. An error message displays to alert the administrator
that the hardware configuration does not match the administered
configuration. When a third Expansion Module is detected, the TPS
changes the key assignments to display across all three Expansion
Modules.

Services key operation
The Services key is used to access user settings and certain features
on the IP Phone. When one or more Expansion Modules are attached
to the IP Phone, the actions of the display diagnostics for the IP Phones
DN/feature key display area are duplicated for the Expansion Modules.

If an incoming call occurs when in the diagnostic mode, the call is
answered by pressing the DN/feature key, handsfree, or headset key, or
by picking up the handset. The display area remains in diagnostic mode
until either the user exits the diagnostic more, or the idle timeout clears
the mode. Once cleared, the normal display for the current state of the IP
Phone is displayed.

Press the Services key to access the following menu items
* Display diagnostics

®* Set Info
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Display diagnostics

Use the Up/Down navigation keys to scroll the Display diagnostics menu to
access the following screens/diagnostic operations

* “Initial screen” (page 353)

*  “Full Contrast” (page 353)

e “LED Test” (page 353)

®* “Character Test” (page 353)

Initial screen
Instructions are displayed on the display area of the IP Phone and the
Expansion Module. The DN/feature key display areas are blank.

Full Contrast

The IP Phone and the Expansion Module display areas are set to
maximum (dark) contrast, including the DN/feature key areas. All LEDs
are off.

LED Test
The IP Phone and the Expansion Module LEDs are set to on. The display
area is cleared, including the DN/feature key display areas.

Character Test

The IP Phone and the Expansion Module LEDs are set to off. The
available character set is displayed across all writable areas of the display,
including the DN/feature key display areas. The telephone on-hook icon is
displayed for all DN/feature keys.

Table 79 "Display diagnostic operation on the IP Phone and the Expansion
Module for IP Phone 1100 Series" (page 353) shows the display diagnostic
operation on the IP Phones and the Expansion Module.

Table 79
Display diagnostic operation on the IP Phone and the Expansion Module for IP Phone 1100
Series
Diagnostic step IF_’ Phone DN/feature key Expansion Module display
display area area
initial screen blank blank
Full Contrast set to highest contrast set to highest contrast
LED Test blank blank
Character Test Characters display across the  Characters display across the
display areas, the telephone display areas, the telephone
on-hook icon is displayed. on-hook icon is displayed.
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Firmware

Set Info

The Set Info menu displays the firmware version for the IP Phone and

any attached Expansion Modules. The attached Expansion Modules are
identified as KEM1, KEM2, and KEM3. KEM1 is the closest to the IP
Phone. The Expansion Module identifies the firmware as a three character
string; the TPS displays the firmware in an n.nn format.

Use the Up/Down navigation keys to scroll the list to display the firmware
for each attached Expansion Module. The firmware version is displayed
even if the Expansion Module is not configured in LD 11. In this case, the
Expansion Module is identified in the display area by an asterisk (*) after
the Expansion Module number (for example, KEM1*).

If an Expansion Module is configured but does not respond, the firmware
version displays as <unknown>.

The Expansion Module uses a TFTP or UFTP Server to upgrade the
firmware. The firmware is downloaded to the IP Phone, then distributed
to each attached Expansion Module, one at a time. After the Expansion
Module confirms to the IP Phone that the firmware file is downloaded and
saved successfully, the IP Phone starts the download to the next attached
Expansion Module.

If any error causes the firmware download to fail, or if the saved firmware
file is corrupted, the Expansion Module reverts to the factory installed
firmware. The factory installed firmware file is always available to facilitate
firmware download in case the downloaded firmware is unusable.

For more information about TFTP Server firmware upgrade, see “TFTP
Server” (page 647).

For more information about Expansion Module, see Expansion Module for
IP Phones 1100 Series User Guide (NN43130-101).
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Features

Contents

This section contains the following topics:

“Telephony features” (page 355)
“Network features” (page 382)

Telephony features
The IP Phones support the following features (unless otherwise stated).

“Corporate Directory” (page 356)

“Personal Directory” (page 356)

“Redial List” (page 356)

“Callers List” (page 356)

“Password Administration” (page 357)

“IP Call Recording” (page 357)

“Virtual Office” (page 359)

“ Emergency Services for Virtual Office” (page 359)
“Active Call Failover” (page 359)

“Enhanced UNIStim Firmware download” (page 360)
“Media security” (page 360)

“Live Dialpad” (page 368)

“Languages” (page 369)

“Key number assignments” (page 380)

Personal Directory, Redial List, Callers List, Application Server
Administration, Password Administration are software on the Signaling
Server. An IP Phone must be registered to a Signaling Server to access
these features.
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Corporate Directory

You must press the Directory key to access the Corporate Directory. The
Corporate Directory feature extends the use of a system database, created
from Telephony Manager 4.0 information, to the IP Phones. This database
is downloaded and stored on the system CPU platform. For information
about using Corporate Directory from IP Phones, see the appropriate user
guide. For details about Corporate Directory, see Features and Services
Fundamentals (NN43001-106).

Corporate Directory is not supported on the IP Phone 2001, IP Audio
Conference Phone 2033, IP Phone 1110, or IP Phone 1210.

Personal Directory

You must press the Directory key to access the Personal Directory.
Personal Directory allows an end user to create and control a personal
directory. Up to 100 Personal Directory entries can be created, edited,
copied from other sources, or deleted. (For information about using
Personal Directory on IP Phones, see the appropriate user guide. For
more information about the Personal Directory feature, see Features

and Services Fundamentals (NN43001-106). Personal Directory uses a
separate central database, called the Application Server, to store directory
data and end-user profile options.

Personal Directory is not supported on the IP Phone 2001, IP Audio
Conference Phone 2033, IP Phone 1110, or IP Phone 1210.

Redial List

You must press the Directory key to access the Redial List. Redial List
is a call log feature whose content is generated by the system during
call processing. The list resides on the Application Server. An end user
can scroll through a list of up to 20 entries of the most recent calls dialed
from the IP Phone and redial a selected telephone number. For more
information about using Redial List with IP Phones, see the appropriate
user guide. For more information about the Redial List feature, see
Features and Services Fundamentals (NN43001-106).

Redial List is not supported on the IP Phone 2001, IP Audio Conference
Phone 2033, IP Phone 1110, or IP Phone 1210.

Callers List

You must press the Directory key to access the Callers List. Callers List
is a call log feature whose content is generated by the system during

call processing. The list resides in the Application Server. An end user
can scroll through a list of up to 100 entries of the most recent calls
received by the IP Phone and call a selected telephone number. For more
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information about using Callers List with IP Phones, see the appropriate
user guide. For more information about the Callers List feature, see
Features and Services Fundamentals (NN43001-106).

Callers List is not supported on the IP Phone 2001, IP Audio Conference
Phone 2033, IP Phone 1110, or IP Phone 1210.

Password Administration
Once the Station Control password (SCPW) has been set by the system
administrator on the Call Server, end users can operate this feature from
IP Phones to protect private directory information stored on the Application
Server. For more information about using Password Administration from
IP Phones, see the appropriate user guide. For information about the
Password Administration feature, see Signaling Server IP Line Applications
Fundamentals (NN43001-125).

IP Call Recording
IP Call Recording enables an IP Call Recording Server to monitor the
media stream for the active call and record it by providing the IP address
and port information for an IP Phone on an active call. The following
recording models are supported

* bulk call recording — records all calls on an IP Phone

* quality monitor recording — records individual calls on an IP Phone

If the network connection between the IP Call Recording Server and the IP
Phone is lost, active calls cannot be recorded.

For more information about the IP Call Recording feature, see Signaling
Server IP Line Applications Fundamentals (NN43001-125) and Automatic
Call Distribution Fundamentals (NN43001-551).

Secure IP Call Recording
The Secure IP Call Recording feature adds security to the duplicated
media stream from the IP Phone to the call recorder. This feature uses
Datagram Transport Layer Security (DTLS) protocol to negotiate Secure
Real-time Transport Protocol (SRTP) keys for the duplicated media
stream. This feature requires a call recorder with secure call recording
support.

The Secure IP Call Recording feature requires tokens to license the
feature on the phone. The number of tokens required is determined by
the call recorder vendor type. Four tokens are required for third-party
call recorders. The call recorder is configured in the provisioning file. For
more information about configuring the parameters for this feature, see
“Provisioning the IP Phones” (page 461)
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This feature requires root certificates to be installed on the phone to
authenticate the call recorder and a license. For information about root
certificates, see “Root certificates” (page 419). For information about
licenses, see “Licensing” (page 565).

ATTENTION
Enable Secure Call Recording after the call recorder is upgraded to UNIStim 4.0;
otherwise delays in duplicated media stream recording can result.

You can collect debug information from the PDT tools. To show the last or
current status of the secure call recording, including the duplicated media

encryption setting, use listsecuritylogs and scrStatusShow at the
PDT level.

The Secure IP Call Recording feature operates in two modes:
* Mirror mode
® UNIStim mode

Mirror mode

The Secure Call Recording feature operates in Mirror mode when the
Call Server does not support Secure Call Recording. The call recording
security mirrors the security setting of the primary media stream while the
primary media stream SRTP keys are provided using the secure UNIStim
message.

Mirror mode is configured in the provisioning file. The default option is no
encryption. If there is no encryption, the phone sends unencrypted Real
time Transfer Protocol (RTP) stream to the call recorder. If encryption

is enabled and the primary media stream is secure then the duplicated
media stream from the IP Phone to the call recorder is secured using
DTLS-SRTP.

The Call Recorder vendors are also configured in the provisioning file.

For more information about configuring the parameters for this feature, see
“Provisioning the IP Phones” (page 461).

UNIStim mode

If the Call Server supports the Secure Call Recording feature, the
security setting of the secure call recording is under the Call Server
control. UNIStim mode is configured using Element Manager, Unified
Communications Management, or Telephony Manager.
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The following list provides the three encryption options for this mode:
* Not to be encrypted
* Absolutely must be encrypted

* Encryption is best effort

Virtual Office
The Virtual Office feature enables end users to log into any IP Phone using
their own user ID and password. This redirects the telephone calls and
other features to the Virtual Office logged-in IP Phone. For information
about using Virtual Office on an IP Phone, see the appropriate user guide.
For more information about the Virtual Office feature, see Signaling Server
IP Line Applications Fundamentals (NN43001-125) and Features and
Services Fundamentals (NN43001-106).

Emergency Services for Virtual Office
The E911 for Virtual Office feature allows Virtual Office users to place
an emergency call to the correct Public Safety Answering Point (PSAP)
for their geographic location. For more information about the E911 for
Virtual Office feature, see Emergency Service Access Fundamentals
(NN43001-613).

Active Call Failover
The Active Call Failover (ACF) feature enables an IP Phone to reregister in
the ACF mode during a Signaling Server failure.

The ACF mode preserves the following

® active media stream

* LED status of the Mute, Handsfree, and Headset keys
* DRAM content

All other elements (feature keys, soft keys and text areas) are retained

until the user presses a key or the connection with the Signaling Server
is resumed. If the user presses a key during the failover, the display is

cleared and a localized "Server Unreachable" message is displayed.

The IP Phone uses this new mode of reregistration only when the
Signaling Server explicitly tells the IP Phone to do so. IP Phones clear
all call information if they register to a Signaling Server or Line Terminal
Proxy Server (LTPS) that does not support the ACF feature.

For more information about Active Call Failover, see Signaling Server IP
Line Applications Fundamentals (NN43001-125).
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Enhanced UNIStim Firmware download

Enhanced UNIStim firmware download feature provides the following
functionality for IP Phones

* Enhanced firmware file header that includes the IT_TYPE and name
string for each IP Phone type.

* Revised definition of the IP Phone identification of the IP Phone Client.

* Maintenance Mode for the Signaling Server that allows more
simultaneous firmware downloads.

Maintenance Mode is not applicable to Voice Media Gateway Cards.

* Identification of the registered IP Phones using string names and
detailed identification of IP Phones that register as emulations of the
base IP Phone 2001, IP Phone 2002, and IP Phone 2004.

* UNIStim IP Phones are able to register with older versions of firmware
when the UFTP servers are busy, and are periodically offered an
option to start the firmware upgrade to the IP Phone.

Enhanced UNIStim Firmware download feature requires a Signaling Server
to be present on the node. Without a Signaling Server, the only firmware
files available for downloading are the three available in CS Release 4.0
for the Phase 0/1/2 IP Phone 2001, IP Phone 2002, and IP Phone 2004.

For further information about Enhanced UNIStim Firmware download and
IP Phone firmware upgrade using Element Manager, see Signaling Server
IP Line Applications Fundamentals (NN43001-125).

Media security

Media security normally shares keys using a secure UNIStim channel. In
situations where CS 1000 Release 5.0 or later is not available, you can
use Pre-Shared keys (PSK).

For CS 1000 Release 5.0 and later, the controlling Call Server provides all
of the keying material and control of the SRTP operation.

For CS 1000 Release 4.5 or earlier, the key is protected by a preshared
secret embedded in the IP Phone to generate and exchange encryption
parameters.

For more information about the Media Security feature, see Security
Management Fundamentals (NN43001-604).

The Media Security feature is supported on the following IP Phones:
* |P Phone 2001

* [P Phone 2002
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IP Phone 2004

IP Phone 2007

IP Phone 1110

IP Phone 1120E
IP Phone 1140E
IP Phone 1150E
IP Softphone 2050
IP Phone 1210

IP Phone 1220

IP Phone 1230

ATTENTION

The IP Softphone 2050 supports media security for CS 1000 Release 5.0
and later. The IP Softphone 2050 supports UNIStim key (USK) SRTP media
encryption only.

Media security is not available on the IP Phones 1210, 1220, and 1230 for the
following payloads: G.711 10ms, G.723 10ms, and G.729 10ms

Operating parameters
The Media Security feature has the following operating parameters

During a firmware upgrade, the Media security is automatically
disabled.

Media security does not support duplicate media streams encryption,
such as IP Call Recording.

Pre-Shared key (PSK) SRTP media encryption negotiates after the
call is setup. The first few seconds of the call can sometimes be
unsecured; after the lock icon displays the call is secure. UNIStim key
(USK) SRTP media encryption is negotiated before the call is setup
so no delays occur. In both versions of SRTP the call is secure when
the lock displays.

When USK SRTP negotiates, an outlined lock icon and Encrypted
appears on the display. When PSK SRTP negotiates, a solid lock icon
displays but Encrypted does not display.
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ATTENTION

A maximum of 24 characters for a name in the Personal Directory, Callers
List, or Redial List can appear in the display area. If PSK SRTP is enabled
and the name has the maximum of 24 characters, the last character in the
name truncates to display the secure lock icon.

®* SRTP PSK does not negotiate if you use 10ms G.729, due to the
small payload size. The call remains in RTP. All other payloads are
supported for PSK SRTP. USK SRTP supports all payloads.

ATTENTION
The IP Phone 1210, IP Phone 1220, and IP Phone 1230 do not support 10ms
G.729.

Configuration

For CS 1000 Release 5.0 or later, you can configure a system-wide
configuration setting (USK SRTP), which controls whether or not the CS
1000 system is capable of providing Media Security.

It is possible to enable both PSK SRTP on the IP Phone and configure
USK SRTP at the Call Server. If USK SRTP does not negotiate for a call,
PSK SRTP attempts to negotiate during a call. If the two endpoints for the
call have PSK SRTP enabled, the call is encrypted using PSK SRTP.

By default, Media Security is enabled on the system. To configure USK
SRTP, see “USK SRTP configuration” (page 362) . To configure PSK
SRTP on the IP Phone, see “PSK SRTP configuration” (page 363) .

USK SRTP configuration Use LD 17 to configure a system-wide Class
of Service parameter for IP Phones called Media Security System Default
(MSSD). The system default value is one of the following:

* Always Secure IP (MSAW)

* Best Effort (MSBT)

* Never (MSNV)

When you change the MSSD parameter, the system updates any IP

Phones that have a Class of Service value of MSSD to use the new MSSD
parameter.

Use LD 11 to configure the Media Security Class of Service on each IP
Phone. The IP Phone can have any of the following values:

* MSSD

* Best Effort
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* Always

®* Never

For more information about configuring system-wide Media Security and
configuring Class of Service, see Security Management Fundamentals
(NN43001-604).

PSK SRTP configuration The SRTP PSK (Pre-Shared Key) media
encryption feature provides encrypted media. A preshared secret is
embedded in the Nortel IP Phone to generate and to exchange encryption
parameters without any Call Server involvement. This feature provides
SRTP capabilities to IP Phones managed by call servers, which do not
support SRTP USK (UNIStim Key). The SRTP PSK feature must not be
used in networks where phone-to-phone one-way delay is greater than
200 ms.

You can configure an SRTP PSK payload type ID for exchanging SRTP
PSK encryption parameters, either manually or by using automatic
provisioning. You cannot manually configure the SRTP PSK payload type
ID when it is provisioned automatically. The payload type ID values are 96,
115, and 120. The default value is 96. SRTP PSK must be enabled before
you can change the payload type ID.

SRTP PSK uses RTP packets with Payload Type ID of 96 to exchange the
encryption parameters. With UNIStim firmware Release 3.2, three Payload
Type IDs can be selected to exchange the encryption parameters: 96, 115,
and 120.

The automatic provisioning feature enables you to configure SRTP
automatically through a provisioning file. For more information, see
“Provisioning the IP Phones” (page 461).

To configure PSK SRTP on IP Phones, see the following procedures:

* |P Phone 2001, IP Phone 2002, IP Phone 2004, IP Phone 1110, IP
Phone 1210, IP Phone 1220, and IP Phone 1230—Procedure 96
“Enabling SRTP media encryption on text-based IP Phones” (page
364)

* |P Phone 1120E, IP Phone 1140E, and IP Phone 1150E—Procedure
97 “Enabling SRTP media encryption on graphics-based phones”
(page 364)

IP Phone 2007—Procedure 99 “Enabling SRTP media encryption on
an IP Phone 2007” (page 365)

* |P Phone 1165E — Procedure 98 “Enabling SRTP media encryption
on an IP Phone 1165E” (page 365)
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For more information about configuring an IP Phone, see the applicable
section in this document.

Procedure 96
Enabling SRTP media encryption on text-based IP Phones

Step

Action

Disconnect then reconnect the power on the IP Phone to reset it.

When the Nortel logo appears, press each of the four soft keys
at the bottom of the display in sequence from left to right, one at
a time.

If no other configuration changes are required, press OK
repeatedly until PSK SRTP (0-No, 1-Yes) option appears.

Press 1 to enable PSK SRTP.
Press OK.
Restart the IP Phone.

—End--

For more information about configuring an IP Phone, see “Provisioning
the IP Phones” (page 461).

Procedure 97
Enabling SRTP media encryption on graphics-based phones

Step

Action

Double-press the Services key.

Press 3 on the dialpad to access the Network Configuration
menu or use the Up/Down navigation keys to scroll and highlight
the Network Configuration option.

Press Enter to start the edit mode.

Use the Right navigation key to navigate to Enable PSK SRTP.
The current setting displays.

Press Enter to switch this item on and off.

Press the Apply&Reset soft key to apply the current
configuration and reset the phone.

—End--
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Procedure 98
Enabling SRTP media encryption on an IP Phone 1165E

Step

Action

Disconnect then reconnect the power on the IP Phone to reset it.

When the Nortel logo appears, press each of the four soft keys
at the bottom of the display in sequence from left to right, one at
a time.

If no other configuration changes are required, press OK
repeatedly until PSK SRTP (0-No, 1-Yes) option appears.

Press 1 to enable PSK SRTP.
Press OK.
Restart the IP Phone.

—End--

Procedure 99
Enabling SRTP media encryption on an IP Phone 2007

Step

Action

Tap the Tools icon.
Select Network Configuration.

Use the Right navigation key to scroll to Enable PSK SRTP. The
current setting displays.

Select the check box to enable SRTP media encryption.

Tap the Apply&Reset soft key to apply the current configuration
and reset the phone.

—End--

Media Security information

Use the Encryption Info menu to view Media security information for the
IP Phone. Select Telephone Options > Set Info > Encryption Info. The
Encryption Info submenu offers the following choices:

* Encryption Capability—set to Available or Not Available depending on
the IP Phone type and the firmware version

* Encryption Policy—set to Never, Best Effort, or Always, depending on
configuration in LD 11
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UNIStim Security DTLS

Secured UNIStim signal encryption is provided by Datagram Transport
Layer Security (DTLS), which encrypts the data exchanges between

the Signaling Server and the IP Phones. Previously, Secure Multimedia
Controllers (SMC 2450) were required for UNIStim encryption, but DTLS
requires no new additional hardware and can coexist with currently
installed SMCs. DTLS and non-DTLS systems can be configured on the
same network.

To enable DTLS encryption, the Communication Server (CS) 1000 system
must be upgraded to CS 1000 Release 6.0 and the IP Phones must have
the latest firmware. Also, the system has to be configured with at least the
Basic Security level. For information about configuring UNIStim DTLS, see
Security Management Fundamentals (NN43001-604).

Note: This feature does not provide signaling encryption for the UFTP
protocol, which is used when transferring firmware to IP Phones.
Firmware data contains no sensitive information and is protected from
third-party tampering by a digital signature. Notifications from the
signaling server to the phones are sent using DTLS-protected UNIStim
signaling to protect the signals from intercept.

DTLS and IP Phone registration
There are two modes of IP Phone registration:

* Secure Handshake mode—the IP phone is configured to initiate a
DTLS session immediately upon beginning registration.

* Switchover mode—the IP phone is configured to first establish an
unencrypted RUDP session to the LTPS, then switchover to DTLS
depending on the DTLS Palicy.

IP Phones supporting DTLS
Currently, the following IP Phones support DTLS signaling encryption
(after applicable firmware upgrade):

* [P Phone 1200 series (IP Phone 1210, IP Phone 1220, IP Phone 1230)

* |P Phone 1100 series (IP Phone 1110, IP Phone 1120E, IP Phone
1140E, IP Phone 1150E)

* [P Phone 2000 series (IP Phone 2001, IP Phone 2002, IP Phone 2004,
IP Phone 2007)

ATTENTION
IP Phones require UNIStim 4.0 or later to support DTLS signaling encryption.
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UNIStim signalling security
With UNIStim firmware release 3.1, IP Phone 1120E, IP Phone 1140E,
and IP Phone 2007 can secure a connection with the Graphical External
Application Server (GXAS) using TLS. Securing the connection validates
the authenticity of the GXAS, using the certificate the server provides the
IP Phone.

If the authenticity of the GXAS is not validated and the application gateway
sends a dial command to the IP Phone, a prompt is displayed requesting
that the user confirm dialing. When the connection to the GXAS is secured
and the server authenticity is validated, the confirm prompt is not required
and the number is automatically dialed.

When the IP Phone connection to the GXAS is secure, a security icon
appears at the top right corner of the IP Phone 1120E and IP Phone
1140E display screen, and at the bottom of the IP Phone 2007 display
screen, just above the application button. The security icon appears
whether the GXAS application or the telephony screen is displayed on
the IP Phone. If the IP Phone connection to the GXAS is not secure, the
security icon does not appear.

To establish a secure connection between a GXAS that supports secure
mode and IP Phones 1120E, IP Phone 1140E, and IP Phone 2007, you
must provision the secure mode on the IP Phone manually or by using Info
Block.

To provision secure support on the IP Phone manually, you must
configure the XAS Mode menu item to Secure Graphical in the IP
Phone configuration menu. For more information about provisioning
secure support on the IP Phone manually with XAS Mode, see Table 124
"Provisioning parameters for graphic-based IP Phones" (page 522).

To provision secure support on the IP Phone using Info Block, you must
include s in the xa parameter character string. For more information about
provisioning secure support on the IP Phone using Info Block, see Table
110 "Provisioning info block format" (page 484).

When secure GXAS support is configured, the GXAS must assign a
certificate to the Application Server, which is then presented to the IP
Phone for authentication. For the IP Phone to authenticate this server
certificate, the Certificate Authority (CA) root certificate that issued the
server certificate must be in the IP Phone trusted store. For information
about installing and validating root certificates, see Root certificates.
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Live Dialpad

The primary Directory Number (DN) key is activated when the user makes
a call by dialing a DN on the dialpad without picking up the handset or
pressing the Handsfree key. To set the Live Dialpad feature to On or Off,
select Telephone Options > Live Dialpad. By default, Live Dialpad is set to
Off.

For more information about configuring Live Dialpad, see the applicable
IP Phone User Guide.

Normal Mode Indication

The Normal Mode Display notification can be on or off for IP Phones
registered in normal mode. This feature prevents the Branch User ID
(BUID) overwriting the date and time on the IP Phone 2002, IP Phone
1120E, and IP Phone 1220. This feature also stops infinite scrolling on the
IP Phone 2001, IP Phone 1110, IP Phone 1210, and IP Audio Conference
Phone 2033.

The Normal Mode Indication menu item is only available for single-line
phones with cookie support.

To turn notification on, select Telephone Options > Normal Mode
Indication, and then change Normal Mode Display to On.

To turn notification off, select Telephone Options > Normal Mode
Indication, and then change Normal Mode Display to Off.

Caller ID display order

The Caller ID can appear in two formats:
®* Number, name (Default)

* Name, number
To select the format, select Telephone Options > Caller ID display order.

If you select Number, name, then the Caller ID number always appears on
the first line. If the number and name (Calling Party Name Display [CPND]
or Proffered Name Match [PNM]) cannot fit on one line, then the name
appears on the second or third line.

If you select Name, number, then the Caller ID name always appears on
the first line and the number is displayed on the second line. If the name
does not exist, the number appears on the first line.

The Caller ID display order menu item is only available for single-line
phones with cookie support.
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Languages

The IP Phones support the following languages:

Arabic

Chinese Simplified

Chinese Traditional

Czech
Danish
Dutch
English
Finnish
French
German
Greek
Hebrew
Hungarian
Italian
Japan Kanji
Japan Katakana
Korean
Latvian
Norwegian
Polish
Portuguese
Russian
Spanish
Swedish
Turkish

With the appropriate downloaded fonts, the IP Phone supports Chinese
Simplified, Chinese Traditional, Japanese, and Korean. For more
information about downloadable fonts, see “Language enhancement”
(page 631).
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For the IP Phone 1110 and IP Phone 1210, the IP Phone display changes
from three-line mode to two-line mode when the language is Greek,
Hebrew, Arabic, Chinese Simplified, Chinese Traditional, Japanese, and
Korean. The IP Phone displays two-line mode for these languages as the
characters require more space.

Figure 69
Three-line and two-line displays

Three-line display Two-line display

Screen Saver Slideshow IP Phone 2007

The screen saver includes a photo slide show feature for the IP Phone
2007. You can use the Screen Saver Slideshow feature to download
images onto the phone for sequential display after the screen saver
activates. You can download up to ten images and you can specify the
interval between when the phone becomes idle and the slide show starts.

Minimum release IP Phone UNIStim software 3.3 is required to support the
new GUI for existing IP Phone 2007.

The following sections describe the operation of the Screen Saver
Slideshow feature:

* “General operation” (page 370)

®* “Screen saver images” (page 371)

® “Storing screen saver images” (page 372)

* “Deleting screen saver images” (page 372)

General operation
The screen saver slideshow cycles through a list of user-supplied images
in the phone.

The default value for the Screen Saver Slideshow feature is Off.

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.




Telephony features 371

You can use the ScreenSaver option in the Display Settings dialog to
delay the start of the slide show after the phone becomes idle. Use the
Down and Up soft keys in the Display Settings dialog, ScreenSaver option,
to configure a delay of

* 1 minute

* 5 minutes
® 10 minutes
* 15 minutes
* 30 minutes
* 1 hour

* 2 hours

After the slide show starts, each image displays for 10 seconds. Images
display continuously, and rotate sequentially, until the backlight timer
deactivates the backlight. If you select Display Dim Enabled, the slide
show remains visible after the backlight dims.

If you enable the screen saver and there are no images to display, your
phone does not display a screen saver.

Screen saver images

Images for use with the screen saver must be 320 x 240 pixels (height
X width) and can be either portable network graphic (PNG) or Joint
Photographic Experts Group (JPEG) format. (JPEG is Recommended)
Your Trivial File Transfer Protocol (TFTP) Server image directory can
contain both formats.

Name image files as screensaverN.png or screensaverN.jpg, depending
on the file format. N is a number from 0 to 9 inclusive. Because the
system ignores file extensions, ensure that you do not duplicate file
names.

You can store up to 10 screen saver images, either in the same folder
TFTP Server folder as the i2007.cfg file or in a sub-folder. If you store
the images in a sub-folder, ensure that the file path is included at the
beginning of each file name.

The following list provides examples of the image files hames.

® screensaver0.png is an image file stored in the i2007.cfg file

® 2007pics/screensaverl.jpg is an image file stored in a sub-folder
named 2007pics
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Storing screen saver images

To send screen saver images to your phone, add a new section, called
[IMAGES], to the i2007.cfg file. The [IMAGES] section can reside by itself
or with the [FW] and [FONTON] sections. Configure the section using the
command lines and specify the files you want to copy. Then use a TFTP
server to send images to the configuration file.

Following are the command lines you can use in the [IMAGES] section

of the i2007.cfg file:

* DOWNLOAD_MODE (required)

* VERSION (required)

* DELETE_FILES (optional)

* FILENAME (one file name per image file)

* PROTOCOL (required; value = TFTP)

* SERVER_IP (optional if the address is the same as the one sending
the .cfg file)

Following are the download modes that determine how the phone software

processes the [IMAGES] section:

* DOWNLOAD_MODE=FORCED

e DOWNLOAD_MODE=AUTO when the VERSION value is greater than
the current version value stored in the telephone

If you specify the forced download mode, your phone downloads the image
regardless of version number.

If you specify auto download mode, then VERSION specifies the version of
the images to download. Version applies to all files listed in the [IMAGES]
section. The factory default version value is 0. When images are written to
the software, the version value in the configuration file becomes the new
stored version value.

Deleting screen saver images
You can delete screen saver image files in the following ways:
* overwrite the file

* delete all the image files

To overwrite an image file, download an image file with an identical name.
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Table 80

To delete all images, add a line called DELETE_FILES to the configuration
file. Follow the command with a space and the character Y ory, or the
numeral 1. If you specify any other character or numeral, or leave the
space blank, the command is ignored and the system processes the
remainder of the [IMAGE] file contents.

If the [IMAGES] file contains a valid DELETE_FILES command and
FILENAME parameters, the system deletes the currently stored image files
first and then downloads the new images.

Table 80 "Valid delete command lines" (page 373) provides an example of
valid delete command lines.

Valid delete command lines

DELETE_FILES 1
DELETE_FILES Y
DELETE_FILES y
DELETE_FILES Yes

Table 81

Table 81 "Delete image files and load new images" (page 373) provides an
example of an [IMAGES] section containing commands to delete image
files with a version of less than 2 and to load new images and save the
version value 2.

Delete image files and load new images

[[IMAGES]

DOWNLOAD MODE AUTO

VERSION 2

DELETE_FILES yes

FILENAME screensaver0.png
FILENAME screensaverl.png
FILENAME 2007pics/screensaver4.jpg
FILENAME 2007pics/screensaver5.jpg
FILENAME 2007pics/screensaver6.jpg

Screen Saver Slideshow for IP Phone 1165E

The screen saver includes a photo slide show feature for the IP Phone
1165E. You can use the Screen Saver Slideshow feature to download
images onto the phone for sequential display after the screen saver
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activates. You can specify the interval between when the phone becomes
idle and the slide show starts. You can download or copy the images from
the USB flash drive to the phone.

Minimum software is required to support this feature.

The following sections describe the operation of the Screen Saver
Slideshow feature:

* “General operation” (page 374)

®* “Screen saver images” (page 375)

* “Storing screen saver images” (page 375)

* “Deleting screen saver images” (page 376)

General operation
The screen saver slideshow cycles through a list of user-supplied images
in the phone.

The default value for the Screen Saver Slideshow feature is Off.

You can use the ScreenSaver option in the Display Settings dialog to
delay the start of the slide show after the phone becomes idle. Use the
Down and Up soft keys in the Display Settings dialog, ScreenSaver option,
to configure a delay of

* 1 minute

* 5 minutes

* 10 minutes

* 15 minutes

* 30 minutes

* 1 hour

* 2hours

After the slide show starts, the phone displays the slideshow images from
the /image directory. Images display continuously, and rotate sequentially,

until the backlight timer deactivates the backlight. If you select Display Dim
Enabled, the slide show remains visible after the backlight dims.

If you enable the screen saver and there are no images to display, your
phone does not display a screen saver.
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Screen saver images

Images for use with the screen saver must be 240 x 320 pixels (height x
width) and can be either 24-bit portable network graphic (PNG) or Joint
Photographic Experts Group (JPEG) format. (JPEG is Recommended)
Your Trivial File Transfer Protocol (TFTP) Server image directory can
contain both formats.

Name image files as screensaverN.png or screensaverN.jpg, depending
on the file format. N is a number from 0 to 99 inclusive. Because the
system ignores file extensions, ensure that you do not duplicate file
names.

You can store images either in the same folder TFTP Server folder as the
1165e.cfg file or in a sub-folder. If you store the images in a sub-folder,
ensure that the file path is included at the beginning of each file name.
The following list provides examples of the image files hames.

* screensaver0.png is an image file stored in the 1165e.cfg file

* 1165Epics/screensaverl.jpg is an image file stored in a sub-folder
named 1165Epics

Storing screen saver images

To send screen saver images to your phone, add a new section, called
[IMAGES], to the 1165e.cfg file. The [IMAGES] section can reside by itself
or with the [FW] and [FONTON] sections. Configure the section using the
command lines and specify the files you want to copy. Then use a TFTP
server to send images to the configuration file.

Following are the command lines you can use in the [IMAGES] section

of the 1165e.cfg file:

e DOWNLOAD_MODE (required)

®* VERSION (required)

* DELETE_FILES (optional)

* REPLACE_BKGRND (optional)

* FILENAME (one file name per image file)

* PROTOCOL (required; value = TFTP)

* SERVER_IP (optional if the address is the same as the one sending
the .cfg file)

Following are the download modes that determine how the phone software
processes the [IMAGES] section:
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Table 82

¢ DOWNLOAD_MODE=FORCED

* DOWNLOAD_MODE=AUTO when the VERSION value is greater than
the current version value stored in the telephone

If you specify the forced download mode, your phone downloads the image
regardless of version number.

If you specify auto download mode, then VERSION specifies the version of
the images to download. Version applies to all files listed in the [IMAGES]
section. The factory default version value is 0. When images are written to
the software, the version value in the configuration file becomes the new
stored version value.

Deleting screen saver images
You can delete screen saver image files in the following ways:

* overwrite the file

* delete all the image files
To overwrite an image file, download an image file with an identical name.

To delete all images, add a line called DELETE_FILES to the configuration
file. Follow the command with a space and the character Y ory, or the
numeral 1. If you specify any other character or numeral, or leave the
space blank, the command is ignored and the system processes the
remainder of the [IMAGE] file contents.

If the [IMAGES] file contains a valid DELETE_FILES command and
FILENAME parameters, the system deletes the currently stored image files
first and then downloads the new images.

Table 82 "Valid delete command lines" (page 376) provides an example of
valid delete command lines.

Valid delete command lines

DELETE_FILES 1
DELETE_FILES Y

DELETE_FILES yES
DELETE_FILES Yes

Table 83 "Delete image files and load new images" (page 377) provides an
example of an [IMAGES] section containing commands to delete image
files with a version of less than 2 and to load new images and save the
version value 2.
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Table 83
Delete image files and load new images

[IMAGES]

DOWNLOAD MODE AUTO
VERSION 2

DELETE_FILES yes
FILENAME screensaver0.png

FILENAME screensaverl.png

FILENAME 1165Epics/screensaver4.jpg
FILENAME 1165Epics/screensaver5.jpg
FILENAME 1165Epics/screensaver6.jpg

Background image for IP Phone 1165E
You can select a picture as the background for the current theme of the
phone. You can download or copy the background image from the USB
flash drive.

You can use the background image of the theme by using the Use Theme
Background check box. This check box is selected by default. If the Use
Theme Background check box is not selected, you can browse the images
or download the image to set as background.

Note: The background image replaces the background image of the
theme only for the telephone screen. The background of the color
theme is still used for all menus and dialogs. That ensures menus will
always be readable and usable.

The following sections describe the operation of the background image
feature:

* “Background images” (page 377)
* “Storing background images” (page 378)
* “Deleting background images” (page 379)

Background images

Images for use with the screen saver must be 240 x 320 pixels (height x
width) and can be either 24 bit portable network graphic (PNG) or Joint
Photographic Experts Group (JPEG) format. (JPEG is recommended)
Your Trivial File Transfer Protocol (TFTP) Server image directory can
contain both formats.
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There can be one FILENAME entry in the [IMAGES] section for the
background image. The image file must be named background.png or
background.jpg. The phone ignores the filename extension once the file is
copied to it, so there can be only one background image file.

The following list provides examples of the image files hames.

* background.jpg is an image file stored in the 1165e.cfg file

Storing background images

You can store images either in the same folder TFTP Server folder as the
1165e.cfg file or in a sub-folder. If you store the images in a sub-folder,
ensure that the file path is included at the beginning of each file name.

To send background images to your phone, add a new line to the section,
called [IMAGES], to the 1165e.cfg file. Then use a TFTP server to send
images to the configuration file.

Following are the command lines you can use in the [IMAGES] section
of the 1165e.cfg file:

* DOWNLOAD_MODE (required)

VERSION (required)

* DELETE_FILES (optional)

* REPLACE_BKGRND (optional)

* FILENAME (one file name per image file)

* PROTOCOL (required; value = TFTP)

* SERVER_IP (optional if the address is the same as the one sending
the .cfg file)

Following are the download modes that determine how the phone software
processes the [IMAGES] section:

* DOWNLOAD MODE=FORCED
e DOWNLOAD_MODE=AUTO when the VERSION value is greater than
the current version value stored in the telephone

If you specify the forced download mode, your phone downloads the image
regardless of version number.
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If you specify auto download mode, then VERSION specifies the version of
the images to download. Version applies to all files listed in the [IMAGES]
section. The factory default version value is 0. When images are written to
the software, the version value in the configuration file becomes the new
stored version value.

Deleting background images
You can delete screen saver image files in the following ways:

* overwrite the file by transferring another background file
* delete the file via the File Manager
* delete all the image files using the DELETE_FILES line

To overwrite an image file, download an image file with an identical name.

To delete all images, add a line called DELETE_FILES to the configuration
file. Follow the command with a space and the character Y ory, or the
numeral 1. If you specify any other character or numeral, or leave the
space blank, the command is ignored and the system processes the
remainder of the [IMAGE] file contents.

If the [IMAGES] file contains a valid DELETE_FILES command and
FILENAME parameters, the system deletes the currently stored image files
first and then downloads the new images.

Table 84 "Valid delete command lines" (page 379) provides an example of
valid delete command lines.

Table 84
Valid delete command lines

DELETE_FILES 1
DELETE_FILES Y
DELETE_FILES yES
DELETE_FILES Yes

Table 85 "New section in 1165E.cfg file" (page 379) provides an example
of new section in the 1165E.cfg file. The background image in this
example file is in a subdirectory named “1165Epics”

Table 85
New section in 1165E.cfg file

[IMAGES]
DOWNLOAD MODE AUTO
VERSION 000005
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FILENAME 1165Epics/background.png
REPLACE_BKGRND yes
FILENAME screensaver0.png

Key number assignments

This section describes the key number assignments for the IP Phone
2001, IP Phone 2002, IP Phone 2004, IP Phone 2007, IP Phone 1110,
IP Phone 1120E, IP Phone 1140E, IP Phone 1150E, IP Phone 1210,
IP Phone 1220, and IP Phone 1230. The IP Phone 1150E feature key
number assignments are described in “IP Phone 1150E feature key
number assignments” (page 380).

Programmable line/feature keys

Key numbers 1 to 15 are used for programmable line/feature keys. These
keys can be any DN or feature except for Message Waiting and those
configured on keys 17 to 26.

Soft keys

You can assign a maximum of nine functions to the four soft-labeled,
predefined soft keys. Because the soft keys are predefined, the user
cannot change the key number assignment. Functions are assigned to the
soft keys in layers in LD 11.

The Message Waiting key is numbered 16.

Functions mapped to key numbers 17 to 26 are assigned to the four soft
keys. Labels for the soft keys appear in the display area.

For a description of the IP Phone function assignment for each soft key,
see “IP Phone context-sensitive soft keys” (page 677).

IP Phone 1150E feature key number assignments
This section describes the following keys supported on the IP Phone
1150E

* “Self-labeled line/programmable feature keys” (page 380)
* “ACD fixed feature keys” (page 381)
* “Soft keys” (page 381)

Self-labeled line/programmable feature keys The IP Phone 1150E has
six self-labeled line/programmable feature keys, which can support up to
12 DNs or features on two pages. When a call is presented on a feature
key which is not currently shown, the message Shift for Call appears in the
display area. Press the Shift/Outbox key to access the second page of a
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feature or DNs, or to access any Expansion Module 1100s attached to the
phone.

The six self-labeled line/programmable feature keys are numbered 0 to 5
for the first key page, and 6 to 11 for the second key page.

When key 0 is programmed as the ACD In-Calls key, the default features
are assigned to the Automatic Call Distribution (ACD) fixed keys.

ACD fixed feature keys

Key numbers 12 to 15 are used for the ACD fixed features. See Table 86
"ACD default Agent fixed feature keys" (page 381) for a list of the ACD
default Agent fixed feature keys or Table 87 "Supervisor fixed feature
keys" (page 381) for a list of Supervisor fixed feature keys.

For a description of supported call features, see “Call features” (page 679).

Table 86

ACD default Agent fixed feature keys
Key number Response Description
Key 12 NRD Not Ready
Key 13 MSB Make Set Busy
Key 14 ASP Call Supervisor
Key 15 EMR Emergency

The In-Calls key mirrors the programming of key 0; it is not separately
programmable.

Table 87
Supervisor fixed feature keys
Key number Response Description
Key 12 OBV Observe Agent
Key 13 RAG Call Agent
Key 14 AAG Answer Agent
Key 15 AMG Answer Emergency

Soft keys You can assigh a maximum of nine functions to the four
soft-labeled, predefined soft keys. Because the soft keys are predefined,
the user cannot change the key number assignment. Functions are
assigned to the soft keys in layers in LD 11.

The Message Waiting key is numbered 16.
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Functions mapped to key numbers 17 to 26 are assigned to the four soft
keys. Labels for the soft keys appear in the display area. For further
information, see “Context-sensitive soft key label” (page 329). Figure 60
"IP Phone 1150E display area" (page 328) shows the IP Phone 1150E
display area.

Key number mappings at the Call Server align with the IP Phone 2004.

For a description of the IP Phone function assignment for each soft key,
see “IP Phone context-sensitive soft keys” (page 677).

Network features

This section provides a description of the following IP Phone network
capabilities

* “Full Duplex " (page 382)

* “802.1x Port-based network access control” (page 388)
e “802.1ab Link Layer Discovery Protocol” (page 390)

* “Dynamic Host Configuration Protocol” (page 391)

* ‘“Gratuitous Address Resolution Protocol” (page 416)

* “Automatic QoS” (page 416)

Full Duplex

In the Configuration menu, autonegotiate mode is the default setting for
initial startup. Nortel recommends that autonegotiate mode is used on the
network and the IP Phone. Use Full Duplex mode only when the network
is forced Full Duplex for 100BT Full Duplex mode; otherwise, a duplex
mismatch results. No intervention is required under normal operation.

ATTENTION
Nortel recommends that autonegotiate mode is used on the network and the IP
Phone. Use Full Duplex mode only when the network is forced Full Duplex for

100BT Full Duplex mode; otherwise, a duplex mismatch results.

If the IP Phone connects to a network configured for Full Duplex mode
only, the IP Phone cannot automatically negotiate the proper configuration.
Therefore, in this instance, to allow the IP Phone to work at the optimum
speed and duplex mode, Full Duplex mode must be enabled.

Use the following procedure to enable Full Duplex mode for IP Phone
2001, IP Phone 2002, IP Phone 2004, IP Audio Conference Phone 2033,
IP Phone 1210, IP Phone 1220, and IP Phone 1230.

Nortel Communication Server 1000
IP Phones Fundamentals
NN43001-368 06.03 16 December 2009

Copyright © 2003-2009 Nortel Networks. All Rights Reserved.




Network features 383

Procedure 100
Enabling Full-duplex mode for 2000 Series and 1200 Series IP Phones

Step Action

1 Double-press the Services key to access the Local Tools menu.
Press 3. Network Configuration to access the configuration
menu.

2 If you do not require other configuration changes, press OK

repeatedly until the Speed option appears.
3 Select one of the following:

e 1 for 10 Mb/s

e 2 for 100 Mb/s

Press OK repeatedly until the Duplex network option appears.

5 Select 1 to enable Full-duplex mode or 2 to enable Half-duplex
mode.

Select OK to confirm the change.

Press OKEnter repeatedly. The IP Phone saves the
configuration and then reboots.

8 Restart the IP Phone. The firmware settings are read and are
applied to UPLINK and the PC Ethernet Port.

—End--

If the IP Phone restarts, the firmware reads the setting for Full-duplex
mode and sets the LAN Ethernet port, PC Ethernet port, duplex, and
speed accordingly.

Use Procedure 101 “Checking Ethernet statistics for 2000 Series and 1200
Series IP Phones” (page 383) to confirm activation of Full Duplex mode.

Procedure 101
Checking Ethernet statistics for 2000 Series and 1200 Series IP Phones

Step Action

Double-press the Services key.

Use the navigation keys to scroll and highlight Local
Diagnostics.

Press the Select soft key.

Use the navigation keys to scroll and highlight Ethernet
Statistics .

5 Press the Select soft key.
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6 If Full-duplex mode is active, use the navigation keys to scroll
the following information:

* Link: UP

* Duplex: Full

* Speed: 10 (Mb) or 100(Mb)
* Auto-Negotiate Capability: N
* Auto Sense/Negotiate

¢ Auto-Negotiate Completed: N
* VLANPriority

e VLANID

* PktColl

e CRCErrors

*  FrameError

® UcastPktTx

® UcastPktRx

* BcastPktRx

* McastPktRx

* 802.1x Status

e EAP Status

—End--

Use the following procedure to enable Full Duplex mode for the IP Phone
2007.

Procedure 102
Enabling Full-Duplex mode for IP Phone 2007

Step Action

Tap the Tools icon.

Enter the Tools menu password (if Password protection is
enabled). For information about Password Protection, see “Local
Tools menu” (page 441).

3 Tap the Network Configuration menu entry.

4 Use the Right navigation key to scroll and highlight the Duplex
list.

5 Press the Down navigation key to open list box.
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Use the Up/Down navigation keys to scroll and highlight one of
the following options:

* 10BT Full—10 BT Full Duplex mode
¢ 100BT Full—100 BT Full Duplex mode
Tap the Apply&Reset soft key to save the changes and to

restart the IP Phone. The firmware settings are read and are
applied to UPLINK and the PC Ethernet Port.

—End--

When the IP Phone restarts, the firmware reads the setting for Full Duplex
mode and sets the LAN Ethernet port, PC Ethernet port, duplex, and
speed accordingly.

Use the following procedure to confirm activation of Full Duplex mode.

Procedure 103
Checking Ethernet Statistics for IP Phone 2007

Step

Action

Tap the Tools icon.

Tap the Local Diagnostics soft key.
Tap the Ethernet Statistics soft key.
The following statistics are displayed:
* Link: Up

* Duplex: Full

* Speed: 10 (Mb) or 100 (Mb)

* Auto-Negotiate Capability: N

* Auto-Negotiate Completed: N

—End--

UseProcedure 104 “Enabling Full Duplex mode for IP Phone
1120E/1140E/1150E" (page 386) to enable Full Duplex mode on the IP
Phone 1110, IP Phone 1120E, IP Phone 1140E, and IP Phone 1150E.
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Procedure 104
Enabling Full Duplex mode for IP Phone 1120E/1140E/1150E

Step Action
Double-press the Services key to open the Local Tools menu.
Press 3 on the dialpad to access the Network Configuration
dialog.
3 Press the right navigation key until the Ntwk Port Duplex item
is highlighted.
Note: The Ntwk Port Speed item must be set to 10BT or
100BT first.
Press Enter to start the edit mode.
Press the Down navigation key to open list box.
Use the Up/Down navigation keys to scroll and highlight one of
the following options
* Force Full - forced full duplex mode
* Force Half - forced half duplex mode
7 Press Enter to select the setting and exit the list.

Press Apply to save the settings and restart the IP Phone. The
saved setting is read and applied to the NI ethernet port.

—End--

Use Procedure 105 “Checking Ethernet Statistics for IP Phone
1120E/1140E/1150E ” (page 386) to confirm activation of Full Duplex

mode.

Procedure 105
Checking Ethernet Statistics for IP Phone 1120E/1140E/1150E

Step

Action

Double-press the Services key.

Press 2 to select Local Diagnostics, then press 3 to open the
Ethernet Statistics menu.

If Full Duplex mode is active, the following is displayed
* Link Status: UP
* Duplex Mode: Full
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* Network Speed: 10 Mb, 100 Mb, or 1 G
* Auto Sense/Negotiate

— Auto-Negotiate Capability: No

— Auto-Negotiate Completed: No

—End--

Use the following procedure to enable Full Duplex mode on the IP Phone
1165E.

Procedure 106
Enabling Full-Duplex mode for IP Phone 1165E

Step Action

Double-press the Services key to open the Local Tools menu.

Press the left navigation key to access the Configuration menu.
Then press 1 on the dialpad to open the Network Configuration
dialog.

3 Press the down navigation key until the Ntwk Port Duplex item
is highlighted.

Note: The Ntwk Port Speed item must be set to 10BT or
100BT first.
Press Enter to start the edit mode.

5 Press the Down navigation key to highlight one of the following
options

* Force Full - forced full duplex mode
* Force Half - forced half duplex mode

Press Enter to select the setting and exit the list.

Press Apply to save the settings and restart the IP Phone. The
saved setting is read and applied to the NI ethernet port.

—End--

Use the following procedure to confirm activation of Full Duplex mode.
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802.1x

Procedure 107
Checking Ethernet Statistics for IP Phone 1165E

Step Action

Double-press the Services key to open the Local Tools menu.

Press the left/right navigation keys to scroll to the Diagnostics
menu. Then press 3 on the dialpad to open the Ethernet
Statistics dialog.

3 If Full Duplex mode is active, the following is displayed:
* Link Status: UP
* Duplex Mode: Full
* Network Speed: 10 Mb, 100 Mb, or 1 G
* Auto Sense/Negotiate
— Auto-Negotiate Capability: No
— Auto-Negotiate Completed: No

—End--

Port-based network access control
802.1x defines the following three roles

® Supplicant—an IP Phone which requires access to the network to use
network services.

* Authenticator—the network entry point to which the supplicant
physically connects (typically a Layer 2/3 switch). The authenticator
acts as the proxy between the supplicant and the authentication
server. The authenticator controls access to the network based on the
authentication status of the supplicant.

* Authentication server—performs authentication of the supplicant.

Extensible Authentication Protocol

Extensible Authentication Protocol (EAP) supports multiple authentication
methods, such as EAP-PEAP, EAP-MD5, and EAP-TLS and represents
a technology framework that facilitates the adoption of Authentication,
Authorization, and Accounting (AAA) schemes, such as Remote
Authentication Dial In User Service (RADIUS). RADIUS is defined in RFC
2865.
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Authorization If 802.1x is configured and the IP Phone is physically
connected to the network, the IP Phone (supplicant) initiates 802.1x
authentication by contacting the Layer 2/3 switch (authenticator). The IP
Phone also initiates 802.1x authentication after the Ethernet connection
(network interface only) is restored following a network link failure.
However, if the phone resets, the IP Phone resets then reinitiates a
reauthentication. The IP Phone fails to authorize if the credentials that the
IP Phone presents do not authenticate. Each EAP type requires different
credentials. The Layer 2 switch (authenticator) locks out the IP Phone
and network access is denied. If this happens during reauthorization, all
IP Phone services are lost.

The connected PC operates as normal if MHMA is properly configured on
the Layer 2 switch and if the PC successfully authenticates using EAP.
Otherwise, the PC disconnects from the network, as well.

If EAP is enabled, multihost must be configured on the Layer 2 switch
or PC cannot connect. If MHMA is properly configured, the PC must
authenticate, as well. If MHSA is configured, the IP Phone and the PC
cannot authenticate and the PC is blocked.

Authentication methods Table 88 "IP Phone authentication methods"
(page 389) shows the authentication methods and the IP Phone it

supports.
Table 88
IP Phone authentication methods
Authentication method IP Phone
EAP MD5 IP Phone 2001, IP Phone 2002, IP Phone 2004, IP Audio

Conference Phone 2033, IP Phone 1210, IP Phone 1220,
IP Phone 1230, IP Phone 2007, IP Phone 1110, IP Phone
1120E, IP Phone 1140E, IP Phone 1150E

EAP PEAP, EAP TLS IP Phone 1210, IP Phone 1220, IP Phone 1230, IP Phone
2007, IP Phone 1110, IP Phone 1120E, IP Phone 1140E, IP
Phone 1150E

EAP-TLS requires root and device certificates while EAP-PEAP requires a
root certificate only.

If you configure EAP-TLS, then the root and device certificate must first be
installed on the phone. The Certificate Authority (CA), Domain Name, and
Hostname (optional) must be configured on the phone. After configuration,
the phone uses Simple Certificate Enrollment Protocol (SCEP) to request
the root and devices certificates from the CA Server. To install the root
certificate, you can be prompted to accept the root certificate fingerprint.
You can permanently save the root certificate and the device certificate in
the trusted certificate store.
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It is possible to install more than one customer root certificate on the
phone if more than once Certificate Authority is used.

The IP Phone sends a request to server to obtain a root certificate and a
device certificate.

If you configure EAP-PEAP, the root certificate extracts from the
configuration file and stores in the trusted certificate store.

If the certificate installation fails, EAP-TLS or EAP-PEAP does not
initialize. The IP Phone does not authenticate and cannot access the
network.

802.1ab Link Layer Discovery Protocol
802.1ab Link Layer Discovery Protocol is available for the following IP
Phones

* |P Phone 2001
* [P Phone 2002
* [P Phone 2004
* |P Phone 2007
* |P Phone 1110
* [P Phone 1120E
* |P Phone 1140E
* |P Phone 1150E
* [P Phone 1210
* [P Phone 1220
* |P Phone 1230

Description

The IEEE 802.1ab Link Layer Discovery Protocol (LLDP) defines a
standard method for Ethernet network devices, such as IP Phones,
switches, and routers to exchange information about their capabilities with
other devices and to store this information in a Management Information
Base (MIB).

LLDP also enables the system administrator to view the entire network
infrastructure.

The Telecommunications Industry Association (TIA) developed the
Link Layer Discovery Protocol (LLDP)-Media Endpoint Discovery
(LLDP-MED) extension of 802.1ab LLDP for VolP networks, as defined by
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ANSI/TIA-1057. This extension enables media devices such as IP Phones,
IP media gateways, IP media servers, and IP media controllers to transmit
and receive media related information.

LLDP provides the following functionality
® periodic transmission of advertisements containing device information

* device capabilities and media specific configuration information to
neighbors in the same network

* implementation of behavioral requirements specified by LLDP-MED

LLDP devices advertise their information by sending Type-Length-Value
(TLV) messages to their neighbors. The TLVs supported in the IP phones
include:

* Basic Management TLV
* |EEE 802.1 Organizationally Specific TLV
* |EEE 802.3 Organizationally Specific TLV

* TIA Media Endpoint Discovery (